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ABOUT THE RELEASE NOTES

The release notes provide information about new major Salesforce features and major enhancements to existing features.
You can choose from PDF and HTML versions. The release notes include:

e Brief, high-level descriptions of the functionality

e Setup information

e Implementation tips to help you get started

e Best practices to ensure your continued success

The release notes also identify all other changes and provide details about how those changes might affect your organization.

IN THIS SECTION:
Stay Informed about Updates

Use Twitter to get documentation updates.
Browse the Top Winter '15 Features in the New Release Notes Spotlight

Excited about Winter 15 but too busy to page through the whole Release Notes? We're here to help. The new Release Notes Spotlight
gives you just the most important facts about what's new and what's changed in Salesforce.

You Asked for It!

We delivered the features you asked for on Ideakxchange.

Your Feedback Matters

We know how important our documentation is to your company’s success. We want to know what works for you and what doesn't.

Links in the Release Notes May Not Work before the Salesforce Release

Some links to the Salesforce Help, implementation guides, tip sheets, and developer guides won't work until the Salesforce release
itself is available in your sandbox or production organization.

Other Resources
In addition to these release notes, we provide other resources to get you up to speed quickly.

Release Notes Changes
Monitor this list to keep track of changes to the release notes.

Stay Informed about Updates

Use Twitter to get documentation updates.

When you follow @salesforcedocs on Twitter, you'll receive notices whenever we publish new documentation or make significant
updates to existing documentation.

Browse the Top Winter ‘15 Features in the New Release Notes Spotlight

Excited about Winter "15 but too busy to page through the whole Release Notes? We're here to help. The new Release Notes Spotlight
gives you just the most important facts about what's new and what's changed in Salesforce.


http://docs.releasenotes.salesforce.com/en-us/winter15/release-notes/rn_included_release_notes.htm
http://twitter.com/salesforcedocs

About the Release Notes You Asked for It!

The Release Notes Spotlight is available as a beta with the Winter 15 release. Use it for a quick overview of the most important new
features and updates in this release, then dive into the full Release Notes knowing just what you're looking for.

RELEAS: (NOTES
& SPOTLIGHT

@ Nofe: The Release Notes Spotlight is in beta. Its content may lag slightly behind the latest updates to the full Release Notes.

You Asked for It!

We delivered the features you asked for on Ideakxchange.

IdeaExchange Idea delivered
Salesforce - Need ability to convert leads Convert Leads to Contacts (Beta)

Allow Products / Pricebooks to be displayed in Salesforcel app ~ Create an Action to Add Products to Opportunities (partially
delivered)

Ability tofilter out certain attachments with Salesforce for Outlook  Let Users Select Specific Email Attachments to Add to Salesforce

Support of CORS (Cross-Origin Resource Sharing) in RESTful APl Use CORS (Cross-Origin Resource Sharing) to Access Chatter REST

API

Track Export History Use Event Monitoring to Understand Organization Trends (Generally
Available)

Login / Logout History Use Event Monitoring to Understand Organization Trends (Generally
Available)

Access To Transactional Logs for Your Organization Use Event Monitoring to Understand Organization Trends (Generally
Available)

API Calls Report - More Depth Use Event Monitoring to Understand Organization Trends (Generally
Available)

Tracking Users Activities Use Event Monitoring to Understand Organization Trends (Generally
Available)

Logging How Many Times a Report Is Used Use Event Monitoring to Understand Organization Trends (Generally
Available)

Salesforce.com Needs Better Logging Support Use Event Monitoring to Understand Organization Trends (Generally
Available)


https://cs7.salesforce.com/help/pdfs/en/salesforce_winter15_release_spotlight.pdf
https://success.salesforce.com/ideaSearch
https://success.salesforce.com/ideaView?id=08730000000l21iAAA
https://success.salesforce.com/ideaView?id=08730000000kxxfAAA
https://success.salesforce.com/ideaView?id=08730000000g5DMAAY
https://success.salesforce.com/ideaView?id=08730000000ZojFAAS
https://success.salesforce.com/ideaView?id=08730000000BqQGAA0
https://success.salesforce.com/ideaView?id=08730000000Bqv8AAC
https://success.salesforce.com/ideaView?id=08730000000IddEAAS
https://success.salesforce.com/ideaView?id=08730000000BpfzAAC
https://success.salesforce.com/ideaView?id=08730000000BrU2AAK
https://success.salesforce.com/ideaView?id=08730000000KT8MAAW
https://success.salesforce.com/ideaView?id=08730000000BqTOAA0

About the Release Notes

IdeaExchange

Track Who Viewed Content in Preview and Full Screen Mode
History Object to Hold Report Usage

Breakdown API Usage

Allow Tracking of APl Usage Per User

Report Usage

Option to Only Enforce Two-Factor Authentication Outside of
Trusted IP Ranges

Add Time Based Setting to Two-Factor Authentication

Delegated Admin Reset Time-Based Tokens for Two Factor
Authentication

Enable Hover Links in Feed-Based Layout
Copy all recipients on auto-response replies to cases generated
by email-to-case

Ability to Upload Chatter Profile Photo Via Salesforce

Your Feedback Matters

Your Feedback Matters

Idea delivered

Use Event Monitoring to Understand Organization Trends (Generally
Available)

Use Event Monitoring to Understand Organization Trends (Generally
Available)

Use Event Monitoring to Understand Organization Trends (Generally
Available)

Use Event Monitoring to Understand Organization Trends (Generally
Available)

Use Event Monitoring to Understand Organization Trends (Generally
Available)

Customize and Manage User Authentication with Login Flows

TwoFactorlnfo object

Use Hover Links to Quickly Access Related Lists on Feed-Based
Layout Detail Views

Include Additional Email Addresses on Email-to-Case Auto-Response
Messages

Edit Profile Pictures in All Versions of the Salesforcel App

We know how important our documentation is to your company'’s success. We want to know what works for you and what doesn't.

e Feedback forms: As you're working with our documentation—whether it's in the Salesforce Help, release notes, or developer
guides at Salesforce Developers—Iook for the feedback form and vote up or down. Add comments if you have them.

e Twitter: Tweet us at @salesforcedocs.

Links in the Release Notes May Not Work before the Salesforce Release

Some links to the Salesforce Help, implementation guides, tip sheets, and developer guides won't work until the Salesforce release itself

is available in your sandbox or production organization.

Other Resources

In addition to these release notes, we provide other resources to get you up to speed quickly.

e Release Readiness community. Join a community of Salesforce experts.


https://success.salesforce.com/ideaSearch
https://success.salesforce.com/ideaView?id=08730000000BqDTAA0
https://success.salesforce.com/ideaView?id=08730000000bLLDAA2
https://success.salesforce.com/ideaView?id=087300000006n5YAAQ
https://success.salesforce.com/ideaView?id=08730000000hQNpAAM
https://success.salesforce.com/ideaView?id=08730000000XgZDAA0
https://success.salesforce.com/ideaView?id=08730000000l2u9AAA
https://success.salesforce.com/ideaView?id=08730000000l2u9AAA
https://success.salesforce.com/ideaView?id=08730000000l7TxAAI
https://success.salesforce.com/ideaView?id=08730000000l0qPAAQ
https://success.salesforce.com/ideaView?id=08730000000l0qPAAQ
https://success.salesforce.com/ideaView?id=08730000000l3qrAAA
https://success.salesforce.com/ideaView?id=087300000007EuhAAE
https://success.salesforce.com/ideaView?id=087300000007EuhAAE
https://success.salesforce.com/ideaView?id=08730000000kz5KAAQ
http://twitter.com/salesforcedocs
https://success.salesforce.com/_ui/core/chatter/groups/GroupProfilePage?g=0F9300000001oku

About the Release Notes Release Notes Changes

e Release demos. Get quick video overviews of what's coming this release.

e Winter 15 Training. Take online training to check out Winter '15 features and enhancements and to prepare for certification release
exams.

Release Notes Changes

Monitor this list to keep track of changes to the release notes.

December 30, 2014

Other Changes in Files
Added an entry for a change to the Google Doc URL field when attaching a Google doc to a record.

December 24, 2014

Salesforce Chatter Mobile Version 3.1 for Android No Longer Available
Added information that Chatter Mobile version 3.1 for Android has been removed from Google Play.

December 3, 2014

Sync Shared Files with Salesforce Files Sync on page 189
Added a release note about the new sync shared files feature.

Metadata Types and Fields
Added a change to the apiKey field on the ExternalDataSource type.

Duplicate Management (Closed Beta)
Added information to clarify that this feature has been released in a closed beta program for Winter '15. Due to high demand for
participation in the closed beta program, we have reached our capacity and are not taking new nominations. For complete details
about expected general availability (Safe Harbor applies), see the “Duplicate Management (Closed Beta)” topic.

Submit and Monitor Jobs for Asynchronous Execution with the Queueable Interface
Corrected the testing sample and removed information about job delay that doesn't apply.

November 20, 2014

Salesforce1 Enhancements
Salesforce1 Downloadable Apps for iOS and Android Version 7.0 Generally Available

What's new in version 7.0:

e Support for iOS 8, and for Apple iPhone 6 and 6 Plus devices (i0S only)

e Support for Android OS 5.0 (Android only)

e Do most actions with the new Salesforce1 action bar and list item actions

e See up to 200 list views

e Sort and filter list views

e Open most Salesforce URLs directly in the Salesforce1 downloadable app (i0S only)

e (reate contacts from mobile contact lists


http://www.youtube.com/user/SalesforceReleases
http://www.salesforce.com/customer-resources/releases/winter15/release-training.jsp

About the Release Notes Release Notes Changes

e (reate an action to add products to opportunities

e See profile pictures for opportunity team members

e Make updates to tasks without opening task records

e See a weekly view of Salesforce events

e See more data in Today, including recently accessed records
e Share dashboards in the feed

e Bug fixes and performance improvements
The Salesforce1 Downloadable App for iOS version 7.0 is currently available for download in the Apple App Store.

The Salesforce1 Downloadable App for Android version 7.0 will be available soon on Google Play. When the release is announced,
the app will be gradually rolled out to users over the course of several days.

November 19, 2014

Other Changes in Salesforce1
The Salesforce1 mobile browser app is now generally available on Windows 8.1 phones.

November 12, 2014

Send Email from an Organization-Wide Email Address
Added information about changes to the Send Email element in Visual Workflow.

Deploy Your Components in Less Time (Pilot)
Clarified note about when quick deployments are supported.

November 5, 2014

Access External Data with Lightning Connect
Changed the feature name from Platform Connect to Lightning Connect throughout the release notes and other documentation.

Environment Hub Setup Simplified
Added Developer Edition to the list of editions that no longer require My Domain deployment.

October 29, 2014

Chatter for SharePoint 2010—Generally Available
Added information about a new feature available in Winter 15, Chatter for SharePoint 2010.

Manage Thanks Badges with the Badges Tab
Changed information about allowing community users to access company badges.

Retirement of Support for the Salesforce CTI Toolkit
Added information about the retirement of support for all versions of the CTI Toolkit.

Ask Questions in the Chatter Feed with Chatter Questions (Generally Available)
Added information about Similar Questions, a Chatter Questions Beta feature.

Let Your Users Control Task Notifications Globally
e (larified information about triggerUserEmail for notifications.

e (larified information about how to hide user settings.
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Changed Objects
Updated sort order constraints and examples for the following objects.

e ActivityHistory
e LookedUpFromActivity
e OpenActivity

October 22, 2014

Other Changes in Chatter
Added information about Topic Assignments custom report type, and removed dated information about redesigned email notifications.

Get Data.com Contacts for an Account
Added information about the new Data.com Get Contacts for Salesforce AppExchange package.

October 18, 2014

Introducing Wave, the Analytics Cloud
Added information about Salesforce Analytics Cloud.

Visually Automate Your Business Processes (Beta)
Added information about the Process Builder.

Differences in using Chatter with Salesforce1 Mobile Browser App
You can’t upload files in Salesforce mobile browser app using the Good Access” secure mobile browser.

Limits on Numbers of Territory Models, Territories, and Assignment Rules
Added information about the default number of territories allowed per territory model.

October 8, 2014

Lightning Components (Beta)
Added information about the Lightning Components (Beta). The Lightning Component framework powers Salesforcel. You can
use it to create your own Lightning components and make them available to Salesforce1 users.

Indexing Changes for Global Search and SOSL
Removed information about the option to exclude custom objects that your users aren't actively searching from the search index.
This change was not included in this release.

Manage Thanks Badges with the Badges Tab
Added information about changes to the Chatter publisher and company badges.

October 1, 2014

Let Your Users Control Task Notifications Globally
Corrected the information about tasks that are generated by the triggerUserEmail field:If you don't expose the user setting,
thenthe triggerUserEmail field continues to support sending an email when a task is created or modified.

Labels Changed in User Settings
Corrected the information about changes to the labels in the user settings. In My Settings, Calendar and Reminders was not
changed between Summer 14 and Winter '15. Under Calendar and Reminders, the Reminders page has been renamed Reminders
& Alerts.
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Salesforce1 Enhancements
Salesforce1 Downloadable App for Android Version 6.0 Generally Available

What's new in version 6.0:

e View Salesforce data with Offline Cache

e Quickly switch between accounts in multiple organizations and communities
e Bug fixes and performance improvements

The Salesforce 1 Downloadable App for Android Version 6.0 will available on Google Play for all users a few days after the initial release
date.

Other Changes in Salesforce1
Temporary known issue that the View Comment button in notification emails no longer correctly directs users of the Salesforce
Downloadable App for iOS.

Salesforce1 Enhancements
Removed information about being able to see more list views from an object’s record search page in Salesforce1. This change was
not included in this release.

Ask Questions in the Chatter Feed with Chatter Questions (Generally Available)
Clarified how to enable Chatter Questions.

Other Changes in Service Cloud
Added information about a change that prevents Self-Service Portal pages from redirecting to non-Salesforce domains. This action
will eliminate the risk of users unknowingly being diverted to sites by an unauthorized third party.

Community Templates for Self-Service (Generally Available)
Removed a note indicating that the Napili template isn't available in sandbox organizations. This template is now available in all
Winter '15 organizations, including sandboxes.

Let Customers Ask Questions and Find Articles in Your Support Community
Removed a note indicating that the Napili template isn't available in sandbox organizations. This template is now available in all
Winter '15 organizations, including sandboxes.

September 24, 2014

Indexing Changes to Help Your Users Search Faster for Global Search and SOSL
Added information about a new option to remove custom objects that your users aren't actively searching from the search index.
This change provides faster indexing and search response times via global search and SOSL.

September 17, 2014

REST API
Added that the Post to Chatter standard invocable action can include @mentions and topics.

Tooling API
The following objects are not available but were earlier listed as new in the Tooling APl Developer’s Guide.

e CompactLayoutinfo
e CompactlLayoutlteminfo
e Name

e ValidationRuleMember
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Submit and Monitor Jobs for Asynchronous Execution with the Queueable Interface
Clarified the documentation about the maximum stack depth for chaining queueable jobs.

Deploy with Active Jobs
Updated the label text of the new deployment option.

Other Changes in Chatter
Added information about using attachments in email posts to groups.

New and Changed Apex Classes
Updated the Auth.AuthConfiguration class methods. These methods now support custom domains that are created
using My Domain.

New Names for Reporting Products and Features
Added information about changes to text in the user interface. Added references to mobile analytics features previously mentioned
only in the Mobile section.

Salesforce1 Enhancements
Added information about an easier way to see more list views in Salesforce1. Removed information about the Salesforce Today app
displaying a new avatar for matched users records that don't have a profile image. This change was not included in this release.

New Look and Feel for the Salesforce Console
Added information about how users can refresh all primary tabs with Visualforce pages.

September 10, 2014

APl Access Change for Connected Apps
Added information about an APl access change for some Salesforce and partner connected apps, including Salesforce1, Salesforce
for Outlook, and Connect for Outlook. All users of connected apps affected by this change must have the “API Enabled” profile
permission turned on to allow access to all features.

Salesforce1 Enhancements
Updated information in the “ Work with More Objects Offline on page 87" topic about support for the Salesforce Today app when
offline; corrected It's Easier to Update Tasks in a List on page 79 to indicate the enhancement is available in the Salesforce mobile
browser app only; refined the topics about the action bar and list item actions (formerly called row-level actions); and added several
new screenshots.

New and Changed Chatter REST APl Response Bodies
The reputation property has been added to the User Summary response body. It was previously available only in the User
Detail response body.

New and Changed Chatter in Apex Output Classes
The reputation property hasbeen movedfromthe ConnectApi .UserDetail classtotheabstract ConnectApi.User
class. The ConnectApi.User classis the superclass of the ConnectApi.UserDetail andthe
ConnectApi.UserSummary classes.

New and Changed Apex Classes
Added the Auth.CommunitiesUtil class.

New Names for Reporting Products and Features
Added a release note detailing changes to the names of some reporting products and features.

Community Templates for Self-Service (Generally Available)
Added a note indicating that the Napili template isn't available in sandbox organizations.

Let Customers Ask Questions and Find Articles in Your Support Community
Added a note indicating that the Napili template isn't available in sandbox organizations.
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New Look and Feel for Documentation PDF Files
Added a release note describing the new PDF design for salesforce.com documentation.

September 3, 2014

SOQL query filtering with the new USING LOOKUP clause
Removed the USING LOOKUP section because the USING LOOKUP feature has been removed from this release.

Help & Training Search Includes Success Community Content
Added information about improvements to Help & Training search.

Updates to Translated Terminology
Added information about updated terminology for Hebrew and Korean language users.

Use CORS (Cross-Origin Resource Sharing) to Access Chatter REST API
To enable CORS support for Chatter REST API, contact your Salesforce representative.

New and Changed Apex Classes
Addedthese new Apex methodsforthe System.Network class: getLoginUrl (String), getLogoutUrl (String),
and getSelfRegUrl (String).

Display More Public Community Content
Added info about new objects accessible for guest users in communities.
Salesforce1 Enhancements

Added expanded information about offline support and about group and Today recommendations; these features are now covered
in their own sections.

The new Approvals item in Salesforce is also supported in the Salesforce downloadable app for iOS devices, version 6.0 and later.

New Look and Feel for the Salesforce Console
Changed the section name from Other Changes in the Salesforce Console to New Look and Feel for the Salesforce Console, and
updated the screenshot of the new console user interface.

August 27, 2014

More Streamlined Look for the Rich Text Editor
Corrected the screenshot of the Rich Text Editor to reflect the updates to the toolbar.

Security and Identity Enhancements for Communities
Added information about security and identity enhancements that benefit communities.

New and Changed Apex Classes
Added the new getReferenceTargetField () methodforthe Schema.DescribeFieldResult class.

Added the new headers properties for the Messaging. InboundEmail .BinaryAttachment and
Messaging.InboundEmail.TextAttachment classes.

Added the new loadAllPackageDefaultNetworkDashboardSettings () methodforthe System.Network
class.

Apex Method Change Removed
The section for the toString () method changein System. Type has been removed from the release notes, because this
change has been removed.

SOAP API
Added the “Changed Types” section, which includes changes to the Field type for DescribeSObjectResult.
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Adding and Removing Case Feed Highlights Panel from the Salesforce Console Has Changed
Added a release note about changes to the highlights panel on feed-based case page layouts.

Include Additional Email Addresses on Email-to-Case Auto-Response Messages
The send response to all recipients option now letsyou send auto-responses to addresses on the To line of the
original message.

Custom HTTPS Domains Supported for Communities
Added information about how your domain name affects the target of your CNAME.

It's Easier to Create a Task
Added information about limitations of the simpler New Task page in Salesforce]. If users in your organization need to create tasks
of more than one record type, consider disabling the new page, because the page doesn't let users choose a record type when they
create a task. Also, the new page requires the global task create action in the global action layout.

Metadata Types and Fields
Added the isContainerAutoSizeEnabled field to the Container subtype of Layout.

New Look and Feel for the Salesforce Console
Added information about the console’s new look and feel, how stacked components autosize vertically, and the warning message
on navigation tab setup.

Ask Questions in the Chatter Feed with Chatter Questions (Generally Available)
Added information about Chatter Questions.

Use Action Icons to Perform User Tasks
Added information about the new action bar and action icons in SalesforceA.

Companies with a Wrongly Created D-U-N-S Number No Longer Shown in Data.com
Corrected information about which companies are no longer shown in Data.com.

10



FEATURE SUMMARY AND USER IMPACT

Winter '15 has features that immediately affect all users after the release. You may want to communicate these changes to your users
beforehand so they are prepared. Other features require direct action by an administrator before users can benefit from the new
functionality.

When will you start seeing Winter 15 changes on your instance? The best way to find out is to check the Major Release Schedule section
of the Salesforce trust site at t rust.salesforce.com/trust/maintenance/.

These release notes describe the new and modified features available in this release. For visibility into known Salesforce issues, please
refer to the Known Issues Site.

This table summarizes the Winter '15 features and their impact on users. Review the feature details for the applicable Salesforce editions.

IN THIS SECTION:
General Enhancements
Analytics Cloud
Mobile
Communities
Sales
Work.com
Data.com
Service
Salesforce1 Reporting
Chatter
Force.com Customization

Force.com Development

General Enhancements

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable
New Look and Feel for Documentation PDF
Files
API Access Change for Connected Apps
Help & Training Search Includes Success
Community Content
Introducing Duplicate Alerts and Blocking

(Beta)

n


http://trust.salesforce.com/trust/maintenance/
http://success.salesforce.com/issues_index

Feature Summary and User Impact

Analytics Cloud

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable
Updates to Translated Terminology
More Streamlined Look for the Rich Text
Editor
Analytics Cloud
Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable
Introducing Wave, the Analytics Cloud
Mobile
Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable
Salesforce1
Set Up Salesforce with the Salesforcel
Wizard
Quickly Access Salesforce1 Setup Tasks from
a Single Page
View and Search Data That's Stored Outside
Salesforce
Sort List Views
Filter List Views to See Just What's Needed
Add Lightning Components to the
Navigation Menu in Salesforce
Open Most Salesforce URLs Directly in the
Salesforce1 Downloadable App for iOS
Devices
Do Most Actions from the Salesforce1
Action Bar
Work with Records Directly from Lists

12



Feature Summary and User Impact Mobile

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable
How Actions Are Ordered in the Salesforce
Action Bar and List Item Actions
See Chatter Recommendations in
Salesforce
Attach Files to Comments on Feed Posts
See Where External Files Originate
Stay in Context When Searching
Narrow Global Search to a Recently
Accessed Object
Find the Right Record While Typing
Keywords
Prevent Duplicate Records (Beta)
Log Calls Faster
Create Contacts from Mobile Contact Lists
Convert Leads to Contacts (Beta)
Create an Action to Add Products to
Opportunities
Find Thanks Badges to Give to Coworkers
View All Pending Approval Requestsin One
Location
It's Easier to Create a Task
Add New Task Update Actions to
Salesforce
It's Easier to Update Tasks in a List
Make It Easier to Change a Task's Due Date
See Salesforce Events in a Weekly View
Manage the Day Effectively with More Key
Information in Salesforce Today
Share a Dashboard in Chatter
Drill Down from a Dashboard to a Matrix
Report
Filter Dashboard Components
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Feature Summary and User Impact Mobile

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable
See Truncated Text in Report Columns
Stay in Context When Viewing Reports with
Floating Headers
Access Reports More Quickly With
Descending or A-Z Sort Order
Work with More Objects Offline
Get Data.com Contacts for an Account
Other Changes in Salesforce1
Device and Browser Support
See More List Views on Record Search Pages
Show Nicknames for Community Members
Get Faster Access to Tagged Topics
Get Answers with Chatter Questions
(Generally Available)
See User Profiles if Chatter Is Disabled
Edit Profile Pictures in All Versions of the
Salesforcel App
See the “Following” Related List on User
Profiles
Collaborate More Privately with Unlisted
Chatter Groups
Use Additional Filters to Find the Right
Salesforce Files Sync
Find Information More Easily When Viewing
Records
Clone Contact Records
Do More with the Twitter Component
See Profile Pictures for Opportunity Team
Members
Add New Skills and Endorse Other Users’
Skills
Use Reward Funds and Reward Fund Types

14



Feature Summary and User Impact Communities
Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable
Additional Salesforce1 Information
Salesforce1 Differences from the Full
Salesforce Site
Salesforce1 App Development Overview
SalesforceA
View System Status from SalesforceA
Switch between Accounts in Multiple
Organizations
Communities
Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable
Customization
Customize Your Community with
Community Designer (Beta)
Create Self-Service Communities with
Templates
Template to Configure Identity Features for
Community Users
Add Custom Login, Logout, and
Self-Registration Pages
Administration
Improved Navigation and Label Updates in
Setup, Community Management, and
Community Designer
Display Member Nicknames Instead of Full
Names
Custom HTTPS Domains Supported for
Communities
Security and Identity Enhancements for

Communities
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Feature Summary and User Impact Communities

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable

Apex Triggers Supported on the
NetworkMember Object

Display More Public Community Content
Community Management

Access More Functionality from the
Community Management Page

Organize Self-Service Communities with
Topics

Moderate Flagged Posts Directly on the
Community Management Page

Dashboards

New Dashboards, Reports, and Metrics
Added to the Communities Dashboards
Package

Upgrade to the New Salesforce
Communities Dashboards Package

<]

Dashboard Enhancements

(<]

Report Enhancements

<]

Map Unique Dashboards per Community

(<]

Reputation

Configure Reputation Points for Questions
and Answer Actions

Custom Level Icons for Reputation Levels

Level-Up Notifications for Increases in
Reputation Levels

Developer Enhancements and Apex Triggers
for Reputation

Chatter Questions

Promote Community Collaboration with
Chatter Questions (Generally Available)

Other Changes in Communities

Improve Performance with HTML Page
Caching in Site.com for Communities
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Feature Summary and User Impact Sales

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable
Added Default Force.com Error Page for
Service Unavailability
Enable Reporting Options for External Users
Assign Tasks to Users with Customer
Community Plus Licenses
Sales
Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable
Sales Cloud on Salesforce1
Manage Sales on the Gol
Territory Management 2.0 (Generally Available)
Territory Management 2.0 (Generally
Available)
Clone a Territory Model to Test Out Different
Structures and Scenarios
Define an Assignment Rule Once, Use Itin
Multiple Territories
Assign and View Territories Directly from an
Account
Run Territory Rules Directly from the
Territory Hierarchy
Identify Territory Users by Territory Role
Track Territory Model Changes in the Setup
Audit Trail
Apex Triggers Added to the Territory2 and
UserTerritory2Association Objects
Limits on Numbers of Territory Models,
Territories, and Assignment Rules
Metadata API Support
APl'and API Documentation Enhanced

Collaborative Forecasts and Opportunity Splits
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Feature Summary and User Impact Sales

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable

Sales Managers Can Track Revenue from
Supporting Sales Roles with Overlay Splits
Forecasts (Generally Available)

Give Your Sales Teams Added Flexibility for
Predicting Revenue with Custom Field
Forecasts (Generally Available)

Forecast Managers Can Now Add Context
to Adjustments with Adjustment Notes

Edit Multi-Line Layouts for Opportunity
Splits and Give Users Quick Access to
Custom Fields

Duplicate Management (Beta)

Manage Duplicate Records

<]

Prevent Users from Saving Duplicates

(<]

Define the Logic Used to Identify Duplicates

(<]

Create Custom Report Types for Duplicates
(available within 24 hours after the Winter
"15 release)

<]

Salesforce for Outlook

It's Easier to Set up Side Panel Users to Add
Outlook Items to Salesforce Records

Let Users Select Specific Email Attachments
to Add to Salesforce

Specify Your Users’ Outlook Sync Folders

Side Panel Users Can Do More with Outlook
Tasks

Activities

Add Custom Lookup Fields on Activities
(Beta)

Let Your Users Control Task Notifications
Globally

Salesforce Console for Sales
Salesforce Console Enhancements

Other Changes in the Sales Cloud
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Feature Summary and User Impact

Feature

Person Accounts Can Be Included in
Packages

New Associated Items Transferred with
Changes in Record Ownership

Field Added to Order Object

Account and Contract Fields on
Orders Can Be Updated

Labels Changed in User Settings
Interaction Flow Changed for Private Events

Resources Released When Events Are
Deleted

In Enterprise Edition, Create New Custom
Split Types to Better Reflect Your Business
Process

Work.com

Enabled for users

Enabled for

administrators/

developers

Requires
administrator
setup

Work.com

Contact
Salesforce to
enable

Feature

Manage Thanks Badges with the Badges
Tab

Deploy Performance Summary Cycles More
Effectively

Suggest Skills Automatically to Users

Measure Your Work Better with Enhanced
Goals (Pilot)

Other Changes in Work.com
Get More Out of Salesforce

Display Multi-Language Text and Local
Dates and Numbers

Manage Performance Summaries with the
API

Unendorse Skills from Chatter Profiles

Enabled for users

(< L
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Enabled for
administrators/
developers

Requires
administrator
setup

Contact
Salesforce to
enable



Feature Summary and User Impact

Data.com

Feature

Companies with a Wrongly Created D-U-N-S
Number No Longer Shown in Data.com

Data.com APl Enhanced

Service

Enabled for users

Enabled for
rioistad

Requires
administrator
setup

Contact
Salesforce to
enable

Feature
Case Feed

Show Agents More Case Information in Less
Space with Compact Feed

Add and Work with Addresses More Easily
in Case Feed Email Messages

Rename the Email and Community Case
Feed Actions

Case Feed Files Component Supports
Drag-and-Drop

Email Feed Filter Has Been Renamed
Portal Action Has Been Renamed

Feed View Settings Page for Feed-Based
Case Page Layouts Has Been Reorganized

Case Management
Customize Web-to-Case Email Notifications

The Web-to-Case HTML Generator Has a
New Location in Setup

Email-to-Case

Include Additional Email Addresses on
Email-to-Case Auto-Response Messages

Knowledge

Monitor Salesforce Knowledge Search
Activity

Enabled for users

Enabled for
administrators/
developers

Requires
administrator
setup
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Feature Summary and User Impact Service

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable

Next-Gen Knowledge Search Gives Users
More Relevant Article Search Results
(Generally Available)

Search Highlights and Snippets

Promoted Knowledge Results Give
Knowledge Managers More Control over

Articles in Search Results (Generally

Available)

Send Article Content via Email (Pilot)
Rich Text Editor Upgrade

Improved Look and Feel for Knowledge One

Salesforce CTl Toolkit

Retirement of Support for the Salesforce CTI
Toolkit

Salesforce Console

Salesforce Console Integration Toolkit: New
Methods

Articles Suggested for Cases are More
Relevant (Beta)

Users Get the Latest Search Capabilities

Add the Files and Case Experts Tools as
Salesforce Console Components

Adding and Removing Case Feed Highlights
Panel from the Salesforce Console Has
Changed

Brand Your Salesforce Console with Custom
Colors (Pilot)

Lookup Component Enhanced to Display
Multiple Columns

Users Can Hover Over Related List ltems to
Get Details

Users Can Easily Edit Fields in the Lookup
Component

Stacked Components Autosize Vertically
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Feature Summary and User Impact Salesforcel Reporting

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable

Warning Message on Navigation Tab Setup
Updated User Interface for the Console

Users Can Refresh All Primary Tabs with
Visualforce Pages

Service Communities

Enhance Service with Chatter Questions
(Generally Available)

Community Templates for Self-Service
(Generally Available)

Let Customers Ask Questions and Find
Articles in Your Support Community

Social Customer Service

Social Customer Service Starter Pack (Pilot)
Google+ Social Customer Service (Pilot)
Sina Weibo Social Customer Service (Pilot)
Common Setup Defaults

Social Account Authentication within
Salesforce

Salesforcel Reporting

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable

New Names for Reporting Products and
Features

Salesforcel Mobile Reporting
Enhancements
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Feature Summary and User Impact Chatter

Chatter

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable

Files

Access and Share External Files with Files
Connect

Search for External Files with Files Connect

Run a Report about Publicly Shared Links to
Files

Users Have More Options in the File Sharing
Settings Menu

Users Can Delete Files That Are Part of
Content Deliveries

(<]

Most Recent Version of Files Shown in
Content Deliveries

(<]

Sync Shared Files with Salesforce Files Sync

(<]

Google Doc URL Field on Record Does Not
Require Domain Name in URL

<]

Third-Party Integration

Chatter for SharePoint 2010—Generally
Available

Groups

Enable Users to Collaborate More Privately
in Unlisted Groups

Updated User Search in the Add/Remove
Group Member Dialog

Feeds
Add Action Links to Posts (Pilot)

Ask Questions in the Chatter Feed with
Chatter Questions (Generally Available)

Other Changes in Chatter
Mobile User Context Switching from Emails
APl Enhancements

Chatter REST AP
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Feature Summary and User Impact Force.com Customization

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Enabled for users developers setup enable
ConnectApi (Chatter in Apex)
Force.com Customization
IN THIS SECTION:
General Administration
Data
Business Logic and Process Automation
Security and Identity
Sharing
Globalization
Site.com
Critical Updates
Additional Customization
General Administration
Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Visible to users developers setup enable
Access Additional Recent Items on the
Force.com Home Page (Beta)
Search for Additional Items in Setup (Beta)
View the Parent Object of a Field in Setup
Search Results (Beta)
Advanced Setup Search (Beta) Automatically
Enabled in All Organizations
Delegated Administrators Can Assign
Permission Sets
Manage Access to Custom Processes and
Apps (Generally Available)
Reference Custom Permission Access with

the SPermission Global Variable
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Feature Summary and User Impact

Enabled for
administrators/

Feature Visible to users developers
Show More Information in Less Space with
Compact Feeds on Feed-Based Layouts
Use Hover Links to Quickly Access Related
Lists on Feed-Based Layout Detail Views
Interact with More Publisher Actions
Programmatically
Enable External HTTPS for Domains
Require Secure Connections (HTTPS) for
Salesforce Communities, Site.com Sites, and
Force.com Sites
Update Auto-Response Message Sender
Addresses to Meet New Security
Requirements

Data
Enabled for
administrators/
Feature Visible to users developers

Access External Data with Lightning Connect
(available within 24 hours after the Winter
"15 release)

Retain Field History Data (Pilot)

Manage Customer Data with Data Pipelines
(Pilot)

Business Logic and Process Automation

Enabled for
administrators/

Feature Visible to users developers

Critical Updates

Behavior Changed for Default Values in Flow
Screen Fields

Receive Email for Each Unhandled Fault

Process Builder
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Requires
administrator
setup

Requires
administrator
setup

Requires
administrator
setup

Contact
Salesforce to
enable

Contact
Salesforce to
enable

Contact
Salesforce to
enable

Data



Feature Summary and User Impact Security and Identity

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Visible to users developers setup enable
Visually Automate Your Business Processes
(Beta)
Visual Workflow
Automate Time-Based Processes
Store Multiple Values Together in a Flow
Submit Records for Approval from a Flow
(Generally Available)
Post to Chatter from a Flow
Identify Recipients More Flexibly in the Send
Email Element
Send Email from an Organization-Wide
Email Address
Deploy Flows That Contain Email Alerts
Debug Flows That Contain Loop Elements
and Action Calls
User Interface Changes to the Cloud Flow
Designer
Approvals
Approval Response Enhanced
Specify a Submitter foran Approval Process
Workflow
Notify Assignee Checkbox Removed from
Workflow Tasks When You Expose New
Notification Setting
Security and Identity
Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Visible to users developers setup enable
Administration
Set Session Timeout and Password Policies

for Individual Profiles
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Feature Summary and User Impact Security and Identity

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Visible to users developers setup enable
Use Event Monitoring to Understand
Organization Trends (Generally Available)
Security Tokens Required for API Logins
from Callouts
Some Settings Changed for Managing File
Upload and Download Behavior
Authentication
Customize and Manage User Authentication
with Login Flows
Export and Import Authentication
Certificates between Organizations for
Flexible Certificate and Key Management
Configure a LinkedIn Authentication
Provider
Configure a Twitter Authentication Provider
Give Community Users Button Icons to Log
in with their Third-party Accounts
A Custom Logout URL is Available for
Community Users
View and Download SAML Login Metadata
for Communities and Custom Domains
Internet Explorer 6 Logins Removed from
the Organization Login History Page
View an Optimized OAuth Connected Apps
List on the User Detail Page
Include the Organization ID to Identify Users
from Different Salesforce Auth. Providers
Identity URL and UserInfo Endpoint Redirect
Response Removed
OAuth 2.0 JWT Bearer Token Support
Expands to Meet the Current Standards
Identity
New External Identity License Expands Your
Community User License Choices
Add Bookmark Apps to the App Launcher
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Feature Summary and User Impact

Feature

Use the System for Cross-domain Identity
Management (SCIM), a Standards-based
User Management AP

Identity Features Added to More License
Types

Sharing

Feature

Disable Customizable Forecasting and
Territory Management

Automatic Recalculation Added for Large
Operations

Globalization

Feature

Supported Languages Changed and Added

Process Changed for Enabling Multiple
Currencies

Inactive Multiple-Language Features
Removed from Single-Language
Organizations

Non-Currency Locales Removed from
Currency Locale Lists

New Value Allowed for Gender Metadata
Field Type

Enabled for
administrators/
developers

Visible to users

Enabled for
administrators/

Visible to users developers

Enabled for
administrators/

Visible to users developers
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Requires
administrator
setup

Requires
administrator
setup

Requires
administrator
setup

Contact
Salesforce to
enable

Contact
Salesforce to
enable

Contact
Salesforce to
enable
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Feature Summary and User Impact

Site.com
Enabled for
administrators/
Feature Enabled for users developers
Add Flexibility to Your Page Templates with
Custom Properties
Site.com Workbook Discontinued
Critical Updates
Enabled for
administrators/
Feature Visible to users developers
Behavior Changed for Default Values in Flow
Screen Fields
Receive Email for Each Unhandled Fault
Serve Static Resources from the Visualforce
Domain
Add New Task Update Actions to
Salesforce1
Additional Customization
Enabled for
administrators/
Feature Visible to users developers
User Interface Change to Enabling State and

Country Picklists

Force.com Development

Requires
administrator
setup

Requires
administrator
setup

Requires
administrator
setup

Contact
Salesforce to
enable

Contact
Salesforce to
enable

Contact
Salesforce to
enable

IN THIS SECTION:
Change Sets and Deployment
Force.com Canvas
Visualforce
Apex Code

Lightning Components (Beta)
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Feature Summary and User Impact

AP
ISVForce

Other Changes in Force.com Development

Change Sets and Deployment

Feature

CORS Whitelist Origin Available in Change
Sets

Deploy with Active Jobs

Deploy Your Components in Less Time
(Pilot)

Force.com Canvas

Feature

SDK Object and Field Changes

Visualforce

Feature
Visualforce Development

Add Data Access to Your Visualforce Pages
with Remote Objects (Generally Available)

Other Changes in Visualforce

Standard Style Sheets Combined by
Visualforce

Preserve sObject Field Encryption in
Visualforce Expressions

Serve Static Resources from the Visualforce
Domain

Visible to users

Visible to users

Visible to users
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Enabled for
administrators/
developers

Enabled for
administrators/
developers

Enabled for
administrators/
developers

Requires
administrator
setup

Requires
administrator
setup

Requires
administrator
setup

Change Sets and Deployment

Contact
Salesforce to
enable

Contact
Salesforce to
enable

Contact
Salesforce to
enable



Feature Summary and User Impact

Apex Code

Enabled for
administrators/
Feature Visible to users developers
Submit and Monitor Jobs for Asynchronous
Execution with the Queueable Interface
Run More Future Methods and Callouts
Run More Tests in Sandbox and Developer
Organizations
Apex Supported for the
SearchPromotionRule sObject
New and Changed Apex Classes
ConnectApi (Chatter in Apex)
Apex Triggers Supported for the Territory2
Object
Apex Triggers Supported for the
UserTerritory2Association Object
Lightning Components (Beta)
Enabled for
administrators/
Feature Visible to users developers
Lightning Components (Beta)
Work with Lightning Resources in the
Developer Console
Enable Lightning Components and Debug
Mode
Add Lightning Components to the
Navigation Menu in Salesforce
Enabled for
administrators/
Feature Visible to users developers
New and Changed Objects
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Requires
administrator
setup

Requires
administrator
setup

Requires

administrator
setup

Apex Code

Contact
Salesforce to
enable

Contact
Salesforce to
enable

Contact
Salesforce to
enable



Feature Summary and User Impact ISVForce

Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Visible to users developers setup enable
SOQL
SOSL
APIs
REST API
SOAP AP
Chatter REST API
Tooling API
Metadata API
Data.com API
Publisher.js AP
Salesforce Console API (Integration Toolkit)
ISVForce
Enabled for Requires Contact
administrators/  administrator Salesforce to
Feature Visible to users developers setup enable
Partner Community
Environment Hub Setup Simplified
Create Trialforce Source Organizations in
the Environment Hub
Environment Hub Included with Platform
License
Refresh Licenses using the License
Management App (LMA)
View More Subscriber Information in the
LMA
Package External Data Integrations
Package Lightning Components
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Feature Summary and User Impact Other Changes in Force.com Development

Other Changes in Force.com Development

Feature Automatically Automatically  Not automatically
visible to all visibleto all visible. Feature is
users. No setup  administrators. available but
required. No setup requires some
required. setup.
Make Your Own Improvements to the
Force.com IDE
Person Accounts Are Now Packagable
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Contact
Salesforce to
enable this
feature.



GENERAL ENHANCEMENTS

General enhancements affect many users.

IN THIS SECTION:

APl Access Change for Connected Apps

With the current release, all users of approved connected apps must have the “API Enabled” profile permission turned on to allow
access to all features.

New Look and Feel for Documentation PDF Files

Our documentation PDF files got a makeover! The fresh new design features intuitive page layouts, a new color scheme, and easily
scannable text.

Help & Training Search Includes Success Community Content

Help & Training search now returns valuable content from more sources to make it easier to find what you're looking for.

Introducing Duplicate Alerts and Blocking (Beta)

Now you can maintain clean and accurate data with Data.com Duplicate Management. Control whether and when you allow users
to create duplicate records inside Salesforce, customize the logic that's used to identify duplicates, and create reports on the duplicates
you do allow users to save.

Updates to Translated Terminology

We've updated some terminology, including tab and field names for our Hebrew and Korean language users. You can find details
about the changes made by reviewing the knowledge article available from the Salesforce Customer Support site. For each term,
we provide the English version and the corresponding previous and new translations.

More Streamlined Look for the Rich Text Editor

The Rich Text Editor, also known as the HTML Editor, that's available in most rich text area fields has a new look, better performance,
bug fixes, improved styling for pasted data, improved handling for pasted images, and increased compatibility with newer browsers.
The updated editor is also available in rich text area custom fields on records and more.

APl Access Change for Connected Apps

With the current release, all users of approved connected apps must have the “API Enabled” profile permission turned on to allow access
to all features.

In Winter ‘14 we introduced a program that allows specific approved, security-reviewed connected apps from Salesforce and our partners
to integrate with Salesforce using a process that lets the connected app establish an API connection regardless of user profile settings.
To ensure your users’ access to data is consistent with the permissions you have enabled, these apps will be required to respect user
profile permissions for APl access.

With this change, users who don't have the “API Enabled” profile permission turned on will no longer be able to use the affected connected
apps. The list of affected connected apps from Salesforce includes:

e Salesforcel downloadable apps for iOS and Android devices
e Salesforce for Outlook
e Connect for Outlook

e Connect for Office
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General Enhancements New Look and Feel for Documentation PDF Files

This change affects all Salesforce, Chatter, and Communities users. For the complete list of affected apps and expected changes in app
behavior for different types of users, see the API Access Change for Connected Apps Knowledge article.

If you want your users to continue to have access to the affected connected apps, turn on the “API Enabled” permission. You can
accomplish this through either a profile update or an appropriate permission set. Keep in mind that this will grant users APl access to
your organization and its data.

If you decide not to grant access, you should notify end users who do not have the “API Enabled” profile permission that they will not
be able to use the affected connected apps.

If you are using an affected connected app developed by a Salesforce partner or ISV, you should contact the app provider for details on
the potential impact. A list of affected partner connected apps is available in the API Access Change for Connected Apps Knowledge
article.

Your data is protected by security tools in the application, including org-wide sharing settings, object-level security, and field-level
security. This applies regardless of how users are accessing data, whether through the APl or an application, to ensure that users don't
have improper access to data. For further information on application security settings, see Securing Data Access in the Salesforce Help.

New Look and Feel for Documentation PDF Files

Our documentation PDF files got a makeover! The fresh new design features intuitive page layouts, a new color scheme, and easily
scannable text.

Features of the new PDF design include:

Edition & User Permission Sidebar
Salesforce editions and user permission requirements are now presented in an easily scannable right-hand sidebar.

New Icons
Our new Note, Tip, Warning, Important, and Example icons use a streamlined, eye-catching design.

New Table Design
Tables use an appealing, minimal design that's easy to read.

New Fonts
The new design features sleek, readable sans serif fonts.
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General Enhancements

Help & Training Search Includes Success Community Content

TIPS FOR USING CONTENT DELIVERIES

Enabling Content Deliveries

anopfimized Web page for
online viewing. Once you
create your dallvery, you can
send Its URL 1o colleagues.
pariners, leads, or any other
radpientand hen frack how
ofien the content Is viewed
or downloaded. ou control
how long fhe delivery is
avallable fo viewers and
whether a viewer can
download a fle or see it
onlin oniy.

Toenable content defiveries for your organization:

1. From Setup, click Customize > Content Deliveries - Settings.

L (lick Enable content deliveries fyoudonthavearoesstothe Content Delivery feature.
contact Sdesforce Cstomer Support 10 activate it

To let users crete and share links o Chatter fes, dick Enable Chaster file links.

To ket recipeents of content deliveries preview Office 2007 fles:

a. From Setup, click Customize > Salesforce CRM Content > Settings.

b. Click Enable Office 2007 praviews in contant

¢« From Setup, click Customize > Content Dellveries > Settings.

d. CickEnsble recipients to preview Office 2007 content deliveries.
Some Microsoft Office 2007 features don't display comectly in previews.

=

5. Choosea default option for -defivery passwords. Beacause o delivery URLs can be sent
to leads, customers, icated wser, salesforoe.com, inc e i
protection i yous users will send ia content delivery. The
allow you to select iraticn-wide defaudt for content-delivery pa protection

*  Password protection ks optional and defaults to OFF—F this option is seected, users can
‘choose to require a password when they oreate a content delivery, but the Require
Password to Access Consent field an the creste-delivery wizard is not checked by
defauit.

cled, e Requize
Pas=zword to Access Content fiek h i i s checl L

Users can uncheck the option i they do not want 1o require a password.
I

ted, tme
2 cantent delivery s crested. Users cannat opt aut of the password requiremet.

© nrote:

*  [you choose to require a password, users who create a content defiveny will receive a

password when the delivery i d sendthe rd and the delivery

URL to delivery recipisnts Defivery recipients are prompted for the password when they
dlick the content defivery URL.
Content defivery passwords display with the cortent-defivery URL when the delivery is
created. You can ako access the password on the delivery detail page for the lie of the
content delivery.

Last updaied: September 4, 2014

Check out the improved PDF files in the Salesforce Help and on the Salesforce Developers site.

Help & Training Search Includes Success Community Content

Help & Training search now returns valuable content from more sources to make it easier to find what you're looking for.

The search improvements let you:

See Q&A, Ideas, and Known Issues from the Success Community

Use additional filters to quickly refine search results

Save your filter choices for a more consistent experience

View suggested content across all new sources

To try the new search yourself, go to http://help.salesforce.com.
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General Enhancements Help & Training Search Includes Success Community Content

New Success Community filters and results

SUCCESS Answers  Help & Training  Dreamforce 14  Collaboration Ideas More ~ All > | Search 8] i login

COMMUNITY

|S Contact Support ) |

Help

trust.salesforce.com
salesforce for outlook o |@ > |

Home = Search: salesforce for ...

{3 Document Type X~ = Document Type: Documentation -, Q&A -, Ideas -, Known |ssues b4
+ Documentation 192 Language: English
~ Q&A 130
+ Ideas 56 Results 1-10 in 409 in 0.12 second Relevance Date
~ Known Issues 25 /

Knowledge Articles +2a3 ¥ 1dea Salesforce for Qutlook (SFO) to support Qutlook (without Exchange Server)

Videos +4 . will require the purchase of another app (form another provider) for what Salesforce com

Quick Starts +2 a_lready has - Salesforce for Outlook (SFQ) - and has been working without Exchange Server

since the ...

{2 Topics ~ =

i Hl 0z Using Salesforce for Qutlook (SFO) to add multiple emails at once
Sales & Marketing 101 . . .

with the new side panel, is it possible to add multiple emails to a record at once? When | use
Connect for Outlook 92 ctrl key to select multiple emails, and use the side panel to add to a record, only one of the
Salesforce for Outlook 72 emails get added. |z adding multiple emails at once an avail...

Accounts & Contacts 35
Service & Support 22 [ knownissue Salesforce for Outlook: Unblock button is not available after blocking SFO

Salesforce displays the usual warning message, then hides the option to unblock the .. this

& Searchiin Topics app is blocked by admin"Salesferce for Outlook: Unblock button is not available after

More \\_ blocking SFO /
{2 Language X~ = -
quag & «nownissue Salesforce for Quilook: Quilook email files (.msg) get locked when saved locally
+ English 408 and SFO is installed
Dansk +191 ... contains the file, and then click Properties to check your permissions for the

folder."Salesforce for Outlook: Qutlook email files (.msg) get locked when saved locally and

Svenska +190 SFO is installed

amevlng <178

Portugués (Brasil) ~176 L) Documenation Salesforce for Outlook FAQ

@, Search in Langu
More [:) Documentation Salesforce for Outlook Configurations Qverview
Help users easily maintain their records between Microsoft® Qutlook® and Salesforce by
creating separate settings for groups of users with different needs.
Option to save your filter settings
> Document Type X ~ = Document Type: Documentatio
" Documentation 192 I= Occurrences
E" s Q&F\ 130 Score
+ |deas 56 on
+ Known lssues 25 1= Ascending
Knowledge Articles +283 :
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General Enhancements Introducing Duplicate Alerts and Blocking (Beta)

Introducing Duplicate Alerts and Blocking (Beta)

Now you can maintain clean and accurate data with Data.com Duplicate Management. Control whether and when you allow users to
create duplicate records inside Salesforce, customize the logic that's used to identify duplicates, and create reports on the duplicates
you do allow users to save.

@ Nofte: This release contains a beta version of Data.com Duplicate Management that is production quality but has known limitations.
You can provide feedback and suggestions on the Salesforce Success Community. For information on enabling this feature for
your organization, contact Salesforce.

For more information about how Data.com Duplicate Management works, see Duplicate Management (Closed Beta) on page 128.

- Account Edit Help for this Page &

. Salesforce.com, Inc.

Account Edit Save (lgnore Alert) | Save & Hew (lgnore Alert) | Cancel

5 Possible Duplicate Accounts Found
You're creating a duplicate record. We recommend you use an existing record instead.

Account Name Phone Billing City Last Modified By Last Modified Date
Salesforce.com. Inc. (800) 123-8888 San Francisco Madison Rigsby THS201410:17 AWM
Salesforce.com. Inc. (800) 888-8888 San Francisco Madison Rigsby TITi2014 437 P
Salesforce.com. Inc. (888) 999-9999 San Francisco Madison Rigsby TTi2014 420 P
Salesforce.com. Inc. (800) 123-4569 San Francisco Madison Rigsby TITi2014 9:49 AN
Salesforce.com. Inc. +1.415.901.7000 San Francisco Madison Rigsby 6/4/2014 3:22 P
Account Information | = Required Information

Account Owner  Madison Rigsby Phone [800) 555-1121

CEETi e I Salesforce.com, Inc. =

Parent Account Cg Website

Data.com Key

Updates to Translated Terminology

We've updated some terminology, including tab and field names for our Hebrew and Korean language users. You can find details about
the changes made by reviewing the knowledge article available from the Salesforce Customer Support site. For each term, we provide
the English version and the corresponding previous and new translations.

You can find the complete list of term changes in knowledge article number 000199278 (URL:
https://help.salesforce.com/apex/HTViewSolution?uriname=Winter-15-Updates-to-Translated-Terminology&language=en_US) on the
Salesforce Customer Support site.

These terminology changes are available to all organizations. To keep your current tab and field labels, system administrators can change
the name back using our rename tabs and labels functionality. For more information, see “Renaming Tab and Field Labels” and
“Considerations for Renaming Tab and Field Labels” in the Salesforce Help or contact Customer Support.

For more information about supported languages, see “What languages does Salesforce support?” in the Salesforce Help.

More Streamlined Look for the Rich Text Editor

The Rich Text Editor, also known as the HTML Editor, that's available in most rich text area fields has a new look, better performance, bug
fixes, improved styling for pasted data, improved handling for pasted images, and increased compatibility with newer browsers. The
updated editor is also available in rich text area custom fields on records and more.
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General Enhancements

More Streamlined Look for the Rich Text Editor

The rich text editor lets users quickly and easily format text in rich text fields and in tools such as the Knowledge article editor, questions
in Chatter Answers, and the Case Feed Email action.

Here's what the updated editor’s toolbar looks like:

[ source | | B I U S I B <«

Format -

.= = "lI
= = =

Font -

Size -~ i‘ E‘

The updated rich text editor has the same features and functionality it did previously.

Microsoft® Internet Explorer”® 6 and 7 continue to use the previous version of the editor for all rich text area fields for compatibility reasons
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INTRODUCING WAVE, THE ANALYTICS CLOUD

The Salesforce Analytics Cloud is a powerful business intelligence platform that makes it easy to EDITIONS
bring in data from any source, explore and visualize, and share and collaborate through dashboards

and the iOS mobile app—all within the trusted, secure Salesforce environment. . .
PP Available for an additional

Bring in All Your Data cost in: Enterprise,
Your data lives everywhere: Salesforce, data warehouses, CRM and ERP systems, log files, CSV Performance, and
files, and more. Bring it all together into Salesforce Analytics. Unlimited Editions

Let Your Data Tell Its Story
Valuable insights are already in your data—you just need to find them. Explore and ask questions
through rich, interactive visualizations. Find answers you didn't even know you were looking for.

Drive Action Through Your Discoveries
The purpose of analysis is action. Easily share your findings and collaborate across your team and organization through dashboards,
Chatter, and the iOS mobile app.

Move Fast, Maintain Control
Because Salesforce Analytics lives in the cloud, you can get started in a fraction of the time of traditional business intelligence
implementations. Keep your data safe and secure using the Salesforce tools you know and trust.

Vo @ ey ten daing?

Finally, business intelligence for the rest of us! You don't have to be a business analyst, a data scientist, or a developer to start conversing
with and learning from your data.



Introducing Wave, the Analytics Cloud Find the Value in Your Data

IN THIS SECTION:

Find the Value in Your Data

Now everyone can have a conversation with their data through interactive visualizations. Salesforce Analytics rewards your curiosity
with fast, responsive answers. Exploring any type and combination of data is now fun, easy, and powerful.

Explore Data Anywhere with Salesforce Analytics for iOS

Your data is always close at hand with Salesforce Analytics for iOS. Keep tabs on your business no matter where you are: check in
on this quarter's customer cases, track progress toward sales goals, and instantly share learnings with your team.

Rich Data Visualization in Your Web Browser

A dashboard is a collection of lenses that interact with each other. Drill into one and watch the others change to help you shape the
questions you're asking. Don't just look at the visuals; use the tools on the dashboard to dive deeper into the data you care about.
Go ahead, click around and explore!

Explore with Powerful Visualization Tools

Get to know the boundaries and shape of your data. Use explorer’s interactive visualization tools to play with different views, zoom
in and zoom out, and see what you get with different charting options.

Build Powerful Queries Using SAQL (Pilot)
Use the Salesforce Analytics Query Language (SAQL) to make sure that your lenses return exactly the data you're looking for. SAQL
is a real-time query language that enables ad hoc analysis of data that's stored in datasets.

Dashboards Help Users Help Themselves
A dashboard is your vehicle for telling a specific, focused story about data that people can learn from and act on. It consists of a
curated set of charts, metrics, and tables based on the data in one or more lenses.

Integrate Data from Anywhere

In your business, you have data everywhere: warehouses, spreadsheets, logs, and in Salesforce. With Analytics Cloud, it's easy to
integrate data from any of these sources, including external data else, such as SAP or Oracle data, mobile app data, or product sensor
data.

Get Up and Running Fast
Setup is simple and familiar. You can enable Analytics Cloud from the Setup menu. Enable, configure, and establish access control
and security just like you would for other Salesforce products.

Find the Value in Your Data

Now everyone can have a conversation with their data through interactive visualizations. Salesforce Analytics rewards your curiosity
with fast, responsive answers. Exploring any type and combination of data is now fun, easy, and powerful.

Analytics Cloud gives you a fast, fluid way to drill through it, discover compelling insights, and share the right visuals to tell your data
story. Datasets, lenses, dashboards, and apps are collections of data that represent different levels of refinement—everything from raw
data uploaded from your source systems to highly curated, packaged views of your data.

A dataset is a set of source data, specially formatted and optimized for interactive exploration. It can be Salesforce data, external
data, or a combination, such as a mashup of account data and product usage data.

A lens is a particular view into a dataset. It's where you explore using interactive visualizations. A visualization is commonly a chart
or graph, such as a bar chart, donut chart, timeline, or heatmap. It can also be data in tabular form, such as a comparison table or
pivot table. Every visualization has an underlying query, which is how Analytics Cloud retrieves information from the source data.
A dashboard is a curated set of charts, metrics, and tables based on the data in one or more lenses. Dashboards are interactive. You
can tap on charts, buttons, and other elements to dynamically filter and drill into data.
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Introducing Wave, the Analytics Cloud Explore Data Anywhere with Salesforce Analytics for iOS

e Anapp contains dashboards, lenses, and datasets in any combination that makes sense for sharing your data analyses with colleagues.
Analytics Cloud apps are like folders, allowing users to organize their own data projects—both private and shared—and control
sharing.

Explore Data Anywhere with Salesforce Analytics for iOS

Your data is always close at hand with Salesforce Analytics for iOS. Keep tabs on your business no matter where you are: check in on this
quarter's customer cases, track progress toward sales goals, and instantly share learnings with your team.

Access Everything on Your Phone

022 PM
— Playground )
Analytics for Sales Q Sample Dete
ﬂ Haime ALL
e Sales Performance APPS
£z il
20

Analytics for Sales
This sample dashboard mashes up

Opportunity and Targel data
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il Selling More

Project &
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Salesforce Foundation

1 Sales Rep at a Glance
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“ ’ Settings
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] |
T Feedback
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—
-
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Your entire collection of apps, dashboards, lenses, and datasets is only a tap or two away. Leave the laptop at home—you have everything
on your phone.
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Introducing Wave, the Analytics Cloud Explore Data Anywhere with Salesforce Analytics for iOS

Interact with Dashboards and Lenses

Fiscal Year SLA Met
MTD | QTD Mo Yes
| All All
P«Ill All
293,099 226,177
2272 8.5

Case Backlog

Dashboards and lenses aren't static; go ahead and tap around. Notice how data updates in real time. Apply filters and drill into specific
data points to learn even more, like what's behind those escalated cases.
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Introducing Wave, the Analytics Cloud Rich Data Visualization in Your Web Browser

Share Findings with the Team

Count of Rows
Account Owner
Amount ($100 ... $1.500)
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When you're ready to share discoveries with the team, you can annotate your visualization by adding text, drawing, highlighting important
data points, and more.

Download It Today

Download Salesforce Analytics for iOS on the App Store. Analytics for iOS is available for Apple iPhone 4 and later models running iOS
7 and later.

#  Download an the

& AppStore

SEE ALSO:
Analytics for iOS Help

Rich Data Visualization in Your Web Browser

A dashboard is a collection of lenses that interact with each other. Drill into one and watch the others change to help you shape the
questions you're asking. Don't just look at the visuals; use the tools on the dashboard to dive deeper into the data you care about. Go
ahead, click around and explore!

44


http://tiny.cc/getanalyticsRN
http://tiny.cc/analyticshelpRN

Introducing Wave, the Analytics Cloud Explore with Powerful Visualization Tools

Range SFDC Sales Rep At-a-glance - public Selecwrs

$26.493,602
7,460
15

N

Numbers & . .
% '
K - “

Charts

You read a Salesforce Analytics dashboard interactively, by clicking the widgets displayed. Every widget is a live, filtered database query.
e Aselectoris a dropdown list that lets you filter down to a particular value that matters to you. Selectors are often tied to each other
in sequence so you can progressively drill deeper.

e Arich variety of charts shows you data from multiple angles. Many parts of a chart are interactive. For example, click a bar in a bar
chart and watch what happens.

e Some information is best presented by a single number. Some number widgets can be affected by filtering actions you take on
charts or selectors.

e Arange widget is a controller for filtering other widgets on the dashboard. In this example, you can set the maximum and minimum
sliders to make the dashboard show you only amounts within a specific range.

Explore with Powerful Visualization Tools

Get to know the boundaries and shape of your data. Use explorer's interactive visualization tools to play with different views, zoom in
and zoom out, and see what you get with different charting options.

Choose from a selection of rich, colorful visualizations to see which views of your data tell the most compelling story.

a
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Introducing Wave, the Analytics Cloud

Build Powerful Queries Using SAQL (Pilot)

Every visualization in Analytics Cloud is based on at least one measure, which is anything that can be represented by a number. Measures
are typically aggregated in some way. For example, you can chart two measures side-by-side, showing both the sum of a revenue amount
and the average of expected revenue. Measures define the type and scope of your visualization as you explore a dataset.

bar length bar leng Giosp

T eines

Stageniame

Detailed Discovery

Surm of Amount snd Avg of Expecte FMeasuie by StageMName  Jrcioup = &

Visualizations often involve dimensions in addition to measures. A dimension is anything qualitative that's not represented by a number,
such as company name, region, and product. Dimensions are handy for grouping your data into useful categories, such as viewing
revenue numbers by stage name. They're also handy for filtering unnecessary data out of a visualization, to unclutter your chart and

narrow your focus to what's most relevant.

Exploring your data can lead you down many paths. Not all of them will be fruitful and that's okay. Explorer keeps a full history of your
activity in a lens. If you've changed your lens in undesired ways, use history to quickly backtrack to a previous state in your visualization.

© History

groups changed to Close Date
(manth)

groups changed to StageName
filter on FiscalYear added: 2013

filter removed: FiscalYear

Share your visualizations with other Analytics Cloud users.

e Give colleagues access to a specific dashboard, lens, or app via a unique URL.
e Share the app itself, with users, groups, or roles.
e Post to Chatter the link to a dashboard, lens, or app.

e Save avisualization as an image file.

SEE ALSO:
Exploring and Sharing Analytics Cloud Data

Build Powerful Queries Using SAQL (Pilot)

Use the Salesforce Analytics Query Language (SAQL) to make sure that your lenses return exactly the data you're looking for. SAQL is a

real-time query language that enables ad hoc analysis of data that's stored in datasets.

SAQL is compositional—every statement has a result, and you can chain statements together. Analytics Cloud uses SAQL behind the

scenes in lenses, dashboards, and explorer to gather data for visualizations.
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Introducing Wave, the Analytics Cloud Dashboards Help Users Help Themselves

@ Note: SAQL is currently available through a pilot program. Any unreleased services or features referenced in this or other press
releases or public statements are not currently available and may not be delivered on time or at all. Customers who purchase our
services should make their purchase decisions based upon features that are currently available.

SEE ALSO:
SAQL Reference

Dashboards Help Users Help Themselves

A dashboard is your vehicle for telling a specific, focused story about data that people can learn from and act on. It consists of a curated
set of charts, metrics, and tables based on the data in one or more lenses.

Dashboards help engage team members in active discussion and collaboration around your data, regardless of where your team members
are. Drop charts into a dashboard, size for any form factor, and watch the lightbulbs turn on.

When you share Analytics Cloud data via a dashboard, you're setting up your end users to do some exploring of their own, without
turning them loose on the whole dataset.

IN THIS SECTION:

Create Dashboards Fast with the Dashboard Builder

The dashboard builder is a visual interface for quickly and easily creating dashboards that tell a story about data for a particular set
of readers. You capture the data you want to work with in lenses. These live, fully-synced views of your data are displayed in containers
called widgets. You design widgets that work together to tell a data story from different angles.

Represent Dashboard Data in JSON
It's easy to design dashboards in the builder, but you can also use JSON to directly manipulate the data in a dashboard.

SEE ALSO:
Share Analytics Cloud Data with Dashboards

Create Dashboards Fast with the Dashboard Builder

The dashboard builder is a visual interface for quickly and easily creating dashboards that tell a story about data for a particular set of
readers. You capture the data you want to work with in lenses. These live, fully-synced views of your data are displayed in containers
called widgets. You design widgets that work together to tell a data story from different angles.

Widgets that come from the same dataset are faceted by default. This means that when you filter one widget, all the related widgets
are filtered in the same way. You can turn faceting on or off for each widget.

You can use widgets to present data in all the standard ways: Line graphs, bar charts, pie charts, drop-down selection lists. The important
thing is that these graphics don't just display information. Each chart is itself a live query, which a user can drill into at will for more
focused knowledge.

Represent Dashboard Data in JSSON

It's easy to design dashboards in the builder, but you can also use JSON to directly manipulate the data in a dashboard.
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Introducing Wave, the Analytics Cloud Integrate Data from Anywhere

Work with JSON for more control over advanced dashboard features, such as specifying SAQL queries, setting query limits, and creating
manual bindings between values.

SEE ALSO:
Dashboard JSON Reference

Integrate Data from Anywhere

Inyour business, you have data everywhere: warehouses, spreadsheets, logs, and in Salesforce. With Analytics Cloud, it's easy to integrate
data from any of these sources, including external data else, such as SAP or Oracle data, mobile app data, or product sensor data.

You integrate data into datasets. A dataset is an collection of data that's been specially formatted and optimized for interactive exploration
in Analytics Cloud. Datasets can contain Salesforce data, external data, or a combination. You can register datasets to enable users to
explore data within them.

IN THIS SECTION:

Integrate Salesforce Data

Would you like to explore your Salesforce data? Use a dataflow to load it into a dataset. A dataflow is a reusable set of instructions
that defines how to extract data from Salesforce and load it into datasets.

Bring in External Data
Salesforce Analytics Cloud can handle data from anywhere, not just inside Salesforce. You can upload external data using the
application, or you can get more control by using the pilot External Data API.

Integrate Salesforce Data

Would you like to explore your Salesforce data? Use a dataflow to load it into a dataset. A dataflow is a reusable set of instructions that
defines how to extract data from Salesforce and load it into datasets.

You can also use a dataflow to break down barriers between disconnected data. Still have those spreadsheets with information that
complements your Salesforce data? Use a dataflow to connect those two sources in the same dataset.

Extract Data Transform Datasets Register Datasets
Salesforce Dataset

Object

sfdcDigest q

it More Transformations
Dataset sfdcRegister

Transformation
edgemart Transformation

Dataflows also support transformations that let you create, transform, and optimize datasets for different kinds of analysis. For example,
you can join two different datasets, pull existing datasets into the dataflow, set up security on datasets, and register datasets to make
them available for querying. When the dataflow runs, Analytics Cloud processes each transformation sequentially.
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Introducing Wave, the Analytics Cloud Bring in External Data

o%-

After you configure the dataflow, you upload it to Analytics Cloud and run it to create the datasets.

— A
W
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Salesforce

i . )
{ Data
p
—, — .
- Edit
Download the Edit the file to define: Upload the edited Dataflow job runs Dataset created
dataflow definition file » Objects to extract, dataflow definition file

» Row-level security for the dataset

The dataflow runs daily to keep data synchronized. Worried that your dashboard won't contain the latest data for your 10 a.m. meeting?
Don't worry! You can also start a dataflow on demand to capture the latest data.

SEE ALSO:
Data Integration Guide

Bring in External Data

Salesforce Analytics Cloud can handle data from anywhere, not just inside Salesforce. You can upload external data using the application,
or you can get more control by using the pilot External Data API.

Analytics Cloud includes new Salesforce sObjects to help you upload your external data programmatically. You can work with these
objects to upload data using any of the familiar Salesforce APIs, such as the SOAP API, REST API, or Apex.

To upload external data with the API, you prepare your data in CSV format and create a metadata JSON file to specify the structure of
the data. Then you configure the InsightsExternalData object with the name of the dataset, the format of the data, and the operation to
perform on the data. Upload your data using InsightsExternalDataPart objects. From there, just monitor the InsightsExternalData object
for status updates and confirm the successful uploading of files.

— Metadata

Data CSV .=||]=. JSON

. K ] +
| .

Prepare the Create a metadata file that: Upload files via the System job Dataset created
external data file + Describes the data structure, Ul or External Data API created and runs
» Defines row-level security
for the dataset

@ Nofe: The Analytics Cloud External Data APl is currently available through a pilot program. Any unreleased services or features
referenced in this or other press releases or public statements are not currently available and may not be delivered on time or at
all. Customers who purchase our services should make their purchase decisions based upon features that are currently available.

SEE ALSO:

External Data API Reference
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Introducing Wave, the Analytics Cloud Get Up and Running Fast

Get Up and Running Fast

Setup is simple and familiar. You can enable Analytics Cloud from the Setup menu. Enable, configure, and establish access control and
security just like you would for other Salesforce products.

IN THIS SECTION:

Salesforce-Strong Security

Analytics Cloud can pull in tons of data from different sources and make it available for queries through the explorer and builder.
However, not all users may need access to all data. Analytics Cloud offers multiple levels of access control that can be implemented
to ensure that the right user has access to the right information.

Analytics Cloud Limitations
Analytics Cloud works differently from other Salesforce features in some ways.

Salesforce-Strong Security

Analytics Cloud can pullin tons of data from different sources and make it available for queries through the explorer and builder. However,
not all users may need access to all data. Analytics Cloud offers multiple levels of access control that can be implemented to ensure that
the right user has access to the right information.

'App owners, administrators, and users,

The administrator controls
Dataset owners control granted manager access 1o an app
access o Salesforce data. Salesforce control access fo datasets, lenses,
datasets.

and dashboards within apps.

Analytics Cloud

Salesforce
Data

e External
Data

Control Access to Salesforce Data

The administrator can restrict which Salesforce data can be loaded into datasets in Analytics Cloud. The administrator can also define
sharing access within each dataset, using role hierarchies or other means of mapping users to data. Salesforce Analytics Cloud does not
replicate Field Level Security settings in datasets, but administrators can create multiple datasets with various fields and give access to
audiences according to their rights.

Control Access to Datasets, Lenses, and Dashboards

App owners, administrators, and users granted manager access to an app control access to datasets, lenses, and dashboards within apps.
Keep them in your private app to hide them from others. Add them to the Shared App to share them with everyone.
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Introducing Wave, the Analytics Cloud Analytics Cloud Limitations

Control Access to Dataset Records

Dataset owners can implement row-level security on each dataset that they create to restrict access to its records.

SEE ALSO:
Security Guide

Analytics Cloud Limitations

Analytics Cloud works differently from other Salesforce features in some ways.

Releases Are Not Staggered

All Analytics Cloud customers will receive releases of new Analytics Cloud features at the same time, and not on the normal staggered
schedule for core releases—regardless of instance. Analytics Cloud releases may occur on a different schedule than major releases.

Rapid Innovation and Deployment

Analytics Cloud releases may happen on a more frequent schedule than major releases. This means that customers will see the product
undergo rapid innovation, which may include more frequent changes to end-user functionality. Release timing will be communicated
to all customers.

Copy to Sandbox is Not Supported

Customers currently can preview or test new Analytics Cloud features in Sandbox before enabling them in production, but assets can't
be migrated between Sandbox and production environments.

No Localization or Internationalization

Userinterface labels and product documentation for Analytics Cloud will be available in English only. Translated labels and documentation
will not be provided.

Analytics Cloud does not support multi-currency. Analytics does not convert the currency field on behalf of the user. As a result, users
who want to analyze multiple currencies simultaneously should convert them into a single currency master before analysis.

Accessibility Features Are Not Supported

Accessibility features haven't been incorporated into Analytics Cloud.

Packaging and Metadata API Are Not Supported

The use of the Metadata API is not supported for Analytics Cloud. You cannot package or version Analytics Cloud applications. Migrating
Analytics Cloud data, objects, and applications from Sandbox to Production orgs must be done manually. The Default Org Template
(DOT) is not supported for org duplication.
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Introducing Wave, the Analytics Cloud Analytics Cloud Limitations

Limited Field-Level Security

Field-Level security is not available for external data uploaded via files. Field-level security implemented in the original database or
Salesforce object is not preserved when the data is loaded into an Analytics Cloud dataset. For more information, see the Security
Implementation Guide for Analytics Cloud.

Supported Browsers

Browser support is available for: Microsoft” Internet Explorer® versions 10 and 11; Mozilla® Firefox”, most recent stable version; and Google
Chrome™, most recent stable version.
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MOBILE

Not in the office? No worries! Salesforce mobile apps help you stay productive no matter where you are.

IN THIS SECTION:

Salesforcel

The Salesforce1 app lets users stay up to date on their most-important records, activities, conversations, and dashboards—from
wherever they are.

SalesforceA
Manage users and view information for Salesforce organizations from your mobile device.

Salesforce Chatter Mobile Version 3.1 for Android No Longer Available
The Salesforce Chatter Mobile app version 3.1 for Android is no longer available for download from Google Play.

Salesforcel

The Salesforce1 app lets users stay up to date on their most-important records, activities, conversations, and dashboards—from wherever
they are.

IN THIS SECTION:

Access the Salesforcel App
There are several options for accessing Salesforce1 on mobile devices.

Salesforce1 Enhancements

Our latest round of new and improved Salesforce1 features further expands the utility of the downloadable and mobile browser
apps, making it even easier to access Salesforce on the go.

Salesforce1 Differences from the Full Salesforce Site

The Salesforce1 app doesn't have all of the functionality of the full Salesforce site, and in some cases includes features that aren't
available in the full site.

Salesforcel App Development Overview
There are several Force.com platform enhancements that support Salesforce1 development.

Access the Salesforcel App

There are several options for accessing Salesforce1 on mobile devices.

e Install the Salesforce 1 downloadable app on Android ™ and Apple® mobile devices. Users can download the app from the App Store
or Google Play™.

e Access the Salesforce1 mobile browser app from a supported mobile browser on Android, Apple, BlackBerry, and Windows 8.1
devices. This option doesn't require anything to be installed.

See “Requirements for Using the Salesforce1 App” in the Salesforce Help for the complete list of supported devices and browsers.
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Mobile Salesforcel Enhancements

Salesforcel Enhancements

Our latest round of new and improved Salesforce1 features further expands the utility of the downloadable and mobile browser apps,
making it even easier to access Salesforce on the go.

Use of the Salesforce app is supported for all editions (except Database.com Edition) without any additional licenses. The Salesforce
data and features that are available in Salesforce1, however, are determined by your organization’s Salesforce edition and licenses and
by a user's assigned profile and permission sets.

@ Note: Ata glance, here is what's new in version 7.0 of the Salesforce1 downloadable apps for iOS and Android devices.
e Support foriOS 8, and for Apple iPhone 6 and 6 Plus devices (iOS only)
e Support for Android OS 5.0 (Android only)
* Do most actions with the new Salesforce1 action bar and list item actions
e See up to 200 list views (iOS only)
e Sort and filter list views
e Open most Salesforce URLs directly in the Salesforce1 downloadable app (i0S only)
e (reate contacts from mobile contact lists
e (reate an action to add products to opportunities
e See profile pictures for opportunity team members
e Make updates to tasks without opening task records
e See a weekly view of Salesforce events
e See more data in Today, including recently accessed records
e Share dashboards in the feed

e Bug fixes and performance improvements

Android iOS Mobile Setup in
Salesforcel Enhancement Downloadable Downloadable Browser the Full
App App App Site
Device and Browser Support
Use Salesforce1 on more devices—including iPhone 6 and 6 Plus phones, w w w

Android 5 devices, and the mobile browser app on select Windows 8.1

' (As of version (As of version
smartphones (generally available).

7.0) 7.0)
General Salesforce1 Setup Enhancements
Do basic Salesforce setup with the new Salesforce1 Wizard. w o o W
Quickly access Salesforce setup pages and documentation, all from one

« « « +
place.
Available Data and Navigation Enhancements
Switch between accounts in multiple organizations and communities. w w

(As of version (As of version
6.0) 6.0)
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Android iOS Mobile Setupin
Salesforcel Enhancement Downloadable Downloadable Browser the Full
App App App Site
View and search for data that's stored outside of Salesforce. s s «
(As of version
6.0)
See up to 200 list views directly on object record search pages. o

(As of version

7.0)
Sort list views. W W W
(As of version (As of version
7.0) 6.0)
Filter list views by user-specified criteria to display the desired records. « «
(As of version (As of version o
7.0) 7.0)
Add Lightning components to the Salesforce1 navigation menu. « «
Open most Salesforce URLs directly in Salesforce. "

(As of version
7.0)

Actions Enhancements

Do actions from a centralized place with the new action bar. « « «

(As of version (As of version

7.0) 7.0)
Act on specific records directly from lists. o« o« o«
(As of version (As of version
7.0) 7.0)
Understand how actions are arranged on the action bar and in lists. o o o o

(As of version (As of version
7.0) 7.0)

Salesforce Communities Enhancements

Enable nickname display for all the members in a community, so that

users’ first and last names are hidden. v v
Chatter Enhancements
See recommendations in the feed about useful groups to join and about v v

using the Today app.
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Android iOS Mobile Setup in
Salesforcel Enhancement Downloadable Downloadable Browser the Full
App App App Site
Access topic detail pages directly from topics tagged to feed items. o
Ask questions and get answers in the feed (generally available). o
Access the People item from the navigation menu even when Chatter « « «
is turned off (As of version  (As of version
6.0) 6.0)
Upload photos to use as profile pictures. « « «
(As of version
5.1)
See who co-workers are following in Chatter. ip ip ip
(As of version
5.0)
Collaborate with more privacy in unlisted Chatter groups. o
Access Shared with Me and Following filters in Salesforce Files Sync list w w w
VIEWS. (As of version (As of version
5.0) 5.0)
Attach files to comments in feed posts. « « «

(As of version (As of version
5.0) 5.0)

Identify files that are connected to Salesforce from other sources, such
as Microsoft” SharePoint®, when browsing feeds and Salesforce Files «
Sync list views.

Search Enhancements

Do global searches directly from the Salesforce1 header. «

Scope global search results to find records by the type of object. «

While typing a search term, see matching results for all accessible records

instead of just those recently viewed. v v
Relationship and Data Management Enhancements

Find information in a record view more easily with new tabs and an

. 4 . « « =

improved swipe experience.

Prevent the creation of duplicate records. (Beta) « « « >
Log calls faster using a page that shows only key field:s. o o o
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Android iOS Mobile Setup in
Salesforcel Enhancement Downloadable Downloadable Browser the Full
App App App Site
Create contacts directly from mobile device contact lists. o o

(As of version (As of version

7.0) 7.0)
Get new contacts for an account from the Data.com Get Contacts for
Salesforcel AppExchange package. v v v v
Clone contact records. w w w
See more Twitter details on contact records. « « «
Convert qualified leads to contacts. (Beta) « « « >
Add products to opportunities. w w w +
See profile pictures for opportunity team members. o o o
Add new skills and endorse users. « «
Work with reward funds and reward fund types. o« o« o«
Search for thanks badges to use for showing appreciation to colleagues. w w w
Approvals Enhancements
View the status of pending approvals and approve or reject approval o o
requests, all from a central place. (As of version

6.0)
Activities Enhancements
Create tasks faster using a New Task page that's focused on key task
. W W W L
fields.
Add several new update actions for tasks via a critical update. o o o W
Update task lists with a swipe and a tap. « « «
(As of version (As of version

7.0) 7.0)
Update task due dates more easily with the new due date selector. « « «
Let users decide whether to receive email notifications for tasks assigned

" " " W
to them.
See Salesforce events in a weekly view, with events lists for specific

" " "

days—including previous days.

Today Enhancements
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Android iOS Mobile Setupin
Salesforcel Enhancement Downloadable Downloadable Browser the Full

App App App Site
Manage the day better from Today, with centralized access to more key
information. v v
Analytics Enhancements
Share dashboards in the feed. « « «

(As of version  (As of version

7.0) 7.0)

Drill down from a dashboard component to see matrix reports, as well
L4 L4 L4
as tabular and summary reports.
Apply field filters and scope filters to a report to see the desired data. ip ip ip
View all of the data in a truncated column on a report. o o o
Stay in context when scrolling through a report because the header row
always displays at the top of the page. v v v
Access report records more quickly with the new default sort order. « « «
Offline Enhancements
Work Offline with Salesforce1 « «
(As of version (As of version e

6.0) 6.0)

View more cached data when working offline. « «

Set Up Salesforcel with the Salesforcel Wizard

The Salesforce1 Wizard provides an easy way to complete the essential setup tasks for the Salesforce1 mobile app. The wizard is ideal
for you if you're new to Salesforce1 and would like a visual tour of its key point-and-click settings.

When you walk through the Salesforce1 Wizard, you'll configure the following Salesforce1 settings, which will apply to all users in your
organization.

e Specify which items appear in the navigation menu

e Organize global actions

e (reate a custom compact layout for contacts

To use the Salesforce1 Wizard, from Setup, click Salesforce1 Setup. Then, on the Salesforce1 Setup page, click Launch Quick Start
Wizard.

Note: We recommend using Google Chrome for the Salesforcel Setup page and the Salesforce1 Wizard. Microsoft Internet
Explorer 9 or later and Moxzilla Firefox are also supported.
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Home Chatter Profile Leads D Contacts O

with a long long name  Contracts Cases AddUsers + ¥

earch All Setup

Expand All | Colapse Al

salestorcel Setup New!

Force.com Home Salesforcel Setup
» s:ilesfr}rce Sewp  Help & Traming

Administer

» Manage Users
+) Manage Apps Welcome!
» Manage Territories.

+ Company Profile

* Security Controls

+ Domain Management

Quick Start Wizard

e e Comple About the Quick Start Wizard l

+ Translation Workbench minu
+ Data Management
+ Mobile Administration Launch Quick Start Wi —
+ Deskiop Administration
+ Email Administration

+ Google Apps
+ Data.com Administration
Customizable Parts of the App
Build ks of
+) Customize - o
+ Create B » ’, FET— Y
’ T Let's Get Started

@ Nofte: Although the Salesforce1 Wizard gets you up and running with basic setup tasks, it doesn’t include all Salesforce1 setup
tasks. For example, the wizard shows you how to make a compact layout for contacts to introduce you to that process. You have
to configure compact layouts for accounts, opportunities, and other objects elsewhere on their respective setup pages. You can
access and learn more about these additional settings in the Salesforce1 Setup page.

Quickly Access Salesforcel Setup Tasks from a Single Page

The Salesforce1 Setup page gives you quick access to Salesforce1-related settings and documentation, so you can tackle your mobile
configuration tasks from a single place.

To access the Salesforcel Setup page, from Setup, click Salesforce1 Setup.

Note: We recommend using Google Chrome for the Salesforce1 Setup page. Microsoft Internet Explorer 9 or later and Mozilla
Firefox are also supported.
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Home Chatter Leads Accounts Contacts Opportunities Reports Dashboards Documents Products Forecasts +
|

| Quick Find |

Expand Al | Collapse Al sale:ky‘f}rce

Salesforcel Setup New! [ 7 .

Salesforce1 Setup

Force.com Home

The Salesforcel mobile app allows you to bring Salesforce with you everywhere. Use the

Administer tools on this page 1o set up Salesforcel so you can run your business from your phone.
Manage Users
Manage Apps
Manage Territories
Company Profile Quick Start Wizard Security and Access Settings

Security Controls

ete the essenti = i v @ few ( sopent TUp page)
N e Complete the essential setup tasks in only a fev (Links open the Setup page)

Communication Templates minutes = App security controls
Mobile browser option

Translation Workbench N S

Mobile Administraion * Offiine sync
Desktop Administration
Email Administration
Google Apps

I N e A e I I E

Customizable Parts of the App Work With Records While Mobile
i {Links open the Setup page) (Links open documentation In a new window)
+ Navigation menu + Compact layouts
v Customize « Branding + Mobile cards
¥ Create = Actions
| Develop .

Page layouts
Schema Builder
Canvas App Previewer
Installed Packages Expose Custom Code for Salesforcel
AppExchange Marketplace {Links open decumentatien In a new window)
Critical Updates « \Visuslforce pages
« Flexible Pages
Deploy e Canvas apps

Outbound Change Sets
Inbound Change Sets

For settings that are configured on a single page, the Salesforce1 Setup page directly links to those pages. In cases where a setting
requires work on multiple pages, we've provided links to relevant documentation that will guide you through the necessary steps.

Switch Between Accounts in Multiple Organizations and Communities

Users of the Salesforce1 downloadable app for Android, as well as those using the downloadable app for iOS, can now access their
accounts in different organizations and communities without having to log out and re-log in to each account. Users can stay logged

into multiple accounts in different organizations, and this saves users time by letting them easily switch to the accounts they need to
access.

Users can tap next to their avatar and name at the top of the navigation menu to access the account drop-down menu. To add a

new account, users tap and they'll be redirected to the familiar Salesforce login page to enter their user name and password
credentials. Once their user name and password are authenticated, they can open the account drop-down menu to see and access their
accounts. The items your users see in the navigation menu changes based on the selected account. To remove an account from the
account drop-down menu, simply log out of that organization.

Users can view and switch between communities and their internal organization. The communities your users see and have access to
changes based on the selected account. Members of your communities who have Customer Community, Partner Community, or other
supported portal licenses can use the account drop-down menu to access and switch between their communities.

Communities in Salesforce1 work similarly to the full Salesforce site with some minor differences. See Communities in Salesforce1: Limits
and Differences from the Full Salesforce Site in the Salesforce Help.
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View and Search Data That's Stored Outside Salesforce

Salesforce1 users can view and search records that are stored in external systems with Lightning
Connect, so they can seamlessly interact with all relevant data. This feature is available in the
Salesforcel mobile browser app and version 6.0 or later of the Salesforce downloadable app for

EDITIONS

Lightning Connect is

iOS devices. . )
available in: Developer
For example, some of your data may be in an enterprise resource planning (ERP) system. Salesforce Edition and for an additional
represents that data in external objects and accesses the data in real time via Web service callouts cost in: Enterprise,
tothe external data source. External objects are read only both in Salesforce1 and in the full Salesforce Performance, and
site. Unlimited Editions

As long as the following conditions are true, external objects are automatically included in the

Recent section of the Salesforce1 navigation menu as part of the Smart Search ltems element. Users

may need to tap More to see these items. In addition, when these conditions are true, related lists for external objects appearin Salesforce 1
when users view the parents of those external objects.

e Aswith custom objects, the external objects must be deployed and assigned to tabs that the users can access, and object permissions
must be granted via profiles or permission sets.

e The external objects' associated external data sources must have the High Data Volume checkbox deselected.

e Forthe Salesforce1 downloadable app for iOS devices, the external data sources must have the Tnclude in Salesforce
Searches checkbox selected.

To find these checkboxes, from Setup in the full Salesforce site, click Develop > External Data Sources, then click the name of the
external data source.

For more information about Lightning Connect, see Access External Data with Lightning Connect on page 206.

Sort List Views

Locate data in list views faster by controlling how information is sorted and displayed. This option is now available in the Salesforce1
downloadable app for Android, versions 7.0 and later. Sorting has been available in the mobile browser app since the Summer 14 release
and in the downloadable app for iOS as of version 6.0—but in both of these cases, the Sort icon is now located in the action bar.

On a list view, tap to see the sort options. Tap the column name by which to sort. Tap the column name again to alternate
between sorting in an ascending and descending order. Tap Apply to sort the list view.
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Cancel

Opportunity Name

Account Name

Amount

Close Date

4+ Ascending

Stage

Opportunity Owner Alias

Filter List Views to See Just What's Needed

Salesforce users can filter existing list views to see just the records they need, instead of cluttering up Salesforce with even more list
views. This option is available in the Salesforce mobile browser app and the Salesforce1 downloadable apps, versions 7.0 and later.

Recently Viewed Accounts »

Acme

Phone:
Type:

Global Media

Phone:
Type:

salesforce.com

Phone:
Type:

Billing State/Provin,..

Account Owner Ali...

Billing State/Provin...

Account Owner Ali...

Billing State/Provin...

Account Owner Ali...

NY

{212) 555-5555
Prospect
Alser

Ontario

(905) 555-1212
Frospect
Alser

CA

(415) 901-7000
Customer
Alser

e (©)
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Salesforce1 list view filters let a user fine-tune the data that's displayed in a list view without affecting how the list view appears to other

people in the organization. While viewing a list view, tap

. The Filter page shows any existing filters, which can be cleared if the user

wants to start over. To add a new filter, tap + select the field by which to filter, and tap Apply. Then enter the filter criteria for the
selected field and tap Apply to filter the list view.
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Cancel Filter Apply

@ Add Filter Clear All

The way to enter filter criteria varies, depending on the type of field.

e For text fields, enter the first few characters that match the records to display. For example, to see accounts whose names start
with *A,” create an Account Name filter on an accounts list view and type A in the field.

Cancel Filter Apply

Account Mame

A

+ Add Filter Clear All

e For date fields, set a start date and an end date to specify a date range. Only results within those dates will appear in the list view.

Cancel Set
4 August 2014 »
SUN MON TUE WED THU FRI SAT

27 | 28 | 29 | 300 | 31 1 2
3 B 5 6 7 2
10 1 12 13 14 15 16
17 18 9 20 219 22 23
24 25 26 27 28 29 30

31 1 2 & 4 = 6

e For number fields, enter a minimum and maximum value. Only results in that range will appear in the list view. For example, to

see only accounts with a certain number of employees, create an Employees filter on an accounts list view, and enter numbers to
create the desired range.

Cancel Filter Apply
Employees
(1&,000 15,000 )
+ Add Filter Clear All
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@ Nofte: It's possible to accidentally create a filter that displays no results if the filter criteria is inconsistent with the list view's

parameters. For example, creating a filter that shows only opportunities between $5,000 and $10,000 for a list view that displays
opportunities over $20,000 returns no results. If a filter has no results, the user should check to see if the filter is screening out all
results.

Add Lightning Components to the Navigation Menu in Salesforcel

The Lightning Component framework powers Salesforce1. You can use it to create your own Lightning components and make them
available to Salesforce1 users.

From Setup, click Create > Tabs to create a Lightning Component tab. Creating a custom tab is a prerequisite to enabling your component
in the Salesforce1 navigation menu, but accessing your Lightning component from the full Salesforce site is not supported. An administrator
has to add the custom tab to the navigation menu in Salesforce1 by clicking Mobile Administration > Mobile Navigation from Setup.
For more information, see “Adding Lightning Components to Salesforce1” in the Salesforce Help.

For more information on Lightning components, see Lightning Components (Beta) on page 288.

Open Most Salesforce URLs Directly in the Salesforcel Downloadable App for iOS

Devices

When users of the Salesforce1 downloadable app for iOS tap a Salesforce URL hyperlink, or enter a Salesforce URL into a browser address
bar on a mobile device, they're taken directly into the Salesforce1 app. This saves users time from having to manually navigate to desired
information in the app.

For example, a user can send a Salesforce URL for an account to some coworkers. Simply by tapping the Salesforce URL, a coworker
using the Salesforce1 downloadable app on an iOS device can automatically open the account record in the mobile app.

Do Most Actions from the Salesforcel Action Bar

Now, users of the Salesforce1 downloadable apps, version 7.0 or later, as well as Salesforce1 mobile browser app users, have a one-stop
place to find actions so there’s no more confusion about where to go to do something. We've consolidated actions from different places
in Salesforce1 into a new home: the action bar.

Record actions (1), standard and custom record buttons (2), and actions from the publisher (3) are now located in the action bar (4) or

in the action @ menu (5), which displays all actions that are available on a given page. The images displayed on action icons have
been redesigned.
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Salesforce1 Actions Have Moved from Various Locations to the Action Bar and Action Menu

Edge Communications

Edge Communications
C o - Direct « cs

Edge Communications

FEED DETAILS RELATED @ Call or Log
n o New Task
Account Owner
L Admin User
e Post
( Edll ~ ) '_E
= ' ._—13
Edit
A t r Hot J
Admin User i
File
t Na
Rat Edge Communications
New Contact
Hot
Phone ° c
Log a Call
PR (512) 757-6000 ’
Edge Communications —
(HE® © © 6 ®
—

The action bar is present on the feed, groups, user profiles, dashboards, and standard and custom object record views. The actions that
are available depend on where a user is in Salesforce, and to some extent on how you've configured page layouts and publisher layouts
for your organization.

Users may see some or all of these kinds of actions in the action bar (including the action menu).

e Record actions—These actions are available on accounts, contacts, leads, opportunities, person accounts, and mobile calendar
events in Salesforce Today. They've moved from the highlights area to fixed positions in the action bar.

e (Custom and standard buttons—Buttons (such as Edit, Delete, or Clone) that are included on an object’s page layout are available
for records in Salesforce1 as actions in the action bar. With the exception of the Edit button, which is in a fixed position, the order of
these actions in the action bar is determined by the order of the buttons on the page layout.

e Publisheractions—These actions have moved from the publisher action tray to the action bar. If you add, remove, or reorder actions
in either the global publisher layout or on an object’s page layout, these changes are reflected in Salesforce1. However, depending
on the object, some publisher actions are in a fixed position in the action bar.

e Standard Chatter publisher actions—Actions unique to Chatter, such as Post, File, Link, or Poll, have also moved from the publisher
action tray to the action bar. For some objects, the Post action is in a fixed position that overrides your publisher layouts.

For more information about which actions are displayed, and in which order, see How Actions Are Ordered in the Salesforce Action
Bar and List Item Actions on page 67.

What are the exceptions?

e On record feeds, the Follow/Unfollow button remains at the top of the page.

e On public group feeds, the Join Group button remains at the top of the page, but the Leave Group button is in the action bar. On
private group feeds, the Ask to Join/Leave Group buttons are in the action bar.

e On record search pages for objects, the New button remains at the top of the page.

What does this mean for custom branding?

Because the publisher () doesn't exist anymore in the mobile browser app or in version 7.0 or later of the downloadable apps, it's no
longer applicable to configure a custom publisher icon for these apps. However, if you set a custom background color for SalesforceT,
the action bar displays that color.
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@ Note: The publishericon is still available in versions 5.x and 6.x of the downloadable apps and it's still possible to customize the
image that's used for the icon in these earlier apps.

There can be only one version of a custom icon. Custom action icons you created prior to Winter "15 are still supported, but they will
look truncated in the action bar. To optimize your custom action icons for display in the action bar, use these guidelines.

e Theicon should be 72 x 72 pixels. Use the full pixel area for the image—don't leave spacing around the image like before.
e Make the image a PNG with a transparent background, with a file size that is less than 10k.

e Have a resolution of 72 dpi.

e Theicon graphic should be white, or lighter than the background color.

e Avoid heavy inner or outer shadows.

e Use simple and flat styling resembling the Salesforce1 icon family.

Work with Records Directly from Lists

Salesforce1 users can now update records without having to open them. This huge time-saver comes in the form of list item actions—a
version of the action bar that's available for items in list views, task lists, and related record lists.

To access list item actions, navigate to a list view or task list or open a related list from an object’s related information page. Then swipe
left on the desired record. For example, here’s how it works for the Opportunities related list on an account.

Here's the Opportunities related listonan ~ Swipe a listitem to the left to reveal listitem  Tap '@' to show the action menu, with the
account. actions. full list of actions available for the list item.

Opportunities Opportunities Opportunities
Edge Emergency Generator Edge Emergency Generator
Stage: Id. Decision Makers © Q e Stage: Id. Decision Makers
Amount: $35,000.00 2y
Close Date: 9/27/20M [~] Log a Call
Edge SLA Edge SLA Q New Task
Stage: Closed Won Stage: Closed Won
N : ()

Amount: $60,000.00 Amount: $60,000.00 New Event
Close Date: 9/27/201 Close Date: 9/27/201

. . | Post
Edge Installation Edge Installation
Stage: Closed Won Stage: Closed Won ‘
Amount: $50,000.00 Amount: $50,000.00 0 Edit
Close Date: 9/27/201 Close Date: 9/27/201 P

) File
Edge Emergency Generator Edge Emergency Generator
Stage: Closed Won Stage: Closed Won New Case
Amount: $75,000.00 Amount: $75,000.00
Close Date: 9/27/201 Close Date: 9/27/201
Close

Hide list item actions by swiping the list item back to the right or by tapping another item in the list.
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List item actions show the same actions that are available in the action bar when viewing the actual record. In other words, using the
example above, a user sees the same set of actions, in the same order, in the list item actions (and action menu) for the Edge Emergency
Generator list item and in the action bar (and action menu) after navigating to the Edge Emergency Generator opportunity record.

Same as with the Salesforce1 action bar, some list item actions are fixed in their positions, while some actions respect the ordering you've
established for standard and custom buttons on page layouts and publisher actions in the global publisher layout and on object page
layouts. For a complete breakdown of the order of actions, see How Actions Are Ordered in the Salesforcel Action Bar and List ltem
Actions on page 67.

How Actions Are Ordered in the Salesforcel Action Bar and List ltem Actions

The order in which actions appear in the Salesforce action bar and list item actions is partly controlled by your organization’s page
layouts and publisher layouts. But in some cases, the location of key actions is predefined by Salesforce to make these actions easily
accessible.

The actions in the action bar, list item actions, and associated action menus are divided up into groups. The arrangement of these groups
is fixed, but the order of actions within the groups can vary based on the object and the actions that are present on the global publisher
layout or on an object’s page layout.
Table 1: Action Groups and the Order They Display In
Action Group1  Action Group 2  Action Group 3  Action Group 4  Action Group 5  Action Group 6

Set of actions Set of actions Remaining publisher Custom buttons, in  Remaining standard Remaining record
predefined by predefined by actions, in the order  the order definedon  buttons, in the order actions.
Salesforce. These can  Salesforce. For most  defined on eitherthe the page layout. defined on the page
vary dependingon  objects, this set global publisher layout.
the page the useris contains only the layout or the object
viewing. Edit standard page layout.

button.

Not every object or page displays every group. Action groups 3,4, and 5 respect the ordering of the actions as defined by the global or
object page layouts, with a few exceptions, as you'll see in the next table.

Here's the breakdown of which actions are contained in each group for each object or page.

Objector Page Action Group 1 Action Group Action Group Action Group Action Group Action Group

2 3 4 5 6
Account 1.Call, 2. Task, 3. 5. Edit Remaining Custom buttons, Remaining Send Email, Map,
New Event, 4. publisher actions in the order standard buttons, Read News, View
Post in the order defined onthe  in the order Website
definedonthe  page layout. defined on the
page layout page layout.
Case First three 5. Edit Remaining Custom buttons, Remaining
publisher actions publisher actions in the order standard buttons,
in the order in the order defined onthe  inthe order
defined on the definedonthe  page layout. defined on the
page layout, 4. page layout page layout.

Post
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Objector Page Action Group 1 Action Group Action Group Action Group Action Group Action Group
2 3 4 5 6
Contact 1.Call,2.5end 5. Edit Remaining Custom buttons, Remaining Map
Email, 3. Task, 4. publisher actions in the order standard buttons,
New Event in the order defined onthe  in the order
definedonthe  page layout. defined on the
page layout page layout.
Custom Object  First four actions 5. Edit Remaining Custom buttons, Remaining
in the order publisher actions in the order standard buttons,
defined on the in the order defined onthe  in the order
page layout definedonthe  page layout. defined on the
page layout page layout.
Event 1.Quick Message, 4. Edit
2. Conference
Call, 3. Map
Feed Publisher actions  Sort
in the order
defined on the
global publisher
layout
Flexible Page Actions in the
order defined in
the Flexible Page
Group First four actions  Remaining Edit Leave Group
in the order publisher actions
defined onthe  in the order
global publisher  defined on the
layout page layout
Lead 1.Call, 2. Task, 3. 5. Edit Remaining Custom buttons, Remaining
Lead Convert, 4. publisher actions in the order standard buttons,
Post in the order defined onthe  in the order
definedonthe  page layout. defined on the
page layout page layout.
List View 1. New
<object>,2.
Filter, 3. Sort
Opportunity 1.Log-a-Call, 2. 5. Edit Remaining Custom buttons, Remaining
Task, 3. Event, 4. publisher actions in the order standard buttons,
Post in the order defined onthe  in the order
definedonthe  page layout. defined on the
page layout page layout.
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Objector Page Action Group 1 Action Group

2

1.Call, 2. Send
Email, 3. Task, 4.
New Event

Person Account 5. Edit

Task 1. Edit Comment, 5. Edit
2. Defer, 3.
Change Status, 4.
Change Priority

User 1. Call, 2. Send
Email, 3. Post

4. Edit

Action Group
3

Remaining
publisher actions
in the order
defined on the
page layout

Remaining
publisher actions
in the order
defined on the
page layout

Remaining
actions in the
order defined on
the global
publisher layout

Action Group
4

Custom buttons,
in the order
defined on the
page layout.

Custom buttons,
in the order
defined on the
page layout.

Custom buttons,
in the order
defined on the
page layout.
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Action Group
5

Remaining
standard buttons,
in the order
defined on the
page layout.

Remaining
standard buttons,
in the order
defined on the
page layout.

Remaining
standard buttons,
in the order
defined on the
page layout.

Action Group
6

Map, Read News,
Website

As we mentioned, some actions are in fixed positions. In places where you see a numbered list in the table, this is the fixed order that
those actions appear in on the action bar, list item actions, and in the respective action menus.

For example, for the Account object, the standard Chatter Post action is fixed in the fourth position. Regardless of where you put the
Post action in the Publisher Actions section of the account page layout, Post always displays in the fourth position when viewing accounts

in Salesforce1.

However, deletion of actions is always respected. So in our example, if you delete the Post action from the account page layout, the
remaining actions move up and you see Edit in the fourth position.

See Chatter Recommendations in Salesforcel

In the SalesforceT mobile browser app, the Chatter feed now includes recommendations to help your users take advantage of useful
options. The feed suggests public groups to join and recommends using the Salesforce Today app for event preparation and management.

Group Recommendations

Group recommendations appear in feeds in your internal Salesforce organization and in Salesforce Communities. Chatter suggests public
groups that a user hasn't already joined and staggers recommendations over time to avoid cluttering up feeds. Group recommendations

can't be disabled.

Salesforce Today Recommendation

The Today recommendation appears in your internal organization’s feeds only. Today is an app that helps users plan for and manage
their daily meetings, and includes time-saver options like instant access to conference calls, quick logging of events, and more. Today
is available in the Salesforce1 downloadable apps only—users who tap the recommendation card are directed to the App Store or

Google Play, where they can install the downloadable app and then try out Today.

The Today recommendation is turned on by default and displays twice in users' feeds, spaced out over a week. If desired, you can disable
this recommendation for your organization from Setup. Click Setup > Customize > Chatter > Settings, then deselect the Allow
Today Recommendations checkbox. If disabled, all existing Today recommendations are removed from your users’ feeds.
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Attach Files to Commments on Feed Posts

It's now possible to attach files directly to comments on feed posts using the Salesforce1 mobile EDITIONS
browser app, as well as the Salesforce1 downloadable apps. Users can attach files from Salesforce

or files stored on a mobile device. ) . )
Files available in: Group,

To attach a file to a comment, tap " . A preview of the attached file displays in a new comment Professional, Enterprise,

on the post. Performance, Unlimited,
Contact Manager, and
Developer Editions

B
Fred Williamson . Q
Auguet 4, 2014 8t THS AM
@Whitney Humboldt, here's a helpful "geting D Files e Like
started” guide that you can distribute to
customers
Company Logo s Fred Williamson
ustNow - Delete

Upgrede Window Design This presentation also has some useful

Information.

Start Using

Salesforce Files Sync Select a file from Salesforce

Start Using Salesforce Files Sync

Upload a file from device Company Logo Salesforce Files:
What's New in Spring “14

Salesforce Files Presentation

Naotes

b Like

% o 2

This presentation also
has some useful
Lo ntormation

See Where External Files Originate

If Salesforce Files Connect is set up for your organization, Salesforce 1 mobile browser app users can

e - } ) ® e EDITIONS

see if files originate from outside sources, such as Microsoft” SharePoint”. -

In feeds and Files list views, external data source names appear below file names. For example, if a Files Connect available in:

file originates from a SharePoint data source an administrator named “Office 365,” that appears Enterprise, Performance,

below the file name. Unlimited, and Developer
Editions
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All Company »

’ Fred Williamson to Whitney
Humboldt:

10m ago

=

@Whitney Humboldt, here's the overview
| mentioned this morning. Let me know If
you have any feedback, especially about
the branding!

& Pacifica QOverview.pdf

via Office 365

e Like Comment

O 0@ O

This information appears only if your organization is set up to reference external files, rather than copy them. For details, see Set Up
Salesforce Files Connect.

Stay in Context When Searching

To make it easier for users to search for information without having to switch away from their work to the navigation menu, the global
search box is now accessible directly from the header. This enhancement is currently provided in the Salesforce1 mobile browser app
only, but will be included in a future update of the downloadable apps for Android and iOS devices.

What | Follow =

Conner McCoy
AR August 25,2014 5t 9:52 AM

Our new web site looks fantastic!
Thanks to @Kathy Cooper and @Alan
Wangfor contributing to our very first
blog entires. Next up, how do we
funne...

Continue Reading

1o Like Comment

QWO O6 @

Tap m to open the search box. This icon displays in the header when viewing the feed, Approvals, Events, and Tasks.
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Object-specific search boxes continue to display at the top of the record search pages—the pages that are accessed by selecting objects
such as Contacts, Groups, or Dashboards from the navigation menu. And searching in the main feed is unchanged.

Narrow Global Search to a Recently Accessed Object

Users can now scope global searches to just find records for a specific object. This enhancement is currently provided in the Salesforce1
mobile browser app only, but will be included in a future update of the downloadable apps for Android and iOS devices.

Tapping E in the Salesforce1 header opens the global search box. Then select the type of records to find by tapping an object in the
search scope bar below the search box. The search scope bar contains the same objects that users see in the Recent section of the
navigation menu. To see all of the objects, swipe to the left on the bar.

OPPORTUNITIES CONTACTS ACCOUNTS PEQ

All Opportunities

Initrode, Inc. - Laptops

Firefly Insurance - Desktops

Dixon Chemical - 20 Spider 3 Serie:

Acme Inc - 6 Star 10 Series Desktog

It can take up to 15 days for the objects that users work with regularly in the full Salesforce site to appear in the Recent section. To make
objects appear under Recent sooner, users can pin them from the search results screen in the full site.

If an object doesn't appear in the search scope bar, users can do object-specific searches directly from the object’s record search page.
Tap the item in the navigation menu to access the object-specific search box.

Find the Right Record While Typing Keywords

Salesforce1 now helps users quickly find and access all records they have permission to view without having to finish typing the keywords
for the search. Using the small, touch keypads on mobile phones is often error-prone, so the less typing the better! This enhancement
is currently provided in the Salesforce mobile browser app only, but will be included in a future update of the downloadable apps for
Android and iOS devices.

When users begin typing in a search box, a list below the box shows recently accessed records and list views that match the characters
entered so far. As three or more characters are entered, the list continues to filter matching recently accessed items and also starts to
show all other matching records that the user has permission to access for the object.

When the desired item shows in the list, tap it to open it. If the right record doesn't show up in the list by the time all keywords are
entered, start the full search from the keyboard or by tapping Search for keywords.
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@ Nofte: This feature is automatically available for all objects supported in the Salesforce mobile browser app, with the exception
of Salesforce Files Sync and Salesforce Knowledge. For Files, only matching recently accessed records are displayed in the list.

To make this option available for Knowledge searches, in Setup, click Customize > Knowledge > Settings. In the Knowledge
One section, select the Auto-complete title search checkbox.

Prevent Duplicate Records (Beta)

Data.com Duplicate Management lets you control whether and when you allow users to create

) o : . : EDITIONS
duplicate records inside Salesforce. Set up duplicate rules in the full Salesforce site and you can also
manage whether Salesforce1 users can save records that are identified as possible duplicates.

Data.com Duplicate

Duplicate rules tell Salesforce what action to take when users attempt to create records that may Management available in:
duplicate existing Salesforce records. For example, the duplicate rule could block users from saving Professional, Enterprise,
the possible duplicate record or allow them to save it anyway. Performance, Unlimited,

and Developer Editions

Did you mean one of
these records?

sparrow E

Account Na Acme Inc
Phone:
Email; jack@sparrow.com

Go to this contact

sparrow E

Account Na Acme Inc

Phone:
Email: jack@sparrow.com

Go to this contact

Jack Sparrow E

Account Na Acme Inc

Phone:

By default, duplicate rules run when users save records. You can change this behavior for Salesforce so that duplicate rules run as users
complete fields on the record instead. This reduces data entry time, which is always desirable on a mobile device. In the full Salesforce
site, from Setup, click Mobile Administration > Salesforce1 > Settings. In the Duplicate Rule Settings section, select Run duplicate

rules when users complete fields.

For more information about duplicate rules, including how to set them up, see the Duplicate Management entry in the Sales Cloud
section of these release notes.
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Log Calls Faster

Your sales reps no longer need to fiddle with all the fields in a task record when they're simply trying to log a call. The Log a Call action
available on leads, contacts, and accounts now displays only key fields. Just add notes about the call and move on to the next one. All
versions of Salesforce include this enhancement.

Cancel Log a Call Submit
Subject

Details
Name Brandi Thomas, Som...
Related To

Due Date

MORE

Create Contacts from Mobile Contact Lists

Sales reps can save time and eliminate typos by using the Salesforce1 app to import contacts from mobile device contact lists directly
into Salesforce. This feature is only available in the Salesforce1 downloadable apps.

With the tap of a button, a user can map the fields for an existing contact in a mobile contact list to the Salesforce1 create page for
contacts. Start by creating a new contact and tap Import from Device to open the device’s contact list, then select the contact to add
to Salesforce.

Get Data.com Contacts for an Account

The Data.com Get Contacts for Salesforce AppExchange package lets your Salesforce1 users quickly add new contacts for accounts
while on their phone or tablet. It's a great way to expand networks and find new customers while on the go.

You need to install the package for your organization and complete a few setup steps. Then, any users with a Data.com Prospector
license can get started adding new Data.com contacts simply by tapping Get Contacts on an account record and selecting which
contacts to add.
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Salesforce.com, Inc
Headquarters + P ct » Tec

L (=]

-d1 Get Contacts

3.058 contacts found in Data.com

Convert Leads to Contacts (Beta)

Sales representatives on the go can now convert qualified leads to contacts and create opportunities, which helps sales representatives
grow their revenue pipeline. This option is available in all versions of Salesforcel.

@ Note: The Lead Conversions feature in Salesforce is a beta version that is production quality but has known limitations. You can
provide feedback and suggestions for Lead Conversions on the IdeaExchange.

It's easy to make this option available to your sales reps. From Setup in the full Salesforce site, click Customize > Leads > Settings.
Then, select the option Enable Conversions on the Salesforcel App.

To convert qualified leads to contacts and create opportunities using the Salesforce 1 mobile browser app, open the lead record and tap

on the action bar. Because the Salesforce1 downloadable apps do not have the action bar yet, swipe to the Details page on the
lead record, tap , then select Convert.

Create an Action to Add Products to Opportunities

Improve your sales reps' productivity in the field by creating an action for adding products to opportunity records. This type of action is
supported in all versions of Salesforce1.

Create this new action from Setup, by clicking Customize > Opportunities > Buttons, Links, and Actions > New Action. Populate
the Target Object and Standard Label Type fields so they match the settings in (1) and (2).
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Opportunity Actions

New Action

Enter Action Information Save  Cancel

Object Name  Opportunity | ;

Action Type | Create a Record )i

Target Object I Opportunity Product % | i
Standard Label Type New "Record" =13

Name | Add Product Line i

Description 244 ProductLine to | | i
\Opportunity &

leon ) Change Icon

Save Cancel

Then add the new action to the Publisher Actions section on the opportunity page layout. From Setup, click Customize > Opportunities
> Page Layouts.

In Salesforce1, the action is available from the action menu on opportunity records. In versions of the downloadable apps that don't
have the new action bar, users access the action from the publisher. The action is also available in the full Salesforce site, from the
publisher on opportunities.

Find Thanks Badges to Give to Coworkers

When recognizing coworkers with a public “thank you" in the feed, it's now easier to find the right kind of badge to go along with the
Thanks post. This enhancement is available in all versions of Salesforce1.

76



Mobile

Cancel Select a Badge

Most Recent Badges

Team Player
Succe atean . Thanks tor playir

You're a RockStart
Great job - you rocked !

Gold Star
Seallr g a great job with a gold sta
Deal Maker

Always be closing!

Customer Hero

The customer Is always #1

' @9 O RS

Comnefition Crusher

Salesforcel Enhancements

Using the new badge selector, users can search for badges based on the badge name, description, and owner. It's also possible to filter

badges by Most Recent Badges, Company Badges, Badges | Created, and All Badges.

View All Pending Approval Requests in One Location

Salesforce1 lists all pending approval requests in one central place, making it easy for users to keep
track of pending approvals and respond to requests while on the go. This feature is available in the
Salesforce1 downloadable app for iOS devices and the Salesforce1 mobile browser app.

To view an approval request, tap Approvals in the mobile browser app navigation menu or
Approval Requests in the iOS downloadable app navigation menu. A list of pending approvals
for the current user displays. Tap a specific approval request to view the request details and then
tap Approve or Reject. Approvers can also tap notifications to open an approval request, view
request details, and approve or reject requests.

This item is included in the navigation menu by default. The layout can be configured using the
Setup menu in the full site.

EDITIONS

Approvals are available in:
Enterprise, Performance,
Unlimited, and Developer
Editions, and for an
additional cost in:
Professional Edition

For more information, see “Approvals in Salesforce1: Limits and Differences from the Full Salesforce Site” in the Salesforce Help.

It's Easier to Create a Task

No need for your sales reps to scroll through a page of fields just to add to their to-do lists—now the New Task page displays key task
fields first. Tap More to see additional fields. This simpler page is available to varying degrees in all versions of the Salesforce1 app. Prefer
to use a different layout in your organization? Use Setup to specify that layout instead. If your users apply record types to tasks, keep in

mind that the simpler page has limitations in regard to task record types.
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Where Users See the New Page

e Inthe Salesforcel downloadable app for Android devices and the Salesforce1 mobile browser app, all task creation actions open
the new page, including the New Task button on task lists and New Task publisher actions.

e Inthe Salesforce1 downloadable app foriOS devices, only the New Task button on task lists opens the new page. New Task publisher
actions continue to open the standard task creation page.

Cancel New Task Submit
Subject
Details
Name
Due Date
MORE
v

Disable the New Page and Show a Different Layout

In the full Salesforce site, from Setup, click Customize > Activities > Activity Settings and deselect the checkbox Show simpler New
Task form in Salesforce1.

Limitations of the Simpler New Task Page

Users Can’t Choose a Record Type
The new page is applied to the global task create action, which can be associated with only one task record type at a time. If you've
defined a record type in your organization, users won't see the new page when they create a task unless you change the record type
in the global task create action. Change the value of the Record Type field from the default, master, to the record type that
you've defined.

If your Salesforce users need to create tasks of two or more task record types, consider disabling the new page, because the page
doesn’t let users choose a record type when they create a task.

Any tasks created before you change the value of the Record Type field in the global task create action retain the record type
value master.

Global Task Create Action Required in Global Action Layout
The global action layout must include the global task create action. Otherwise, tapping New Task displays the full New Task page.
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Add New Task Update Actions to Salesforcel

Your organization receives notifications about the “Add New Task Update Actions to Salesforce1”
critical update only if the default task layout in your organization has been modified. When you
activate this critical update, four new update actions are added to all task page layouts, including

USER PERMISSIONS

To view crifical updates:

custom layouts, and are available in all versions of Salesforce1. The update actions are: Edit Comment *  “View Sefup and

(edit the task description), Change Date (change the due date), Change Status, and Change Priority. Configuration”

You can activate this critical update from Setup, by clicking Critical Updates and then clicking To activate critical updates:
Activate for “Add New Task Update Actions to Salesforce1.” *  “Modify All Data”

For more information, see It's Easier to Update Tasks in a List on page 79. AND

“Customize Application”
lt's Easier to Update Tasks in a List

Do your users want to add details to a task? Push out the due date? Change the status or priority? There’s no need to open a task and
scroll through a page full of fields while editing the record. In a task list, just swipe left on a task and tap an option. Four new update
actions—Edit Comment (description), Change Date, Change Status, and Change Priority—make it simple for your users to keep their
task lists up-to-the-minute. (Tap the last icon in the row to see all available options.) This feature is available in the Salesforce 1 mobile
browser app, and the Salesforce1 downloadable apps, versions 7.0 and later. In some organizations, this feature requires a critical update.

For more information, see Work with Records Directly from Lists on page 66. If the default task layout in your organization has been
changed, this feature requires a critical update; for details, see Add New Task Update Actions to Salesforce1 on page 79.

Make It Easier to Change a Task’s Due Date

Give all your Salesforce users a simple way to change a task’s due date. On any task update action, you can replace the reqular calendar
date picker with a new due date selector that displays common due date choices first.

Cancea

To use the new date selector, in Setup, create a task update action or edit an existing action. Prepend “Defer” to the contents of the
Name field (then save the action and add it to a task layout).

For example, suppose you have an action with the label “Sales Task” and the name “Sales_Task". Insert “Defer” at the beginning of the
name.

79



Mobile

Task Actions

New Action

Enter Action Information Save | Cancel

Object Mame  Task| ;

Action Type I Update a Record v 1

Standard Label

—Mone— v
Type !

Description

lcon & Changelcon

Save | Cancel

Label I Sales Task
Hame I DeferSales_Task i
i

See Salesforce Events in a Weekly View

Viewing Salesforce events in Salesforce1 has gotten easier. Events are now available in a weekly view, allowing users to see an event list
for a specific day—including previous days—instead of having to scroll through a single list of all events. And it's now possible to create
new events directly from the Events page. (The action bar for Events is available in the Salesforce1 mobile browser app and the Salesforce
downloadable apps, versions 7.0 and later.)

Tap Events in the Salesforce1 navigation menu to open the new events weekly view.

August 28 2014

SUN MON WED THU

TUE FFR
24 25 26 27 28 29 30

Weekly Sales Team ... 8:00 AM
Location:

Start: 8/28/2014 8:00 AM

End: 8/28/2014 9:00 AM

—

Arbuckle Demo 9:00 AM
Location:

Start: 8/28/2014 9:00 AM

End: 8/28/201410:00 AM
Sync up with Kevin B... 1:00 AM

9 New 'l:::l' Today
1 - 1

SaT

=

2 o
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@ Nofte: Salesforcel mobile browser app users on Windows 8.1 devices can see the current week only.
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For more information, see “Create Object-Specific Actions” and “Customize Actions with the Action Layout Editor” in the Salesforce Help.

The events list for the current day (1) displays, using the same sorting rules as in Summer "14. Events are shown by start time, with all-day
and multi-day events displayed at the top of the list.

To see events for a different day, tap a date in the date bar (2). Swipe left on the date bar to see the next week; swipe right to see the
previous week. The date bar shows up to four future weeks and four previous weeks.
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Same as before, tap an event in a list to open the event record.

Users can create new events (3) and quickly return to the events list for the current day (4).

Notes about Salesforce events in Salesforce1:

As in the Summer '14 release, events lists use the active event compact layout to determine the fields that are displayed for each
event. But because events lists are now shown on a day-by-day basis and to make the lists easier to read, each event no longer
includes its date or the event icon.

Lists now show a maximum of 20 events per day.

Lists don't automatically refresh to show new or edited events. Pulling down on a list refreshes the events for the current day only.
The list does automatically refresh if an event is deleted from Salesforce1.

The 0 icon launches the first create action for events that is in your organization’s global publisher layout. This allows you to
override the default New Event action, if desired.

Manage the Day Effectively with More Key Information in Salesforce Today

To ensure that Salesforce Today is the one-stop place where sales reps can manage their day, we've redesigned the main Today view
to include more key information instead of forcing users to navigate around Salesforce to find what they need. In addition to mobile
calendar events, users can also see important tasks and recently accessed Salesforce records.

No longer just an event list, the main Today view now shows these cards, in this fixed order:

Current Event (1)
Agenda (2)

My Tasks (3)

My Recent Records (4)

Wed, August 27 ® o I
E'—'ZBOpm 1hr My Tasks More -——E

Weekly Sales Team Meeting

123 11th Street Review product list Today
Fumiko Suzuki, Kathy Cooper, Bradley Update Arbuckle Today
Durgan, and 1 other presentation
E]—' Later Today More My Recent Records More e=—— —| 4 |
3:00pm Arbuckle Demo Brandi Thomas

3:30pm  Sync up with Kevin Bailey
Ann Hansen

4:00pm Microsoft Compete 194 alig...

Cat Wong
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Users can still tap current and future mobile calendar events to see details, including invitees with matching Salesforce contacts and
accounts, and to access the conference call dialer, quick message, and log this event actions. And now users can just as easily tap to
manage tasks and other relevant Salesforce records.

Current Event card

This card puts the focus on the user’s current or next meeting, highlighting key details like the starting time, duration, location, and
number of invitees.

A current event is one that starts 15 minutes before and up to 15 minutes after the current time. If there are multiple meetings
scheduled in this window, each one is displayed in a separate Current Event card.

If there aren’t any events in the current time window, the Current Event card shows the next event scheduled for the day.

All-day events and multi-day events that have already started aren't displayed in this card.

Agenda card

As the day progresses, this card evolves to show upcoming events or earlier events so users can prepare for what is most relevant
at the moment. Users can toggle the card to show all mobile calendar events scheduled for the day.

The Later Today state shows all upcoming events for the day. This state applies when at least one event has concluded and there
are other upcoming events. The More link expands the card to show the complete list of events for the day.

The Earlier Today state shows all of the concluded events for the day. This state appears when all events are finished or the last event
of the day is displaying in the Current Event card.

The Agenda state appears if the only event for the day is an all-day event or a multi-day event that's in progress. (Today indicates
in-progress multi-day events by showing “Starts” or “Ends” in connection with the event’s time.)

This card doesn't display if there are no events for the day.

My Tasks card

This card includes up to three of the user's most important tasks that are due on the current day, so it's easier to keep activities
updated before and after meetings.

Priority tasks show first, followed by other tasks. In each of these categories, tasks are sorted by creation date in descending order.
The More link opens the user’s full Task list.

This card doesn't display if the user doesn't have any tasks due on the current day.

My Recent Records card

This card gives users a quick way to access recently viewed Salesforce records, which may be related to a user's meetings for the
current day. Accessing these records from Today also makes it faster to do quick updates after a meeting or wrap up to-do items at
the end of the day.

The card only shows records for objects that are available in the Salesforce1 app and that are supported in a Salesforce most recently
used (MRU) items list. For example, because Salesforce Files Sync records aren’t supported as recently used items, recently viewed
files aren't included in this card.

The card displays up to three records; tap More to see the My Recent Records list of the 15 most recently accessed records.

All of the Today cards update every time a user accesses Today—either from the navigation menu or when tapping [& to return to
Today from the Task list, the My Recent Records list, or an event or other record that was opened from Today. In addition, the Current
Event and Agenda cards auto-refresh as the day proceeds. The pull-to-refresh gesture doesn’t work on the Today main view.
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Share a Dashboard in Chatter

Salesforce1 users can post a snapshot of a dashboard component to Chatter by mentioning a group
or a user. The feed shows a thumbnail preview of the component, along with the comment. Other

users reading the feed can tap the thumbnail to open the full dashboard. This option is available
in the Salesforce1 mobile browser app and the Salesforce1 downloadable apps, versions 7.0 and
later.

Cancel Share

This Is great @[Tom Resellerl@[Sarah

=

Jones]
X
FEED
Untitled
2
Component
Record Count '—: D- )
Stage Asof 7/26/201410:4
P
B Frospecting 1 Quslificstion z M
L] Analysis W Value Propasition " Viewing as Test User
oposalPrice Quote M Negotistion/Review -
Closed Won B Closed Lest v S e -vonl

W Cther - e

Opportunities by Type and Stage

Jones
Opportunity Name Account Name Warning

Snapshots In feeds are public. Don't post

Homeland A.. 27K Data Mart sensitive Information.

Advanced .. 130K Southern Sound Co

Twitter - 100... gets Twitter Inc

© ©

1. Tap the Sharing button to get a snapshot of the chart.
2. Tap Share to post the snapshot. The recipient can tap the snapshot to go to the dashboard.

Drill Down from a Dashboard to a Matrix Report

When viewing a dashboard in any version of the Salesforce1 app, users can tap a dashboard

component to see the report that's delivering the data to the dashboard. This is now available for

matrix reports as well as tabular and summary reports.

Groupings in matrix reports are shown as columns. Swipe right or left to see all the columns.

Users can see a maximum of 2,000 records. To see all records, log into the full Salesforce site.

O Important: When users drill from a dashboard to a report, they may see slightly different
data in the report view from what they saw in the dashboard view. That's because the data
displayed in a dashboard is from the last dashboard refresh (the date and time of which are

shown in the dashboard header), but drilling down to a report actually runs the report, so in
that case the user is seeing the most current report data.
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Test User
July 1, 2014 at 10:50 AM

o: E:l
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EDITIONS

Dashboards available in:
Group, Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Q,

Sarah Jones

RELATED

Follow

This Is great @Tom Reseller@Sarah

EDITIONS

Dashboards available in:
Group, Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Reports available in: All
editions except
Database.com
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Filter Dashboard Components

Users can apply field filters and scope filters to a report by tapping the related chart. Users can tap
the Filters button to see which report filters have been applied to the report. This enhancement
is available in all versions of Salesforce1, except for the Salesforce1 mobile browser app when used

on a Windows 8.1 phone.

Tap a section of the chart (1) to filter by that value. The filter button shows how many filters are

applied.

Tap the filter button (2) to see which filters are applied.

Opportunity Count

Opportunity Subtitle

Record Count
Stage
W Proposal/Price Quote Qusl
W Closed Last my
Needs Analysis L]
Frospacting [ 1=
W Cther

Prep8ged by T User

Oppty Matrix Report

Amount

Opportunig Name

Optos Inc. - 25K $25,000.00

o

losed Won

1015/2013

Close Filter

Currently filtenng by

Stage equals Closed Won

In this release, users can filter by date, but not by a date range.

See Truncated Text in Report Columns

To fit multiple columns on a small mobile screen, parts of the content of a field (the middle words
of a text field or the trailing digits for a numeric field) may be dropped out. Salesforce users can
now tap the field to see the full text in a pop-up, then tap the pop-up to go to the record.
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EDITIONS

Dashboards available in:
Group, Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

Reports available in: All
editions except
Database.com

EDITIONS

Reports available in: All
editions except
Database.com
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Oppties by Stage
Which deals should | focus on?

Closed won
Frospecti.. R
Negotiati. T
neezs ans. [
& vaiue Frc.. I
I
]
I

Closed Lo..

o

Advanced Interconnections Corp -
130K

Go to Record

Quslifica..
Progosal
Parcaptic. |
14, Decis. |

Prepared by T. User

Opportunities by Ty,

Opportu 1[ me

Homeland A

and Stage
Account Name
Data Mart
Advanced |- 130K

Southern Sound Co.

Twitter - 100... cets Twitter Inc

1. Tap an abbreviated table cell to see it spelled out in full.

2. Tap Go to Record to see the underlying data.
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Advanced Interconnections Corp

FEED DETAILS RELATED

Opportunity Owner
Test User

Close Date
2/2/2014

Opportunity Name
Advanced Interconnections Corp - 130K

Stage
Closed Lost

Stay in Context When Viewing Reports with Floating Headers

When users scroll down to read a report, the header rows at the top stay visible.

Opportunity NameA  Account Name
Southern Sound Co. SUstamable Audio
Tech Labs DOT Green Media
Towson Inc. Optos Inc.
UlyssesNet - 30K Troy Bullock
United Partn... 22K Bronze Partners
Universal Container AB Partners, Inc
Universal Se... 22K XPower
Universal Se... 25K DFC Inc.

UP 3000

General Utilities

Vand Enterp... 35K  Nicole Grace

© 9
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Mobile

Salesforcel Enhancements

Access Reports More Quickly With Descending or A-Z Sort Order

The default sort order in all versions of the Salesforce 1 app helps most users get to the report records -
they want with one less tap. When a user taps to sort a numeric field, it sorts in descending order

first. The next time the user taps the field, the order is reversed. When a user taps to sort a text field,
it sorts from A to Z first, then from Z to A.

Work Offline with Salesforcel

EDITIONS

Reports available in: All
editions except
Database.com

Users of the Salesforce1 downloadable app for Android, as well as those using the downloadable app for iOS, can now view much of

their Salesforce data when their mobile devices are offline.

Offline access is enabled by default when you install one of the Salesforce1 downloadable apps. You can manage this setting in Setup

from Salesforce1 Setup > Offline Sync.

When offline access is enabled, data is downloaded to each user's mobile device based on the objects in the Recent section of the
Salesforce1 navigation menu, and on the user's most recently viewed records. Data is encrypted and stored in a secure, persistent cache.

This table lists the elements that are available offline.

Salesforcel Element
Navigation Menu

Global Search
Notifications

Feeds, Groups, and People

Today

Salesforce Events
Recent Objects
Other Objects
Record Details
Related Records
List Views

Tasks

Dashboards

Approvals (submit, approve, or reject)
Visualforce pages

Canvas Apps

Flexible Pages

Settings

Available for Offline Use
Yes

Previous searches only
Previously viewed only
Previously viewed only

Recent Event and Agenda cards on the main view; individual mobile
event records available if previously viewed

Previously viewed only

Yes (top five)

No

Yes (15 most recent records)
Previously viewed only

No

Only tasks from the first page of the My Tasks list (up to 10 tasks),
and only if the list was previously viewed or after the user syncs

Yes (top five)
No
No
No
No

Yes
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When users switch to Salesforce1, their data is cached, which refreshes the local data store. When a user switches to another app, the
user's data is cached automatically if the existing cache is over one hour old.

Users can manually cache their data and refresh that cache at any time (for example, before switching into airplane mode or entering
an area with no service), from Settings > Offline Caching in the Salesforce1 navigation menu.

@ Note: The cache is saved for two weeks. Users can clear the cache by logging out of the Salesforce app.

Work with More Obijects Offline

Offline support in the Salesforce1 downloadable apps is expanded to include access to dashboards and events, and partial access to the
Salesforce Today app. This enhancement is new for current Salesforce1 for iOS users who have been using offline support for the past
few months. Salesforce1 for Android users also receive these offline support enhancements in the version 6.0 general availability release.

The Salesforce1 downloadable apps now automatically cache a user’s five most recently accessed dashboards. This includes dashboards
viewed in the full Salesforce site, as well as in Salesforcel. For these dashboards, the view page is available offline but not the
single-component view. In addition, other dashboards that a user views during a Salesforce1 session are also stored for offline viewing.

Previously viewed Salesforce events are available offline too.

On the main Today view, the Current Event and Agenda cards are automatically cached but none of the other cards are available offline.
Individual mobile events are available if viewed before going offline.

For details about the complete set of Salesforce data that's available when offline, see “Configure Offline Access to Salesforce1” in the
Salesforce Help.

Other Changes in Salesforcel

Learn about other changes in the Salesforce1 app.

Device and Browser Support

More iOS and Apple Device Support
Salesforce1 is supported on iOS 8, and on iPhone 6 and iPhone 6 Plus devices.

More Android OS Support
Salesforce1 is supported on Android 5.0.

Salesforce1 Mobile Browser App on Windows 8.1 Phones (Generally Available)
The SalesforceT mobile browser app is now generally available for use in the Microsoft” Internet Explorer” 11 browser on Nokia™
Lumia™ 1020 and HTC™ 8X phones running Windows® 8.1. Salesforce1 isn't supported on mobile phones with Windows 8.0 or on
Windows tablets.

Salesforce1 Mobile Browser App on Android Tablets
The SalesforceT mobile browser app is supported on Google® Nexus 7™ and Nexus 10™ tablets running Android™ 4.2 or later, as well
as Android phones.

Other Navigation Enhancements
See More List Views on Record Search Pages

Users of the Salesforce1 downloadable app for iOS devices, versions 7.0 and later, can see up to 200 list views for an object, not just
the ones they've accessed recently. Tap More List Views on the object’s record search page. This enhancement makes it possible
to access more list views without having to first open a specific list view.
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Other Salesforce Communities Enhancements

Show Nicknames for Community Members
If an administrator or community manager has enabled nickname display for the members in a community, users’ first and last
names are hidden in the Salesforce mobile browser app, as well as the full site. See “Show Nicknames Instead of Full Names in the
Community” in the Salesforce Help for more information.

Other Chatter Enhancements

Get Faster Access to Tagged Topics
In the Salesforce1 mobile browser app, tapping a topic tagged to a feed item takes users directly to the topic detail page. (Previously,
the full list of tagged topics was displayed, requiring an extra tap to access the detail page.)

Get Answers with Chatter Questions (Generally Available)
The Chatter Questions feed in the Salesforce1 mobile browser app is now generally available. The interface for asking questions and
getting answers is unchanged from the Beta release in Summer '14.

See User Profiles if Chatter Is Disabled
If Chatter is turned off, users are still able to access the People item from the Salesforce1 navigation menu.

Edit Profile Pictures in All Versions of the Salesforce1 App
In the SalesforceT mobile browser app and the Salesforce1 downloadable app for Android devices, users can now upload photos
to use as their profile pictures. Administrators can edit users’ profile pictures if they have the proper permissions. A profile picture is
editable if a pencilicon displays in the lower-right corner of the image. This feature has been available in the Salesforce 1 downloadable
app for iOS devices as of version 5.1.

See the “Following” Related List on User Profiles
The Following related list is now available in the Salesforce 1 mobile browser app and the Salesforce1 downloadable app for Android
devices. Users can see who others are following from the related information page on a user’s profile. This feature has been available
in the Salesforce1 downloadable app for iOS devices as of version 5.0.

Collaborate More Privately with Unlisted Chatter Groups

Salesforce1 mobile browser app users can create and access unlisted groups. Unlisted groups offer more privacy than private groups.
Only members and users with the “Manage Unlisted Groups” permission can access unlisted groups in list views, feeds, and search
results in the mobile browser app.

Use Additional Filters to Find the Right Salesforce Files Sync
The Salesforce mobile browser app now includes two additional filters for Files list views: Shared with Me and Following. Previously,
mobile browser app users had to switch to the full site to use these filters. (The downloadable apps have included the Shared with
Me filter as of version 5.0, but don't offer the Following filter.)

Other Relationship and Data Management Enhancements

Find Information More Easily When Viewing Records
The record view in all versions of Salesforce1 has been updated to display tabs for the feed, details, and related information pages,
instead of the dots that were previously used to represent these pages. Users can access record view pages by tapping a tab, or by
swiping right or left on the page. The performance of the swiping experience has been improved.

Clone Contact Records
For all versions of Salesforce1, the Clone action is now available on contacts. This action isn't available for other objects like accounts,
however.

Do More with the Twitter Component
All versions of Salesforce include new options for using Twitter on contact records. Users can see more details about people in
common, more easily read handle lists with new pagination, and log out of Twitter.
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See Profile Pictures for Opportunity Team Members
In all versions of Salesforce1, users can now see profile pictures for members of an opportunity team. Tap a picture to see the team
member’s profile page or to call or email the person.

Add New Skills and Endorse Other Users’ Skills
Users can add new skills and endorse other users’ skills in the Salesforcel mobile browser app and the Salesforce1 downloadable
app for Android devices. To add new skills, open the Skills page from the navigation menu then tap New. Add endorsements when
viewing a user’s skill.

Use Reward Funds and Reward Fund Types
Users can now see, edit, and create reward funds and reward fund types directly in all versions of Salesforce1. This item is automatically
included in the Recent section of the Salesforce1 navigation menu as part of the Smart Search Items element. Users may need to
tap More to see the item.

Tap New on the Reward Fund or Reward Fund Type page to create a new record of that type. Tap Edit on a detail page to edit an
existing reward fund or reward fund type. Additionally, users can search for specific reward funds and reward fund types.

Temporary Known Issues

Tapping the View Comment button in a notification email no longer directs users to the intended post in the Salesforce1
downloadable app for iOS.
For a short period of time in Winter 15, when users get an email notification about a feed post, tapping the View Comment button
in the email doesn't direct them to the actual post in the Salesforce1 downloadable app for iOS. Instead, users are directed to their
feed with the What I Follow filter selected.

This known issue is temporary and only affects users on the Salesforce1 downloadable app for iOS. Users on the Salesforce T mobile
browser app and Salesforce1 downloadable app for Android do not see this issue.

We apologize for this known issue, which will resolve soon in upcoming releases of the Salesforce 1 downloadable app for iOS.

Salesforcel Differences from the Full Salesforce Site

The Salesforce1 app doesn't have all of the functionality of the full Salesforce site, and in some cases includes features that aren't available
in the full site.

For complete details about the Salesforce features that are different in Salesforce1, see “Salesforce1 Limits and Differences from the Full
Salesforce Site” in the Salesforce Help. For features introduced or updated in Winter '15, there are differences in these areas:

e Using Chatter

e Finding information

e Preventing the creation of duplicate records
e Using Salesforce events

e (onverting leads

e Using dashboards

e Working in Salesforce Communities

Differences in Using Chatter

e When using topics in the Salesforce1 mobile browser app, if the list of tagged topics extends to the edge of the mobile display, a
More link leads to the full list of topics.

e When using the Good Access™ secure mobile browser, you can't upload files.
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Differences in Finding Information

In this release, it's not possible to search across multiple objects in global search. Instead, users select an object from the bar beneath
the search box to scope the search to that object.

Differences in Duplicate Management (Beta)

e Each possible duplicate is shown on a “duplicate card.” Salesforce1 shows a maximum of 15 duplicates, even if there are more.

e Aduplicate card displays three fields, which are derived from the search results format defined for the organization, not from the
associated matching rule.

e Auser can tap a duplicate card to view the possible duplicate record’s complete details, but that action erases the information the
user entered in the new or updated record. The user must re-enter that information before the record can be saved or additional
duplicate cards can be viewed.

e By default, duplicate rules run when users save records. You can change this setting in Salesforce1 so that duplicate rules run as
users complete fields on the record. In the full Salesforce site, from Setup, just click Mobile Administration > Salesforce1 >
Settings. In the Duplicate Rule Settings section, select Run duplicate rules when users complete fields.

Differences in Using Salesforce Events

e When viewing Salesforce events from the Events item in the Salesforce1 navigation menu, the date bar always begins on Sunday
and ends on Saturday, regardless of your device and Salesforce locale settings.

e Salesforce events respect the user’s Salesforce time zone settings, not the time zone setting on the user's mobile device.

e Ifauserisviewing the current day’s event list at 11:59pm, the list doesn't automatically refresh to the next day at Midnight.

e Users can't add invitees to events or remove them from events.

Differences in Converting Leads

e Users can select accounts, but can't create them.
e Users can create opportunities, but not select existing ones.

e If duplicate management rules identify a contact as a duplicate, the rules prevent the conversion, regardless of the duplicate
management settings.

e Users can't select lead sources.
e Users can't create related tasks during the conversion, but they can create tasks from the contact record.

e Users can't automatically notify owners of converted leads.

Differences in Using Dashboards

In some situations, data displayed in a dashboard component can get out of sync with data in the report that's displayed on the same
page. When a dashboard component’s data doesn’t match the report, one of these things is happening:

e The dashboard is being refreshed as the configured user or the running user, while a report is always run as the current user.

e The report was refreshed more recently than the dashboard. A report is refreshed every time a user looks at it (if the userisn't offline),
but a dashboard component is only refreshed when the dashboard it belongs to is refreshed.

The same temporary mismatch can occur in the full site, but there users see reports and dashboard charts on separate pages. In SalesforceT,
users see the report and the dashboard chart on the same page.
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Differences in Working in Salesforce Communities

Notifications in Salesforce1 show first and last names, even if nickname display is enabled in the community.

Salesforcel App Development Overview

There are several Force.com platform enhancements that support Salesforce1 development.
e Flexible Pages

e Force.com Canvas

e Lightning Components

e API Support

Flexible Pages

Flexible Pages now support three new components.

* flexipage:reportChart—~Enablesyou toinclude asingle chart from a report in your Flexible Page.
o flexipage:richText

® flexipage:visualforcePage

For more information about these components and their properties, see New Components for Flexible Pages.

Force.com Canvas

Use new methods to smoothly integrate navigation between a canvas app and the Salesforce1 app, without using Visualforce. The
methods are events that reside in the JavaScript library within the Force.com Canvas framework. When you call one of the navigation
methods from your canvas app code, you send an event into Salesforce1 that reads the payload and directs the user to the specified
destination. For more information, see “Salesforce 1 Navigation Methods for Use with Canvas Apps” in the Force.com Canvas Developer's
Guide.

Lightning Components

Lightning Components (Beta)
The Lightning Component framework powers Salesforce1. You can use it to create your own Lightning components and make them
available to Salesforce1 users. For more information, see Lightning Components (Beta) on page 288.

Salesforce1 Mobile Browser App URL Update
If you enable Lightning components, the URL for accessing Salesforce1 with a mobile browser changes from
https://instance.salesforce.com/one/one.app 10
https://instance.lightning.force.com/one/one.app.fyou navigate to the old URL, it redirects to the new
URL. Entering the URL manually in a supported mobile browser can be useful to quickly test changes during development. For more
information, see Enable Lightning Components and Debug Mode on page 289.

API Support

The Force.com APIs support Salesforce1 development. Unless otherwise noted, these enhancements for Salesforce1 development were
made available in APl version 32.0.
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SOAP API
The describeSoglListViews () call returnsinformation about the specified list view, including the ID, the columns, and
the SOQL query.

The executeSoglListView () call executesthe SOQL query for the list view and returns the resulting data and presentation
information.

REST API
The List View Resource returns basic information about the specified list view.

The List View Describe Resource returns information about a list view, including the ID, the columns, and the SOQL query.
The List View Results Resource executes the SOQL query for the list view and returns the resulting data and presentation information.
The List Views Resource returns a list of list views for the specified sObject.

The Recent List Views Resource returns the list of recently used list views for the specified sObject type.

New Components for Flexible Pages

Three new components are now available for use with Flexible Pages.

For information on how to use Flexible Pages and their components, see the Salesforcel App Developer Guide.

flexipage:reportChart
The Report Chart component gives you the ability to include a chart from a report in your Flexible Page.
Properties:

e label: If you leave this property blank, the component label is taken from the label of the report instead.

e reportName: the APl name of the report

This component is supported in APl version 32.0 and later and won't work with reports that are located in the My Personal Custom
Reports folder. If you include them in a package, Report Chart components that refer to reports in the Unfiled Public Reports folder aren’t
deployable.

flexipage:richText
The Rich Text component gives you the ability to add text and simple HTML markup to your Flexible Page.
Properties:

e richTextValue: the HTML or text to display

@ Note: JavaScript, CSS, iframes, and other advanced markup aren't supported in the Rich Text component. If you need to use
advanced HTML elements in a component, we recommend that you use a Visualforce page component.

The Rich Text component is limited to 4,000 characters. This component is supported in APl version 32.0 and later.

flexipage:visualforcePage
The Visualforce Page component gives you the ability to include a Visualforce page in your Flexible Page.
Properties:

e label: the component label. If you leave this property blank, the component label is taken from the label of the Visualforce page.

e pageName: the APl name of the Visualforce page to render

92


http://www.salesforce.com/us/developer/docs/salesforce1/salesforce1_guide.pdf

Mobile SalesforceA

e height: the height of the Visualforce page in pixels. This value must be a whole number, and not negative. If this property is left blank,
a default height of 300 pixels is assigned.

This component is supported in APl version 32.0 and later.

A Visualforce page that you want to include as a component must have the Available for Salesforce mobile apps
checkbox selected so that it will appear in Salesforce. This checkbox is available for pages that are set to APl version 27.0 and later.

SalesforceA
Manage users and view information for Salesforce organizations from your mobile device. EDITIONS
IN THIS SECTION: Available in:
e Contact Manager

View System Status from SalesforceA
e Group

e Professional
e Enterprise
e Performance
Switch between Accounts in Multiple Organizations e Unlimited

Access the Salesforce system status site (trust.salesforce.com) from SalesforceA. This site provides
real-time information on system performance, alerts for current and recent phishing and malware
attempts, and tips on best security practices for your organization.

Now you can easily access multiple accounts in different organizations without having to log * Developer
out and log in each time you need to switch to a different account.

Use Action Icons to Perform User Tasks
In SalesforceA, user task buttons are now displayed as action icons and are available from the

action bar at the bottom of the page. Action icons are compact, intuitive images, making it easy To use SalesforceA:
foryou to find and perform tasks such as changing passwords, assigning permission sets, editing, * "Manage Users”

freezing, and deactivating users, and so on.

View System Status from SalesforceA

Access the Salesforce system status site (trust.salesforce.com) from SalesforceA. This site provides real-time information on system
performance, alerts for current and recent phishing and malware attempts, and tips on best security practices for your organization.

To access the Salesforce system status site from SalesforceA, do one of the following.

e From the home screen under the Scheduled Maintenance section, tap Go to trust.salesforce.com.

e From the navigation menu, tap System Status.

Switch between Accounts in Multiple Organizations

Now you can easily access multiple accounts in different organizations without having to log out and log in each time you need to
switch to a different account.

@ Note: The account switcher is available only in the SalesforceA mobile app. It's not available if you access SalesforceA from a
browser.

To add a user account:

1. o
Tap E to open the navigation menu.

2. Tap u to show the account drop-down menu.
3. Tap Add account.
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4. Enteryourusername and password to log in. If you've saved one or more usernames, select a username or tap Login with a different
user name.

@ Note:

e Ifyou switch to an account that's in an organization using the Summer '14 release, the account switcher won't be available.
To return to an account in an organization using the Winter '15 release, log out, and then log in again.

e iOS users: With version 2.0 of the downloadable SalesforceA mobile app, tap the gear icon on the login screen to set your login
host (production, sandbox, or custom). Earlier versions required you to set your login host from your iOS system settings. With
version 2.0, these iOS system settings are ignored. Optionally, you can delete and reinstall the SalesforceA mobile app to clear
the old host settings from your device.

After you've added multiple accounts, you can quickly switch between them.
1. Fromthe navigation menu, tap u
2. Tap the account that you want to access.

For each account, the switcher shows your Chatter picture, email address, and organization information.

Add account

To remove an account:

1. Switch to the account that you want to remove.

2. From the navigation menu, tap n to close the account drop-down menu.

3. Scroll to the bottom of the navigation menu, and then tap Log Out.

Use Action Icons to Perform User Tasks

In SalesforceA, user task buttons are now displayed as action icons and are available from the action bar at the bottom of the page.
Action icons are compact, intuitive images, making it easy for you to find and perform tasks such as changing passwords, assigning
permission sets, editing, freezing, and deactivating users, and so on.
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Mobile Salesforce Chatter Mobile Version 3.1 for Android No Longer
Available

Connor McCoy

15) 55

DETAILS RELATED

STANDARD FIELDS

Name

Connor McCoy
Role

Alias

cmcco

User Type

@ 0 & ©

The available action icons depend on the user and organization. To open the action menu with all available actions for the current user,
tap the More Actions (ellipsis) icon.

The icons represent the following actions.

Action Icon Action

Edit the user record
Freeze or unfreeze the user account
Reset the user’s password

Deactivate or activate the user account

e 6 09

Assign permission sets to the user
Email the user

Call the user or log a call made outside of the SalesforceA app.

)

Salesforce Chatter Mobile Version 3.1 for Android No Longer Available

The Salesforce Chatter Mobile app version 3.1 for Android is no longer available for download from Google Play.
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COMMUNITIES

Communities helps companies share information with their customers and partners.

IN THIS SECTION:

Customization

We've built a new Community Designer that allows you to create self-service communities and configure single sign-on access
portals using templates. You can also add custom pages to your community for login, logout, and self-registration.
Administration

Enable nicknames, configure custom domains and Apex triggers, and use the simplified navigation scheme to quickly administer
and manage your communities.

Community Management

In Winter '15, we've added more functionality to the Community Management page, simplified the Ul, and added some quick
navigation links to the Setup and Community Designer. You can also organize the content in your community with featured and
navigational topics.

Dashboards

We've made additional dashboards, reports, and metrics available for community managers to track the health of their community.
Reward Community Members with New Reputation Enhancements

Configure reputation points for questions and answers in the feed, customize reputation level images, view level-up notifications
for reputation level changes, and use Apex triggers to create custom events driven by changes in reputation points.

Promote Community Collaboration with Chatter Questions (Generally Available)

Promote collaboration in your communities by allowing users to ask and answer questions in Chatter.

Other Changes in Communities

Learn about other changes that affect Communities.

Customization

We've built a new Community Designer that allows you to create self-service communities and configure single sign-on access portals
using templates. You can also add custom pages to your community for login, logout, and self-registration.

IN THIS SECTION:

Customize Your Community with Community Designer (Beta)

Community Designer in conjunction with community templates for self-service lets you create, brand, and publish a custom
community site that looks great on any mobile device! Choose from four templates to quickly start your site, and then easily style
the pages to match your company’s branding.

Create Self-Service Communities with Templates

The Community Designer provides three templates that you can use to create self-service communities out of the box.

Template to Configure Identity Features for Community Users

Give community users Salesforce Identity features, including their own App Launcher, so they can have access to useful applications
from other service providers in one view.
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Add Custom Login, Logout, and Self-Registration Pages
Create custom login, logout, and self-registration pages with your own company’s branding and associate them with your community.

Customize Your Community with Community Designer (Betal)

Community Designer in conjunction with community templates for self-service lets you create, brand, and publish a custom community
site that looks great on any mobile devicel Choose from four templates to quickly start your site, and then easily style the pages to match
your company’s branding.

@ Nofte: This release contains a beta version of Community Designer that's production quality but has known limitations.

Access the Community Designer

From Setup, click Communities > All Communities. You can access Community Designer by clicking the Community Designer link,
which was previously named Site.com.

COITHTIU n ItIeS Help for thiz Page &9

The list shows all communities in your organization. Clicking on the Community Mame link takes you directly to the
Community. If you're not a member, the Community Mame is not a link.

Maximum number of active communities; 99 |1

All Communities MNew Community

Action Community Name Custom Pages i Description Status
(=] AW.J Sports Farce.comj Community Designer Preview
(=] Movies Force.com | Community Diesigner Preview

If you're setting up a custom community site for the first time, when you click Community Designer, you can choose from one of four
templates to create your site before being brought to Community Designer. (If you don’t want to use the templates, you can skip the
template selection to access Site.com directly.)

@ Notfe: When you access a community site that existed before Winter '15, you're brought to Community Designer. However,
Community Designer doesn't support branding for sites that weren't created by using one of the four templates. Instead, you must
use Site.com Studio. To open Site.com Studio, click Go to Site.com Studio in the Communities drop-down.

After you're in Community Designer, you can customize the community template to update your community’s branding and fonts.
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e Navigate (1) to the view that you want to style by clicking links and menu items.
e Brand the community (2) to match your organization’s style and see your changes immediately appear on the page (1).

e Use the toolbar (3) to see how your community appears on different devices, access views that aren't easy to navigate to (such as
error and login views), and preview and publish the community.

e Use the Communities menu (4) to go to Site.com Studio to make advanced customizations to your community pages, open
Community Management to manage topics, reputation, and for community dashboards and moderation, and access Community
Setup to update community membership, login, and other settings.

Known Limitations

e Community Designer doesn't support branding for sites that weren't created by using one of the four available templates.

e With Community Designer, you can brand only the site’s default home page. To try out a different template, you must set the new
page as the site’s home page in Site Configuration in Site.com Studio. But don't worry—you can always switch back to the original
home page.

Create Self-Service Communities with Templates

The Community Designer provides three templates that you can use to create self-service communities out of the box.
These templates are bundled with the Community Templates for Self-Service (Generally Available) feature available in Winter '15.

Kokua
Kokua is a visually rich, self-service template that presents users with Knowledge articles that are organized by data categories. Users
can also submit cases to get help from agents.

Koa
Koa is a text-based, self-service template that's optimized for mobile devices. It lets users search for and view articles by text categories
and contact support if they can't find what they're looking for.

Napili
Napili is a powerful template for support communities that lets users post questions to the community, search for and view articles,
and contact support agents by creating cases.
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Choose a Template Template Type: Service Identity

FEATURED CATEGORIES

R " _ ]
Knowledge  Cases Knowledge  Cases Knowledge  Cases Qaa
Kokua Is a visually rich self-service template that Koa Is a text-based self-service template that's cptimized Naplll Is @ powerful template for support communities
presents users with Knowledge articles organized by for moblle devices. It lets users search for and view that lets users post questions 1o the community, search
data categorles. Users can also submit cases to get help articles by text categorles, and contact support If they for and view articles, and contact support agents by
from agents. can't find what they're looking for. creating cases.

With each template, you also have the option to create a custom Login page, which adds login, password reset, and self-registration
functionality to your community. Selecting a login page with a template automatically associates it with the community. You can view
and override the login page in the community’s Administration Settings in the Login & Registration section.

Each template creates a single-page application, which is a Web app that loads a single HTML page. Unlike a traditional website, which
comprises several pages that the user navigates between. A single-page application consists of multiple views with dynamic components
that allow user interaction. You can customize and rebrand all the components in the templates and the login, password reset, and
self-registration functionality using the Community Designer and Site.com Studio.

To learn more about using the Kokua, Koa, and Napili templates, see the Community Templates for Self-Service Implementation Guide.

Template to Configure Identity Features for Community Users

Give community users Salesforce Identity features, including their own App Launcher, so they can have access to useful applications
from other service providers in one view.

Select Identity for the Template Type in the Community Designer, and then use the Aloha template to provide a configurable App
Launcher experience to your communityusers. It lets them quickly link to applications configured as connected apps in the organization.
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Communities Add Custom Login, Logout, and Self-Registration Pages

Choose a Template Template Type: Service Identity

M Qofice365  \ydrkday.

[[Aconcur B SharePoint

e
exactiarget

The Aloha template uses Salesfor Tty T vide a
configurable App Launcher exp s quickly
find applications that they can acce! single sign-on.

The template creates a single-page application, which is a Web app that loads a single HTML page. Unlike a traditional website, which
comprises several pages for the user to navigate. A single-page application consists of multiple views with dynamic components that
allow user interaction. You can customize and re-brand all the views and components in the templates and the login, password reset,
and self-registration functionality using the Community Designer and Site.com Studio.

For more information about Identity features, see the Salesforce Identity Implementation Guide. And, for information about a new license
type that includes Identity features, see New External Identity License Expands Your Community User License Choices.

Add Custom Login, Logout, and Self-Registration Pages

Create custom login, logout, and self-registration pages with your own company’s branding and associate them with your community.

Previously, communities allowed you to customize the standard login and self-registration page for your community. You can now
override this page with a Site.com or Visualforce page in one of two ways:

e Specify a custom login page in the community’s Administration Settings in the Login & Registration section.

e Add a custom login page while selecting a community template in the Community Designer.

Custom login pages created using the Community Designer are automatically associated with the community. The URLs for these
pages display in the Login & Registration settings in the community’s Administration Settings.

Users who use single sign-on to log in to the community bypass the login screens.

For detailed instructions on customizing your community, see the Getting Started with Communities guide.

Administration

Enable nicknames, configure custom domains and Apex triggers, and use the simplified navigation scheme to quickly administer and
manage your communities.
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Communities Improved Navigation and Label Updates in Setup, Community
Management, and Community Designer

IN THIS SECTION:

Improved Navigation and Label Updates in Setup, Community Management, and Community Designer

Community managers and administrators can easily navigate easily between Setup, the Community Management page, and
Community Designer with the improved navigation scheme. We've also updated the labels of some of the links and areas of the
application to more accurately reflect what they contain.

Display Member Nicknames Instead of Full Names
Enabling nickname display in your community allows more privacy and protects member identities. This is especially helpful in a
public community where unregistered visitors can access member profiles.

Custom HTTPS Domains Supported for Communities
You can now set up a custom domain with HTTPS so that your community URLs reflect your company brand.

Security and Identity Enhancements for Communities
The following new security and identity features expand your control over community authentication and management.

Apex Triggers Supported on the NetworkMember Object
The NetworkMember object now supports Apex triggers. You can use this to drive custom events and notifications based on changes
to NetworkMember records.

Display More Public Community Content
In addition to groups, topics, feeds, and user profiles are now available for guest user access in public communities via Chatter in
Apex.

Improved Navigation and Label Updates in Setup, Community
Management, and Community Designer

Community managers and administrators can easily navigate easily between Setup, the Community Management page, and Community
Designer with the improved navigation scheme. We've also updated the labels of some of the links and areas of the application to more
accurately reflect what they contain.

¢ InSetup
1. The “Manage Communities” link in the Setup navigation has been renamed to “All Communities”.

2. The page with the list of all the communities in your organization has been renamed from “Manage Communities” to
“Communities”.

3. The “Edit" link next to the community name has been replaced with a drop-down button with links to your community’s
administration settings and the Community Management page.

4. Thelinkto Site.com has been replaced with a link to the new Community Designer. You can access the Site.com Studio functionality
from within Community Designer.
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Communities Display Member Nicknames Instead of Full Names

Communities ‘ Communities

Expand All | Collapse All Let us know what you think | Video Tutorial | Help for this Page &

The list shows all communities in your erganization. Clicking on the Community Name link takes you directly to the Community. If you're not

Build a member, the Community Name is not a link.
. Maximum number of active communities: 100 '
B Customize
B Communities 1 All Communities New Community
Settings
Action Community Hame Custom Pages i Description Status
All Communities
= James Community Force.com | Community Designer James Community Published
=) Spider Laptops Suppart Eorce.com | Community Designer Published
=) Acme Customer Support Eorce.com | Community Designer Preview
4] Customer Pivat Community Eorce.com | Community Designer Preview
=] NTQ Eorce.com itv Designer Preview
Administration Setings Eorce.com | Community Designer Preview
Community Management Eorce.com | Community Designer Preview

¢ |In Community Management

Quickly access the Setup page with the list of communities and the Community Designer.

Ovenview Welcome to Community Management!

Goto +
Acme Customer Support
Acme Customer Support

Community Designer URL  hitps:finto.mobile.tforce.co
miacmecustomersupport

Community Setu
! P Share before publishing

Status  Preview

* In Community Designer

Navigate easily to the Setup page, the Community Management page, and the Site.com Studio functionality.

fj-‘- Communities Acme Customer Support

Go to Site.com Studio

Branding Edi| Go to Community Management

Color Palett
olor Falerte Go to Community Setup

Display Member Nicknames Instead of Full Names

Enabling nickname display in your community allows more privacy and protects member identities. This is especially helpful in a public
community where unregistered visitors can access member profiles.

You can enable nickname display from the community’s Administration Settings in the Miscellaneous section. All users have nicknames
by default, which they can modify by goingto Your Name > Edit Contact Info in the global header or from their Chatter user profile.

Nicknames are shown in place of first and last names in almost all locations in the community, including in feeds, list views, groups,
search results, recommendations, and on user profiles and files. Additionally, Salesforce1 and any community sites published using
community templates show nicknames as well.

"

For details on enabling nicknames and the limitations that apply to them, see “Show Nicknames Instead of Full Names in the Community
in the Salesforce Help.

Custom HTTPS Domains Supported for Communities

You can now set up a custom domain with HTTPS so that your community URLs reflect your company brand.
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Communities Security and Identity Enhancements for Communities

As of Winter '15, new Salesforce Communities require secure connections by default. Existing Salesforce Communities will continue to
not require HTTPS for all connections by default. Authenticated requests in a Salesforce Community continue to require secure connections
when the organization requires secure connections in the session settings.

@ Note: Before you switch the CNAME of your domain name to point to a new target name, ensure that the new target name exists

in the DNS by using dig or nslookup. When you created your domain names affects the target of your CNAME:

e Domain names that were added before Summer ‘13, typically need to have their CNAME adjusted to point to the fully qualified
domain followed by .live.siteforce.com instead of to the organization’s force . com sub-domain. For example,
if your pre-Summer ‘13 domain is www . example . com, then the target of its CNAME will need to be
www.example.com.live.siteforce.com instead of example. force.com before HTTPS will work

e Domain names that were added in or before Summer 13, don't have the 18-character organization ID in the CNAME target.
e Domain names that were added in or after Summer ‘13, already point to the proper place for setting up HTTPS in a custom
domain.

e Domain names that were added in or after Winter ‘14, use a CNAME that points to the fully qualified domain followed by your
organization’s 18-characteriDand . live.siteforce.com Forexample,ifyourdomainnameis www.example.com
and your 18-character organization IDis 00dxx0000001ggxeay, then the target of its CNAME will need to be
www.example.com.00dxx0000001ggxeay.live.siteforce.com

Security and Identity Enhancements for Communities

The following new security and identity features expand your control over community authentication and management.

New External Identity License Expands Your Community User License Choices
Customize and Manage User Authentication with Login Flows

A Custom Logout URL is Available for Community Users

Configure a LinkedIn Authentication Provider

Configure a Twitter Authentication Provider

Give Community Users Button Icons to Log in with their Third-party Accounts
View and Download SAML Login Metadata for Communities and Custom Domains

Security Fix Protects Organization Data from Guest Users

Apex Triggers Supported on the NetworkMember Object

The NetworkMember object now supports Apex triggers. You can use this to drive custom events and notifications based on changes
to NetworkMember records.

For example, you can directly update reputation points for a community member, or create triggers to send custom notifications based
on changes to reputation points.

Display More Public Community Content

In addition to groups, topics, feeds, and user profiles are now available for guest user access in public communities via Chatter in Apex.

You can use the Chatter in Apex methods to expose public community content with custom Visualforce pages to make it available for
guest users. Alternatively, you can also use a template in the Community Designer that allows you to display public community content.

103



Communities Community Management

Community Management

In Winter 15, we've added more functionality to the Community Management page, simplified the Ul, and added some quick navigation
links to the Setup and Community Designer. You can also organize the content in your community with featured and navigational topics.

IN THIS SECTION:

Access More Functionality from the Community Management Page

The Community Management Page provides Community Managers with insights into the health of their Communities, as well as
the level of adoption and engagement. The Community Management page exposes Communities dashboards (members, activity,
groups, licenses) with trending capabilities that can be installed from the AppExchange. We've made many improvements to the
Community Management page to make it easier for community managers to do their jobs.

Organize Self-Service Communities with Topics

Topics are available in all communities. But when you set up a self-service community with the Napili template, you can use the
Community Management page to quickly guide visitors to key navigational and featured topics.

Moderate Flagged Posts Directly on the Community Management Page

View and take action on all the flagged posts and comments in your community from the Flagged Posts feed in Community
Management.

Access More Functionality from the Community Management Page

The Community Management Page provides Community Managers with insights into the health of their Communities, as well as the
level of adoption and engagement. The Community Management page exposes Communities dashboards (members, activity, groups,
licenses) with trending capabilities that can be installed from the AppExchange. We've made many improvements to the Community
Management page to make it easier for community managers to do their jobs.

“Community Engagement Console” Renamed to “Community Management”
The Community Engagement Console is now called Community Management, also referred to as the Community Management
page, to more accurately represent the wide array of management features it provides access to.

New Functionality Added to the Community Management Page
We've added more functionality and moved things around in the navigation on the left side of the Community Management page,
providing easier access to everything you need to manage your community.
e Dashboards: If you've mapped dashboards to a community, you see the Dashboards menu, and under it, the links to each
mapped dashboard. Previously, the dashboards were accessed from the drop-down list on the Overview page.
e Moderation: The Moderation section contains the Flagged Posts feed, which shows all the posts and comments that were
flagged as inappropriate by community members.

e Settings: Under the Settings menu, you can map unique dashboards for each community, configure reputation levels and
reputation points that can be earned by community members, and define navigational and featured topics to organize information
in the community.
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Communities Organize Self-Service Communities with Topics

Organize Self-Service Communities with Topics

Topics are available in all communities. But when you set up a self-service community with the
Napili template, you can use the Community Management page to quickly guide visitors to key
navigational and featured topics.

On the Community Management page, you choose navigational topics to provide a consistent
map of your site, and featured topics to highlight current, popular conversations. In the community
itself, member-created topics let users organize information for each other, creating a personalized
experience that boosts community engagement.

In a self-service community, the Napili template specifies the layout and design of navigational,
featured, and member-created topics. Below are visual examples of each type in a published
community.

EDITIONS

Available in:

Enterprise
Performance
Unlimited
Developer

O Tip: To add navigational and featured topics to other types of communities, Apex developers can use the

ConnectApi.ManagedTopics class in a Visualforce page.

Navigational topics

On every page of a self-service community, navigational topics are available from the Topics menu at upper left.

TOPICS ~ CLIMBING

Backpacking
Camping

Climbing

When visitors choose a navigational topic, the banner image you selected for it appears at the top of the page.
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Communities Organize Self-Service Communities with Topics

A Search for articles and discussions - Backpacking Search

BACKPACKING

BACKPACKING

DISCUSSIONS  ARTICLES

=

e SWalters (Customer) asked 2 quastion
How to get a replacement zipper for my daypack?
broke the zipper on the Daytripper back pack and | love it! Can | just take it to the store to get it replaced or

Featured topics

Featured topics are accessible from the body of your community home page. Thumbnail images you select for featured topics uniquely
identify them. (These unique thumbnails appear only on the home page; at the top of all featured topic pages, the default bannerimage
specified in Community Designer appears.)

FEATURED DISCUSSIONS
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Communities Organize Self-Service Communities with Topics

Member-created topics

When posting questions, community members create topics by using hashtags in body text, or typing in the topic suggestions box
below.

Post To Backpacking ~ X

What's the best backpack for a solo expedition?
I'm doing a solo hike of the Pacific Crest Trail next July. Any recommended packs for a #PCT trek

ke this?

opics help g
sneElp g

Camping, Expeditions “

If any suggested topics are poor matches for the post, members can simply click to delete them.

m

t vour guestions seen by the right pe

o Tip: Member-created topics can be accessed via search, or highlighted as featured topics in Community Management.

IN THIS SECTION:
Set Up Navigational Topics

Navigational topics provide consistent entry points to key community areas that people often return to. If your organization uses
data categories, community managers add current Salesforce Knowledge articles with those categories to the topic page. (If data
categories aren't enabled, administrators add articles to each topic using the Chatter REST API.)

Set Up Featured Topics

Featured topics highlight current, popular community conversations. Change them regularly to keep community members up-to-date
and engaged.
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Communities

Set Up Navigational Topics

Navigational topics provide consistent entry points to key community areas that people often return
to. If your organization uses data categories, community managers add current Salesforce Knowledge
articles with those categories to the topic page. (If data categories aren't enabled, administrators

add articles to each topic using the Chatter REST API.) Management:
@ Note: You can create a maximum of 25 navigational topics. * "Manage Communities
OR
1. From Setup, choose Build > Customize > Topics > Topics for Objects, and enable topics “Create and Set Up
for all the article types you want to include. Communities”
@ Note: Enabling topics disables public tags on articles. Personal tags aren't affected. To set up navigational
topics:
2. From the community, click = in the global header. e "Edit Topics”
3. Atleft, click Settings > Navigational Topics. To add articles to fopics:
4. Inthe text box at right, enter a topic name, and click Add. * "View Data Categories
AND
5. If your organization uses data categories, in the “Add articles” overlay, select a Data Category )
. . 4 . “Read” on related article
Group. Then select the categories you want to add to the topic, and click Add Articles & Close ypes
Window. P
@ Important: This process adds only current articles to a topic. To add new articles, return
to Community Management, hover over the navigational topic name, and click = .
6. Hoverover a topic name, and click g. Then click Upload Image, and select a topic banner image. (Images are scaled to 1400 x 180
pixels. To prevent distortion, create image files with those dimensions.)
7. Repeat steps 4-6 to create several navigational topics for your community, and then click Save.
Set Up Featured Topics

Featured topics highlight current, popular community conversations. Change them regularly to
keep community members up-to-date and engaged.

@ Note: You can create a maximum of 25 featured topics.

1.
2.
3.

5.

From the community, click = in the global header.
At left, click Settings > Featured Topics.

From the pop-up menu at right, select a navigational or member-created topic you want to
feature. Then click Add.

o Tip: Using the Chatter REST API, you can create unique featured topics, separate from
navigational or member-created ones.

Hover over a topic name, and click #. Then click Upload Image, and select a topic thumbnail

Organize Self-Service Communities with Topics

USER PERMISSIONS

To access Community

USER PERMISSIONS

To access Community
Management:
*  “Manage Communities”

OR
“Create and Set Up
Communities”

To set up featured topics:
e "Edit Topics”

image. (Images are scaled to 250 x 250 pixels. To prevent distortion, create image files with those dimensions.)

Repeat steps 3-4 to create several featured topics for your community, and then click Save.

To quickly edit existing navigational or featured topics, simply hover over a topic name, and do any of following:

To move topics up or down, click the arrows at left.

To rename or delete topics, or change theirimages, click g.
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Communities Moderate Flagged Posts Directly on the Community
Management Page

Moderate Flagged Posts Directly on the Community Management Page

View and take action on all the flagged posts and comments in your community from the Flagged Posts feed in Community Management.

All community managers with the “Moderate Communities Feeds” permission can now view the Flagged Posts feed under Moderation >
Flagged Posts and take action on those flagged items. Community managers can remove flags and delete posts directly from the
Community Management page.

Dashboards

We've made additional dashboards, reports, and metrics available for community managers to track the health of their community.

IN THIS SECTION:

New Dashboards, Reports, and Metrics Added to the Communities Dashboards Package

The Salesforce Communities Dashboards 2.0 package will be available on the AppExchange shortly after the Winter 15 release. The
updated package provides additional dashboards, reports, and metrics. The previous version of this package was called Salesforce
Communities Analytics.

Upgrade to the New Salesforce Communities Dashboards Package

If you installed the Salesforce Communities Analytics Summer 14 package, you can upgrade to the new Salesforce Communities
Dashboards 2.0 package when it becomes available on the AppExchange shortly after the Winter ‘15 release.

Dashboard Enhancements

We've made enhancements to dashboards in communities that provide additional capability to community managers.

Report Enhancements

We've made enhancements to reports in communities that provide additional capability to community managers.

Map Unique Dashboards per Community

You can map different dashboards in Community Management for different communities. Previously, the same dashboard mappings
applied to all the communities in your organization.

New Dashboards, Reports, and Metrics Added to the Communities
Dashboards Package

The Salesforce Communities Dashboards 2.0 package will be available on the AppExchange shortly after the Winter 15 release. The
updated package provides additional dashboards, reports, and metrics. The previous version of this package was called Salesforce
Communities Analytics.

New Self-Service, Topics, and Moderation Dashboards
Additional dashboards are now available in the Salesforce Communities Dashboards package.

e The Self-Service dashboard provides reports and metrics about questions, answers, discussions, public page views, unique visitors,
and contributors in your community. This dashboard uses data from the Questions and Answers in the feed.

e The Topics dashboard provides reports and metrics about the topics in your community, including the topic creators and
assigners.

e The Moderation dashboard provides reports and metrics about your communities flagged content, including metrics about
users who flag content and your moderators activity.

For detailed information, including a list of the reports provided in each dashboard, see the Salesforce Communities Managers Guide.
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Communities Upgrade to the New Salesforce Communities Dashboards
Package

Updates to Existing Dashboards
e The Overview dashboard now provides trending metrics on daily page views.
e The Activity dashboard now provides metrics on posts with the most likes and comments.

e The Groups dashboard now provides additional reports on the group members and contributions.
For detailed information, see the Salesforce Communities Managers Guide.

Redesigned Dashboards
Dashboards have been redesigned to use titles and headers that group related metrics and reports, so you can identify your data
more easily.

Upgrade to the New Salesforce Communities Dashboards Package

If you installed the Salesforce Communities Analytics Summer 14 package, you can upgrade to the new Salesforce Communities
Dashboards 2.0 package when it becomes available on the AppExchange shortly after the Winter '15 release.

For detailed steps on how to upgrade, including links to the packages on the AppExchange, see the Salesforce Communities Managers
Guide.

Dashboard Enhancements

We've made enhancements to dashboards in communities that provide additional capability to community managers.

Manual Dashboard Refresh Added to the Community Management Page
You can now manually refresh dashboards on the Community Management page by clicking Refresh on the appropriate dashboard
page. If you access the dashboard after it has been recently refreshed, the dashboard displays the globally cached data from the last
refresh. If the dashboard has not been refreshed for 24 hours, it is refreshed automatically when you access it from the Community
Management page.

Community Management Displays Dashboards Instead of Reports
Previously on the Community Management page you could only display report components. Now the Community Management
page displays dashboard components instead of report components.

@ Note: This change might impact how reports display on the Community Management dashboards page, because now the
dashboard component controls the user interface.

To specify the dashboards to display for a community, on the Community Management page, click Settings > Dashboards.

Report Enhancements

We've made enhancements to reports in communities that provide additional capability to community managers.

New Custom Report Types
Reports and dashboards that are based on the Networks primary object show community-specific information on the Community
Management page. You can now create custom report types for the following data:
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Communities

Report Type

Network Chatter Messages

Network Login History

Network Public Usage Daily
Metrics

Topics

Topic Assignments

Possible Use

Map Unique Dashboards per Community

Create reports on the private  Chatter Messages

message activity in your
community.

@ Note: To reporton

Chatter Messages, you

must have the
“Manage All Data” or
“Manage
Communities”
permissions.

Create reports on the login

activity in your community.

Create reports on your
community’s daily public
usage.

Create reports on the topic

activity in your community.

Create reports on the topic

B (Child Object) C (Child Object, If
Applicable)
Network Members Login History

Network Public Usage Daily
Metrics

Topics

Topic Assignments

assignments in your
community.

Create and Customize Reports Using the Networks Object
You can now create and customize reports with Networks (Communities) custom report types. You can then add your custom report
to a dashboard and map that dashboard in Community Management. When viewing reports on a dashboard from the Community
Management page, custom reports using the Networks object now automatically display data specific to the community you're
accessing the report from. This means you can create one custom report and use it across all your communities.

@ Notfe: When you view the same report in your internal organization, it shows data from all of your communities.

Tabular Reports Supported on the Community Management Page
You can now use tabular reports on the Community Management page.

Map Unigue Dashboards per Community

You can map different dashboards in Community Management for different communities. Previously, the same dashboard mappings
applied to all the communities in your organization.

Pre-existing org-level dashboard mappings are automatically ported to each community and are available to customize.

To specify the dashboards to display for a community, on the Community Management page, click Settings > Dashboards. Your
mapped dashboards then appear under Dashboards.

For detailed steps on mapping dashboards, see the Salesforce Communities Managers Guide.
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Communities Reward Community Members with New Reputation
Enhancements

Reward Community Members with New Reputation Enhancements

Configure reputation points for questions and answers in the feed, customize reputation level images, view level-up notifications for
reputation level changes, and use Apex triggers to create custom events driven by changes in reputation points.

IN THIS SECTION:

Configure Reputation Points for Questions and Answer Actions
Reward members who post questions and provide helpful answers in the community.

Custom Level Icons for Reputation Levels

Personalize reputation levels to meet your company's needs. Community managers can now upload custom images to represent
reputation levels. Click the default image and browse to an image of your choice to associate it with the reputation level.

Level-Up Notifications for Increases in Reputation Levels
With Community Reputation, you can motivate community members to collaborate by assigning reputation levels and points. Now,
with Level-Up Notifications, community users will receive a notification in their feed when they reach a new reputation level.

Developer Enhancements and Apex Triggers for Reputation
Customize and control your community's reputation using Apex triggers and the Salesforce Chatter REST API.

Configure Reputation Points for Questions and Answer Actions

Reward members who post questions and provide helpful answers in the community.
Configure reputation points for:

e Asking a question

e Answering a question

e Receiving an answer

e Marking an answer as best

e People marking your answer as best

Questions and answers in the community feed are not to be confused with the Chatter Answers functionality.

@ Note: In organizations with reputation enabled prior to the Winter 15 release, actions associated with questions and answers
will be available at the time of the release and their default point values will be set to 0. Existing user reputation points will not be
affected by the release, and users won't accrue points from these actions until you configure point values for them.

Custom Level Icons for Reputation Levels

Personalize reputation levels to meet your company's needs. Community managers can now upload custom images to represent
reputation levels. Click the default image and browse to an image of your choice to associate it with the reputation level.

You can't revert to the default image from the Ul; use the Salesforce Chatter REST API to do this.

Level-Up Nofifications for Increases in Reputation Levels

With Community Reputation, you can motivate community members to collaborate by assigning reputation levels and points. Now,
with Level-Up Notifications, community users will receive a notification in their feed when they reach a new reputation level.
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Communities Developer Enhancements and Apex Triggers for Reputation

Developer Enhancements and Apex Triggers for Reputation

Customize and control your community's reputation using Apex triggers and the Salesforce Chatter REST API.

Developers can now directly update the users's point total using sObject API; write Apex triggers based on the user's point total allowing
them to create custom notifications and events; and utilize the Salesforce Chatter REST API for reputation level, icons, and points.

Promote Community Collaboration with Chatter Questions (Generally
Available)

Promote collaboration in your communities by allowing users to ask and answer questions in Chatter.

Question Post File More ~

How do | add more memory to my VX6

To My Followers = E

For more information about Chatter Questions, see Ask Questions in the Chatter Feed with Chatter Questions (Generally Available) on
page 195.

Other Changes in Communities

Learn about other changes that affect Communities.

Improve Performance with HTML Page Caching in Site.com for Communities
HTML caching lets you improve the performance and page rendering of your community’s Site.com site by controlling how often
the generated markup of the page is reloaded.
In Site.com Studio, use the Cache Duration (Minutes) fieldinthe Cache section of the Properties tab to specify the length
of time to cache the page. By default, the caching duration of a page is set to 30 minutes. To disable caching, set the page’s caching
duration to 0.
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Communities Other Changes in Communities

Properties

Page

1D

Class Name

» REQUIRED PROPERTIES
¥ CACHE

Cache Duration (Minutes)

30

The caching duration applies only to community pages that are accessed by guest users. When a user logs in to access the page,
caching is disabled.

Added Default Force.com Error Page for Service Unavailability
Communities now supports a default Force.com error page for service unavailability. You can choose to update this page assignment
in Setup. Click Customize > Communities > All Communities, then click Force.com next to the community name. For instructions
on changing Force.com page assignments, see “Assigning Force.com Site Error Pages” in the online help.

Enable Reporting Options for External Users

Allow external users with Partner Community or Customer Community Plus licenses that have the “Run Reports” permission, to view
and modify report options so that they can summarize and filter reports.

From Setup, click Customize > Communities > Settings, then select Enable report options for external
users.

Assign Tasks to Users with Customer Community Plus Licenses
You can now assign tasks to all users with a Customer Community Plus license. When creating a task, you can filter the Assigned
To field for Customer Portal users. Any user with a Community Success Portal license can be assigned a task. However, only Customer

Community Plus users with the “Edit Task" permission (which is on by default) can edit the task assigned to them. Customer Community
Plus users with the "Edit Task" permission can also create tasks.
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SALES

Salesforce is the world's #1 sales and CRM application. Our latest features help your sales reps close bigger deals with even more efficiency.

IN THIS SECTION:

Manage Sales on the Go!

With the Salesforce app, your users can stay current on their most important records, activities, and conversations while out of the
office.

Territory Management 2.0 (Generally Available)

Territory Management 2.0 lets you model your sales territories into a logical and flexible structure that connects sales reps to the
accounts they sell to.

Opportunities and Collaborative Forecasts

Trackall the deals in your sales pipeline with Opportunities. Predict and plan the sales cycle from pipeline to closed sales, and manage
sales expectations throughout the organization with Collaborative Forecasts.

Duplicate Management (Closed Beta)

Maintaining clean and accurate data is one of the most important things you can do to help your organization get the most out of
Salesforce, so we're excited to introduce Data.com Duplicate Management. Now you can control whether and when you allow users
to create duplicate records inside Salesforce; customize the logic that's used to identify duplicates; and create reports on the duplicates
you do allow users to save.

Salesforce for Outlook

You'll discover new Salesforce Side Panel features to help your users get more Salesforce work done directly from Microsoft” Outlook”.
We've also improved setup so you can help new users hit the ground running quickly, and added helpful customizations in Outlook
configurations to keep you in control.

Activities

Events and tasks are the building blocks of sales productivity. We've made enhancements that boost your sales teams’ edge over
the competition, along with updates to improve performance and usability.

Salesforce Console for Sales

The Salesforce Console for Sales gives you easy access to sales intelligence in a dashboard that means more access to contextual
data with fewer clicks and less scrolling.

Other Changes in the Sales Cloud

We've made additional changes to Sales cloud features to improve usability.

Manage Sales on the Go!

With the Salesforce1 app, your users can stay current on their most important records, activities, and conversations while out of the
office.

The Salesforcel app helps sales professionals manage Salesforce records like tasks, contacts, and opportunities—all from their mobile
devices. In addition, Today, an app that helps sales team members plan for and manage their day, integrates calendar events from their
mobile devices with their Salesforce tasks, contacts, person accounts, user records, and other key CRM data. Learn about the latest mobile
features in SalesforceT.
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Territory Management 2.0 (Generally Available)

Territory Management 2.0 (Generally Available)

Territory Management 2.0 lets you model your sales territories into a logical and flexible structure
that connects sales reps to the accounts they sell to.

Salesforce’s original territory management feature lets you grant users access to accounts based
on criteria such as postal code, industry, revenue, or a custom field relevant to your business. Territory
Management 2.0 builds upon the original feature by introducing territory types, territory models,
and territory model states. These components let you create and preview multiple territory structures
and strategies before you activate and implement the one that works best. Custom reports help
you organize your territory model for optimum coverage, assess territory effectiveness, and modify
your model if necessary.

Territory Management 2.0 builds on a successful pilot and “goes G.A." with several important new
features, which you'll learn about here. Here’s how to get it.

e Starting with Winter 15, Territory Management 2.0 is ready to be enabled by administrators in
new Salesforce organizations.

e Organizations created before Winter '15 need to call salesforce.com to enable the feature.

Territory Management 2.0 cannot be enabled in existing organizations that have Customizable
Forecasting enabled.

For administrators and others who maintain territory models, we've provided complete, step-by-step

EDITIONS

Available in:

e Enterprise

e Performance
e Unlimited

e Developer

USER PERMISSIONS

To enable Territory
Management 2.0
e “Customize Application”

To implement Territory
Management 2.0:

e “Manage Territories”

setup information in the Salesforce Help and our PDF guide, Implementing Territory Management 2.0. We also invite you to join our active
success community, Official: Territory Management, where you can interact with our development team and post questions and

comments. Find us at https://success.salesforce.com/.

Territory Model

New Territory Model

About Territory Model Cloning

f Cloning this territory model will copy all the objects within it, including territories, object territory assignment rules,
assigned users, and manually assigned accounts.

Help for this Page &

Territory Model Edit Save | | Save & New | | Cancel
Information
Label | Clone-Planning_US Sa Territory Model Name | Clone-Planning_US Sa |
Description  ~ang of US Sales model for testing State  Cloning
realignment scenarios|
Save Save & New Cancel

Clone a Territory Model to Test Out Different Structures and Scenarios

| = Required Information

Cloning lets you copy a territory model so you can safely explore alternative modeling options. Use the new model to try out variations
on the original’s territories, hierarchy, assignment rules, users, and manually assigned accounts. If you identify changes you want to

implement, you can adjust the original model or activate the new, cloned one.
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Clone a Territory Model to Test Out Different Structures and
Scenarios

Define an Assignment Rule Once, Use It in Multiple Territories
Assingle rule can now be assigned to multiple territories. If you start from a territory record, you can also apply the rule to the territory’s
descendants.

Assign and View Territories Directly from an Account

Sometimes it makes sense to assign or view territories directly from a specific account. The Assigned Territories related list on the
Account record lets you do just that. Only territories that belong to models in Planning or Active state can be assigned to
accounts.

Run Territory Rules Directly from the Territory Hierarchy
In response to user feedback, we've added a Run Rules option for each territory in the hierarchy. Now you can run rules for individual
territories without leaving the context of the hierarchy.

Identify Territory Users by Territory Role

Territory roles can help assigned users identify colleagues, collaborators, and other key resources to help close deals. Territory users
can even have different roles in different territories. The RoleInTerritory fieldis also exposed for developer use in the
UserTerritory2Association object in the SOAP API (version 32.0).

Track Territory Model Changes in the Setup Audit Trail

Flexible modeling is a key feature of Territory Management 2.0, and now you can track changes to rules, assignments, and the model
itself from the Setup Audit Trail, where you'll see what changes were made, when, and by which user.

Apex Triggers Added to the Territory2 and UserTerritory2Association Objects

Territory Management 2.0 offers triggers on the Territory2 and UserTerritory2Association objects. Use them to automate actions
related to record changes on those objects.

Limits on Numbers of Territory Models, Territories, and Assignment Rules

Winter '15 includes limits on the number of territory models, territories, and assignment rules you can create. The territory model
limit is a default.

Metadata API Support
Territory Management 2.0 joins the Metadata API (version 32.0) with five new metadata types.

APl'and API Documentation Enhanced
The Territory Management 2.0 Beta release, in Summer ‘14, provided a full set of APl objects. For Winter '15 (APl version 32.0), we've
enhanced the APl and added more detail to our APl documentation.

Clone a Territory Model to Test Out Different Structures and Scenarios

Cloning lets you copy a territory model so you can safely explore alternative modeling options. Use
gietsyou copya termiory youcansaiely expore a 100eIng op USER PERMISSIONS
the new model to try out variations on the original’s territories, hierarchy, assignment rules, users,

and manually assigned accounts. If you identify changes you want to implement, you can adjust To clone a ferritory model:
the original model or activate the new, cloned one. *  “View Setup and

Only modelsin Planning, Active, or Archived state can be cloned, and archived models Configuration”

cannot be reactivated. The model state changes to C1oning while Salesforce processes your AND

request. Cloning may take some time, depending on the size and complexity of your model. When “Manage Territories”

the process is complete, we'll send you an email to let you know. The new territory model will be
in Planning state.

Your organization’s Salesforce edition determines the number of territory models you can create in production and sandbox orgs, and
that limit includes models created by cloning. Edition-based limits are listed in Limits on Numbers of Territory Models, Territories, and
Assignment Rules on page 121.

To clone a model: open the model you want to clone and click Clone.
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Define an Assignment Rule Once, Use It in Multiple Territories

Define an Assignment Rule Once, Use It in Multiple Territories

A'single rule can now be assigned to multiple territories. If you start from a territory record, you can
also apply the rule to the territory’s descendants.

o Tip: It's a best practice not to assign a rule to a territory if that rule is a child of another rule
already assigned to the territory. To find out what rules apply to a territory, just open the
territory’s record detail page and look at the Assignment Rules Assigned to this Territory
related list. Ifarule has Apply to Child Territories selected, do notassign the
rule separately to child territories.

To view a territory’s detail page: open the model the territory belongs to, then click View Hierarchy,
then click the name of the territory. To assign rules: click Assign Rules.

Assign and View Territories Directly from an Account

Sometimes it makes sense to assign or view territories directly from a specific account. The Assigned
Territories related list on the Account record lets you do just that. Only territories that belong to
modelsin Planning or Active state can be assigned to accounts.

Make sure you add the Assigned Territories related list to Account page layouts so that you can
assign territories to accounts and users can view territories for their own accounts.

Run Territory Rules Directly from the Territory Hierarchy

In response to user feedback, we've added a Run Rules option for each territory in the hierarchy.
Now you can run rules for individual territories without leaving the context of the hierarchy.

You can run account assignment rules for any territory that has rules defined and belongs to a
territory model in Planning or Active state. If your territory isin Planning state, running
rules lets you preview account assignments. If your territory isin Active state whenyourun rules,
accounts are assigned to territories according to your rules.
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USER PERMISSIONS

To create assignment rules:
e “Customize
Application”AND

“Manage Territories”

USER PERMISSIONS

To assign ferritories
manually within your
accounts:

e "View Setup and
Configuration”
AND

“Manage Territories”

To view assigned territories
on an account:

e "Read” on Accounts

USER PERMISSIONS

To run rules for territories:
e "Customize Application”

AND

“Manage Territories”



Sales Identify Territory Users by Territory Role

US Sales Territory Model Territory Hierarchy (Active) Hel forthis Pace

« Back to List: Territory Models
Give Us Feedback

Rules Last Run: 7/31/2014

Activated: GHO2014 | Run All Rules | | Archive | Tree View -
Collapse All Expand All
— US Sales Territory Model (Active)
+ Northern California Edit | Del | Run B‘EHS | Create Termitory

+ Southern California

Identify Territory Users by Territory Role

Territory roles can help assigned users identify colleagues, collaborators, and other key resources _
to help close deals. Territory users can even have different roles in different territories. The LSER PERMISSIONS

RoleInTerritory fieldisalso exposed for developer use in the UserTerritory2Association

To define picklists:
object in the SOAP API (version 32.0). « “Cusfomize Application”
Administrators need to create a custom picklist so that territory roles can be assigned on territory AND
records. For complete instructions on creating the picklist and assigning roles, see “Identify Territory “Manage Territories”
Users by Territory Role” in the Salesforce Help or Implementing Territory Management 2.0.

To assign territory roles to

users:
e "View Setup and
Configuration”
AND
“Manage Territories”
Users Assigned to Northern California Helofortis Pace €
User Territory Association Edit Save Cancel
Information

User  Stuart Pritchard

Role in Territory ~Nane- :

-None-
Owner
Administrator  |Save | | Cancel

Territory  MNorthern California

Example: For example, you might create roles like Territory Owner, Sales Manager, Product Specialist, or Sales Representative.

19


http://help.salesforce.com/help/pdfs/en/salesforce_implementing_territory_mgmt2_guide.pdf

Sales Track Territory Model Changes in the Setup Audit Trail

Track Territory Model Changes in the Setup Audit Trail

Flexible modeling is a key feature of Territory Management 2.0, and now you can track changes to
rules, assignments, and the model itself from the Setup Audit Trail, where you'll see what changes
were made, when, and by which user.

USER PERMISSIONS

To implement Territory
Management 2.0:

Example: For example, you and your organization’s sales operations managers all have the Y L
* “Manage Territories

“Manage Territories” permission. You create and activate a territory model. One of the sales

operations managers creates a new territory in that model and then assigns users and gives To view the Setup Audit Trail:
them territory roles. Later, another manager creates and activates rules for that territory and ¢ ”V'eVY Setup and
manually assigns two accounts. All of this activity appears in the Setup Audit Trail so that Configuration

territory managers can track it and work together to manage the model.

Apex Triggers Added to the Territory2 and UserTerritory2Association Objects

Territory M t 2.0 offers tri the Territory2 and UserTerritory2Association objects.
erritory Management 2.0 offers triggers on the Territory2 and UserTerritory2Association objects USER PERMISSIONS

Use them to automate actions related to record changes on those objects.

Find more information in Apex Code on page 253 and code samples in the Salesforce Apex Code To define Apex triggers:
Developer's Guide. e “Author Apex”

Build

B Customize
¢/ Tah Names and Labels
+| Home
v Activities
v/ Campaigns

v Asseis

B Territories
Fields
Fage Layouts

Trigoers Mew!

* Territory Models
B User Territory Associations
Fields Hew!

Trigoers Mew!

+| Object Territory Assignment
Rules

Example: For example, you might create a trigger to automatically notifications to your organization’s sales managers when
users are assigned to or removed from territories.
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Sales Limits on Numbers of Territory Models, Territories, and
Assignment Rules

Limits on Numbers of Territory Models, Territories, and Assignment Rules

Winter '15 includes limits on the number of territory models, territories, and assignment rules you can create. The territory model limit
is a default.

Territory Model Limits

Your organization’s Salesforce edition determines the number of territory models you can create in production and sandbox orgs. This
limit includes models created by cloning.

Edition Number of Models in Production Number of Models in Sandbox Orgs
Orgs

Developer 4 4

Enterprise 2 2

Performance 4 4

Unlimited 4 4

Territory Default Limit

By default, each territory model can have up to 1,000 territories.

Assignment Rule Limit

Territories can have up to 15 assignment rules each.

Metadata API Support

Territory Management 2.0 joins the Metadata API (version 32.0) with five new metadata types.

Through the metadata API, developers can now export and import territory definitions, including all associated objects, from one
organization to another—for example, from sandbox to production. Find descriptions of these types in Metadata Types and Fields on
page 333. Find complete details in the Salesforce Metadata APl Developer’s Guide.

API and APl Documentation Enhanced

The Territory Management 2.0 Beta release, in Summer "14, provided a full set of APl objects. For Winter '15 (APl version 32.0), we've
enhanced the APl and added more detail to our APl documentation.

The API now supports the ability to define territory user roles, witha RoleInTerritory picklist on the UserTerritory2Association
object.

We've also included a Territory Management 2.0 Objects entity relationship diagram.

Find more information on the new picklist at Changed Objects on page 292. Find complete picklist details and the new object diagrams
in the Salesforce SOAP API Developer's Guide
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Opportunities and Collaborative Forecasts

Opportunities and Collaborative Forecasts

Track all the deals in your sales pipeline with Opportunities. Predict and plan the sales cycle from pipeline to closed sales, and manage
sales expectations throughout the organization with Collaborative Forecasts.

IN THIS SECTION:

Sales Managers Can Track Revenue from Supporting Sales Roles with Overlay Splits Forecasts (Generally Available)

Sales managers can track revenue from sales team members who help close opportunities but are not directly responsible for them.
By tracking this kind of revenue, sales managers can see the contributions of their overlay sales teams.

Give Your Sales Teams Added Flexibility for Predicting Revenue with Custom Field Forecasts (Generally Available)

Let your sales teams forecast on custom opportunity currency fields that matter to your organization. That way, sales teams are no
longer limited to the standard Revenue and Quantity fields.

Forecast Managers Can Now Add Context to Adjustments with Adjustment Notes

Forecast managers can now add a brief note along with each adjustment they make to forecast amounts, allowing others to
understand the reason for the adjustment.

Edit Multi-Line Layouts for Opportunity Splits and Give Users Quick Access to Custom Fields

Customize the fields displayed in the Multi-Line Layout to let users access those fields quickly.

Sales Managers Can Track Revenue from Supporting Sales Roles with
Overlay Splits Forecasts (Generally Available)

Sales managers can track revenue from sales team members who help close opportunities but are
, . . o EDITIONS
not directly responsible for them. By tracking this kind of revenue, sales managers can see the

contributions of their overlay sales teams.

Available in:
Your sales managers may already be using Revenue splits to credit team members who are directly e Performance
responsible for opportunities. To provide more flexibility in how credits for opportunities are assigned, *  Unlimited
we've added overlay splits, which help sales managers and other team members allocate credit to * Enferprise
overlay sales roles for working on opportunities. Overlay splits can add up to any percentage of the ¢ Developer

opportunity amount, sometimes exceeding 100%. For example, a sales team may include sales
engineers, product specialists, or partners who help close deals, but are not directly responsible for
them.

Overlay Forecasts let sales managers predict revenue from overlay splits. Forecast amounts roll up through the role hierarchy based on
the opportunity’s Amount field and the overlay team member’s split percentage.

Here we can see that sales representative Scott owns an opportunity (1), which includes a 50% overlay split for sales engineer Owen (2),
who's working with Scott to close the deal. For Scott, the opportunity Amount field will roll into his opportunity revenue forecast.
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Opportunity

Sales Managers Can Track Revenue from Supporting Sales
Roles with Overlay Splits Forecasts (Generally Available)

Custamize Pags | Printable View | Help for this Page @

(2 Anaco Limited - 400K
- Snow Feed
Oeporunde Team (21 | Opeorunky Spils (4 | Ooen Achdies 2 | Achvily Hislery 07 | Conbacl Bk (o) | Preducts (Nedh Amereatt 1) | Queles 1)
Oppertunity Detail Edit |Delete| Clone ¥ | Sharing
Opportunity Mame  Anaca Limited - 400K Amount  §385.000.00
Opportunity Owner [P Scott Thomgson [Change) Frofit
AccountMame  Anaco Limited Close Date  12/27/2013
Type New Business Stage Meeds Analysis
Forecast Category  BestCase
Probability (%) 20%
w Description
Description Great sales cycle, with our new product this looks like a great fit
Next Step  calling up the chain
¥ Marketing Information
Lead Source  Google Adwords
¥ System Information
Created By Scott Thompson, 81812013 2:04 P Last Modified By al n
Opportunity Record Type  Simple [Changs!

.oppnmnity Team

Action Team Member
Edit Scott Tnampsan

Edit| Dzl Sug Market
Edit| Dl Dwan Overlay

(= Opportunity Splits
Action Team Member
Del  Qwan Overay

Edit |Delete| Clone ¥ | Sharing

Add

Edit Opportunity Splits || Feedback Survey || &1

Opperiunity Split Type.
Owverlay

Member Role
Opportunity Owner
Account Manager

- Wideo Tutorial |
Amount  Heote

JPercenifil] B
50.00

§198.000.00 specialist

In addition to the opportunity revenue forecast, Owen’s manager can view the overlay splits forecast (1) where he can see the deal to
which Owen is contributing, along with all of the other opportunities his sales engineer team is working on. Owen’s manager can see
that Owen is receiving a 509% credit (2) for this deal, which contributes $198,000 (3) to a total of $948,000 revenue in his Best Case forecast
(4). If Owen's manager thinks the deal will ultimately close for a higher amount, he can adjust the Best Case forecast amount upward.

Home Chatter Leads Accounts Contacts O ities D +
1
Jump to Efict Smith » Jeff Damond » Valerie Jones » Forecasts Setup | Video Tutorial | Hel for this Page @
. Karen Adams Forecast Overiay Splits in U.5. Dollar * | Display Options » Refresh -
Quota Closed Commit Besl Case Pipeline
Total: 2 Quarters (Change) $1,200,000.00 $74,000.00 $377.129.00 $948,000.00 591,000.00
= FO4FY 2013 $600,000.00 $74,000.00 $377,129.00 $948,000.00 $591,000.00
Octavia Ovenlay $200,000.00 $53.500.00 $54,000.00 $160,000.00 $160.000.00
Olbia Overlay $200,000.00 $12,000.00 $217 564 50 $590,000.00 $347,000 00
Owen Overlay $200,000.00 $8.500.00 $105564.50 $198,000.00, $34,000.00
Wendy Overiay's Own Opportunities $0.00 50.00 50,00 50,00 il
@ Wendy Overlay Team « FQ4 FY 2013 - All Forecast Categories « $1,! nits) & Hide
Action  Opportunity Mame Account Name Amount +  Split ‘'orecasted Amount Close Date  Stage Probability (%) Forecast Category ‘Owner Full Name Next
Edit Haven Enterprises Haven Enterprises $500,00000 100.00% $590,000.00 121202013 Needs Analysis 20 BestCase Thompson, Scott Disi ~
Edit Anaco Limiled - 400K Anaco Limited $396,00000 50.00% $198,000.00 1202772013 Needs Analysis 20 BestCase Thompson, Scolt calli =
Eait Emplovnet -322K Employnet $322.000.00 100.00% $322.000.00 1172572013 Qualification 10 Pipeline Lee Kasey Qus
Edit Green Dot - 160K Green Dot $160,000.00 100.00% $160,000.00 121772013 Needs Analysis 35 BestCase McCrane Elv
Edit gwsoning - 140K Towsonng $140,00000 100.00% §140,000.00 121872013 Qualification 10 Fipeline ong, Cingy Quc
i - . - e Ty e R — . ___J - o
1-150f 15 = 4 4 Prev bW Page| 1 |of1 J‘!CM

For more details, see “Overlay Splits Forecasts Overview” and “Enable Overlay Splits Forecasts for Sales Managers” in the Salesforce Help.
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Give Your Sales Teams Added Flexibility for Predicting
Revenue with Custom Field Forecasts (Generally Available)

Give Your Sales Teams Added Flexibility for Predicting Revenue with Custom
Field Forecasts (Generally Available)

Let your sales teams forecast on custom opportunity currency fields that matter to your organization.

- , . EDITIONS
That way, sales teams are no longer limited to the standard Revenue and Quantity fields.
Now, your sales teams can forecast on custom currency fields on opportunities. For example, your Available in:
sales teams might use a custom field such as Margin, Monthly Recurring Revenue, * Performance
Annual Contract Value,orany other currency field that your organization requires. You *  Unlimited
can easily set up a forecast based on any of those custom fields, which your sales managers can * Enferprise
then view in the Forecasts tab like any other forecast. *  Developer

If you use opportunity splits with your custom field, your forecast incorporates those splits. You can
use a custom field forecast by itself or in addition to other forecasts, such as an opportunity-revenue
forecast based on the opportunity Amount field.

@ Note: To enable a custom field forecast, you must first enable:
e A custom opportunity currency field
e Opportunity Splits

e A custom split type for the custom field (You must enable the split type even if you don't intent to use splits with the custom
field.)

If the forecast manager or sales rep viewing the forecast does not have access to the custom opportunity field, they can see forecast
amounts but they won't be able to see any of the custom field values in the opportunity list.

Forecasting on Annual Contract Value-a Simple Custom Field Forecast

Here we see an example of an opportunity owned by sales rep Anna Bressan (1). Anna’s organization has a lot of multi-year deals, so
they use a custom Annual Contract Value field (2) to track the revenue received from the deal each year.

Opportunity

(2’ Acme - Premium Support

Customize Page | Edit Layout | Printable View | Help for this Page 3
Click to add topics

« Back to List: Users
Opportunity Team [3] | Opportunity Splits [21 | Open Activities [0] | Activity Historv[0] | Contact Roles [01 | Partners (01 | Competitors [01 |

Products [01 | Notes & Attachments [0] | Stage History [11
Opportunity Detail _Edit || Delete | Clone || Sharing
Opportunity Owner  [E] Anna Bressan [Changel Close Date  4/15/2014
Opportunity Name  Acme - Premium Support Stage  Negotiation/Review
Account Name  Acme Inc 1 Probability (%)  90%
Type  Existing Business Amount  USD 250,000.00
Primary Campaign
Source
Discount Percentage
Commission  USD 0.00
Region/Zone |/ 2
Discounted Amount  USD 250,000.00

Annual Contract Value USD 125,000.00
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Here we see the Forecasts tab for Anna (1). The Annual Contract Value field in all of Anna’s opportunities rolls up into her
Annual Contract Value forecast (2), which appears in the Forecasts tab along with any other forecasts that you set up. The Forecasted
Amount (3) isthe value of the Annual Contract Value field thatrolls upinto Anna’s forecast. Anna’s Acme — Premium Support

opportunity (4) appears in the list at the bottom of the page.

Give Your Sales Teams Added Flexibility for Predicting
Revenue with Custom Field Forecasts (Generally Available)

| Home Chatter Leads Accounts Contacts Opportunities Reports Dashboards Documents Products +

e Jump to
&

Allison Wheeler » Kathy Ci

Anna Bressan Forecast

oOpEr » | 1

2

e Annual Contract Value in U.S. Dollar = | Display Options »

Forecasts Setup | Video Tutorial | Help for this Page &

m

Refresh

Amounts shown are based on exchange rate conversion.

Total: 3 Months (change)

USD 20,000.00

Closed

USD 1,276,250.00

Commit

Best Case

USD 3.649,500.00

Pipeline

USD 2,033,000.00

April FY 2014 UsD 0.00 UsD1,221,250.00 USD 922,500.00 USD 265,000.00

May FY 2014 USD 20,000.00 USD 27,500.00 USD 1,340,000.00 USsD 1,719,000.00

June FY 2014 UsD 0.00 USD 27,500.00 USD 1,387,000.00 USD 49,000.00
5] Anna Bressan - April FY 2014 - All F ast Categories = USD 2,408,750.00 ¥ Hide
Action Opportunity Name Account Name Forecasted Amount  Split Close Date  Stage Probability (%) Forecast Category Owner Full Name Amount +
Edit Canson 55 WidgetDeal Canson UsD 922,500.00 — 4/23/2014 Proposal/Price ... 75 BestCase Bressan, Anna UsD 1,230,000.00 =
Edit Red Packages - 10 Spi... RedPackages UsD 550,000.00 — 4/30/2014 Negotiation/Revi... 90 Commit Bressan, Anna USD 1,125,000.00
Edit Red Packages - 10 Spi .. Red Packages UsD 550,000.00 — 4M11i2014 Megotiation/Revi. 90 Commit Bressan, Anna UsD 1,125,000.00 L
Edit Canson-20 Spider4 3... Canson UsD 173,000.00 — 4/14/2014 Prospecting 10 Pipeline Bressan, Anna UsD 383,250.00
Edit Acme - Premium Support  Acme Inc. USD 125,000.00 — 4/15/2014 Negotiation/Revi... 90 Commit Bressan, Anna UsD 250,000.00
Edit Universal Technologie. Universal Tec / USD 57,000.00 — 4M11i2014 Meeds Analysis 20 Pipeline Bressan, Anna UsD 117,700.00
Edit STCLabs-9infinityLa .. STCLabs a USD 25,000.00 — 4M11i2014 Megotiation/Revi... 90 Commit Bressan, Anna USD 50,000.00
Edit STC Labs-15Infinity L... STC Labs USD 14,000.00 — 4/11i2014 Prospecting 10 Pipeline Bressan, Anna USD 28,000.00 ~
< T Lk
111 0f 11 =] Page 1 ofi ¢ chat

@ Note: To enable a custom field forecast, your administrator also has to enable opportunity splits for the custom field. However,
the opportunity owner automatically receives a 100% split for the field, so if your organization doesn't plan to use splits with the

field, the rollup is the same as if there were no splits.

A Custom Field Forecast with Opportunity Splits

If you use opportunity splits on your custom fields, your custom field forecasts roll up those splits. For example, here we can see that
sales representative Anna owns an opportunity (1), which includes the Annual Contract Value field (2) and a custom split on
the Annual Contract Value fieldforKevin (3), a sales engineer responsible for increasing overall Annual Contract Value for the

company. In this case, Kevin's 25% split will roll up into his Annual Contract Value forecast.
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Give Your Sales Teams Added Flexibility for Predicting
Revenue with Custom Field Forecasts (Generally Available)

Opportunity

Click to add topics

« Back to List

() Acme - Premium Support

Customize Pag

Opportunity Team [3] | Opportunity Splits [21 | Open Activities 101 | Activity History [01 | Contact Roles [o] |

Opportunity Detail
Opportunity Owner
Opportunity Name
Account Name

Type

Primary Campaign
Source

Discount Percentage
Commission
Region/Zone

Discounted Amount

Annual Contract Value
» Finance Information
» Additional Information

» System Information

Opportunity Team

Action Team Member

Edit Anna Bressan

Edit| Del Kevin Bailey

(=) Opportunity Splits

Action Team Member

Del Anna Bressan
Del Kevin Bailey

Notes & Attachments [0] |

Stage History [3]

Edit | Delete | Clone Sharing
[E] 2nna Bressan [(Chanael Close Date
Acme - Premium Support 1 Stage
Acme Inc. Probability (%)
Existing Business Amount
uUsD 0.00
)
usD 250,000.00
UsD 125,000.00

Edit | Delete | Clone Sharing

Add Default Team Display Access

Add

Edit Opportunity Splits

Member Role
Opportunity Owner

Pre Sales Engineer

Feedback Survey

Al

Opportunity Split Type
Annual Contract Value
Annual Contract Value

-
Percent (%)

T5.00
25.00

e | Edit Layout | Printable View | Help for this Page tj

Partners [0] | Competitors [01 | Products [0] |

4M15/2014
Negotiation/Review
90%

USD 250,000.00

Opportunity Team Help 7

Video Tutorial | Opportunity Splits Help
?

Amount Note
UsD 93750.00
UsD 31,250.00

Kevin's manager can view the Annual Contract Value forecast (1) where he can see the deal to which Kevin is contributing, along with
all of the other opportunities his sales engineer team is working on. Kevin's manager can see that Kevin is receiving a 25% credit (2) for
all of his opportunities, which contribute to a total of $1,026,000 revenue in his Best Case forecast. If Kevin's manager thinks the deal will
ultimately close for a higher amount, his manager can adjust the Best Case forecast amount upward. When Anna’s manager views his
forecast, he can see Anna’s 75% split.

| Home Chatter Leads Accounts Contacts Opportunities Reports Dashboards Documents Products + |
. Jumpto... | Alison Wheeler » Jessica Heinz » | 1 Forecasts Setup | Video Tutorial | Help for this Page &
gal . o w—=—=e Annual Contract Value in U.5. Dollar v | Display Options = Refresh 3
Kevin Bailey Forecast —
Amounts shown are based on exchange rate conversion Closed Commit Best Case Pipeline
Total: 3 Months (Change) USD 36,250.00 USD 326,875.00 USD 1,026,000.00 USD 812,000.00
April FY 2014 UsD 0.00 USD 313,125.00 USsD 307,500.00 USD 66,250.00
May FY 2014 USD 5,000.00 USD 6,875.00 USD 371,750.00 USD 733,500.00
June FY 2014 UsD 31,250.00 USD 6,875.00 USD 346,750.00 UsD 12,250.00
2
2] Kevin Bailey - April FY 2014 - All Forecast Categories - USD 686,875.00 ¥ Hide
Action Opportunity Name Account Name Forecasted Amount  Split Clgke Date  Stage Probability (%) Forecast Category Owner Full Na... Amount +
Edit Canson 55 Widget Deal Canson USD 307 500.00 25.00% '23/2014 ProposaliPrice Q. 75 BestCase Bressan, Anna USsD 1,230,000.00 *
Edit Red Packages - 10 Spid... RedPackages USD 137,500.00 25.00% 4/30/2014 MNegotiation/Revi... 90 Commit Bressan, Anna UsD 1,125,000.00 ‘j
Edit Red Packages - 10 Spid... Red Packages USD 137,500.00 25.00% 4/11/2014 MNegotiation/Revi... 90 Commit Bressan, Anna UsD 1,125,000.00
Edit Canson - 20 Spider4 5. Canson USD 43,250.00 25.00% 4114/2014 Prospecting 10 Pipeline Bressan, Anna USD 383 250.00
Edit Acme - Premium Support  Acme Inc. USD 31,250.00 25.00% 4/15/2014 Negotiation/Revi... 90 Commit Bressan, Anna USD 250,000.00
Edit Universal Technologies ... Universal Tec... USD 14,250.00 25.00% 4/11/2014 Needs Analysis 20 Pipeline Bressan, Anna USD 7 70000~
@
1 0r11 7l Page 1 of1 (et ‘

126




Sales

Forecast Managers Can Now Add Context to Adjustments
with Adjustment Notes

Forecasts with the Expected Revenue Field

If your organization uses the standard Expected Revenue field,you can setup aforecast foritas well. The Expected Revenue
field is useful for opportunities that are likely to produce more or less revenue than indicated in the Amount field.

For complete details about Custom Opportunity Field Forecasts, see “Custom Opportunity Field Forecasts Overview” and “Enable Custom
Field Forecasts for Sales Managers” in the Salesforce Help.

Forecast Managers Can Now Add Context to Adjustments with Adjustment
Notes

Forecast managers can now add a brief note along with each adjustment they make to forecast amounts, allowing others to understand
the reason for the adjustment.

When your forecast managers make adjustments to their immediate subordinates’ forecast amounts, they can include a note of up to
140 characters with each adjustment to provide information about the nature of or reason for the adjustement. When a forecast manager
includes a note with an adjustment, a blue triangle () appears next to the forecast amount.

Each type of forecast you enable maintains its own adjustment data, including notes. Adjustment notes do not appear in reports.

Edit Multi-Line Layouts for Opportunity Splits and Give Users Quick Access
to Custom Fields

Customize the fields displayed in the Multi-Line Layout to let users access those fields quickly.

Just as you can customize layouts for Opportunities, you can customize the page layout for Opportunity Splits. Click Edit Multi-Line
Layout and choose which fields you'd like to use as well as the order they appear on the page.

Home Chatter Profile Groups Files Leads Accounts Contacts Opportunities Reports Dashboards Products Forecasts

Take Salesforce with you wherever you go.

Run your business from any mobile device with the Salesforcel Mobile App.

ScachAlSewp. O Q Opportunity Split Layout Edit Mult-Line Layout Mini Page Lavout Mini Console View | Video Tutorial Help for this Page %)
‘ Search All Setup. | pportunity Sp yout ~

save ¥ | Quick Save | Preview As...¥ | Cancel | 4% Undo 3 Redo | | [E] Layout Properties
Expand All | Collapse All —

_ @, Quick Find| Fie|d Name ®

Buttons +H Section Opportunity Name
Expanded Lookups *FlBlank Space Opportunity Split..
Force.com Home Report Charts Amount Percent (%)

Hote Team Member

Salesforcel Setup New!

Administer
»| Manage Users L ee——e——
*/ Manage Apps

*/ Manage Territories
»| Company Profile

»| Security Controls Opportunity Split Detail Standard Buttons
Save & Close | Delete

»/ Domain Management

You can choose up to 10 fields to display, but you can't use the Multiselect Picklist, Dependent Picklist, or Rich Text Area fields. To
make the fields that you've selected visible on the Opportunity details page, configure the related list layout.
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Duplicate Management (Closed Betal)

Duplicate Management (Closed Beta)

Maintaining clean and accurate data is one of the most important things you can do to help your
organization get the most out of Salesforce, so we're excited to introduce Data.com Duplicate

EDITIONS

Management. Now you can control whether and when you allow users to create duplicate records Available in:
inside Salesforce; customize the logic that's used to identify duplicates; and create reports on the e Professional
duplicates you do allow users to save. e Enterprise
@ Note: J Perfor.mcnce
e Unlimited
e Due toextremely high demand for participation in the Data.com Duplicate Management «  Developer

Closed Beta program, we have reached our capacity and are not taking new nominations.
Please understand that Data.com Duplicate Management is scheduled to be generally
available to all our CRM customers with Professional Edition and higher in the Spring '15
release (Safe Harbor applies). Based on the current release schedule, this means the feature
will be available in production organizations by mid-February, 2015, and mid-January,
2015, for sandbox organizations.

e This release contains a beta version of Data.com Duplicate Management that is production
quality but has known limitations. You can provide feedback and suggestions on the
Salesforce Success Community. For information on enabling this feature for your
organization, contact Salesforce.

After Duplicate Management is set up, any time a user attempts to save either a new record or an existing record, the duplicate
management tools go to work. First, the record is compared with existing Salesforce records to identify possible duplicates (1). The
criteria used to compare records and identify the possible duplicates are defined by a matching rule. Next, a list of possible duplicates is
returned (2).

What happens when the record being saved is identified as a possible duplicate depends on what's defined in the duplicate rule (3). For
example, the duplicate rule could block users from saving the possible duplicate record or allow them to save it anyway. Both the Block
and Allow options include an alert, which tells users why they can't save the record and what they need to do. The Allow option includes
the ability to report on the duplicate records.
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Duplicate Management (Closed Beta)

- - - -

- -

OAOE

Duplicate Management Beta Limitations

Duplicate management is only available for accounts, contacts, and leads. All other objects, including custom objects and Person
Accounts, are not currently supported.

Matching rules do not work across objects. For example, a matching rule won't compare Contact records to Lead records.

Duplicate rules run as described here for records created from their respective tabs and edited directly from the respective record
detail page (either by clicking Edit or editing the record inline). Any other method of creating or editing records (including but not
limited to Lead Convert, creating record from the Chatter publisher, and adding records to Salesforce using data import tools) will
always result in the save being blocked, regardless of the action specified in the duplicate rule, and the user will not see a list of
possible duplicates.

Duplicate rules don't run when records are created using Quick Create.

If your organization doesn't have the “Use Apex Lead Convert” permission, duplicate rules don't run when leads are converted to
accounts or contacts.

Duplicate rules created for leads do not compare converted leads; therefore, converted leads will never be returned as possible
duplicates for leads.

When a person account is converted to a business account (and the newly created business account matches existing business
accounts), duplicate rules will always block the save, regardless of the action specified in the duplicate rule.

You cannot manually merge records if there's an active duplicate rule that specifies the action on edit as either Allow or Block.

The customizable alert text in duplicate rules isn't supported by the Translation Workbench.
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Create or Edit Duplicate Rules

If your organization uses Data.com and the Data.com duplicate preference option is set to allow duplicate records to be added from
Data.com Prospector, duplicate rules will run but always block users from adding the new records, regardless of the action specified
in the duplicate rule.

e When arecord is restored with the Undelete button, duplicate rules do not run.

e For matching rules to work in a sandbox organization, you must deactivate all matching rules (and any associated duplicate rules)
and then activate them again. Doing so allows the match index to be created.

e Standard and custom matching rules that use fuzzy matching methods only support Latin characters.

e Ifyou're using international data, we recommend you use the Exact matching method with your matching rules.

For more information about Data.com Duplicate Management, including detailed information about matching rules, see the
implementation guide.

IN THIS SECTION:

Create or Edit Duplicate Rules

Use duplicate rules to define what happens when a user tries to save a duplicate record. Currently, duplicate rules are only available
with accounts, contacts, and leads.

Create or Edit Custom Matching Rules

Use matching rules to determine how two records are compared and identified as duplicates. Currently, matching rules are only
available with accounts, contacts, and leads.

Create Custom Report Types for Duplicate Record Reports

If your organization uses the Report action with its duplicate rules, you can run reports to analyze the quality of your data and to see
how well your duplicate rules are working. First, you'll need to set up the appropriate custom report types.

Create or Edit Duplicate Rules

Use duplicate rules to define what happens when a user tries to save a duplicate record. Currently,
duplicate rules are only available with accounts, contacts, and leads.

EDITIONS

Available in:

e Professional
e Enterprise

e Performance
e Unlimited

e Developer

@ Note: This release contains a beta version of Data.com Duplicate Management that is
production quality but has known limitations. You can provide feedback and suggestions on
the Salesforce Success Community. For information on enabling this feature for your
organization, contact Salesforce.

° Watch a Demo (3:12)

1. From Setup, click Data.com Administration > Duplicate Management > Duplicate Rules >

Object. USER PERMISSIONS
2. C(lick either New Rule or Edit next to the existing rule you want to modify. To create, edit, or delete

duplicate rules:

3. Enterthe rule details, including the rule’s name, description, and record-level security settings. ) ) o
e "Customize Application

4. Select which action will occur when a user tries to save a duplicate record. ) )
To activate and deactivate

If the action includes an alert to users, we'll provide default alert text that you can customize. duplicate rules:
Only the Allow action includes the report option. « "Customize Application”
5. From the Matching Rule drop-down list, select which matching rule will determine how records To view duplicate rules:
are identified as duplicates. * "View Setup and
Configuration”
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Create or Edit Custom Matching Rules

The list includes one standard matching rule and all of your organization’s custom matching rules for the particular object. If none
of the matching rules in the list are what you want, select Create New Matching Rule.

o Tip: We recommend you use the standard matching rule because it's been carefully designed to return the best possible set
of match candidates. Just be sure you've activated it. If, however, you decide to create a new matching rule, we recommend
you first finish creating your duplicate rule. Then create and activate the new matching rule. When you come back to the
duplicate rule, it will automatically have the newly created matching rule associated it, as long as it didn't already have an
associated matching rule.

6. If you want your duplicate rule to run only if specific conditions are met, specify the conditions.
For example, you could add a condition that tells the rule to run only if the record was entered by a user with a certain profile or
role, or if the record includes a specific country or state.

7. C(lick Save.
Your saved rule will be visible in the duplicate rule list view.
8. From the duplicate rule list view, click Activate next to the appropriate duplicate rule.

For the activation to succeed, the duplicate rule must have an active matching rule associated to it. You can have up to five duplicate
rules active at one time.

9. Ifyou have more than one active duplicate rule for a particular object, you may want to adjust the order in which the rules are
processed. You can reorder rules from the duplicate rule list view.

o Tip: If the first duplicate rule finds a match for a particular record, that record will not be evaluated by subsequent duplicate
rules. Therefore, you should order your duplicate rule so that rules with the Block action are run before rules with the Allow
action.

Create or Edit Custom Matching Rules

Use matching rules to determine how two records are compared and identified as duplicates.
Currently, matching rules are only available with accounts, contacts, and leads.

EDITIONS

Available in:

e Professional
e Enterprise

e Performance
e Unlimited

e Developer

@ Nofte: This release contains a beta version of Data.com Duplicate Management that is
production quality but has known limitations. You can provide feedback and suggestions on
the Salesforce Success Community. For information on enabling this feature for your
organization, contact Salesforce.

o Watch a Demo (3:39)

1. From setup, click Data.com Administration > Duplicate Management > Matching Rules.

USER PERMISSIONS
2. Ifediting an existing matching rule, make sure the rule is inactive.
3. Click New Rule or Edit next to the existing rule you want to edit. To create, edit, or delefe
matching rules:
4. Select which object this matching rule will apply to. « “Cusfomize Application”
5. Enteraname and description for the rule. To activate and deactivate
6. Enter the matching criteria. matching rules: I
e "Customize Application”
The matching criteria is where you define which fields to compare and how. To add additional . ‘ PP
fields (up to 10 total) click Add Filter Logic... and then Add Row. To view matching rules:
e "View Setup and
7. Ifyouneed to adjust the matching equation, click Add Filter Logic.... Here you can, for example, Configuration”

manually change an AND expression to an OR expression.
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8. C(lick Save.

You'll see a summary of your saved matching rule.

9. C(lick Activate.

Create Custom Report Types for Duplicate Record Reports

The activation process may take some time, so we'll send you an email when the process is complete and your matching rule is

ready to use.

After the matching rule is active, it's available to use with other Data.com Duplicate Management tools. For example, using a matching
rule with a duplicate rule tells Salesforce to take certain actions when users try to save a record the matching rule has identified as a
duplicate.

Create Custom Report Types for Duplicate Record Reports

If your organization uses the Report action with its duplicate rules, you can run reports to analyze
the quality of your data and to see how well your duplicate rules are working. First, you'll need to

set up the appropriate custom report types.

@ Nofe: This release contains a beta version of Data.com Duplicate Management that is

production quality but has known limitations. You can provide feedback and suggestions on

the Salesforce Success Community. For information on enabling this feature for your
organization, contact Salesforce.

The only records that will appear in these reports are:

1.

Records identified as duplicates by duplicates rules that include the report action

Records that were manually added to the Duplicate Record Set object

Make sure you're familiar with custom report types and the general steps for creating and

maintaining them.

Create custom report types with the appropriate object relationships and configure them as

necessary.

Here are some examples of custom report types to get you started.

Report Type

Account
Duplicates

Contact
Duplicates

Possible Use A (Primary

Obiject)

Createreportson Accounts
the duplicate

accounts that

were found by

your duplicate

rules.

Createreportson Contacts
the duplicate

contacts that

were found by

your duplicate

rules.

B Additional

Steps

Duplicate Record
ltems

Duplicate Record
ltems
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EDITIONS

Available in:

e Professional
Enterprise

e Performance

e Unlimited

e Developer

USER PERMISSIONS

To create or update custom

report types:

e “Manage Custom Report
Types”

To delete custom report

types:
e "Modify All Data”
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Report Type Possible Use A (Primary Object) B

Salesforce for Outlook

Additional Steps

Lead Duplicates Create reports on the Leads Duplicate Record Items

duplicate leads that
were found by your
duplicate rules.

All Duplicates Create reports to see Duplicate Record Set Duplicate Record Items  Add the Duplicate

how well your duplicate
rules are performing.

3. Deploy the report types you want to make available to users.

4. Letusers know that they can create reports using these custom report types.

Salesforce for Outlook

Rule Name lookup
field to the Duplicate
Record Set page layout.

You'll discover new Salesforce Side Panel features to help your users get more Salesforce work done
directly from Microsoft® Outlook’. We've also improved setup so you can help new users hit the
ground running quickly, and added helpful customizations in Outlook configurations to keep you
in control.

Before we dive into our latest features, it's a good time to consider migrating any remaining folks
using Connect for Outlook to Salesforce for Outlook, because in addition to including Connect for
Outlook features your users know, Salesforce for Outlook includes:

*  Support for Microsoft” Exchange Online, the Microsoft -hosted service that integrates with
Office 365"

e The Salesforce Side Panel
e Options to sync only some or all Microsoft” Qutlook”® contacts, events, and tasks

e Automatically scheduled sync cycles

Now let's take a look at our latest enhancements to Salesforce for Outlook and the side panel.

IN THIS SECTION:

It's Easier to Set up Side Panel Users to Add Outlook Items to Salesforce Records

We've enabled Add Email by defaultin Outlook configurations, and removed the need for
side panel users to set up My Email to Salesforce to add Outlook emails and attachments to
Salesforce records.

Let Users Select Specific Email Attachments to Add to Salesforce

Reduce your company’s data usage in the cloud by letting users add only the attachments that
matter to them to Salesforce records.

Specify Your Users’ Outlook Sync Folders

Now you can control where your users sync their records by specifying common Outlook sync
folders in Outlook configurations. When you specify sync folders, it simplifies users’
Salesforce for Outlook setup and keeps sync folders consistent across your company.
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EDITIONS

Salesforce for Outlook Side
Panel available in: All
Editions

Outlook configurations
available in: Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions

USER PERMISSIONS

To edit users’ Outlook
configurations in
Professional, Enterprise,
Performance, Unlimited, and
Developer Editions:

e "Customize Application”

To create, edit, or delete

Outlook configurations in

Professional, Enterprise,

Performance, Unlimited, and

Developer Editions:

e “Manage Email Client
Configurations”



Sales It's Easier to Set up Side Panel Users to Add Outlook Items
to Salesforce Records

Side Panel Users Can Do More with Outlook Tasks
Now users can see the side panel from Outlook Tasks, and add their Outlook tasks to Salesforce records, helping users get more
Salesforce work done directly from Microsoft” Outlook”.

It's Easier to Set up Side Panel Users to Add Outlook ltems to Salesforce
Records

We've enabled Add Email by default in Outlook configurations, and removed the need for side panel users to set up My Email to
Salesforce to add Outlook emails and attachments to Salesforce records.

These changes mean your side panel users can start adding emails, attachments, events, and tasks to their Salesforce records as soon
as you add them to an Outlook configuration, and users aren't required to take additional setup steps.

Users you haven't set up to use the side panel are still required to set up My Email to Salesforce to add Outlook emails and attachments
to Salesforce records from the Add Emails button in the Salesforce section of the Outlook ribbon.

You can disable these features for users by clicking Setup > Desktop Administration > Outlook Configurations > New Outlook
Configuration and deselecting Add Email.

Let Users Select Specific Email Attachments to Add to Salesforce

Reduce your company’s data usage in the cloud by letting users add only the attachments that matter to them to Salesforce records.

In Outlook configurations, Add Email lets side panel users add emails to Salesforce records, and automatically includes email
attachments. Now you can let users add only specific attachments when you enable Side Panel, Add Email,and Allow

users to select attachments.

Data Settings Data Settings Help ' ?

Overwrite configuration changes made by users
Email

Q ‘When you select Side Panel and Add Email the add email, add event, and add task options appear in the Salesforce Side
Panel.

[ Side Panel
Add Email [ Allow users to select attachments
Create Case | i To use this feature you must enable Email to Case 7

Whenyou enable A11ow users to select attachments foryour users, attachments aren'tincluded automatically when
users add an email to a Salesforce record. Instead, users can select specific attachments they want to include when they click in the
side panel next to each attachment.
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Sales Specify Your Users’ Outlook Sync Folders

salesforce Q »

Email added to:
Grant Belden

> Attachments
customer_contacts.do
customer_spreadsheet xlsx

¥ GrantBelden g
Intron Corporation
gbelden@intron.com
P: 1-408-555-8085
View Contactin Salesforce

Activity History

B<

Specify Your Users’ Outlook Sync Folders

Now you can control where your users sync their records by specifying common Outlook sync folders in Outlook configurations. When
you specify sync folders, it simplifies users’ Salesforce for Outlook setup and keeps sync folders consistent across your company.

The new setting, Outlook folder for syncing contacts,isenabledin new and existing Outlook configurations. This
means that by default, users can change their Outlook sync folders. To prevent users from changing their sync folders, open your Outlook
configurations and, in the Allow users to modify area, disable the Outlook folder for syncing contacts setting for
contacts, events, and tasks. Then, in the text boxes that appear, type the name of the Outlook folders where you want your users’ contacts,
events, and tasks to sync.

Contacts

‘Sync Direction Conflict Behavior

| Sync both ways s | Salesforce always wins +

p Edit Field Mappings
If an Outlook contact matches multiple Salesforce contacts, sync it with the Salesforce contact that:

() Has the most recent activity | i
(_)Was lastupdated
(_)Has the oldest creation date

Allow users to modify:[_| Whether abject is synced [_| Syncdirection || Conflict behavior [ Field mappings@ Outlock folder for syncing contacts | i | | Contacisisfde sync contacts D

If the folders you specify don't exist in your users’ Outlook directories, Salesforce for Outlook creates the folders for them.

Your users can then move the contacts, events, and tasks they want to sync to the folders you specified.

Side Panel Users Can Do More with Outlook Tasks

Now users can see the side panel from Outlook Tasks, and add their Outlook tasks to Salesforce records, helping users get more Salesforce
work done directly from Microsoft” Outlook”.

Users can add Outlook tasks to multiple Salesforce contacts and to one other record that accepts tasks, like an account, a lead, or an
opportunity. To do this from the side panel in Outlook Tasks, users select the task they want to add to a Salesforce record (1), search in
the side panel for the record they'd like to add the task (2), and click .= next to the records in the search results (3).
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ﬂa L_‘I:I: s Tasks - Qutlook ? H - O X
HOME SEND / RECEIVE FOLDER VIEW

3 Ijl T‘ x I E:ﬁ J |k< > Today | Next Week c ¥ Eﬂ | [] Search People
“’E -2 | Tomomow [* Mo Date e m 1 [EE: Address Book
Mew MNew New  Delete Reply Reply Forward E-E . Mark  Remove X > Change Move OneMote Categorize
Task  Email lems~ All Complete from List | This Week > Custom View = - - +
Mew Delete Respond Manage Task Follow Up Current Vi... Actions Tags Find ~
<
Search Tasks (Ctrl+E) H Adam Done
4 My Tasks
] SUBJECT DUE DATE CATEGORIES v
To-Do List Click here to add a new Task To add the Task, click += [x]
Tasks : next fo those records.
Enable-Chattertavites Mon-2H02044

bemit plan for LIPS te Noah Larki B

o . [T e Resulis for Adams

reate new email templates Fri 8/8/2014 ) l Red Category
oTCe FHe 972012

Review upcoming IT projects Fri 8/15/2014

Call Deborah Fri 8/29/2014

Take Saleforce new release certification Sat 8/30/2014

Create new email templates Thu 9/25/2014

(] LIRS

Contacts (1)

Arnold AdamQ‘B
Phone: 1-408-565-2122 - Mailing City: San

Jose + Email: ameld.adams{@trainingarg-
abclabs.com - Contact Owner Alias: mwils -
Account Name: AEC Labs

§

)
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O

O

O

O

Mail Calendar People Tlasks -

ITEMS: 9 ALL FOLDERS ARE UP TO DATE. COMNNECTED TO: MICROSOFT EXCHANGE

S IEY JLN ALY

s AN SN

Leads (1)

The task is then added to the Salesforce record as an activity, which users can see on the record’s Activity History or Open Activities
related lists.

If you're using Professional, Enterprise, Performance, Unlimited, or Developer Edition, make sure your Outlook configurations include
Add Email and Side Panel tosetup users for this feature. If you're using Contact Manager or Group Editions, you don't need
to do anything.

Activities

Events and tasks are the building blocks of sales productivity. We've made enhancements that boost your sales teams’ edge over the
competition, along with updates to improve performance and usability.

IN THIS SECTION:

Add Custom Lookup Fields on Activities (Beta)

Tired of having to choose which type of record is most important to activities? Now your users can track events, meetings, and tasks
related to partners, suppliers, trainers—whatever additional record types make sense in your organization. A field type for lookup
relationships, now available for use with activities, lets you add custom lookup fields from activities to other records. To enable this
feature in your organization, contact salesforce.com Customer Support.

Let Your Users Control Task Notifications Globally

Users can now control notification emails for all of their task assignments. This new setting replaces the checkbox on the Create Task
page that triggers an email to the assignee of the task. The user setting is exposed by default. You can hide the setting from users.
Either option has specific effects on users of Salesforce1 and the full Salesforce site, on Communities users, on partner portal users,
on users who are assigned tasks via workflow task rules, and on users who are assigned tasks that are generated by the
triggerUserEmail field.
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Add Custom Lookup Fields on Activities (Beta)

Add Custom Lookup Fields on Activities (Beta)

Tired of having to choose which type of record is most important to activities? Now your users can track events, meetings, and tasks
related to partners, suppliers, trainers—whatever additional record types make sense in your organization. A field type for lookup
relationships, now available for use with activities, lets you add custom lookup fields from activities to other records. To enable this
feature in your organization, contact salesforce.com Customer Support.

Example

Suppose that as a general contractor you regularly partner with landscape designers, and that you want to track the milestones in their
work for each customer. You've already created a custom object named “Landscape Designer.” Use the field type Lookup
Relationship to create an activity custom field on Landscape Designer records.

Field Type Lookup Relationship

Creates a relationship that links this object to another object The relationship field allows users to click on 3

® Lookup Relationshi
v v lookup icon to select a value fram a popup list. The other abject is the source of the values in the list.

Now when you create activities on the account, you can specify the landscape designer who's working with the customer.

Event Record with Custom Lookup Field

Calendar Details | =Required Information
Assigned To I Christiane Fournier Q) Related To  [account *  |Ocean View Condominiurm @)
suvtect | Kickoff meeting & tame  [Contact * | |Marion Moorman @, [ Add to Invitees |
All-Day Event Private
start |amzo14 10:00 PM [957PM]
End |amzo14 11:00 PM [957PM]
Opportunity on Ql
Account -
Landscape  [Roga Cruz Design Q)
Designer

The record for each landscape designer displays a list of past and upcoming activities, including the corresponding customer contacts
and accounts.

Related List of Activities on Accounts via Custom Lookup

Landscape Design Milestones Hew Task | |New Event Landscape Design Milestones Help (7
Action Subject Name Related To Task Due Date Status Closed Priority Assigned To  Last Modified Date/Time
Edit | Del Materials ordered Maton ~— CoeanView V922014 e Normal % 8/3/2014 924 PM
Edit | Del m%m Maton ~ Coeanvien v oazwme Normal E:L% 8/8/2014 9:25 PM
Edit | Dol Sievaldhioughwith - Rabat i, gipger Shops Bronn phistizne /69014 9.47 P
oo Sommmean hmn g v D g ssomy
Edit | Del Kickofl mesting Maton ~— CoeanView Bliz0i 000 v 7%"9 8/8/2014 961 P

For details on creating activity custom fields, see “Creating Custom Fields” in the Salesforce Help.

Limitations

This release contains a beta version of Activity custom lookup fields that is production quality but has known limitations. You can provide
feedback and suggestions for activity custom lookup fields on the IdeaExchange. To enable this feature in your organization, contact
Salesforce Customer Support.
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Let Your Users Control Task Notifications Globally

Custom Lookups Don’t Control Activity Sharing
Referencing another record using an Activity custom lookup doesn't affect users’ access to the activity, because a record referenced
by an activity custom lookup isn't a parent of the activity. The lookup is simply a reference to another record.

Each Custom Lookup Can Reference One Type of Record, One Record Type at a Time
Each custom lookup field can reference one type of record, and no two fields can look up to the same type of record. To reference
records of different types, create multiple custom lookup fields.

Each Custom Lookup Field Supports One Activity Lookup Related List
Unlike the Open Activities and Activity History related lists, which display activities related to other records through the Name and
Related To fields, custom lookup fields combine open and closed activities in the same related list.

Custom Sorting Isn’t Supported
The related list of activities from a custom lookup is sorted by ActivityDate DESCENDING and LastModifiedDate DESCENDING (that
is, starting with the activity farthest in the future and continuing into the past). You can't customize this sorting.

Activity Lookup Fields Are Unavailable in Custom Report Types for Join
You can't use a custom lookup relationship to join an activity to other objects in a custom report.

Let Your Users Control Task Notifications Globally

Users can now control notification emails for all of their task assignments. This new setting replaces the checkbox on the Create Task
page that triggers an email to the assignee of the task. The user setting is exposed by default. You can hide the setting from users. Either
option has specific effects on users of Salesforce1 and the full Salesforce site, on Communities users, on partner portal users, on users
who are assigned tasks via workflow task rules, and on users who are assigned tasks that are generated by the triggerUserEmail
field.

Settings

Organization Setting (Enabled by Default)
To hide the user setting, in Setup, click Customize > Activities > Activity Settings and deselect Enable user control over task
assignment notifications.

@ Important: If you migrate an organization, consider disabling Enable user control over task assignment notifications
to avoid excessive email notifications.

User Setting (Exposed by Default)
Users can disable email notifications for task assignments by going to My Settings > Reminders & Alerts > Events and Tasks
and deselecting Email me when someone assigns me a task.

Effects of Exposing and Hiding the User Setting

Users Affected Effects of Exposing the User Setting Effects of Hiding the User Setting
Salesforce users, including Communities  In My Settings > Notifications, the In My Settings > Notifications, the
users Assigns you a task checkbox remains as  Assigns you a task checkbox is removed.

IS.

Users of the full Salesforce site, including

e Onthe Create Task page, the Send e Onthe Create Task page, the Send
Communities users

email notification and Make this the email notification and Make this the
default setting checkboxes are default setting checkboxes remain as
removed. they are, and users receive email
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Users Affected

Partner portal users

Users who are assigned tasks that are
generated by workflow task rules

Users who are assigned tasks through the
API

@ Important: An APl must be used to
setthe triggerUserEmail
value. The default value for
triggerUserEmail isfalse.

Default Behavior Changes
Self-Assigned Tasks

Let Your Users Control Task Notifications Globally

Effects of Exposing the User Setting

e In My Settings > Reminders &
Alerts > Events and Tasks, the Email
me when someone assigns me a task
checkbox is added, and it's selected by
default.

e On the Create Task page, the Send
email notification and Make this the
default setting checkboxes are
removed.

e Usersreceive email whenever someone
assigns them a task (partner portals
have no settings page for administrators
or users).

e Onthe New Task page for workflow
tasks, the Notify Assignee checkbox is
removed.

e Evenifan administrator selected the
Notify Assignee checkbox before
Winter '15, task assignees who use the
new setting to suppress task assignment
email notifications no longer receive
any notifications.

If triggerUserEmail =true,then
email notifications are sent according
to individual users’ settings.

e [ftriggerUserEmail =false then
email notifications are not sent when a
task is assigned.

If you create a task and assign it to yourself, no notification is sent to you.

Closed Tasks
Notifications are not sent for closed tasks.
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Effects of Hiding the User Setting

notifications according to whether the
checkboxes are selected.

e No user setting is added.

On the Create Task page, the Send email
notification and Make this the default
setting checkboxes remain as they are, and
users receive email notifications according
to whether the checkboxes are selected.

Task assignees continue to receive email
notifications according to workflow task
rules.

e |FtriggerUserEmail =true then
email notifications continue to be sent
to all users when tasks are assigned.

e [ftriggerUserEmail =false then
email notifications are not sent when a
task is assigned.



Sales Salesforce Console for Sales

Salesforce Console for Sales

The Salesforce Console for Sales gives you easy access to sales intelligence in a dashboard that
means more access to contextual data with fewer clicks and less scrolling.

EDITIONS

Available in: Enterprise,

Salesforce Console Enhancements Performance, Unlimited,
and Developer Editions with

The Salesforce Console for Sales and the Salesforce Console for Service share new features that help the Service Cloud

administrators ahd developers customize the console for users. For more information, see Salesforce Available in: Performance

Console for Service and Developer Editions with
the Sales Cloud

Other Changes in the Sales Cloud Available in: Enferprise and

Unlimited Editions with the
Sales Cloud for an additional
cost

We've made additional changes to Sales cloud features to improve usability.

Person Accounts Can Be Included in Packages
Now, you can include Person Account components and attributes in managed and unmanaged
packages.

New Associated Items Transferred with Changes in Record Ownership
When records are transferred between members of your sales team, additional items associated with those records are also transferred.

Record Type Associated ltems That Are Also Transferred

Accounts Orders with Draft status that are associated with either a transferring contract or no contract
Contracts Orders with Draft status

Orders Open tasks and future events (only applies if neither the old nor new owner is a queue)

Field Added to Order Object
The Order object has a new field: Owner.

Account and Contract Fields on Orders Can Be Updated
Orders are more flexible now that your sales team can update the Account and Contract fieldson orderswith Draft status.
The Account field can be updated as long as any contract associated with the order is also associated with the new account. The
Contract field can be updated as long as the following conditions are true.

e The account associated with the order is the same as the account associated with the new contract.
e The currency associated with the order is the same as the currency associated with the new contract.
e Ifthe order has an associated price book, that price book is also associated with the new contract.

Labels Changed in User Settings
In My Settings, under Calendar and Reminders, the Reminders page has been renamed Reminders & Alerts, and the heading “Tasks
and Events” has been changed to “Events and Tasks”. In My Settings in Communities, the page Reminders has been renamed
Reminders and Alerts, and the label “Reminders for tasks and events” has been changed to “Reminders and alerts for events and
tasks”. In addition, the paragraph explaining the reminder window has been edited for clarification on both My Settings pages.
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Sales Other Changes in the Sales Cloud

Interaction Flow Changed for Private Events
Before Winter ‘15, when a user viewed an event related to another record, the Private checkbox on the event edit page was enabled

even though an event related to another record can't be private. If a user selected the checkbox and tried to save the record, Salesforce
displayed an error message. Now when an event is related to another record, the Private checkbox is hidden.

Resources Released When Events Are Deleted
Before Winter 15, when you deleted an event, related resources remained related to the event, but they simultaneously became

available for booking on another event. If you booked one of those resources on a different event and then undeleted the original
event, an erro message would say that the resource had been double-booked. Now resources are removed when an event s deleted;

if you undelete the event, you must book resources again.

In Enterprise Edition, Create New Custom Split Types to Better Reflect Your Business Process
Have a custom currency that you haven't been able to use with Opportunity Splits? Want to make splits available in all your
opportunities? Now you can. In Summer "14, Custom Field Splits was released for Unlimited, Performance, and Developer Editions.

In Winter "15, we're making this feature available in Enterprise Edition, too.
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WORK.COM

Help managers and teams learn faster and perform better with Work.com, a suite of sales-management and service-management tools
that boost performance with simple, customizable features including goals, real-time coaching, rewards, and performance reviews.

IN THIS SECTION:

Manage Thanks Badges with the Badges Tab
Sales teams can better manage their Thanks badges using the new Badges tab. Badges work like standard Salesforce objects, so you
have more options for customizing them, like adding custom fields.

Deploy Performance Summary Cycles More Effectively

Performance cycle managers can deploy performance cycles more effectively with new functionality, including the automatic removal
of inactive users from a deployment cycle.

Suggest Skills Automatically to Users

Increase your organization’s engagement with Skills by activating the Suggested Skills feature. This feature automatically suggests
skills based on a user's related Chatter topics. For example, if an account executive has a lot of posts with the topics “Contract
Negotiation” and “Forecasting,” these topics will emerge as Suggested Skills on the account executive's Chatter profile. The Suggested
Skills feature is a great way of increasing the use of Skills in your organization or rolling it out for the first time.

Measure Your Work Better with Enhanced Goals (Pilot)

Easily create goals to define, track, and measure your work on both Salesforce1 and on the desktop. The Enhanced Goals feature
gives you more control over goals and metrics, and allows them to be customized like other Salesforce objects.

Other Changes in Work.com
There are other important changes in Work.com.
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Work.com Manage Thanks Badges with the Badges Tab

Manage Thanks Badges with the Badges Tab

Sales teams can better manage their Thanks badges using the new Badges tab. Badges work like
. ) . . . EDITIONS
standard Salesforce objects, so you have more options for customizing them, like adding custom

fields. Available in: Professional,

Enterprise, Performance,
Unlimited, and Developer
Editions

Recognition requires a
license to Work.com
Motivate, Work.com Align,
or Work.com Perform,
which are available as
add-on licenses for
Professional Edition,
Enterprise Edition,
Unlimited Edition, or
Developer Edition, and are
included in Performance
Edition.

Profile Chatter People Reward Fund Reward Fund Type Feedback Coaching Performance Calibration +
Badges Help for ths Page @
W Home I

View: Al v][Got | Grate New View

&% All About Execution

&% Top Performer New Recently Viewed ¥

BCen I8 e

&% Teacher Recent Badges —

ﬁ HotlLead Badge Name Description Created By

% KeyWin

Competition Crush . . . .

itk Compefition Crusher All Apout Execution Like the mailman, you deliver! Allser

#% Customer Hero

&% Deal Maker

&% Cold Star

lop Femarmer i ! 4
&% Thanks Top Pedormer Faor crushing your numbers Allser
@ Recycle Bin @ Teacher For sharing your knowledge Alser
@ Hot Lead Thank you for your hot lead! Allser

Sales teams can access their library of badges from the Badges tab, where they can also create new badges. From the Chatter publisher,
your users can pick from the badges displayed or search for badges by name. Users are currently limited to giving badges to one user
at a time from the Chatter publisher and can no longer give badges from the Recognition tab.

The top-level Recognition tab now shows information already displayed on the Recognition subtab of user profiles, so we recommend
removing the tab from the Work.com app. See “Editing App Properties” in the Salesforce Help.
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Work.com Deploy Performance Summary Cycles More Effectively

With the new Badges tab, users automatically leverage additional Salesforce features. For example, users can now search for badges in
global search. Administrators can also create custom fields for badges.

Additional action must be taken to allow community users to continue to access company badges. To allow community users to give
company badges, deselect the Company Badge field and edit the badge access to include all internal and external users. Then, reselect
the Company Badge field for the badge.

Users also have more control over badges in Salesforce1. For more information about Thanks in Salesforce1, see Salesforce1 Enhancements.

Deploy Performance Summary Cycles More Effectively

Performance cycle managers can deploy performance cycles more effectively with new functionality,

. : . o EDITIONS

including the automatic removal of inactive users from a deployment cycle. -

Having inactive users in a performance summary cycle no longer prevents deployment. Instead, Available in: Professional,
when a performance cycle manager deploys a performance summary cycle, inactive users are Enterprise, Performance,
automatically removed and the cycle is deployed. When deployment is complete, we'll send you Unlimited, and Developer
a detailed email that describes the cycle deployment and any users that were removed. Performance Editions

cycle managers can add them back again later, if necessary. Performance summaries
Performance summary cycles can now support more users and cycle actions run more quickly. require a license fo

Further, users with the proper permissions can now also search for performance summary cycles Work.com Perform, which
with global search. is available as an add-on

license for Professional
Edition, Enterprise Edition,
Unlimited Edition, or
Developer Edition, and is
included in Performance
Edition.
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Work.com

Suggest Skills Automatically to Users

Suggest Skills Automatically to Users

Increase your organization’s engagement with Skills by activating the Suggested Skills feature. This
feature automatically suggests skills based on a user's related Chatter topics. For example, if an
account executive has a lot of posts with the topics “Contract Negotiation” and “Forecasting,” these
topics will emerge as Suggested Skills on the account executive’s Chatter profile. The Suggested
Skills feature is a great way of increasing the use of Skills in your organization or rolling it out for
the first time.

1. From Setup, click Customize > Work.com > Settings.
2. (lick Enable under Enable Suggested Skills.
3. C(lick Save.

EDITIONS

Available in: Professional,
Enterprise, Performance,

Unlimited, and Developer
Editions

Skills requires a license to
Work.com Motivate,
Work.com Align, or
Work.com Perform, which
are available as add-on
licenses for Professional
Edition, Enterprise Edition,
Unlimited Edition, or
Developer Edition, and are
included in Performance
Edition.

USER PERMISSIONS

To enable Work.com
seftings:
e "Customize Application”

Measure Your Work Better with Enhanced Goals (Pilot)

Easily create goals to define, track, and measure your work on both Salesforce1 and on the desktop.
The Enhanced Goals feature gives you more control over goals and metrics, and allows them to be
customized like other Salesforce objects.

@ Note: The Enhanced Goals feature is currently available through a pilot program. For more
information on enabling Enhanced Goals, contact Salesforce.
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Enterprise, Performance,

Unlimited, and Developer
Editions

Goals requires a Work.com
Align or Work.com Perform
license, which are available
as add-on licenses for
Professional Edition,
Enterprise Edition,
Unlimited Edition, or
Developer Edition, and are
included in Performance
Edition.



Work.com Other Changes in Work.com

ups F*-- ‘'--=- %---——=*— “pntacts Opportunities Reports Dashboards Products Forecasts | < | Metrics  +
2014 Goals - All

2014 Goals - Manager View

l 4 2014 Goals - My Goals Edit| Delete | Create New View
2015 Goals - Planning

New Goal| | Filter|| Sort | |F ) AlB|c|D|EIF|IGIHIIIJ|KILIM|N|OIP|Q|R|S|T|U
Action Goal Name t Owner Name Status Due Date
Edit| Del | g Develop Team Perkins, Dan Draft 12/31/2014
Edit| Del | €D }w Hit Q3 Sales Targets Perkins, Dan Draft 8/31/2014

Edit| Del | €9 q Onboard New Reps Perkins, Dan Draft 7/31/2014

Enhanced Goals look, feel, and act more like other Salesforce objects, and users can leverage additional Salesforce features. For example,
administrators can create customizable fields, layouts, actions, and list views related to goals.

Metrics are tied to individual goals, and users can now share metrics or create activities for individual metrics.

Goals and metrics are also available on Salesforce1, where users can review, edit, and create new goals and metrics.
Note the following limitations:

e Enhanced Goals does not currently support data from existing goals and metrics.

e Overall goal progress, metric weighting, and linking metrics to reports are not supported.

e Metrics are not yet supported in Coaching or Performance Summaries.

Other Changes in Work.com

There are other important changes in Work.com.

Get More Out of Salesforce1
Edit profile pictures, access reward funds, create new skills, and search and filter Thanks badges from Salesforce1. For more information,
see Salesforcel Enhancements on page 54.

Display Multi-Language Text and Local Dates and Numbers
The text for Work.com features can now appear in different languages according to a user's Language setting. Additionally, dates
and numbers have been localized to support international users according to their Locale setting. For example, Germany uses
commas for decimal delimiters instead of periods, and many countries use the dd/mm/yy date format instead of mm/dd/ yy.
For more information about available languages, see “What languages does Salesforce support?”in the Salesforce Help.

Manage Performance Summaries with the API
Use the SOAP APl to do any of the performance summary actions available within Salesforce. Work.com Perform objects work more
like standard Salesforce objects, so you also have more options for customizing them.

Unendorse Skills from Chatter Profiles
Unendorse a user's skill directly from their Chatter profile. Click dg on the skill you'd like to unendorse.
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DATA.COM

Data.com s the solution for delivering leading business data inside Salesforce. The Data.com product suite includes Data.com Prospector
and Data.com Clean, as well as relatedData.comfeatures: Social Key, Data.com Reports, and Data.com Data Assessments.

IN THIS SECTION:

Companies with a Wrongly Created D-U-N-S Number No Longer Shown in Data.com
We've made sure that companies with a wrongly created D-U-N-S number are removed from Data.com. As a result, you'll be getting
the most up-to-date information from Data.com.

Data.com APl Enhanced
We've made enhancements and added new functionality to the Data.com API.

Companies with a Wrongly Created D-U-N-S Number No Longer Shown
in Data.com

We've made sure that companies with a wrongly created D-U-N-S number are removed from _
Data.com. As a result, you'll be getting the most up-to-date information from Data.com. USER PERMISSIONS
After Data.com deletes a company from its database, the company will: To implement Data.com:

e No longer be shown in your Data.com search results. Customize Application

e Nolonger be matched to your Salesforce account or lead records by Data.com Clean.
If a Salesforce account or lead record was matched to a deleted company, the record’s clean status will change to Not Found when

the record is cleaned, either manually or by automated jobs. If you want to find a new match for the record, delete the value in the
D-U-N-S Number field before cleaning it.

(For Premium customers) Because a deleted company no longer appears in Data.com, its corresponding D&B Company record in
Salesforce cannot be refreshed manually or by automated jobs. If you no longer want to retain a D&B Company record in Salesforce, go
to the D&B Company record detail page and click Delete.

Data.com API Enhanced

We've made enhancements and added new functionality to the Data.com API.
Improved search experience with Data.com Search API
FirstName and LastName are now visible

In previous releases the FirstName and LastName fields were hidden. Starting in version 32.0 the FirstName and
LastName fields are visible in all records.

SELECT CompanylId,CompanyName,ContactId,Email, FirstName, LastName
FROM DatacloudContact
WHERE CompanyName = 'Whirlpool Corporation'

147



Data.com

Companyld  CompayName Contactid

1 235198
2 235198
3 235198
4 235198
5 235198

Data.com Search API

Whirlpool 39232540
Corporation
Whirlpool 15749241
Corporation
Whirlpool 38505491
Corporation
Whirlpool 38505502
Corporation
Whirlpool 38505512

Corporation

Email

Fexxxx@whirlpool.com

satish_kona@whirlpool.com

Frxx@whirlpool.com

Fexxxx@whirlpool.com

Fexxxx@whirlpool.com

FirstName
Michael

Satish

Jenney

Mark

Marie

Data.com API Enhanced

LastName

Farrington

Kona

Collings

Hallmark

Lerud

Searchonthe ParentOrHgDunsNumber field to identify corporate hierarchies. Retrieve the IsParent field to determine
whether a company is a parent company.

SELECT Companyld,Name, IsParent, ParentOrHgBusinessName, DunsNumber
FROM DatacloudDandBCompany
WHERE ParentOrHgDunsNumber = '001024314'

CompanylId Name

1 2224476
2 4239956
3 137692
4 4827310
5 129002

Burlington Northern Santa
Fe, LLC

National Liability & Fire
Insurance Company

Berkshire Hathaway Inc.

International Dairy Queen,
Inc.

The Lubrizol Corporation

New purchase and match APIs

Data.com Purchase API

IsParent ParentOrHgBusinessName

true

false

true

true

true

Berkshire Hathaway Inc.

Berkshire Hathaway Inc.

Berkshire Hathaway Inc.

Berkshire Hathaway Inc.

Berkshire Hathaway Inc.

DunsNumber

927824730

057830879

001024314

022905608

004172565

Purchase Data.com contact or company records in a single API call. The Data.com Purchase APl is a Connect-based API that's used
to purchase Data.com contact or company records, retrieve record details, and get purchase details about specific orders.

Data.com DUNSRight Match API
Match companies by DUNS numbers and other key fields. The Data.com DUNSRight Match APl uses a unified match API call pattern.
Match options can now be specified in the POST body instead of the URL.

Data.com Social Profile Match
The Data.com Social Profile Match API uses a unified match API call pattern. Match options can now be specified in the POST body
instead of the URL. Match Data.com contact records that use LinkedIn and Twitter social handles.
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Data.com Data.com APl Enhanced
@ Important: The Data.com Social Profile Match API doesn't work with Developer Edition.

You need a Data.com Full Clean license to use the Data.com Social Profile Match API.

For more information, see Data.com APl Developer's Guide.
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SERVICE

Salesforce’s Service Cloud gives you the tools to provide a comprehensive customer service experience to your customers.

IN THIS SECTION:

Case Feed

Case Feed gives support agents a more streamlined way of creating, managing, and viewing cases. It includes publishers, which let
agents create case notes, log calls, change the status of cases, and communicate with customers in a Chatter-like feed.

Case Management

Use cases to receive, track, and resolve customers’ issues.

Email-to-Case
Email-to-Case helps your company efficiently receive and resolve cases via email.

Salesforce CTlI Toolkit

The Salesforce CTI Toolkit helps partners build adapter programs that call center users install on their machines to integrate Salesforce
with computer-telephony integration systems.

Knowledge

Salesforce Knowledge is your Knowledge Centered Support certified knowledge base.

Salesforce Console for Service

The Salesforce Console for Service is an app that's designed for users in fast-paced environments who need to find, update, and
create records quickly to support their customers.

Service Communities

Community Templates for Self-Service, Chatter Answers, and Ideas provide customers with self-service communities where they
can post questions and receive answers from other customers or support agents, as well as post, vote for, and comment on discussions.
Social Customer Service

Social Customer Service is the next-generation integration between Radian6 and the Salesforce Service Cloud. Customer service
agents can engage with their customers by responding to cases created from Twitter and Facebook. Salesforce Adminstrators can
customize how the inbound social content is processed using an Apex class and they can configure who in their organization has
permission to respond using social accounts.

Other Changes in Service Cloud

There are other important changes in the Service Cloud.

Case Feed

Case Feed gives support agents a more streamlined way of creating, managing, and viewing cases. It
includes publishers, which let agents create case notes, log calls, change the status of cases, and
communicate with customers in a Chatter-like feed.

EDITIONS

Available in:

e Enterprise

e Performance
e Unlimited

e Developer
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Service

Show Agents More Case Information in Less Space with

Compact Feed

IN THIS SECTION:

Show Agents More Case Information in Less Space with Compact Feed

With compact feed enabled, support agents working in the Salesforce console can see much more information about cases with
less scrolling, making it easier to get the full history of a case and resolve customers’ issues more quickly.

Add and Work with Addresses More Easily in Case Feed Email Messages

Support agents who use the Email action in Case Feed can now search for addresses by name, see whether an address is associated
with a contact or a user, and hover over an address to see more details for it.

Rename the Email and Community Case Feed Actions

Change the names of the Email and Community (formerly Portal) actions in Case Feed based on the terms your company uses,
making these actions more familiar to agents.

(Case Feed Files Component Supports Drag-and-Drop
Support agents can drag files onto the Case Feed files component to quickly and easily add them as case attachments.

Other Changes in Case Feed
The additional changes to Case Feed in Winter '15 give you more customization options and make setup easier.

Show Agents More Case Information in Less Space with Compact Feed

With compact feed enabled, support agents working in the Salesforce console can see much more information about cases with less
scrolling, making it easier to get the full history of a case and resolve customers’ issues more quickly.

& 00001006 + -

Having trouble with my NX-15 unit

Topics
The red light on the front of the unit flashes for about 30 seconds after power on, and then stays solid. v

Unit Flaghes X Red Light *

Email Loga Call Community Change Status Maore = L J

Q. | Show AllUpdates Files o Al

Karen Williams created an attachment. Today at 10:41 AM |- v

@ - o
MR, Closing Cases.png Closing Cases.png support_agents.pdf

L
e Karen Williams support_agents. pdf & Today at 10:29 AM FIT example.png
e Karen Williams FIT example.png & Today at 10:38 AM Experts
Mo Experts

Karen Williams @Joe Philips, is this similar to the oth... August 5, 2014 at 3:30 FM

e Karen Williams changed Status from New to On Hold. August 5, 2014 at 3:12 PM

eo Karen Williams Follow up by phone August 5, 2014 at 3:11 PM

In addition to a sleeker feed, compact feed also includes an updated look and feel for the overall feed view. For a detailed look at the
differences between compact feed and the standard feed view, see Show More Information in Less Space with Compact Feeds on
Feed-Based Layouts on page 202.

Compact feed is available only on feed-based page layouts, and only when agents view records in the Salesforce console. It is not available
on legacy page layouts for Case Feed users and isn't supported on Internet Explorer 7 or 8.
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Service Add and Work with Addresses More Easily in Case Feed
Email Messages

To enable compact feeds, from the Feed View settings page for a feed-based case page layout, select Enable Compact Feed
View in the Console.

@ Note: This option is available only if you've enabled Publisher Actions and have selected Use Page Layout Editor to
Configure Actions onthe Feed View settings page.

For more information on creating and working with feed-based case page layouts, see “Create and Edit Feed Layouts in Case Feed” in
the Salesforce Help.

Add and Work with Addresses More Easily in Case Feed Email Messages

Support agents who use the Email action in Case Feed can now search for addresses by name, see whether an address is associated
with a contact or a user, and hover over an address to see more details for it.

When agents write email messages, they can start typing a name (1) to see email addresses associated with that name. In the list of
suggested email addresses—those that match either a name or an address an agent types—agents can see which are associated with
contacts and which are associated with users (2).

To |’ 4 Helen Ingersoll x \| o [ﬂ
Joe Philips <ewilska@salesforce.coms (User) @

Jon Amos <info@glebalmediato. com= (Contact)

Bee

Once agents select an email address to add to the To, Cc, or Bcc line, they can hover over it to see detailed information for it.

To \’zHeIen Ingersoll x | | AJon Amos X |
ce \ Contact View | | Edit
Beco Hame  Jon Amos
Account Name Clobal Media
Subject Having trouble with my NX-15 unit

Rename the Email and Community Case Feed Actions

Change the names of the Email and Community (formerly Portal) actions in Case Feed based on

‘ : " USER PERMISSIONS

the terms your company uses, making these actions more familiar to agents.

For example, if your company refers to emails as “messages” and the community as “Customer To rename actions and feed

Central,” you could rename the Email action Send Message and the Community action Customer filters:

Central. e “Customize Application”
OR
“View Setup and
Configuration”
AND
Designation as a
translator
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Service Case Feed Files Component Supports Drag-and-Drop

Email |Send Message
Loga Call Log a Call
Community |Customer Central

For more information on changing the names of actions, see “Rename Actions and Feed Filters in Case Feed” in the Salesforce Help.

Case Feed Files Component Supports Drag-and-Drop

Support agents can drag files onto the Case Feed files component to quickly and easily add them as case attachments.

Files Show All

s

Drag and Drop Files Here

Files added by drag-and-drop become case attachments.

Drag-and-drop functionality in the files component is available only on browsers that support HTMLS.

Other Changes in Case Feed

The additional changes to Case Feed in Winter '15 give you more customization options and make setup easier.

Email Feed Filter Has Been Renamed
We've changed the name of the Email feed filter to All Emails.

Show All Updates
‘ All Updates
Status Changes
call Logs
j Case Notes
Portal Answers
Tasks and Events

SORT B

‘ ¥ PostDate

Most Recent Activity

You can rename this and all other feed filters on the Rename Tabs and Labels page for cases. For more information, see “Rename
Actions and Feed Filters in Case Feed” in the Salesforce Help.
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Service Case Management

Portal Action Has Been Renamed
We've changed the name of the Portal action to Community.

Email Log a Call Community Change Status Mare -

In addition, you can now rename the Community action. For more information, see Rename the Email and Community Case Feed
Actions on page 152.

Feed View Settings Page for Feed-Based Case Page Layouts Has Been Reorganized
We've made some changes to the Feed View settings page to make it easier to quickly find and enable feed- and publisher-related
options like full-width feed and the new compact feed.

Feed View Options
Enable Full-Vidth Feed View in the Console

Enable Compact Feed View in the Console | ;

LY

Publisher Options

Use Page Layout Editor to Configure Actions |

LY

Automatically Collapse Publisher | ;

LY

e We've moved feed-related options to their own section at the top of the page.

e Previously, we hid the feed view and publisher options that require Use Page Layout Editor to Configure
Actions tobe enabled when that setting wasn't enabled. Now we show all of these options and simply grey out those that
aren't available until you enable Use Page Layout Editor to Configure Actions.

e We'verenamed Use Full-Width Feed in the Console to Enable Full-Width Feed in the
Console.

Case Management

Use cases to receive, track, and resolve customers’ issues.

EDITIONS

IN THIS SECTION: Available in:

e Group

e Professional
e Enterprise

e Performance
The Web-to-Case HTML Generator Has a New Location in Setup e Unlimited
The Web-to-Case HTML Generator is now located in its own node in Setup, under Customize > * Developer
Self-Service > Web-to-Case HTML Generator.

Customize Web-to-Case Email Notifications

Decrease the risk of data leaks through Web-to-Case email notifications with the Hide Record
Information and Email Signature auto-response email settings.

154



Service Customize Web-to-Case Email Notifications

Customize Web-to-Case Email Notifications

Decrease the risk of data leaks through Web-to-Case email notifications with the Hide Record Information and Email Signature
auto-response email settings.

Automated email notifications often contain information that your customers don't want to be publicly available. When case creation
fails in the Web-to-Case process, customers receive an email notification. You can now hide the customer-entered data in the email
notification when case creation fails with the Hide Record Information option. You can also customize the signature information with
the Email Signature option.

You can customize Web-to-Case auto-response email settings from Setup > Customize > Self-Service > Web-to-Case.

For more information on Web-to-Case settings, see “Set Up Web-to-Case” in the Salesforce Help.

The Web-to-Case HTML Generator Has a New Location in Setup

The Web-to-Case HTML Generator is now located in its own node in Setup, under Customize > Self-Service > Web-to-Case HTML
Generator.

Prior to Winter '15, the Web-to-Case Generator was located in Setup, under Customize > Self-Service > Web-to-Case.

Use the Web-to-Case HTML Generator tool to generate HTML code that your webmaster can insert into your company's website to
capture cases in a Web form. Whenever someone submits information on any of those Web pages, a case will be created.

For instructions on generating Web-to-Case HTML code, see Generate Web-to-Case HTML Code in the Salesforce Help.

Email-to-Case

Email-to-Case helps your company efficiently receive and resolve cases via email.

EDITIONS

IN THIS SECTION: Available in:

e Professional

e Enterprise

e Performance
Unlimited

e Developer

Include Additional Email Addresses on Email-to-Case Auto-Response Messages

You can now send Email-to-Case auto-response messages not only to the customer who
submitted the case by email, but also to any email addresses included on the To or Cc line of
the original message. Use this option to make sure that the auto-response reaches everyone
the customer wants to include on the email thread for their issue.

Include Additional Email Addresses on Email-to-Case Auto-Response
Messages

You can now send Email-to-Case auto-response messages not only to the customer who submitted the case by email, but also to any
email addresses included on the To or Cc line of the original message. Use this option to make sure that the auto-response reaches
everyone the customer wants to include on the email thread for their issue.

For example, a customer might submit a case about a problem with the copier in his office before leaving the office for the weekend.
That customer might Cc colleagues who will be on site over the weekend and are available to work with your support department to
resolve the issue. If you've enabled the option to include Cc'ed addresses on the auto-response message sent when the case is created,
the customer’s colleagues will receive the case number and can be included on other emails about the issue, making it more likely the
case can be resolved and closed quickly.
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To enable this option, select Send response to all recipients on therule entry edit page for an Email-to-Case
auto-response rule. For more information, see “Set Up Auto-Response Rules” in the Salesforce Help.

Salesforce CTI Toolkit

The Salesforce CTl Toolkit helps partners build adapter programs that call center users install on
‘ . . . . . EDITIONS
their machines to integrate Salesforce with computer-telephony integration systems.
Available in:
IN THIS SECTION: *  Professional

e Enterprise

e Performance
e Unlimited

e Developer

Retirement of Support for the Salesforce CTl Toolkit

After the Summer '15 release, Salesforce will no longer provide support for all versions of the
Salesforce CTl Toolkit.

Retirement of Support for the Salesforce CTI Toolkit

After the Summer '15 release, Salesforce will no longer provide support for all versions of the Salesforce CTI Toolkit.

The toolkit helps partners build adapter programs that call center users install on their machines to integrate Salesforce with
computer-telephony integration systems. We understand that retiring support for this feature might cause a disruption for partners. But
we strongly encourage partners to move to Open CTl at their earliest convenience so that they can provide greater value to their customers
and the Salesforce community.

Knowledge

Salesforce Knowledge is your Knowledge Centered Support certified knowledge base.

EDITIONS

IN THIS SECTION: )
Salesforce Knowledge is
Monitor Salesforce Knowledge Search Activity available in Performance
We've added a new article-related primary object that you can use to build custom report types and Developer editions.
for your knowledge managers. Reports that are created by using custom report types that Salesforce Knowledge is
support the Knowledge Search Activity object give knowledge managers better available for an additional
insight into the performance of Salesforce Knowledge articles in searches. This data helps cost in Enterprise and
knowledge managers identify ways to deliver the most relevant content to end users. Unlimited editions.

Next-Gen Knowledge Search Gives Users More Relevant Article Search Results (Generally
Available)

We've unveiled a major search engine upgrade, bringing you faster, smarter search with results that are more relevant. If you have
enabled Salesforce Knowledge, you can take advantage of capabilities such as promoted search terms, searches that automatically
use the most effective operator, and additional synonym features to enhance the search experience for your agents and customers.
Search Highlights and Snippets

Quickly identify the best article and see how articles match your search terms with relevant text and highlighted search terms in the
search results.

Promoted Knowledge Results Give Knowledge Managers More Control over Articles in Search Results (Generally Available)

Knowledge managers can promote an article in search results by associating keywords with the article. End users who search for
these keywords see the article first in their search results. Promoted search terms are useful for promoting an article that you know
is commonly used to resolve a support issue when an end user’s search contains certain keywords.
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Send Article Content via Email (Pilot)

When using Knowledge One, agents can send an email with an externally facing article’s contents embedded in the body of the
email.

Rich Text Editor Upgrade

As part of a cross-product initiative, Salesforce Knowledge has upgraded the rich text editor.

Improved Look and Feel for Knowledge One
Knowledge One has a new look and feel for a better user experience and to match the new Salesforce Console user interface.

Monitor Salesforce Knowledge Search Activity

We've added a new article-related primary object that you can use to build custom report types
for your knowledge managers. Reports that are created by using custom report types that support
the Knowledge Search Activity object give knowledge managers better insight into To create or update custom
the performance of Salesforce Knowledge articles in searches. This data helps knowledge managers report types:

identify ways to deliver the most relevant content to end users. *  “Manage Custom Report
Types”

USER PERMISSIONS

@ Nofte: Creating a custom report type to report on Salesforce Knowledge article data doesn't
require a Salesforce Knowledge license. However, the visibility of custom report types in the
report wizard is controlled by users’ access to the data in the report type.

To create a public reports
folder:

e "Manage Public Reports”
a= Walk Through It: Create a Knowledge Search Activity Report Type

For more information about creating a custom report type to report on Salesforce Knowledge article
data, see Article Reports in the Salesforce Help.

Available Fields

To see the fields custom report types based on the Knowledge Search Activity objectcaninclude, see “Fields Available on
Salesforce Knowledge Reports” in the Salesforce Help.

For more information about adding or removing fields, see “Design the Field Layout for Reports Created From Your Custom Report Type”
in the Salesforce Help.

Actionable Data for Knowledge Managers

Ultimately, the goal of analysis is action. By analyzing trends, comparing numbers, and gauging performance, you identify problem areas,
set expectations, and recognize value. For knowledge managers, metrics that quantify their department’s contributions are key to
increasing the department’s performance, improving planning and control cycles, and ensuring accountability.

Reports that are built by using custom report types with the Knowledge Search Activity object canreveal these insights:
e Analyze the number of searches per day, month, or year for each channel and language..
e Foreach search, see the:

- Date

-~ ID and title of the article that was clicked

e See which keywords users are looking for in your knowledge base.
e Foreach keyword, see the average number of:
- Results

— Articles that appear in the search results
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Arficle Search Results (Generally Available)

e Foreach article, see the average number of:

- Clicks

- Unique users who clicked it

@ Example: A knowledge manager in your organization might see that searches for a popular keyword don't return expected
results, or any at all. Armed with that information, she could create more articles on that topic, add promoted results to boost the
content that should appear, update articles with that keyword, or add a synonym group to link that keyword to the term that
content creators have been using to refer to the topic.

Next-Gen Knowledge Search Gives Users More Relevant Article Search
Results (Generally Available)

We've unveiled a major search engine upgrade, bringing you faster, smarter search with results that are more relevant. If you have
enabled Salesforce Knowledge, you can take advantage of capabilities such as promoted search terms, searches that automatically use
the most effective operator, and additional synonym features to enhance the search experience for your agents and customers.

These enhancements were previously available only through a pilot program.
Take advantage of these improvements and new search capabilities.

Faster indexing
It takes less time for records to be searchable after they're created or updated.

Improved alphanumeric search
Thanks to more efficient handling of punctuation, we've improved search results when you search for specialized strings such as
URLs, email addresses, and phone numbers. Certain leading or trailing punctuation symbols are now removed if they surround a
tokenizedstring: <>[]{} () !,.;:""'.Forexample, (415) istokenizedas475.We remove these symbols fromindexed content
and from users’ search queries, making it easier for the search engine to recognize when a user is searching for a phone number, for
example.

Improved tokenization
We've significantly improved tokenization. The search engine breaks down all searchable text into smaller pieces, or tokens, at
meaningful boundaries (spaces, punctuation, and alphanumeric characters) and stores them in the search index. Proper tokenization
is essential for accurate search results in any language, and especially so for East Asian languages that are written without spaces
between words, such as Chinese, Japanese, Korean, and Thai (CJKT).For details, see Users Searching in Chinese, Japanese, Korean,
and Thai Find Optimized Results on page 159.

IN THIS SECTION:

Users Searching in Chinese, Japanese, Korean, and Thai Find Optimized Results

Organizations that search in Chinese, Japanese, Korean, and Thai (CJKT) languages are uniquely affected by the Salesforce Knowledge
search enhancements. Besides tokenization, we've enhanced punctuation handling and added support for stemming.

Users Searching Articles Get a Smart Default AND/OR Operator
When users don't specify an operator in an article search, the search engine will determine the best operator to use. Users are no
longer required to enter a search operator to see the most relevant results for their search terms.

Search Operators Can't Be Defined as Synonyms
When you define synonyms, you can't use AND, OR, and AND NOT because they're reserved for use as search operators.

Improve Search Effectiveness by Enabling Synonym Matching for Trailing Wildcards in Search Terms

With synonym matching for searches that include a trailing wildcard, your users get what they need faster when they search in
Salesforce Knowledge articles, questions and answers, ideas and idea comments, and cases and case comments.
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Users Searching in Chinese, Japanese, Korean, and Thai Find Optimized Results

Organizations that search in Chinese, Japanese, Korean, and Thai (CJKT) languages are uniquely affected by the Salesforce Knowledge
search enhancements. Besides tokenization, we've enhanced punctuation handling and added support for stemming.

Morphological Tokenization
Akey change is the change from bigram tokenization to morphological tokenization. Previously, when indexing a string of characters,
the search engine applied bigram tokenization to segment the string into pairs of characters, known as bigrams. For example, this
string in Japanese, B ELABAITEE, would be tokenized as four bigrams: 3 3¢, 544D, A1, and HIHE. In the context of this usage, if
a user searched for 54K, the intent is to find &R, not HEHLAR. However, 3R 5¢EK would be returned in search results.

Morphological tokenization properly segments this string, B 5L ABEHIE, into three tokens: B¢, #5, and HIGF. In this context, all
three tokens are meaningful and correct, and 5%#P isn't tokenized. A search for %¢#p returns only 5E&E and not B 5L4F, as expected.

Punctuation Handling
Previously, punctuation in a string such as & > &, 2% would cause this string to be excluded from search results if a user
searched for & - &3k % . Now, this search results in a match.

Stemming Support
Stemming, or lemmatization, isimproved. For example, a search for {7 < wouldn't have previously matched on 17 & 72>, Similarly,

a search for 3 % wouldn't have previously matched on & O % 9. Now, these stemmed matches are correctly returned in search
results.

Katakana-Hiragana Prolonged Sound Marks Not Tokenized

When the Katakana-Hiragana Prolonged Sound Mark, also known as the fullwidth hyphen (—), appears in content (for example, &
V¥ a—&—),it’s excluded from indexed content. It's also removed from users’ search queries.

Limitation with Japanese Language Users who are Querying Records that are Tokenized as Chinese
If a record contains at least 300 characters in total and contains Kanji only (no Katakana or Hiragana), the content is tokenized as
Chinese. Therefore, if a Japanese language user searches for this record, it might be excluded from search results. Kanji-only records

with fewer than 300 characters are tokenized in Chinese and Japanese.

Users Searching Articles Get a Smart Default AND/OR Operator

When users don't specify an operator in an article search, the search engine will determine the best operator to use. Users are no longer
required to enter a search operator to see the most relevant results for their search terms.

Many searches use "“AND" as the default operator. This means that when you search for multiple terms, all of the terms need to match
to generate a result. Matching on all terms tends to produce search results that are more relevant than searches using the “OR” operator,
where matches on any of the search query terms appear in the results.

If the search engine doesn't return any results that match all of the terms, it looks for matches using the “OR” operator. With the “OR”
operator, the search engine boosts documents that contain more terms from the search query, so that they appear higher in the results
list.

Search Operators Can’t Be Defined as Synonyms

When you define synonyms, you can't use AND, OR, and AND NOT because they're reserved for use as search operators.

@ Example: Forexample, if you're defining synonyms for the term Automated Network Dialing, you can't define the acronym AND
as a synonym.
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Improve Search Effectiveness by Enabling Synonym Matching for Trailing Wildcards
in Search Terms

With synonym matching for searches that include a trailing wildcard, your users get what they need faster when they search in Salesforce
Knowledge articles, questions and answers, ideas and idea comments, and cases and case comments.

Contact salesforce.com Customer Support to enable synonym matching for trailing wildcards. It's disabled by default.
Synonym matching returns synonymous terms that match terms resulting from wildcard expansion, on any term in the search query
that has a trailing wildcard.
@ Example: For example, if you've defined a synonym group that contains the terms bill and invoice, a search for bi 11 * returns
matches for:
e bill
e billing (wildcard expansion)
e invoice (synonym matching)

The search term in the query must match the entire synonym and not just a part of the text. For example, a search for bi * returns
results only for:

e bill (wildcard expansion)
e billing (wildcard expansion)

It doesn't return invoice even though invoiceis in the same synonym group as bill, which is returned because of wildcard expansion.
Synonym matches are returned only for the exact search term (not for matches with defined synonyms).

Search Highlights and Snippets

Quickly identify the best article and see how articles match your search terms with relevant text and highlighted search terms in the
search results.

Search highlights and snippets gives your agents and users context as to why the particular result matched their search query.
To enable search highlights and snippets:

1. In Setup go to Customize > Knowledge > Settings.

2. (lick Edit.

3. Under Knowledge One, select Highlight relevant article text within search results.

4. C(lick Save.

The relevant text appears below the title with the search terms in bold.
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tiger woods (7]

Search results form

English = Reset

W Articles Sort by: Relevance

Swing like Tiger Woods
Eldrick Tont|*Tiger® Woods [born December 30, 1975)[4][5] is an American

professional golfer ..
Mew! « 000007684 - Knowledge Base « Last Published 7/2/2014

Play golf with tiger woods
If you want to play golf with|Tiger Woods| then you can talk to Kanishka to make it
happen. ...

Mew! « 000007685 « Knowledge Base « Last Published 7/2/2014

Learn how to play golf likg tiger woods
Mew! « 000007683 - Knowledge Base « Last Published 77272014

@ Note: Search highlights and snippets are not generated for searches with wildcards.

Search highlights and snippets are generated from the following fields:
e Email

® longtextarea

e Richtextarea

e Textarea

Search highlights and snippets aren't generated from the following fields:
e Checkbox

e Currency

e Date

e DateTime

e File

e Formula

e Lookup

e Multi-picklist

e Number

e Percent

e Phone

e Picklist

e URL
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More Control over Articles in Search Results (Generally
Avdilable)

@ Nofte: If a snippet is not generated, the article’s summary field is shown instead.

Promoted Knowledge Results Give Knowledge Managers More Control
over Articles in Search Results (Generally Available)

Knowledge managers can promote an article in search results by associating keywords with the

) e . USER PERMISSIONS
article. End users who search for these keywords see the article first in their search results. Promoted _
search terms are useful for promoting an article that you know is commonly used to resolve a To create, edit, and delete
support issue when an end user’s search contains certain keywords. promoted search terms:
This feature was previously available only through a pilot program. * "Manage Promoted

Search Terms”
View, edit, and delete—from a single page—all the promoted search terms that are associated

with Salesforce Knowledge articles.

To learn more about administering and managing promoted search terms, see “Managing Promoted Search Terms” and “Promoting an
Article in Users' Search Results” in the Salesforce Help.

Send Article Content via Email (Pilot)

When using Knowledge One, agents can send an email with an externally facing article’s contents embedded in the body of the email.

Agents can send article content within an email rather than just sending a URL, letting your customers access the information without
going to a website. Smart links and attached files are not included in email content. The article can only be shared if it is associated with
one or more non-internal Channel types.

Nofe: Sending article content via email is available through a pilot program for articles published on external channels (public
knowledge bases, portals, or communities) and is not supported on Internet Explorer 7. For information on enabling sending article
content by email for your customer service agents, contact Salesforce

To enable and setup which article fields go into emails for each article type.
1. From Setup go to Customize > Cases > Page Layout.

2. Under Page Layouts for Case Feed Users,clickthedrop-down menuin the Action column next to the layout where
you want to enable sending article content in email.

Select Edit feed view.

Under Articles Tool Settings,check Enable attaching articles inline.
Click Save.

From Setup go to Customize > Knowledge > Article Types.

Click on the label or name of the article type you'd like to share via email.

© N o U W

Under Communication Channel Mappings, click New or Edit.
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New Communication Channel Layout

Send Article Content via Email (Pilof)

Save | | Cancel

Enter Communication Channel Layout Information

el I Email Article Content
Name I Email_Article_Content i
Select Communication Channels i

Available Channels

~None-

Add

Selected Channels

Email

[
&5
Remove

Select Communication Channel Layout Fields

Available Fields

Version Number -

Is Latest Version

Visible In Internal App Add
Visible In Public Knowledge
Wisible to Customer

Visible to Partner

Created By

Last Modified Date

Last Modified By

System Modstamp

Is Master Language ~

Remaove

9. Entera Label and Name.

10. Select and add Email to the Selected Channels list.

Selected Fields

Title

Summary

Article Number Up

Last Published Date -
J
=)
Down

11. Select and add the fields you'd like included in the body of an email.

| = Reguired Information

@ Notfe: Smart links and attached files can’t be included in the email and the following fields are not supported:

e ArticleType

e isDeleted

e language

e MultiPicklist
e Picklist

e Publish Status
e Source

e Validation Status

12. Click Save.

Now, while solving customer cases, agents can insert article content into the body of an email. Anywhere agents can attach articles to
cases, such as the Knowledge One sidebar in the Salesforce Console, the Articles list in the case feed, the Article widget, or the suggested
articles in a Knowledge One search, they can email any article of that type with the body of an email by selecting Email article with
HTML in the action drop down. The article content is inserted at top of email thread or wherever the agent left their cursor. Once an
article has been emailed on the case an envelope icon appears to the left of the title.

@ Nofte: If rich text is not enabled on your case feed layout for the article type, only article text is embedded into the email and the

action changes to Email article text only.
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Rich Text Editor Upgrade

As part of a cross-product initiative, Salesforce Knowledge has upgraded the rich text editor.

All Salesforce products that use the rich text editor are upgrading to provide the best user experience.
@ Nofe: The upgraded editor doesn't support Internet Explorer versions 7 and 8 in compatibility mode

Upgraded Rich Text Editor for Chrome, FireFox, Internet Explorer versions 8, 9, 10, and 11, and Safari

[ source | | B I US L B« &

R |
El
e
i
Il

&
= = E Format = || Font ~|| size ~| A- B-

Old rich text editor for Internet Explorer versions 7 and 8 in compatibility mode

Souce & e B | U e 2 <> Eceocg J AL E=E=
= == = {=jjrot |w]|Steev]} gb- -

Improved Look and Feel for Knowledge One

Knowledge One has a new look and feel for a better user experience and to match the new Salesforce Console user interface.
The new interface is more intuitive for agents, partners and customers.

The search box and filters are more streamlined and the Create Article button is no longer green, to discourage confusion for a initiate
search button.

Searnch Saareh

I Knowledge - I Global Media 4

N Aricles Demo % Create Article - ?
My Draft

Published - English = All Article Types = A

N articies

= DEMO Genie HEM Error Codes
VWhat would you like 1o do? Troubleshooot your Wineless Geme Mini if you'ne not seeing a clear picture... DEMO

- DEMO DirectTV Ready TV
A DIRECTY Reagy TV has a chnology called RVU built in that lets you enjoy DIRECTY senvice and full HD DVR

In the Salesforce Console filters can be collapsed for better readability.
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= demo

+ Back o Suggestions Fiters =

Articles

= ("? DEMO Genie HE34 Error Codes

VWhat would you like 1o do7 Troubleshooot your Wireless
Ganie Mini if you're not seeing a clear picture... DEMO

« DEMO DirecTV Ready TV
A DIRECTV Ready TV has a technology called RVU built
in that lets you enjoy DIRECTV sarvice and full HD DVR...

« | DEMO Genie Remote Propramming
Change Passwords to ensure your data is safe during
online ransactions.

« DEMO Connect Multiple TV's to a Genie HI)' DVR
What would you like to do? Troubleshoot your Wireless
Genie Mini if you're not seeing a clear piciure...

| DEMO DirecT V Mobile App and Genie
What would you like to do? Troubleshoaol your Wirgless
Genie Mini if you're not seeing a clear piciure...

Salesforce Console for Service

Salesforce Console for Service

The Salesforce Console for Service is an app that's designed for users in fast-paced environments
who need to find, update, and create records quickly to support their customers.

IN THIS SECTION:

Salesforce Console Integration Toolkit: New Methods
Access API methods to customize a console programmatically.

Articles Suggested for Cases are More Relevant (Beta)

Agents and customers can reduce time-to-resolution with one-click access to articles that most
closely match the keywords that are used in the case subject and description. Suggested articles
are available in the Salesforce Console for Service and your portals when users view and create
cases.

Users Get the Latest Search Capabilities

Users can find what they need and manage their search results more efficiently with Smart
Search, the most up-to-date version of Salesforce search, now included in the Salesforce console.

Add the Files and Case Experts Tools as Salesforce Console Components

EDITIONS

Available in: Enterprise,
Performance, Unlimited,
and Developer Editions with
the Service Cloud

Available in: Performance
and Developer Editions with
the Sales Cloud

Available in: Enterprise and
Unlimited Editions with the
Sales Cloud for an additional
cost

Make it easy for support agents to attach files to cases and find fellow agents who are knowledgable about specific issues while

working with cases in the Salesforce console.
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Adding and Removing Case Feed Highlights Panel from the Salesforce Console Has Changed

We've updated the look of the Case Feed highlights panel when the compact feed option is selected and have changed the steps
for removing it from page layouts.

Brand Your Salesforce Console with Custom Colors (Pilot)
Now you can brand your Salesforce console by specifying the colors of the header and footer.

New Look and Feel for the Salesforce Console
We've added a new look and feel to the console, and made it easier for console users to find and edit information.

Salesforce Console Integration Toolkit: New Methods

Access API methods to customize a console programmatically.

Several new methods are available to help developers and advanced administrators customize a console’s interaction log and navigation
tab. For more information, see Salesforce Console API (Integration Toolkit) on page 338.

Articles Suggested for Cases are More Relevant (Beta)

Agents and customers can reduce time-to-resolution with one-click access to articles that most closely match the keywords that are
used in the case subject and description. Suggested articles are available in the Salesforce Console for Service and your portals when
users view and create cases.

The search engine looks for articles with similar content to the case subject and description based on the frequency and distribution of
matching search terms. The search engine also looks for articles that were attached to other cases with the same keywords in the subject
and description. Prior to Winter ‘15, articles were suggested based on the number of times that they were attached to similar cases only.

= Knowledge m

Filters =

Suggesied Arlicles

- | Sony V515W LCD TV Setup Guide
Sony VB15W LCD TV Setup Guide

FAC = Mot Validated « Last Published 11/5/2013

» | How do | get more information on your products?
Product FAQ
FAQ « Mot Validated « Last Published 11/5/2013

- | Connecting your wireless printer to your WiFi network
This article describes how to connect your wireless printer
to your WiFi network
FAQ « Validated External « Last Published 11/5/2013

This improved suggested articles for a case experience is currently available through a beta program. To enable, from Setup go to
Customize > Knowledge > Settings, under Knowledge One check Suggest articles for cases considering
case content (Beta).
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Users Get the Latest Search Capabilities

Users can find what they need and manage their search results more efficiently with Smart Search, the most up-to-date version of
Salesforce search, now included in the Salesforce console.

With Smart Search, agents no longer have to use the search options dialog box to select types of objects to search. They can also
customize how their search results appear by pinning types of records to the top of the list. For more information about Smart Search,
see "Search for Records in a Salesforce Console” in the Salesforce Help.

Add the Files and Case Experts Tools as Salesforce Console Components

Make it easy for support agents to attach files to cases and find fellow agents who are knowledgable about specific issues while working
with cases in the Salesforce console.

These tools were introduced in Summer 14 and were previously available only as sidebar components on feed-based case page layouts.
Now you can add them as console components instead so they're available to users but don't take up space on page layouts.

The files tool lets agents see the files associated with a case, add new files, and download files or attach them to case email messages.
Files Show All

-,
build_results... Other chang...

VOC_HelpSit... IE 9filestofi.

With the case experts tool, agents can quickly find and collaborate with colleagues who are knowledgeable about certain topics so they
can resolve customers’ issues more quickly.

t
L
o
I

Experts

Joe Philips
L3

For more information on adding Salesforce console components, see “Add Console Components to Page Layouts” in the Salesforce
Help.

Adding and Removing Case Feed Highlights Panel from the Salesforce
Console Has Changed

We've updated the look of the Case Feed highlights panel when the compact feed option is selected and have changed the steps for
removing it from page layouts.

Previously, deselecting the Show in the Console option for the highlights panel in Layout Properties on a page layout removed both the
console highlights panel and the Case Feed highlights panel when users viewed case records in Salesforce console tabs or subtabs.

Now, when compact feed is enabled, deselecting the Show in the Console option for the highlights panel in Layout Properties replaces
the console highlights panel with the updated Case Feed highlights panel on primary tabs. The Case Feed highlights panel s still shown
on console subtabs.

167
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To remove highlights panels altogether from both tabs and subtabs, use the page layout to remove all of the fields from the Case Feed
highlights panel.

@ Notfe: We recommend using the highlights panel to show the case subject, which is otherwise not visible in the compact feed
layout.

£ 00001006 +

@ving trouble with my NX-15 u@

Email Loga Call Community Change Status More -

For more information on compact feed, see Show Agents More Case Information in Less Space with Compact Feed on page 151.

Brand Your Salesforce Console with Custom Colors (Pilot)

Now you can brand your Salesforce console by specifying the colors of the header and footer.

You can define the colors of the header and footer in the Salesforce console in just a few easy steps. For details and instructions, see

"

"Define Colors in the Salesforce Console (Pilot)” in the Salesforce Help.

New Look and Feel for the Salesforce Console

We've added a new look and feel to the console, and made it easier for console users to find and edit information.

Updated User Interface for the Console
Users can now see a console with a more modern look:
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Gautam Vasudev ~ Setup Help & Training

® Home - & 00002039 & 00002104 & 00002138 # Select Email and + -
¢ Details @ LA-Fixed & wrench jpeg + -
-
" i Show M
Case Detail Q Resolution Time completed Today Milestones Ehowe More
DONE!
9 Agent Ramsey to Service Cloud Only closed this case. Today at
Closed N
9 Agent Ramsey Dear Sam Andrett, [Inline image URL : ht... Today
Medium N
o Response Time completed Today E %‘
Email
a Response Time violation has occurred Flters =
= . Suggested Articles
I cannot replace
Sam Andretti 9 Agent Ramsey to Service Cloud Only changed Status fr... August 22, 2014 battery
- Quick instructions on
replacing batteries.
Agent Ramsey Dear Sam Andretti, [Inline image URL : ht August 22, 2014
B agent .
Ramsey]Chanage B
Q Response Time completed August 22, 2014 . How to Add More
Memory to Your
Lapto;
Impact Orill is nat holding ,o Admin User The Blu-ray Disc® (BD) player cannot play ... August 20, 201« In this amc\e_. you'll
its battery charge or power leam how to install
additional memary to...
.0 Admin User I'mGetting a ‘Device Not Found' Message August 20, 201+ .
Battery not is working as 3 . . 3 . I - TV speakers are
long as itshould. Charging 0 Admin User How to Prelong Lithium-based Batteries August 20, 20 making 2 humming
it fully leads to an operating noise
time ofonly 3.510 4 hours . I Fallow this procedure to
We expect this fo last ta at z Agent Ramsey wrench.jpeg & August 20, 2014 troubleshoot ifthe TV
least 9-11hours - speakers are
We tried discharging the - » . -

Senice 505 Knowledge Most Recent Macros Presence Phone

Lookup Component Enhanced to Display Multiple Columns
Users now have greater flexibility for seeing information in lookup components. They can see some types of information—such as
phone and fax numbers—in multiple columns, based on available space, by dragging lookup components’ borders to widen them.
(Users might need to resize their browser windows first.) That way, users get the information that they need without having to scroll
to find it. Other types of information, such as descriptions, are still displayed in a single column.

Users Can Hover Over Related List Items to Get Details
Users now have greater flexibility for viewing details about items in the related list component—a component added to a record
that lists items that are related to that record. By hovering, users get the information that they need without having to look for it
elsewhere. For example, users can hover over a case number to display the case’s details, such as contact name, priority, and status.
They can also click hover links to quickly view and edit the additional information.

Users Can Easily Edit Fields in the Lookup Component
Users can now use inline editing to change field values—such as a contact’s phone number—in the Lookup component. With inline
editing, users can manage information more efficiently.

@ Note: No asterisk (*) appears next to the label of a tab that a user is editing via inline editing.

Stacked Components Autosize Vertically
Users can now find information faster and scroll less in stacked components because they autosize vertically to fit browsers. This
autosize design isn't available in Internet Explorer” 7.

Warning Message on Navigation Tab Setup
Administrators setting up a console can now see which items haven't been fully adapted for a console from messaging and asterisks

(*).

Users Can Refresh All Primary Tabs with Visualforce Pages

Users can now click |E| and select Refresh all primary tabs to refresh tabs showing Visualforce pages without entity IDs.
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Service Communities

Service Communities

Community Templates for Self-Service, Chatter Answers, and Ideas provide customers with
self-service communities where they can post questions and receive answers from other customers
or support agents, as well as post, vote for, and comment on discussions.

IN THIS SECTION:

Enhance Service with Chatter Questions (Generally Available)

With Chatter Questions, you can promote collaboration among users and service agents by
giving users the ability to ask and contribute to questions in Chatter.

Enhance Service with Chatter Questions (Generally
Available)

EDITIONS

Chatter Answers is available
in: Enterprise, Developer,
Performance, and
Unlimited Editions.

Ideas is available in:
Enterprise, Developer,
Performance, Unlimited,
and Professional Editions.

With Chatter Questions, you can promote collaboration among users and service agents by giving users the ability to ask and contribute

to questions in Chatter.

) Question @ Post §l File

How do | add more memory to my VX6

More ~

Add details about your question

To My Followers =

For more information about Chatter Questions, see Ask Questions in the Chatter Feed with Chatter Questions (Generally Available) on

page 195.

Community Templates for Self-Service (Generally Available)

Community Templates for Self-Service lets you build, brand, and deploy self-service customer
support communities that look great on any device.

Your customers want an easy way to interact with your company whenever and wherever they are.
A self-service community gives your customers an easy way access the information they need when
they have questions. With communities built on the Koa and Kokua templates, customers can search
for information using knowledge articles and contact support, if necessary. When they're in a
community based on the new Napili template, they can search for articles as well as ask questions
and get crowd-sourced answers from the community. If they still can't find what they're looking
for, they can contact support without having to log in. The self-service templates let you extend
your community to a variety of devices with a consistent user experience every time.
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NORTHERN TRAIL OUTFITTERS

WELCOME!

TRENDING ASTICLES

FEATURED CATEGORIES

SUPPORT

SUPPORT

Kokua Koa Napili

e Kokuais a visually rich self-service template that presents users with knowledge articles organized by data categories. Users can also
submit cases to get help from agents.

e Koaisatext-based self-service template that's optimized for mobile devices. It lets users search for and view articles by text categories,
and contact support if they can't find what they're looking for.

e Napiliis a powerful support community template that lets your customers post questions to the community and search for and view
articles. If they don't find what they're looking for, they can contact a support agent.

To create a self-service community, you need to create a Salesforce Community, create articles in Salesforce Knowledge, set up data
categories or topics, and then use Community Templates for Self-Service in Site.com. With Winter 15, you can use the beta release of
Community Designer to brand and deploy a custom community that looks great on any mobile device! Optionally, to let guest users
create cases without logging in, you'll need to enable Web-to-Case in your organization.

A wizard in Site.com Studio lets you select a template and then walks you through the initial setup for your data categories or
topics—depending on which template you're using. Each template produces a community that is based on a single-page application—a
Web app that loads as a single HTML page. Unlike a traditional website, which comprises multiple pages, a single-page application
contains views that represent the community pages. Views are customizable and can contain dynamic components that allow user
interaction, just like standard Web pages.

The Community Designer works in conjunction with Site.com Studio and provides all the functionality to update your community’s
branding. The templates supply all of the page elements you'll need to create a single-page application to display your community.
Simply edit a few of the page elements to include information about your community, add images to extend your branding, and you're
ready to go—without any coding!

Site.com Studio even lets you to create different language versions of your site. And because all languages are maintained within the
site, you don't need to create and manage a separate site for each language.

To learn more about setting up your own mobile-ready, self-service site, see the Community Templates for Self-Service Implementation
Guide.
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Service Let Customers Ask Questions and Find Articles in Your Support

Community

Let Customers Ask Questions and Find Arficles in Your Support Community

Napili is a powerful support community template that lets your customers post questions to the
community and search for and view articles. If they don't find what they're looking for, they can
contact a support agent.

This template takes it to the next level by adding discussions and suggested articles to your support
community. When customers type a question in the search text box, the results include articles and
similar questions that are based on matches with the typed text. If the answer isn't in the results,

they can get help from the community by asking a question—Ietting community experts discuss
the issue and provide a solution. And if they decide to contact customer support, they're presented
with a list of suggested articles based on keywords they type in the case subject and description.

So there's an excellent chance they can find an answer without needing to create a support case.

A Search for articles an

M Torics-

WELCOME!

2 place where voucan easily find solutions and ask questions
FEATURED DISCUSSIONS MY FEED TRENDING ARTICLES
Backpacking Before vouLeave Home
Feturn Palic, For Camping Equipment

Backpacking for Beginners
BACKPACKING g S S

e - -

Don'tsee whatvou're looking for

CLIMBING

How to setup camping, by water

How to Chonse Climbing Fopes

EDITIONS

Available in:

Enterprise
Performance
Unlimited
Developer

Both guest users and logged-in users can access articles, search and view discussions, and contact agents through official support

channels. When they log in to the community, they're also able to ask questions and participate in discussions in the feed. Members in
the community can answer questions in Chatter just like commenting on a post in Chatter. The person who asked the question or the
question's moderator can select a best answer—uwhich is prominently displayed in the feed—allowing other users to quickly and easily

find the best response to their question.
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We've added an enhanced profile and navigation experience for logged-in users, as well. From the profile menu, users can quickly access
their profile details and list of cases and contact customer support. Users with permissions to create or manage the community can also
access community management and setup pages directly from the profile menu. Users can edit their contact information, profile photo,
and enable or disable email notifications from the community directly from their profile details. User profiles also show user nicknames
and reputation levels if they're enabled in the community.

The Napili template adds the flexibility of topics to organize your community. Topics help you structure a community to quickly guide
members to the information that matters most. You can choose navigational topics to provide an easy way for customers to explore the
community, and featured topics to highlight current conversations and issues. Member-created topics, meanwhile, let users organize
information for each other, creating a personalized experience that boosts community engagement. When setting up the community,
you or the community manager associate topics with existing data categories, so your articles appear in the appropriate topics in the
community.

To learn more about the Napili template, see the Community Templates for Self-Service Implementation Guide.

Social Customer Service

Social Customer Service is the next-generation integration between Radian6é and the Salesforce
Service Cloud. Customer service agents can engage with their customers by responding to cases
created from Twitter and Facebook. Salesforce Adminstrators can customize how the inbound
social content is processed using an Apex class and they can configure who in their organization
has permission to respond using social accounts.

EDITIONS

Social Customer Service is
available in Enterprise,
Performance, and
Unlimited editions.
IN THIS SECTION:

Social Customer Service Starter Pack (Pilot)

Get started with Social Customer Service quickly and easily.

Google+ Social Customer Service (Pilot)
Let your customer service agents listen and respond to Google+ posts about your company's products and services.

Sina Weibo Social Customer Service (Pilot)
Let your customer service agents listen and respond to Sina Weibo posts about your company’s products and services.

Common Setup Defaults
We have improved the Social Customer Service setup experience with common defaults already set.

Social Account Authentication within Salesforce
Authenticate your social accounts without the Radiané social account manager.

Social Customer Service Starter Pack (Pilot)

Get started with Social Customer Service quickly and easily.
Connect your Facebook and Twitter accounts directly from Salesforce and deliver social customer care without a separate Radian6é
contract.

Note: The Social Customer Service Starter Pack is available through a pilot program. For information on enabling the Social

Customer Service Starter Pack in your organization, contact Salesforce.

With the starter pack pilot program, you can enable Social Customer Service and up to two social accounts directly on the Social Customer
Service settings page (from Setup Customize > Social Apps Integration > Social Customer Management > Settings). Your two
social accounts are from any social network. For example, if you add one Twitter account, you can only add one Facebook account.
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Social Customer Service iaip for tids Pege

Social Customer Service integrates with Radiané 1o push social content from Twitter and Facebook to Salesforce and allows your agents 1o respond to cusiomers throwg)
thir nirw Social publishar, Your organization must have Radiang sel up with a data source 10 gather social media. Usa this page o enable Social Customar Senvice, log ir
o Radian, manage your social accounts, and customiza how social contant |8 procassed.

: £ infprmadion [i] [l il r

Social Customer Service Settings

M Enable Social Cusiomar Service

Radiang Credentials SRR

Crealo an account or login 1o activale your starter Social Customer Sondco account,

Croato Account

Alroady havo an account? Logim

@ Note: This pilot doesn't support the moderation feature; all posts become cases. Also, downgrading from a Radian6 account to
the starter pack is not supported.

When you outgrow the starter pack, for example when you need more than two social accounts or want to moderate which incoming
social posts become cases, upgrading to a Radian6 account is also quick and easy.

Google+ Social Customer Service (Pilot)
Let your customer service agents listen and respond to Google+ posts about your company's products and services.

@ Nofe: Google+ Social Customer Service is available through a pilot program. For information on enabling Google-+ for your
customer service agents, contact Salesforce.

With the Google+ Social Customer Service pilot, your agents can respond to Google+ mentions, posts, and comments in the case feed.
Administrators can authorize Google+ pages so agents can receive Google+ content that +mentions your company and respond to
comments on your posts. You can also publish back comments in reply to other comments or posts.
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Sina Weibo Social Customer Service (Pilot)
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Google+ Social Customer Service Pilot Limitations

Agents can't delete their outbound posts.
Agents can't +1 inbound posts.
Links in outbound post aren’t clickable within Google+.

Agents can't see whether conversations are public or private.

Agents can't change conversations between public and private.

Agents can't see if a private conversation is changed to private on Google+.

@ Note: Private conversations can become public, if the conversation is changed within Google+.

Google+ inbound data may take up to 30 minutes to arrive in Salesforce.

In outbound replies, +1 mentions may not work properly.

Sina Weibo Social Customer Service (Pilot)

Let your customer service agents listen and respond to Sina Weibo posts about your company’s products and services.

@ Note: Sina Weibo Social Customer Service is available through a pilot program. For information on enabling Sina Weibo for your

customer service agents, contact Salesforce.

Administrators can enable agents to respond to Sina Weibo social help inquiries.

Streamlined Steps, Sina Weibo content in the case feed.

Abrand presence on Sina Weibo is vital when doing business in China. With the Sina Weibo Social Customer Service pilot, your agents
can respond to Sina Weibo mentions, posts, and comments in the case feed. Administrators can authorize agents to receive Sina Weibo
social help inquiries.
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Aents receive Sina Weibo posts and other content that directly @mentions your company or responds to your posts, and previous replies.
Agents can receive reposts, or forwards, but these come through as regular posts and not a distinct message type. Agents can also
publish back comments and replies in reponse to other comments or posts.

@ Nofe: To submit a sina weibo reply, you must have the reply you are replying to and also the original post in Salesforce.

Sina Weibo Social Customer Service Pilot Limitations

Agents can't delete their outbound posts.

Agents can't repost/forward of inbound posts.

Links in outbound post aren't clickable within Sina Weibo.
Direct or private messages aren't supported.

Sina Weibo inbound data may take up to 30 minutes to arrive in Salesforce.

Common Setup Defaults

We have improved the Social Customer Service setup experience with common defaults already set.

With defaults already provided, setup time and hassel are reduced significantly. The changes are:

e The case origin is automactically set to the provider, or social network, when a case is created from a social post.
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e The social publisher quick action is automatically created when Social Customer Service is enabled (in Setup go to Customize >
Cases > Button, Links, and Actions and click Edit next to the Social or Social Publisher action).

Edit Case Action Help fer this Page &

Social Publisher

Enter Action Information Save | |Cancel

Object Name  Case|;
Action Type  Social Post| ;
Target Object  Social Post| 3
Standard Label Type [ —None— vl
Lapes I Social Publisher
Hame I Social_Publisher i

Description
lcon &% Change lcon

Save | Cancel

e The predefined field value for the SocialPost.Name is provided automatically to ensure it does not need to be on the Quick Action
layout (in Setup go to Customize > Cases > Page Layoutsand click Edit next to the case feed layout, and then click Action in the
Case Layout header).

Case Layout - Feed View Custom Console Components Mini Page Layout Mini Console View | Video Tutorial Help for this Page @

Save v || Quick Save || Preview As...¥ || Cancel |} 4 Undo | 7 Redo || Layout Properties

| Qouekrnicionene |

Buttons New Account New Event New Opportunity Guestion

Actions New Case New Group New Task Send Email
Expanded Lookups New Child Case News Lead Poll Send Email HTML
Related Lists art Actions || Hew Contact Hew Hote Post

Report Charts

4 »
Uimsimlfnrnn Dannn

e We have improved the default layouts for Social Post and Social Persona. In setup go to Customize > Social Apps Integration >
Social Accounts and Contacts > Social Persona/Social Post > Page Layouts.

Social Account Authentication within Salesforce

Authenticate your social accounts without the Radiané social account manager.
With Winter'15 you can authenicate new social accounts from the Social Customer Service settings page.
1. From Setup go to Customize > Social Apps Integration > Social Customer Management > Settings.

2. Under Manage Social Accounts, click Add Account and select the social provider.

Manage Social Accounts g Add Account ¥
Twitter
Account Status Remove A Facebook
Google+
¥ BestTech Helpdesk ) Sina Weibo
@besttech_help ® Active Remove

Agent
@scsauto_agent ® Active Remove

oL

Adam Smith
(5 @asmithscs ® Active Remove
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3. You are directed to the social provider to authenticate the account.

4. Once the account is authenticated, you are returned to the Social Customer Service settings page.

Other Changes in Service Cloud

There are other important changes in the Service Cloud.

Change to Prevent Self-Service Portal Pages from Redirecting to Non-Salesforce Domains
To align with our security best practices, the Winter ‘15 release includes a change that prevents Self-Service Portal pages from
redirecting to non-Salesforce domains. This action will eliminate the risk of users unknowingly being diverted to sites by an
unauthorized third party.

This update is designed to protect users from potential phishing threats and ensure redirect behavior in the Self-Service Portal is
consistent with redirect behavior in the rest of the Salesforce Platform. With the Winter 15 release, external redirects in the Self-Service
Portal will result in the following error message:

“Invalid Page Redirection: The page you attempted to access has been blocked due to a
redirection to an outside website or an improperly coded link or button. Please contact
your salesforce.com Administrator for assistance.”

To prevent any disruption to your service, you must review any implemented pages and remove all instances of redirections to
non-Salesforce pages. The following URL redirection parameters are subject to this new behavior in the Self-Service Portal for external
URLs:

e retURL

e startURL

e cancelURL

e saveURL

To direct users to an external website from the Self-Service Portal, we recommend the following options:

e Update your links to point directly to the intended website. For example, change <a href =
"https://nal.salesforce.com/sserv/portal jsp?retURL=http://company.com"> to <a href = "http://company.com">.

e Use Visualforce and Apex to recreate the intended process. For more information on developing redirects, refer to the Apex
PageReference documentation.
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SALESFORCET REPORTING

We've renamed our tried-and-true reporting features and expanded their availability for mobile use. Understand historical trends, embed
report charts in object records, and use the Salesforce1 Reporting API to develop your own Salesforce1 Reporting applications.

IN THIS SECTION:

New Names for Reporting Products and Features
The names of some products and features have changed.

Salesforce1 Mobile Reporting Enhancements
The Salesforce1 app now delivers even more of the reporting functionality you're used to from the web version. You can view reports
when you're offline, share dashboards with coworkers on Chatter, change report filters right from the dashboard, and more.

New Names for Reporting Products and Features

The names of some products and features have changed.

e Salesforce Analytics is now called Salesforce1 Reporting.

e Analytic Snapshots is now called Reporting Snapshots.

e The “Manage Analytic Snapshots” user permission is now called “Manage Reporting Snapshots.”
e Embedded Analytics is now called Embedded Report Charts.

e Analytics APl via Apex is now called Salesforce1 Reporting API via Apex.

e Analytics REST APl is now called Salesforce1 Reporting REST API.

References to these products and features in the user interface have been updated to use the new names.

Salesforcel Mobile Reporting Enhancements

The Salesforce1 app now delivers even more of the reporting functionality you're used to from the
web version. You can view reports when you're offline, share dashboards with coworkers on Chatter,
change report filters right from the dashboard, and more.

EDITIONS

Dashboards available in:
Group, Professional,

IN THIS SECTION: Enterprise, Performance,
Share a Dashboard in Chatter Ur?lfml'red, and Developer
Editions

Salesforce1 users can post a snapshot of a dashboard component to Chatter by mentioning a
group or a user. The feed shows a thumbnail preview of the component, along with the
comment. Other users reading the feed can tap the thumbnail to open the full dashboard. This
option is available in the Salesforce1 mobile browser app and the Salesforce1 downloadable
apps, versions 7.0 and later.

Reports available in: All
editions except
Database.com

Drill Down from a Dashboard to a Matrix Report
When viewing a dashboard in any version of the Salesforce1 app, users can tap a dashboard component to see the report that's
delivering the data to the dashboard. This is now available for matrix reports as well as tabular and summary reports.
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Filter a Report From a Dashboard Component

Users can apply field filters and scope filters to a report by tapping the related chart. Users can tap the Filters button to see which
report filters have been applied to the report. This enhancement is available in all versions of Salesforce1, except for the Salesforce
mobile browser app when used on a Windows 8.1 phone.

Tap and Hold to See Truncated Text in Report Columns
To fit multiple columns on a small mobile screen, parts of the content of a field (the middle words of a text field or the trailing digits
for a numeric field) may be dropped out. Salesforce1 users can now tap the field to see the full text in a pop-up, then tap the pop-up

Share a Dashboard in Chatter

to go to the record.

Stay in Context When Viewing Reports with Floating Headers
When users scroll down to read a report, the header rows at the top stay visible.

Reports Are Sorted First in Descending or A-Z Order

The default sort order in all versions of the Salesforce1 app helps most users get to the report records they want with one less tap.
When a user taps to sort a numeric field, it sorts in descending order first. The next time the user taps the field, the order is reversed.
When a user taps to sort a text field, it sorts from A to Z first, then from Z to A.

Share a Dashboard in Chatter

Salesforce users can post a snapshot of a dashboard component to Chatter by mentioning a group
or a user. The feed shows a thumbnail preview of the component, along with the comment. Other
users reading the feed can tap the thumbnail to open the full dashboard. This option is available
in the Salesforce mobile browser app and the Salesforce1 downloadable apps, versions 7.0 and
later.

EDITIONS

Dashboards available in:
Group, Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions
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1. Tap the Sharing button to get a snapshot of the chart.

2. Tap Share to post the snapshot. The recipient can tap the snapshot to go to the dashboard.
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Drill Down from a Dashboard to a Matrix Report

When viewing a dashboard in any version of the Salesforce1 app, users can tap a dashboard
component to see the report that's delivering the data to the dashboard. This is now available for
matrix reports as well as tabular and summary reports.

Groupings in matrix reports are shown as columns. Swipe right or left to see all the columns.

Users can see a maximum of 2,000 records. To see all records, log into the full Salesforce site.

@ Important: When users drill from a dashboard to a report, they may see slightly different
data in the report view from what they saw in the dashboard view. That's because the data
displayed in a dashboard is from the last dashboard refresh (the date and time of which are
shown in the dashboard header), but drilling down to a report actually runs the report, so in
that case the user is seeing the most current report data.

Filter a Report From a Dashboard Component

Users can apply field filters and scope filters to a report by tapping the related chart. Users can tap
the Filters button to see which report filters have been applied to the report. This enhancement
is available in all versions of Salesforce1, except for the Salesforce1 mobile browser app when used
on a Windows 8.1 phone.

Tap a section of the chart (1) to filter by that value. The filter button shows how many filters are
applied.

Tap the filter button (2) to see which filters are applied.

m o Filter —

Opporwnity Count Currently filtering by

Stage equals Closed Won
Opportunity Subtitle

Record Count
Stage

Opportuniyg Name Amount

In this release, users can filter by date, but not by a date range.
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Salesforcel Reporting Tap and Hold to See Truncated Text in Report Columns

Tap and Hold to See Truncated Text in Report Columns

To fit multiple columns on a small mobile screen, parts of the content of a field (the middle words
of a text field or the trailing digits for a numeric field) may be dropped out. Salesforce users can
now tap the field to see the full text in a pop-up, then tap the pop-up to go to the record.

EDITIONS

Reports available in: All
editions except
Database.com

Oppties by Swage

Which deals should | focus on?
Won
i
iati.
ns.. I
- I
- FEED DETAILS RELATED
] —_—
Frogosal’. |
Parcestio. | Advanced Interconnections Corp - o
14, Decis., | _/———'—'_' 130K Opportunity Owner
- !
N - w0 50 Test User
Sord Count
Prepared by T. User Go to Record .
Oppertunities by Tygg and Stage 2/2/2014

Opportunigy Nam Account Name

Opportunity Name

Advanced Interconnections Corp - 130K
Homeland A~ 2

Southern Sound Co.

Twitter - 100... nats Twimer Inc

© ©

1. Tap an abbreviated table cell to see it spelled out in full.

Data Mart

Stage

Closed Lost

9 & @
2. Tap Go to Record to see the underlying data.

Stay in Context When Viewing Reports with Floating Headers

When users scroll down to read a report, the header rows at the top stay visible.

EDITIONS

Dashboards available in:
Group, Professional,
Enterprise, Performance,
Unlimited, and Developer
Editions
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Salesforcel Reporting

Opportunity NameA  Account Name

Southern Sound o, SUstainable Audio

Tech Labs DOT Green Media
Towson Inc. Optos Inc.
UlyssesNet - 30K Troy Bullock

United Partn... 22K Bronze Partners
Universal Container AB Partners, Inc
Universal Se... 22K XPower
Universal Se... 25K DFC Inc.
UP 3000 General Utilities

Vand Enterp... 35K  Nicole Grace

© 9

Reports Are Sorted First in Descending or A-Z Order

Reports Are Sorted First in Descending or A-Z Order

The default sort order in all versions of the Salesforce1 app helps most users get to the report records
they want with one less tap. When a user taps to sort a numeric field, it sorts in descending order
first. The next time the user taps the field, the order is reversed. When a user taps to sort a text field,
it sorts from A to Z first, then from Z to A.
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CHATTER

Chatter helps everyone in your organization stay connected.

IN THIS SECTION:

Files
Simplify file management for your users with file syncing, sharing, and collaboration.

Chatter for SharePoint 2010—Generally Available
Configure access to Chatter from SharePoint 2010.

Chatter Groups
Chatter groups make it easy for users to communicate with each other.

Chatter Feeds
Chatter Feeds make collaboration easy.

Other Changes in Chatter
Smaller changes, such as redesigned email notifications, can improve your experience with Chatter.

Files

Simplify file management for your users with file syncing, sharing, and collaboration.

IN THIS SECTION:

Set Up Salesforce Files Connect

With Files Connect, Salesforce users can access, share, and search external data from SharePoint Online, 2010, or 2013. The setup
process differs for cloud-based and on-premises external data sources.

Access and Share External Files with Files Connect

After you set up Files Connect, your users can access files from external data sources like SharePoint, or share them via the Files tab
and feed.

Search for External Files with Files Connect

If you create an external object from an external data source like SharePoint, users can conveniently search its contents along with
Salesforce data.

Run a Report about Publicly Shared Links to Files

Run a new standard report from the Reports tab in Salesforce to learn which files users are sharing. Use the report to show where
and how users are sharing files in your organization.

Users Have More Options in the File Sharing Settings Menu

Improvements to the Sharing Settings menu make it easier for users to manage file sharing.

Sync Shared Files with Salesforce Files Sync
Now you can sync files shared by others, directly from feed posts, file lists, and file detail pages.

Other Changes in Files
Other changes enhance file usage and management.
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Chatter Set Up Salesforce Files Connect

Set Up Salesforce Files Connect

With Files Connect, Salesforce users can access, share, and search external data from SharePoint EDITIONS
Online, 2010, or 2013. The setup process differs for cloud-based and on-premises external data

sources. Available in:

e Enterprise
First, enable Files Connect, and let users access related Eirlf‘r’r::;‘;me
external data sources * Developer

1. Enable Files Connect for your organization.

2. Letusers access Files Connect data sources.

For cloud-based data sources, create an authentication provider, and then define
the source

1. Create a SharePoint Online authentication provider.

2. Define a SharePoint Online external data source for Files Connect.

For on-premises data sources, set up a Secure Agent, and then define the source

1. Setup a Secure Agent on a Linux or Windows server to securely connect Salesforce to data stored behind your firewall.

2. Define a SharePoint 2010 or 2013 external data source for Files Connect.

Include the external data in federated search

To let users access external data in global Salesforce searches, you'll need to create an external object and give users access to its fields.
This is an optional step, but highly recommended to best integrate external data with Salesforce.

Now, ask your users to authenticate with the data source in Salesforce

After users provide their data source credentials, they can download and share external files via the Files tab and feed, and search for
them right alongside their Salesforce content.

Access and Share External Files with Files Connect

Afteryou set up Files Connect, your users can access files from external data sources like SharePoint,
or share them via the Files tab and feed.

USER PERMISSIONS

To access cloud-based data

Download or Share Files on the Files tab sources fike SharePoint

Online:
If you want to download external files to your local system, or share them with a general set of ¢ "Files Connect Cloud”
people in your organization, use the Files tab. To access on-premises data
1. Atthe top of the Salesforce window, click the Files tab. ;%L]J(r)ces like SharePoint
2. Inthe left column, the External Files list shows available external data sources. Click one to e “Files Connect
access files it contains. On-premises”
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Chatter

Access and Share External Files with Files Connect

3. Tothe left of a file name, click the pop-up menu | * |, and choose one of the following:

e Download downloads the file to your local system.

e Open intarget opens the file in the external data source, such as SharePoint.

e Share a copy stores a copy of the external file in Salesforce. If files are shared with a Chatter group, all group members can

access the files, even if they lack access to the external system.

e Share areference points to the external file stored outside Salesforce. No previews will appear in Chatter, and file downloads
are available only for users with access to the external system. (Users must enter credentials for the system in the External
Authentication Settings section of personal setup).

@ Note: Administrators determine whether shared files are copied or referenced—users will see only one option. Regardless
of sharing mode, Chatter won't reflect file revisions in external systems. However, Reference mode will point to the latest

versions in those systems.

Home Chatter Profile People Groups Knowledge +

Files

Recent ) .
owned by Me Files in
Shared with Me ]

Actions
Following

Synced

) office 365

-

1-30f3

Office 365

Name

& Pacifica Overview

¥ Download pdf (657 KB)
Openin target

Share a reference

Previous Mext

Share Files in the Feed

If you want to include external files in a specific Chatter conversation, use the feed. Al files shared in the feed are either copies or

references, as determined by an admin

istrator.

1. While authoring a post, click File above the feed, and then click Select a file from Salesforce.

2. Inthe left column, click the external source, such as SharePoint.

3. Next to the file you want to share, click Attach.
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Chatter Search for External Files with Files Connect

Select a File to Attach

Recent

Owned by lie Files in Office 365
Shared with Me Action Mame
Following

Synced "
) Office 365
E Pacifica Overview

Attach E productimages
CoLEd

g

Search for External Files with Files Connect

If you create an external object from an external data source like SharePoint, users can conveniently

search its contents along with Salesforce data. USER PERMISSIONS
1. Inthe global search box at the top of the Salesforce window, enter search terms such as To access cloud-based data
document title or author. (The specific information you can search for depends on the 50L|Jrces like SharePoint
Online:

configuration of the external data source.) )
_ _ * “Files Connect Cloud”
2. After the search results appear, click the name of the external data source in the left column

(for example, “SharePoint 2010"). The results now show items only from that source. To access on-premises data

sources like SharePoint

2010:
Search Results * “Files Connect
On-premises”
T search Feeds pacifica Search Sharepoint Online
L= Records b Sharepoint Online (1)
FPeople (0) Actions Name
Sharepoint Online (1) . ™ pacifica Overview

Search All

Run a Report about Publicly Shared Links to Files

Run a new standard report from the Reports tab in Salesforce to learn which files users are sharing.
P P sioree t e SOl USER PERMISSIONS
Use the report to show where and how users are sharing files in your organization.
See when each link was created, when it expires, when it was last visited, whether it is password To run and view a file report
protected, and the total number of times the link has been visited. The report includes links users *  “Run Reports”

created using Salesforce CRM Content deliveries and Share via link in Chatter. Each of the links in
this report can be accessed by users outside of your organization.
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Chatter Users Have More Options in the File Sharing Settings Menu

| Home Chatter Profile People Groups Files Libraries Accounts +

ReportS & Dashboards |wewreport..| [new pashboard... Guided Tour | Help for this Page @
Folders File and Content Reports
Find a folder. |
— Find reports and dashboards... v v

All Folders

|z Unfiled Pubiic Reports Action Qe ooy

Content Authors

|z My Personal Custom Reports = - File and Content Reports

_iil My Personal Dashboards How much content has each author published

.| Company Dashboards Content Publication Time Frame

File and Content Reports
| Account and Contact Reports hat content was published within the specified time frame? P

e Opportuntty Reports
| Sales Reports

| Lead Reports

| Support Reports
| Campaign Reports
|| Administrative Reports File a

= File and Content Downlo.aus‘ File and Content Reports
ho downloaded what files?
File and Content Engagement

How File and Content Reports

many times have files bee

Content E‘Tks File and Content Reports

|m) Activity Reports How many times have file: ernally via a link?
] Product and Asset Reports Library Administrators y
|z Call Center Reports ho are the library administrators for each library? File and Content Reports

File and Content Reports
= = - Library Content

Fil d Content Report:
How much content is in each library and how much storage does ituse? e and Lontent Reports
Most Content D load:
‘?S un E” ,m'fmrua, S, e File and Content Reports
hat content is downloaded mast frequentl
Most Content Subscriptions

hat content has the most subscri

File and Content Reports

Stale Content

hat content has not been downloaded or revised recently?

File and Content Reports

1-10 0of 10 =] Page| 1 |of1

To run the File and Content Links report from the Reports tab, click File and Content Reports > File and Content Links.

Users Have More Options in the File Sharing Settings Menu

Improvements to the Sharing Settings menu make it easier for users to manage file sharing.

Sharing Settings x

Help with Sharing @

~ Share with: People, Groups, Anyone with Link Restrict access
Shared With Permissions | i
Any user in your compan
é}L Y g ot No Access ™
3 Fred Williamson
Owner
i Anyone with Link
» . Viewer
View Link
“» Anyone with Delivery
- Viewer
View List
ﬁ Whitney Humboldt (and anyane who can see Whitney Humboldt) Viewer
Marketing Associate o

@ calac Tazm

Close

See Content Deliveries in the Sharing Settings Menu
The Sharing Settings menu now shows content deliveries, in addition to shares with people, groups, publicly available links, records
in Salesforce, and content libraries. Users can easily manage access to the file directly from the Sharing Settings menu for each type
of share.

If users have access to the record or content details page associated with the content delivery, they can click View List under
Anyone with Delivery toviewassociated contentdeliveries. If users own associated records or content, or have the “Modify
All Data” user permission, they can manage associated content deliveries.

Know Who Can Access Files with Improved Sharing Descriptions
If User Sharing is set to private in your organization, the sharing settings menu better describes who the file is shared with, so users
don'taccidentally share files more widely than they intended. For example, when Fred Williamson posts a file to Whitney Humboldt's
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Chatter Sync Shared Files with Salesforce Files Sync

feed, the Sharing Settings menu informs him that Whitney Humboldt and anyone who can see Whitney Humboldt can access the
file.

Users can open the Sharing Settings menu from the Files tab by clicking | = | > Sharing Settings next to the file they want to share.

Sync Shared Files with Salesforce Files Sync

N files shared by others, directly from feed posts, file lists, and file detall .
ow you can sync files shared by others, directly from feed posts, file lists, and file detail pages USER PERMISSIONS

Toview a complete list of features for Salesforce Files Sync 1.3.0, refer to What's New with Salesforce
Files Sync. To sync a shared file
e “Sync Files”

Other Changes in Files

Other changes enhance file usage and management.

Users Can Delete Files That Are Part of Content Deliveries
Afile that is part of a content delivery can now be deleted. Deleting a delivered file deactivates the content delivery. If the deleted
file is restored, the content delivery reactivates.

Most Recent Version of Files Shown in Content Deliveries
New content deliveries now show the most recent published version of the content file being delivered. Previously made content
deliveries continue to show the version of the file that was delivered.

Google Doc URL Field No Longer Requires Registered Google Apps Domain Name in the URL
When attaching a Google doc to a record, it is no longer required that the URL include your registered Google Apps domain name.
New and existing URLs may still contain the Google Apps domain name, but it is no longer a requirement to include it.

Chatter for SharePoint 2010—Generally Available

Configure access to Chatter from SharePoint 2010.

Chatter users can now access Chatter feeds (company and group feeds) from within SharePoint 2010. They can also post files directly
from SharePoint to Chatter feeds as file references.

To enable Chatter for SharePoint, in Setup, go to Customize > Chatter > Chatter for SharePoint. More information and instructions
to configure the feature is available in the documentation provided in the download link.

Chatter Groups

Chatter groups make it easy for users to communicate with each other.

IN THIS SECTION:

Enable Users to Collaborate More Privately in Unlisted Groups

Give your users a more private option for collaboration in Chatter. Unlisted groups offer more privacy compared to private groups,
because only members and users with the “Manage Unlisted Groups” permission can access unlisted groups in list views, feeds, and
search results.

Unlisted Group Limitations
Consider the limitations of unlisted groups before you decide to enable them in your organization.
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Chatter Enable Users to Collaborate More Privately in Unlisted Groups

Updated User Search in the Add/Remove Group Member Dialog

If you've enabled profile-based rollout of Chatter and have more than 500 users in your organization, the Everyone list on the
Add/Remove Members dialog isn't populated. Start typing a user's name in the search field to find members to add.

Enable Users to Collaborate More Privately in Unlisted Groups

Give your users a more private option for collaboration in Chatter. Unlisted groups offer more privacy USER PERMISSIONS

compared to private groups, because only members and users with the “Manage Unlisted Groups”

permission can access unlisted groups in list views, feeds, and search results. To enable unlisted groups:

Unlisted groups are similar to private groups in that only members can view an unlisted group's e “Customize Application”
feed or files. However, unlisted groups provide more privacy compared to private groups.

e Membership for unlisted groups is by invitation only. Nonmembers can't ask to join them.

e Unlisted groups don't display in list views, feeds, and search results for nonmembers. Only members and users with the “Manage
Unlisted Groups” permission can find and access an unlisted group.

® Youcan't see unlisted groups on a user’s profile in Chatter unless you have access to the group.

e Even users with the “Modify All Data” or “View All Data” permissions can't access an unlisted group unless they're members or they
have the “Manage Unlisted Groups” permission.

e Nonmembers can't visit the group detail page. (With private groups, nonmembers can see a truncated version of the detail page,
which shows the name, description, and member list, but not the feed or files.)

e (hatter enforces group name unigueness across public, private, and unlisted groups. If a user tries to create a group with the same
name as an unlisted group, they'll see an error message that informs them that a group by the same name exists. For this reason,
we recommend that you don't include sensitive information in unlisted group names. Choose names that are difficult to guess or
not obvious. For example, don't use an obvious name like Acme Merger.

@ Nofte: Before you enable unlisted groups in your organization, review the limitations on page 190 that apply to unlisted groups.

To enable unlisted groups in your organization, in Setup, go to Chatter > Settings and click Edit. Select Enable Unlisted Groups and
the checkbox next to | want to enable unlisted groups and understand that | may need to update Apex/Visualforce code in
my organization, and then save your changes.

Unlisted Group Limitations

Consider the limitations of unlisted groups before you decide to enable them in your organization.

EDITIONS
For Administrators Available in:
e Contact Manager
e Users with the “Modify All Data” permission can delete feed items from unlisted groups even o Group
if those users are just group members. e Professional
e Users with the “Manage Unlisted Groups” permission but not the “Modify All Data” permission * Enferprise
can't delete feed items from unlisted groups. * Performance
e Unlimited

e Userswith the “Data Export” permission can export all Chatter data and view the exported posts
and comments from any group, regardless of whether the they have the “Manage Unlisted
Groups” permission.

e Developer

® Youcan't grant the “Manage Unlisted Groups” permission to users with these profiles Chatter External, High Volume Portal, or High
Volume Customer Portal.
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Chatter Updated User Search in the Add/Remove Group Member
Dialog

e Unlisted groups count toward a user’s group limit, but they don't appear in the Groups list on a user’s profile page unless the person
who's viewing the list is a member of those groups or has permission to manage unlisted groups. When unlisted groups are hidden,
the count that's shown next to the Groups list might not be accurate, depending on the permissions of the person viewing the list.

For Developers

Apex code runs in system mode, which means that the permissions of the current user aren't taken into account. This limitation has
implications for pages that are written in Apex.
e Visualforce pages that display groups might expose unlisted groups to users who aren't members.

e Because system mode disregards the user's permissions, all users who are accessing a Visualforce page that's showing an unlisted
group can act as an owner of that group.

e AppExchange apps that are written in Apex and that access all groups will expose unlisted groups to users who aren’t members.
To limit and manage access to the unlisted groups in your organization:

e Explicitly filter out unlisted groups from SOQL queries in all Apex code.
e Use permission sets, profile-level permissions, and sharing checks in your code to further limit unlisted group access.

e Use Apextriggers on the CollaborationGroup object to monitor and manage the creation of unlisted groups. In Setup, go to Chatter >
Groups > Group Triggers to add triggers.

Updated User Search in the Add/Remove Group Member Dialog

If you've enabled profile-based rollout of Chatter and have more than 500 users in your organization, the Everyone list on the Add/Remove
Members dialog isn't populated. Start typing a user’'s name in the search field to find members to add.

Chatter Feeds

Chatter Feeds make collaboration easy.

IN THIS SECTION:

Add Action Links to Posts (Pilot)
Use action links to integrate Salesforce and third-party systems into the feed. An action link is a URL on a post that links to an API, a
Web page, or a file. Enabling users to work in the feed is the most powerful way to ensure that they adopt and engage in Chatter.

Ask Questions in the Chatter Feed with Chatter Questions (Generally Available)
Promote community engagement internally and externally by giving users the ability to ask and answer questions in Chatter.

Add Action Links to Posts (Pilot)

Use action links to integrate Salesforce and third-party systems into the feed. An action link is a URL on a post that links to an API, a Web
page, or a file. Enabling users to work in the feed is the most powerful way to ensure that they adopt and engage in Chatter.

@ Note: Action Links are currently available to select customers through a pilot program. To be nominated to join this pilot program,
contact salesforce.com. Additional terms and conditions may apply to participate in the pilot program. Please note that pilot
programs are subject to change, and as such, we cannot guarantee acceptance into this pilot program or a particular time frame
in which this feature can be enabled. Any unreleased services or features referenced in this document, press releases, or public
statements are not currently available and may not be delivered on time or at all. Customers who purchase our services should
make their purchase decisions based upon features that are currently available.
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Chatter Add Action Links to Posts (Pilot)

In APl version 32.0, action links are no longer restricted to the Salesforce1 mobile browser app.

These action links let a user approve or reject a travel request in the feed:

Pam Smith to Deanna Li:
A Just Mow IEI

Please approve this trip.

Dreamforce Trip
www.example.com

e Like

% ==

Define action links in groups. Action links within a group are mutually exclusive. You can associate multiple groups with a post. You can
specify whether an action link group displays in the post or in the post’s drop-down menu. In this example, “Approve” and “Reject” are
in one group and “Clone” and “View" are in another. “Approve” and “Reject” display in the post. “Clone” and “View” display in the
drop-down menu.
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Chatter Add Action Links to Posts (Pilot)

Clone

View

Bookmark

Delete

Action links are user-specific and can be private or public. In this example, Pam makes a post to Deanna'’s feed asking her to download
some instructions and then place an order. Deanna can see the “Order” and “Download” action links in the post in her feed:
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Chatter

Search this feed

Add Action Links to Posts (Pilot)

What | Follow = =

+=
Pam Smith to Deanna Li:
3m ago

Deanna, here are the Installation instructions. Use
'Order' when you're ready to have your part 3D
printed at your designated pick-up location.

1&@ mz ﬁ

oy

iy Like Com

Pam can see the post, but she can see only the “Download” action link because she doesn't have permission to place the order:
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Chatter Ask Questions in the Chatter Feed with Chatter Questions

(Generally Available)

Search this feed

All Company ¥ =

Pam Smith to Deanna Li:
Just Mow

Deanna, here are the Installation instructions. Use
'Order' when you're ready to have your part 3D
printed at your designated pick-up location.

ads Y

( ‘4\

&)

o
1/@

3

e Like

During pilot, use Chatter REST API to define action links and publish a Chatter post that contains action links. For more information, see
Action Links (Pilot).

Ask Questions in the Chatter Feed with Chatter Questions (Generally
Available)

Promote community engagement internally and externally by giving users the ability to ask and answer questions in Chatter.

Chatter Questions allows users to ask questions in their Chatter feed, in groups, and in records. Members in your users’ groups and
communities can answer questions in Chatter just as they would comment on a Chatter post. The person who asked the question or
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Chatter Other Changes in Chatter

the question moderator can select a best answer, which is then prominently displayed in the feed so other users can quickly find the
best response to their question.

Your users can organize their information with the question title and details about their question. They can ask the question to their
followers, to a group, or to a specific person, as they can with other Chatter feed items.

) Question @ Post {ll File  More ¥
How do | add more memory to my VX6

Add details about your question

To My Followers = m

To enable Chatter Questions in your organization, add the Question action to the global publisher layout. If you're using a customized
publisher layout in groups or on records, make sure that the Question action is added to those layouts as well.

Similar Questions, which displays similar questions when users type a question in the feed, remains in Beta for Winter '15. For information
on enabling Similar Questions for your organization, contact salesforce.com.

Chatter Desktop doesn't support Chatter Questions.

Other Changes in Chatter

Smaller changes, such as redesigned email notifications, can improve your experience with Chatter.

Mobile User Context Switching from Emails
Clicking links in Chatter email notifications and digests on mobile devices launch the context-appropriate application, organization,
and community.

Attachments in Email to Groups
Users can now include attachments when emailing posts to groups in Chatter. A single email can include up to 25 attachments. The
first file attached is included with the post; additional attachments are added as comments. Attachments are uploaded as files in
Chatter, then shared with the group. The sender is the file owner.

You must enable this feature for your organization in Setup by clicking Chatter > Email Settings > Allow Attachments via Email.

Reports on Topic Assignments
Users with the “Manage Custom Report Types” permission can create a report type that reveals how topics are assigned. Choose
the Topic Assignments primary object, and select from these fields: Created By, Created Date, Network, Record Key Prefix,
and Topic. The Network field is available only if Salesforce Communities are enabled for your organization. The Record Key Prefix
field indicates the object type (account, opportunity, etc.).
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FORCE.COM CUSTOMIZATION

Customization features enable you to expand your organization by enhancing your objects, data, and fields, customizing your organization's
look and feel, augmenting your business processes, creating websites, and creating apps—all using point-and-click tools. Customization
features also include tools to administer and secure your organization.

IN THIS SECTION:

General Administration
Administration helps you manage your organization to suit your business needs.

Data

The Force.com platform makes it easy for you to manage and track your data. Your users, apps, and processes can seamlessly interact
with all relevant data, including data that's stored in external systems.

Business Logic and Process Automation

Workflow, approvals, and Visual Workflow provide point-and-click tools for automating and simplifying complex business processes.

Security and Identity
Use security to protect both your data and applications. These features also provide user identity and access management.

Sharing
Sharing improves your control over who sees what.

Globalization

Globalization tools help administrators manage resources that vary from country to country, such as multilanguage, multicurrency,
and translated content.

Site.com

Site.com is a Web content management system (CMS) that makes it easy to build dynamic, data-driven Web pages quickly, edit
content in real time, and manage your websites.

Critical Updates

This release includes updates that improve the performance, logic, and usability of Salesforce but might affect your existing
customizations.

Other Changes in Force.com

Even small customization enhancements can make Salesforce easier to use.

General Administration

Administration helps you manage your organization to suit your business needs.

IN THIS SECTION:

Access Additional Recent Items on the Force.com Home Page (Beta)

The Recent Items list on the Force.com Home page now includes additional types of items. Use the Recent Items list to quickly and
easily access even more Setup items that you've recently viewed.
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Force.com Customization General Administration

Search for Additional Items in Setup (Beta)

Advanced Setup Search continues to expand its scope. Now you can search for even more individual items, including workflow rules
and email templates, by name.

View the Parent Object of a Field in Setup Search Results (Beta)

The Advanced Setup Search results page now includes an Object column, which shows the parent object of any relevant item, such
as custom fields, workflow rules and tasks, approval processes. This makes it easy for you to see the context of any item that has a
parent object.

Advanced Setup Search (Beta) Automatically Enabled in All Organizations

To give your organizations instant access to Advanced Setup Search, Advanced Setup Search is automatically enabled in new and
existing organizations.

Delegated Administrators Can Assign Permission Sets

Now you can specify permission sets that delegated administrators can assign to users in specified roles and all subordinate roles.
This way, you can delegate permission set assignment tasks while maintaining strict control over which permission sets delegated
administrators can assign.

Manage Access to Custom Processes and Apps (Generally Available)

When creating custom processes and apps, developers can now use custom permissions to control which features users can access
at a granular level. Then, administrators can assign custom permissions in permission sets and profiles, making it easy to specify
which users can access specific features.

Reference Custom Permission Access with the $SPermission Global Variable
Use the SPermission global variable in formulas and validations to reference information about the current user’s access to
any of your organization’s custom permissions. For example, you can use the $Permission global variable in a validation rule

that ensures that only users with the “Change Austin Accounts” custom permission can make changes to accounts that have a billing
city of Austin.

Show More Information in Less Space with Compact Feeds on Feed-Based Layouts

Use the compact feed option to let users see more information with less scrolling when working with records in the Salesforce
console, and to give feed views a cleaner, more streamlined look.

Use Hover Links to Quickly Access Related Lists on Feed-Based Layout Detail Views

We've added hover links to the top of the details view for feed-based layouts, making it easier to work with related lists with less
scrolling. Now you don't have to choose between using feed-based layouts and giving your users the functionality hover links
provide.

Interact with More Publisher Actions Programmatically

The publisher.selectAction, publisher.setActionInputValues,and publisher.invokeAction
events in the publisher.js APl now support the Post and Social Post actions, so you can create custom console components that
interact with these actions.

Enable External HTTPS for Domains

Enabling External HTTPS on a domain allows Salesforce to use the domain in secure references to the sites that are associated with
that domain, such as in URLs that appear within an email message from a Salesforce Community. This feature is useful for sites that
require authentication, such as community sites, portal sites, or any type of site where confidentiality, protection from eavesdropping,
or protection against spoofing are important.

Require Secure Connections (HTTPS) for Salesforce Communities, Site.com Sites, and Force.com Sites

This new setting enables you to require that requests on a site that use HTTP are redirected to HTTPS instead. Requiring secure
connections ensures the confidentiality and integrity of the data that's sent to and returned from a website. When a connection isn't
secure, others can view or tamper with that data.
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Update Auto-Response Message Sender Addresses to Meet New Security Requirements

We've updated the requirements for the sender address on auto-response messages for Email-to-Case and Web-to-Lead. These new
requirements increase security for your customers.

Access Additional Recent ltems on the Force.com Home Page (Beta)

The Recent Items list on the Force.com Home page now includes additional types of items. Use the EDITIONS

Recent Items list to quickly and easily access even more Setup items that you've recently viewed.

@ Note: The Recent Items list is in beta. It is production quality but has known limitations. Available in: all editions
except Database.com

The Recent Items list on the Force.com Home page shows items that you've recently viewed, edited,
or created, and their related objects. You can click any item to go directly to its page.

USER PERMISSIONS

We've added the following to the Recent Items list.

e Approval processes To access the Force.com
Home page:

* Customreporttypes e "Customize Application”

e Email templates

e Workflow email alerts

e Workflow field updates

e Workflow outbound messages
e Workflow rules

e Workflow tasks

To access the Force.com Home page, from Setup, click Force.com Home.

Search for Additional ltems in Setup (Beta)

Advanced Setup Search continues to expand its scope. Now you can search for even more individual
items, including workflow rules and email templates, by name.

@ Note: Available in:
e Professional
[ ]

e Enterprise

EDITIONS

Advanced Setup Search is in beta. It is production quality but has known limitations.

e After Winter "15 is available for your organization, it might take a few weeks before your e Performance
organization’s setup data is indexed and searchable. During those initial weeks, searches e Unlimited
might not return all possible results. e Developer

Using Advanced Setup Search, you can now search for these additional items.
e Approval post templates

e Approval processes

e Compact layouts

e Custom home pages

e Duplicate rules

e Email templates

e Home page components

e Queues (with results in the Groups and Queues category)
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e Static resources

e Workflow email alerts

e Workflow field updates

e Workflow outbound messages
e Workflow rules

e Workflow tasks

To find setup items, enter at least two consecutive characters of the item that you want in the Setup Search box, and then click or
press Enter. In the Setup Search Results page that appears, select an item from the list.

View the Parent Object of a Field in Setup Search Results (Beta)

The Advanced Setup Search results page now includes an Object column, which shows the parent EDITIONS
object of any relevant item, such as custom fields, workflow rules and tasks, approval processes.
This makes it easy for you to see the context of any item that has a parent object.

Available in:
@ Note: Advanced Setup Search is in beta. It is production quality but has known limitations. Profess.ionol

e Enterprise
After you have search results that include parent objects, click the object name to navigate to the e Performance
object home page (for standard objects) or detail page (for custom objects). e Unlimited

e Developer

Advanced Setup Search (Beta) Automatically Enabled in All Organizations

To give your organizations instant access to Advanced Setup Search, Advanced Setup Search is

automatically enabled in new and existing organizations.
@ Note: Advanced Setup Search is in beta. It is production quality but has known limitations. Available i'?:
e Professional
To disable or enable Advanced Setup Search, in Setup, click Customize > User Interface, and e Enterprise
then scrollto Enable Advanced Setup Search (Beta) atthe bottom of the list. e Performance
e Unlimited
@ Nofe: If Advanced Setup Search is disabled, the Setup search box returns only the titles of « Developer

pages in the Setup menu, not individual items that you might have created or edited in Setup.

USER PERMISSIONS

To disable or enable
Advanced Setup Search:

e "Customize Application”
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Delegated Administrators Can Assign Permission Sets

Now you can specify permission sets that delegated administrators can assign to users in specified

roles and all subordinate roles. This way, you can delegate permission set assignment tasks while

maintaining strict control over which permission sets delegated administrators can assign. Available in:

For more information, see “Delegate Permission Set Assignment” in the Salesforce Help. e Enferprise
e Performance
e Unlimited

e Developer
e Database.com

Manage Access to Custom Processes and Apps (Generally Available)

When creating custom processes and apps, developers can now use custom permissions to control
. . . EDITIONS

which features users can access at a granular level. Then, administrators can assign custom

permissions in permission sets and profiles, making it easy to specify which users can access specific

Available in:
features. « Enterprise
In Salesforce, many features require access checks that specify which users can access certain * Performance
functions. Permission set and profiles settings include built-in access settings for many entities, ¢ Unlimited
such as objects, fields, tabs, and Salesforce pages. However, permission sets and profiles don't * Developer
include access for some custom processes and apps. For example, for a time-off manager app, all ¢ Database.com

users might need to submit time-off requests, but only a smaller set of users need to approve
time-off requests. You can use custom permissions for these types of controls.

Custom permissions let you define access checks that can be assigned to users via permission sets or profiles, similar to how you assign
user permissions and other access settings. For example, you can define access checks in Apex that make a button on a Visualforce page
available only if a user has the appropriate custom permission.

With the Winter '15 release, custom permissions include the following enhancements.

®  You can specify required custom permissions for other custom permissions. A required custom permission is a custom permission
that must be enabled when the parent custom permission is enabled.

Nofe: In existing Developer Edition organizations, the Required Custom Permissions related list in the Custom Permissions
detail page will appear after October 17, 2014.

e Custom permissions are available in unmanaged as well as managed packages.

e Profile settings in packages now include custom permissions.

For more information, see “Custom Permissions” in the Salesforce Help.
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Global Variable

Reference Custom Permission Access with the $Permission Global

Variable

Use the $Permission global variable in formulas and validations to reference information

about the current user's access to any of your organization’s custom permissions. For example, you
can use the $Permission global variable in a validation rule that ensures that only users with
the “Change Austin Accounts” custom permission can make changes to accounts that have a billing

city of Austin.

For more information, see “Understanding Global Variables” in the Salesforce Help.

Show More Information in Less Space with Compact

Feeds on Feed-Based Layouts

EDITIONS

Available in:

Enterprise
Performance
Unlimited
Developer
Database.com

Use the compact feed option to let users see more information with less scrolling when working with records in the Salesforce console,

and to give feed views a cleaner, more streamlined look.

In the standard feed view, each feed item can take up significant space on the page, requiring users to scroll repeatedly to get an overview

of the activity on a record.

i Acme* | 4
Acme
v ] £ | fis
[ o}
Post &£/ Contact &) Opportunity File Link i Entitlement

ow Al Updates

Karen Williams
Here's where | propose we take the Acme team for dinner on Wednesday. We had a

great meal here the last time we were in NY.

L'Apicio Restaurant
http:/ifapicio.com/

Comment Like Today at 10:28 AM

ﬂ &/ Dana Johnson — Karen Willams created a contact

Dana Johnson
Name: Dana Johnson

itle:

Account Name: Acme

gy Follow

Followers

No followers.

Custom Links
Google Search
Hoovers Profile
Google Maps

Google News

With compact feed, feed items take up much less space, and the overall look of the feed is cleaner and brighter.
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B Acme +
Acme
] £ ]t
n Post Contact Opportunity File a Link  More = 9 =
Click here to expand the Post action “ Follow
Q. | Show AllUpdstes @ g  Followers
Mo followers.
e Karen Williams Today at 10:28 AM [~
Here's where | propose we take the Acme team for dinner on Wednesday. We had a great meal Custom Links
here the last time we were in N Google Search
Apicio Re
L 'p‘I‘CI j_R'StaL,‘ram E] Hoovers Profile
http:/lapicio.com/
Google Maps
Google News
99 Karen Williams Dana Johnson Today at 10:23 AM
e Karen Williams For review during our meeting IB & Today at 10:22 AM
’ Karen Williams We're scheduled to meet with Acme ... Yesterday at 12:00 FM

e Fach publisher action has an updated icon (1), with a corresponding icon for feed items created by that action, making it easier to
see at a glance the types of activity on a record.

e The expand all/collapse all button (2) lets users see more or less information for each feed item with one click.

e Whenarecordloads, only the first feed item is automatically expanded (3). Users can click individual feed items to expand or collapse
them as needed.

e The profile picture showing which user created a feed item is smaller and less obtrusive than in the standard view, and is accompanied
by an icon showing the type of feed item (4).

e Compact feed items show a summary of the activity (5) so users can quickly browse through the record’s history.

In addition, any publisher actions you've created, such as create or update actions, have a more compact layout, with less space between

fields.

Subject Q

Due Date /52014

Name Contact v Q

Related To 000071005

*Assigned To  Karen Williams Q

= Status Mot Started .

*Priority  MWormal .
=]

Compact feed is available only on feed-based page layouts and only when users view records in the Salesforce console. Compact feed
isn't supported on Internet Explorer 7 or 8.

To enable compact feed, from the Feed View settings page for a feed-based page layout, select Enable Compact Feed View

in the Console.

@ Notfe: We've made some small changes to the Feed View settings page to make it easier to use. Use Full-Width Feed
in the Console isnowcalled Enable Full-Width Feed in the Console andhasbeen moved to the new
Feed View Options section at the top of the page.

For information on creating and customizing feed-based page layouts, see “Create Feed-Based Page Layouts” in the Salesforce Help.
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Use Hover Links to Quickly Access Related Lists on Feed-Based Layout
Detail Views

We've added hover links to the top of the details view for feed-based layouts, making it easier to work with related lists with less scrolling.
Now you don't have to choose between using feed-based layouts and giving your users the functionality hover links provide.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

When users hover their mouse over the name of a related list, entries in the list and action buttons related to it appear.

Global Media Customize Page | Edit Lavout | Printable View | Help for this Page &
] £ ] i
m
« Back to List: Users
Feed Details
Contacts [31 Open Activities [11 Activity History [5] Opportunities [31 Cases [2] Partners [01 Notes & Attachments [41
Activity History Log a Call| | Mail Merge | | Send an Email | | View All Activity History Help (2
Action Subject Name Related To Task Due Date Assigned To Last Modified Date/Time
Edit| Del Call log Jon Amos 00001000 v 3nzroz Karen Williams 31212012 4:06 P
Edit| Del Calllog Carole White 00001004 v 3512012 Karen Williams 3B2012 12:11 PM
Edit| Del QC Team Meeting Carole White 00001004 2J29/2012 2:00 PM Karen Williams 21512012 1:34 PM
Edit| Del Calllog Carole White 00001004 v 11152011 Karen Williams 11152011 218 PM
Edit| Del Call 9/23/2011 12:01 PM Carole White d 9/2312011 Karen Williams 9/23/2011 12:02 PM

GBI's network of sites combines breakthrough interactive technology with engaging content and design and is consistently ranked as the Internet's leading content network in

Related list hovers appear on the details view for feed-based layouts only if there are no tools or components (such as custom buttons
or links) in the left sidebar of the layout’s feed view.

For information on customizing feed-based layouts, see “Create Feed-Based Page Layouts” in the Salesforce Help.

Interact with More Publisher Actions Programmatically

The publisher.selectAction, publisher.setActionInputValues,and
publisher.invokeAction eventsinthe publisher.js APl now support the Post and Social

Post actions, so you can create custom console components that interact with these actions. Available in:
Forexample, you could create a component that lets support agents search for and view Salesforce e Enterprise
Knowledge articles and then add a link to an article to a tweet or Facebook post in the Social Post e Performance
action with the click of a button. * Unlimited

. . ) ' Y ) * Developer
For more information on working with these events, see “Creating Custom Console Components

That Interact with Case Feed” in Customizing Case Feed with Code.

Enable External HTTPS for Domains

Enabling External HTTPS on a domain allows Salesforce to use the domain in secure references to the sites that are associated with that
domain, such as in URLs that appear within an email message from a Salesforce Community. This feature is useful for sites that require
authentication, such as community sites, portal sites, or any type of site where confidentiality, protection from eavesdropping, or
protection against spoofing are important.
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Force.com Customization Require Secure Connections (HTTPS) for Salesforce
Communities, Site.com Sites, and Force.com Sites

You can enable External HTTPS on any domain that doesn't point to the
yourdomain.yourl8characterOrgId.live.siteforce.comCNAME target.

When enabled, and when the domain’s DNS record is not a CNAME that pointsto the 1ive.siteforce. com subdomain for that
domain, Salesforce assumes that the domain supports secure connections.

This option is intended for domains that use a non-Salesforce content delivery network (CDN) or endpoint to serve HTTPS.

Require Secure Connections (HTTPS) for Salesforce Communities, Site.com
Sites, and Force.com Sites

This new setting enables you to require that requests on a site that use HTTP are redirected to HTTPS instead. Requiring secure connections
ensures the confidentiality and integrity of the data that's sent to and returned from a website. When a connection isn't secure, others
can view or tamper with that data.

New Salesforce Communities now require secure connections by default. Existing Salesforce Communities don't require HTTPS for all
connections by default. Authenticated requests in a Salesforce Community continue to require secure connections when the organization
requires secure connections in the session settings.

New and existing non-Community Force.com Sites don't require secure connections by default so that Force.com Sites can benefit from
our global, accelerated content delivery network (CDN). Enabling secure connections in a non-Community Force.com Site causes that
CDN to get bypassed, because all HTTP requests get redirected to HTTPS.

Enabling secure connections on a site that uses a portal for authentication disables the Require Non-Secure Connections (HTTP) site
login setting if that login setting is enabled.

New and existing non-Community Site.com sites require secure connections when at least one secure custom domain exists on the site.
When no secure custom domain exists on the site, HTTP requests don't get redirected to HTTPS.

Update Auto-Response Message Sender Addresses to Meet New Security
Requirements

We've updated the requirements for the sender address on auto-response messages for Email-to-Case and Web-to-Lead. These new
requirements increase security for your customers.

The email address shown in the From line on auto-response messages now must be one of your verified organization-wide addresses,
or the address in your Salesforce user profile. Previously, there were no requirements for this address, which meant that inaccurate and
potentially deceiving email addresses, such as those impersonating another company or a public figure, could be used.

For information on viewing or changing your auto-response rule settings, see “Set Up Auto-Response Rules” in the Salesforce Help.

Data

The Force.com platform makes it easy for you to manage and track your data. Your users, apps, and processes can seamlessly interact
with all relevant data, including data that's stored in external systems.

IN THIS SECTION:

Access External Data with Lightning Connect

Lightning Connect enables your users to view and search records that are stored outside Salesforce, such as data in an enterprise
resource planning (ERP) system. Instead of copying the data into Salesforce, which would be redundant and inefficient, use external
objects to reference the data and access the data in real time via Web service callouts.
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Manage Customer Data with Data Pipelines (Pilot)

We're introducing Data Pipelines, a new capability to leverage all your customer data for intelligence and actionable information to
help you engage with customers and build data-driven applications. With Data Pipelines, you can use the power of custom Apache
Pig scripts on Hadoop to process large-scale data stored in Salesforce.

Retain Field History Data (Pilot)

Storing data and how long to store it for have emerged as key concerns for our customers. We hear you and are responding with
an improved Field Audit Trail (formerly Field History Retention) pilot that lets you retain your data longer.

Access External Data with Lightning Connect

Lightning Connect enables your users to view and search records that are stored outside Salesforce,
such as data in an enterprise resource planning (ERP) system. Instead of copying the data into
Salesforce, which would be redundant and inefficient, use external objects to reference the data
and access the data in real time via Web service callouts.

EDITIONS

Available in: Developer

Edition
@ Nofe: We anticipate this product will be generally available in the November 2014 to January Available for an additional
2015 time frame. Any unreleased services or features referenced in this or other public cost in: Enterprise,
statements are not currently available and may not be delivered on time or at all. Customers Performance, and
who purchase Salesforce applications should make their purchase decisions based upon Unlimited Editions

features that are currently available.

Lightning Connect external objects map to data tables in external data sources and are available

to Salesforce tools such as lookup relationships, record feeds, the Salesforce1 app, SOSL and SOQL queries, Salesforce APls, and deployment
via the Metadata API, change sets, and packages. To connect to an external data source, Lightning Connect uses the Open Data Protocol
(OData) version 2.0.

For example, suppose that you have product order information stored in an external database and you want to view those orders as a
related list on each customer record in Salesforce. Lightning Connect enables you to set up a relationship between the (parent) customer
object and the (child) external object for orders. Then you can set up the page layouts for the parent object to include a related list that
displays child records.

For Lightning Connect setup details and considerations, see the Salesforce Help.

@ Example: This screenshot shows how Lightning Connect can provide a seamless view of data across system boundaries. A record
detail page for the Business_Partner external object includes two related lists of child objects. In this example, external lookup
relationships and page layouts enable users to view related data from within and from outside Salesforce on a single page.

e Account standard object (1)

e Sales_Order external object (2)
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Business_Partner

1000000
Customize Page | Edit Layout | Help for this Page &

Accounts [1] Sales Orders [2]

Business_Partner Detail
Business_Partner_ID 1,000,000
City  Munich
Company_Hame  EcoTech
Country  Germany
Currency_Code EUR

Email_Address  roberstamps@trainingorg-echotech-
germany.com

Fax  49-00-88786-0
Website http:iiwww. Ecotech.net

Accounts E] Hew Account
Action Account Name Billing City Phone
Edit| Del Acme Mew York (212) 555-5555
¥ sales Orders El
Action External 1D Sales_Order_ID Customer_Name Total_Sum Currency
500000 50000000 EcaTech 26,581.03 EUR
500008 50000009 EcaTech 397222 EUR

Manage Customer Data with Data Pipelines (Pilot)

We're introducing Data Pipelines, a new capability to leverage all your customer data for intelligence
and actionable information to help you engage with customers and build data-driven applications.

EDITIONS

With Data Pipelines, you can use the power of custom Apache Pig scripts on Hadoop to process Available in:
large-scale data stored in Salesforce. * Enterprise
@ Nofte: This feature is currently available to select customers through a pilot program. To be ¢ Performance
: o . - e Unlimited
nominated to join this pilot program, contact Salesforce. Additional terms and conditions
e Developer

may apply to participate in the pilot program. Please note that pilot programs are subject to
change, and as such, we cannot guarantee acceptance into this pilot program or a particular
time frame that this feature can be enabled. Any unreleased services or features referenced
in this or other press releases or public statements are not currently available and may not
be delivered on time or at all. Customers who purchase our services should make their purchase
decisions based upon features that are currently available.

Each connection to your customer drives an ever-increasing scale of data. This growth demands a new set of tools, and the Data Pipelines
pilot ushers in Apache Hadoop on the Salesforce platform, enabling highly scalable batch processing, transformation, and understanding
of customer data.

As Apex provides a strongly typed, object-orientated programming language that enables developers to control and execute flow and
transaction control, Data Pipelines offers a complementary tool set for data flow control. This tool set comes in the form of Apache Pig,
a broadly used and high-level language for expressing data flow control, along with a set of functions to help evaluate data. Pig offers
an abstraction on top of the Salesforce Hadoop infrastructure to permit MapReduce processing within the context of the established
Salesforce multi-tenant architecture.

Data Pipelines are expressed as Pig Latin scripts that are deployed to your organization by using mechanisms that are familiar to the
Salesforce developer community (the Metadata APl and the Tooling API). Data Pipelines supports Apache Pig 0.13 distribution and
Apache Datafu 1.2.0, and delivers a whitelisted set of Apache DataFu and Piggybank UDF libraries to broaden the computational
expressiveness for a comprehensive set of use cases.
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To learn more about the pilot, see the Data Pipelines Implementation Guide.

Retain Field History Data (Pilot)

For more information about joining the pilot, contact your account team or salesforce.com Customer Support.

Retain Field History Data (Pilot)

Storing data and how long to store it for have emerged as key concerns for our customers. We hear
you and are responding with an improved Field Audit Trail (formerly Field History Retention) pilot
that lets you retain your data longer.

Asthe first part of a larger initiative for data lifecycle management, Salesforce is continuing the pilot
that began in Winter '14. Use the Salesforce Metadata API to define a retention policy for your field
history. Then use the REST API, SOAP API, and Tooling API to work with your archived data.

@ Note: This feature is currently available to select customers through a pilot program. To be
nominated to join this pilot program, contact Salesforce. Additional terms and conditions
may apply to participate in the pilot program. Please note that pilot programs are subject to
change, and as such, we cannot guarantee acceptance into this pilot program or a particular
time frame that this feature can be enabled. Any unreleased services or features referenced
in this or other press releases or public statements are not currently available and may not
be delivered on time or at all. Customers who purchase our services should make their purchase
decisions based upon features that are currently available.

The pilot lets you define a retention policy for field history in these Salesforce objects.
e Accounts

e (ases

e (ontacts

e leads

e QOpportunities

The pilot also supports setting policies for custom objects.

EDITIONS

Available in:

Contact Manager
Group
Professional
Enterprise
Performance
Unlimited
Developer
Database.com

Salesforce will eventually move toward a policy of deleting field history data that is older than 18 months, which is why actively specifying

your own history retention policies will become important for your organization.
To learn more about the pilot, see the Field History Retention Implementation Guide.

For more information about joining the pilot, contact your account team or Customer Support.

208


https://na1.salesforce.com/help/doc/en/data_pipelines.pdf
https://na1.salesforce.com/help/doc/en/field_history_retention.pdf

Force.com Customization Business Logic and Process Automation

Business Logic and Process Automation

Workflow, approvals, and Visual Workflow provide point-and-click tools for automating and
simplifying complex business processes.

IN THIS SECTION:

Visually Automate Your Business Processes (Beta)

The Process Builder is a new workflow tool that helps you easily automate your business
processes by providing a powerful and user-friendly visual representation of your process as
you build it. In just a few clicks you can automate business processes and help your organization
operate more efficiently.

Automate Time-Based Processes

Use the brand-new Wait element to automate processes that require a time-based waiting
period. For example, you can create a flow that activates a contract, waits until one day after
the contract is activated, and then emails the customer with a feedback form.

Store Multiple Values Together in a Flow

Store multiple values together—so that you can operate on them—Dby using the new collection
variable flow resource. Collection variables can store both manually entered values and values
from flow resources, such as email addresses entered in a flow's screen. Using collection variables
can help you conserve limits by not querying the Salesforce database for that information.

Submit Records for Approval from a Flow (Generally Available)

With the new Submit for Approval element, you can configure a flow to submit a record for
approval—without any code. Previously, to do this in a flow you had to write an Apex class and
expose it in the Cloud Flow Designer as an Apex Plug-in.

Post to Chatter from a Flow

EDITIONS

Visual Workflow is available
in: Enterprise, Performance,
Unlimited, and Developer
Editions

Approvals are available in:
Enterprise, Performance,
Unlimited, and Developer
Editions, and for an
additional cost in:
Professional Edition

Workflow is available in:
Enterprise, Performance,
Unlimited, Developer, and
Database.com Editions, and
for an additional cost in:
Professional Edition

Workflow tasks, email alerts,
and flow triggers are not
available in Database.com

With the new Post to Chatter element, you can easily configure a flow to post to the feed of a user, Chatter group, or record. These
posts can include mentions and topics. Previously to create a post from a flow, you had to use an Apex Plug-in or create a Feedltem

record.

Behavior Changed for Default Values in Flow Screen Fields

Previously, flows used the last-entered value for a field on a screen if the screen had been visited before, regardless of whether it
was the same instance of that screen. The “Behavior Change for Default Values in Flow Screen Fields” critical update ensures that
when a flow is designed to visit a screen multiple times, such as in a loop, the default value is used.

Receive Email for Each Unhandled Fault

Previously, when multiple interviews resulted in unhandled faults whose messages were similar, the flow creator received an email
for only the first unhandled fault. When the “Flow Creators Receive Email for Each Unhandled Fault” critical update is activated, flow
creators receive one email for each unhandled fault that occurs. That way, you and other flow creators are aware of every fault that
occurs in one of your flows.

Approval Response Enhanced

Delegated approvers can approve or reject email approval requests by replying to those requests. This feature helps to minimize
bottlenecks in the approval process and is especially useful for organizations with users who receive approval requests on mobile
devices.

Specify a Submitter for an Approval Process

You can specify a submitter of a record programmatically using new Apex methods that have been added to the ProcessSubmitRequest
class. With this improved flexibility, you can submit records in bulk on behalf of other submitters.
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Other Changes in Business Logic and Process Automation
Learn about other enhancements to Visual Workflow and workflow.

Visually Automate Your Business Processes (Beta)

The Process Builder is a new workflow tool that helps you easily automate your business processes by providing a powerful and user-friendly
visual representation of your process as you build it. In just a few clicks you can automate business processes and help your organization
operate more efficiently.

The Process Builder's simple and powerful design allows you to:

e (reate your processes by using a convenient visual layout with point-and-click efficiency.
e (Create your whole process in one place rather than using multiple workflow rules.

e Have multiple colleagues contribute to creating your business processes.

e Stop using Apex code to automate simple tasks.

Automated processes in the Process Builder consist of criteria that determine when to execute action groups and immediate and
time-dependent actions to execute when those criteria are met. Any change that causes a record to match the criteria can automatically
trigger the action group.

If you're familiar with workflow, you can use the Process Builder to perform all of the same actions (with the exception of outbound
messages), but with more power and flexibility. Without writing a single line of Apex code, you can:

e (reate arecord.

e Update any related record—not just the record or its parent.

e Use a quick action (object-specific or global) to create a record, update a record, or log a call.
e Launch a trigger-ready flow—from immediate and also scheduled actions.

e Send an email.

e Post to Chatter.

e Submit a record for approval.

With the Process Builder, it's easy to get started creating automated business processes. For example, you can create automated processes
that:

e Update all the mailing addresses on all child contacts when a billing address is changed on an account.
e Submit a record for approval without requiring users to click submit.

e (reate records and notifications based on stages of an opportunity and schedule follow-up tasks that execute based on changes to
records.

e (reate an order record with the data in the opportunity and associated account when the opportunity stage changes to closed and
won.

e Send an email reminder to the account team if a high-value opportunity is still open ten days before the specified close date.
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Automate Time-Based Processes

Use the brand-new Wait element to automate processes that require a time-based waiting period.
For example, you can create a flow that activates a contract, waits until one day after the contract
is activated, and then emails the customer with a feedback form.

USER PERMISSIONS

To open, edit, or create a
Wait elements are only available in trigger-ready flows, which means you can't have a Wait element flow in the Cloud Flow

in the same flow as any screens, choices, or dynamic choices. Designer:
. . ] o ) e “Manage Force.com
After you add a Wait element to a flow, configure it by defining the events that you need to wait Flow”

for. The available event types are both alarms, which consist of a date/time value and an optional

offset from that time. Each event can also have waiting conditions, which determine whether the

flow interview should wait for the associated event during runtime. For more details, see Configure a Flow to Wait for Events in the
Salesforce Help.

When a flow interview executes a Wait element, it waits for all of the defined events whose waiting conditions are met. When the first
of those events occurs, the interview resumes, still in the context of the user who started the interview originally, and executes the event
path for that event. If you need to execute multiple event paths, configure the flow to return to the Wait element.

Example: For example, in a flow that activates a contract, you can wait until one day after the contract is activated and then
email the customer with a feedback form.

Record Update Wait Send Email
= Activate Zz Wait 1 day after activated Request
Contract - feedback

For details about this and other sample flows that use the Wait element, including a flow that executes multiple event paths, see
“Sample Flows that Wait for Events” in the Salesforce Help.

IN THIS SECTION:

Debug Waiting Interviews
We've added new log messages to help you troubleshoot waiting flow interviews.

Delete Unfinished Interviews

When a flow interview is waiting for an event to occur, you can't update or delete the associated flow or flow version. Rather than
having to wait for every interview to finish, you can now delete interviews that are waiting for events to occur.

Debug Waiting Interviews
We've added new log messages to help you troubleshoot waiting flow interviews.

New debugging messages are available when you're running flows that contain Wait elements and wait events. To help you trace what
occurs when running trigger-ready flows that contain Wait elements, the following events are available in the Workf1low category
of debug logs when the level logged is set to FINER and above.

* FLOW WAIT WAITING DETAIL

e FLOW WAIT RESUMING DETATL

* FLOW WAIT EVENT WAITING DETAIL
* FLOW WAIT EVENT RESUMING DETAIL
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Delete Unfinished Interviews

When a flow interview is waiting for an event to occur, you can't update or delete the associated
flow or flow version. Rather than having to wait for every interview to finish, you can now delete
interviews that are waiting for events to occur.

On the flow list page, the Waiting Interviews list identifies all flow interviews that are waiting for
an event to occur before they proceed.

Store Multiple Values Together in a Flow

Store multiple values together—so that you can operate on them—by using the new collection
variable flow resource. Collection variables can store both manually entered values and values from
flow resources, such as email addresses entered in a flow’s screen. Using collection variables can
help you conserve limits by not querying the Salesforce database for that information.

Previously, you couldn't store manually entered values or values from another flow resource. Both
sObject variables and sObject collection variables can store multiple values, but they must be field
values.

Create a collection variable from the Resources tab in the Cloud Flow Designer by double-clicking
Collection Variable.

Store Multiple Values Together in a Flow

USER PERMISSIONS

To delete flow interviews:

e “Manage Force.com
Flow"

USER PERMISSIONS

To open, edit, or create d
flow in the Cloud Flow

Designer:
e “Manage Force.com
Flow”

Unlike with variables, sObject variables, and sObject collection variables, you can't use Record Lookup or Fast Lookup elements to
populate a collection variable. To populate a collection variable, add values whose data type matches the collection variable by using
an Assignment. In other words, don't try to add a variable of type Text to a collection variable of type Number.

¥ Assignments:
Variable Operator Value
|{lcollectionVariable} |F| [ add || [temail_1) [
|{lcollectionVariable} |F| [ add || [temail 2) [
| {lcollectionVariable} -] [add |7 ] |temail_3) I~]

Submit Records for Approval from a Flow (Generally Available)

With the new Submit for Approval element, you can configure a flow to submit a record for
approval—without any code. Previously, to do this in a flow you had to write an Apex class and
expose it in the Cloud Flow Designer as an Apex Plug-in.

In the Summer '14 release, the Submit for Approval element was available only through a pilot
program and you could only specify the record to submit.

After you add a Submit for Approval element to a flow, use the input parameters to identify which
record you want to submit. You can further customize the element by entering values for optional
parameters, such as identifying a specific approval process or who the approval request should be
sent to.

USER PERMISSIONS

To open, edit, or create d

flow in the Cloud Flow

Designer:

e “Manage Force.com
Flow”

For more details about configuring this element, see “Submit a Record for Approval from a Flow” in the Salesforce Help.
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Post to Chatter from a Flow

With the new Post to Chatter element, you can easily configure a flow to post to the feed of a user,
Chatter group, or record. These posts can include mentions and topics. Previously to create a post
from a flow, you had to use an Apex Plug-in or create a FeedlItem record.

Afteryou add a Post to Chatter element to a flow, use the input parameters to identify the message
that should be posted and the user, Chatter group, or record whose feed it should be posted to.
The message can include mentions and topics.

For details about this element, see “Post to Chatter from a Flow” in the Salesforce Help.

Post to Chatter from a Flow

USER PERMISSIONS

To open, edit, or create a
flow in the Cloud Flow

Designer:
e “Manage Force.com
Flow”

Behavior Changed for Default Values in Flow Screen Fields

Previously, flows used the last-entered value for a field on a screen if the screen had been visited
before, regardless of whether it was the same instance of that screen. The “Behavior Change for
Default Values in Flow Screen Fields” critical update ensures that when a flow is designed to visit a
screen multiple times, such as in a loop, the default value is used.

There are two ways that an interview—a running instance of a flow— can visit a flow screen field
multiple times.

e Thesameinstance: The user who's running the flow enters information into a screen field, clicks
Previous, and then clicks Next.

e Differentinstance: A screen is used within aloop, and the flow requires the fields to be completed
independently each time.

If you activate this update now, flows use the default value (if you set one) for the field when visited

USER PERMISSIONS

To view critical updates:

e "View Setup and
Configuration”

To activate critical updates:
e “Modify All Data”

AND
“Customize Application”

for the first time for that instance. If the user reaches the screen because the flow is navigating through a loop, the default value for that
field is used. If the user reaches the screen by navigating back—or by navigating back and then forward—the last-entered value for

that field is used.

You can activate this critical update from Setup by clicking Critical Updates and then clicking Activate for “Behavior Change for Default

Values in Flow Screen Fields.”

Receive Email for Each Unhandled Fault

Previously, when multiple interviews resulted in unhandled faults whose messages were similar,
the flow creator received an email for only the first unhandled fault. When the “Flow Creators Receive
Email for Each Unhandled Fault” critical update is activated, flow creators receive one email for each
unhandled fault that occurs. That way, you and other flow creators are aware of every fault that
occurs in one of your flows.

Whenever a flow interview fails, the system generates a fault message. If there’s no fault path defined
to handle the error gracefully, the error is considered an unhandled fault and the system sends an
email that contains the fault message to the flow creator.

We recommend that you activate this update now. Note that you and other flow creators might
receive more emails that contain flow fault messages than you are used to receiving. You can
activate this critical update from Setup by clicking Critical Updates and then clicking Activate for
"Flow Creators Receive Email for Each Unhandled Fault.”

USER PERMISSIONS

To view critical updates:

e "View Setup and
Configuration”

To activate critical updates:
e "Modify All Data”

AND
“Customize Application”

For details about adding fault paths to more gracefully handle these errors, see “Fault Connector Overview” in the Salesforce Help.
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Approval Response Enhanced

Delegated approvers can approve or reject email approval requests by replying to those requests. This feature helps to minimize
bottlenecks in the approval process and is especially useful for organizations with users who receive approval requests on mobile devices.

A delegated approver is a user appointed by an assigned approver as an alternate for approval requests. When a delegated approver
responds to an approval request, the first line of the email body may contain one of the following words:

® approve
e approved
° yes

° reject

* rejected
® no

Periods and exclamation marks are allowed at the end of each word. Delegated approvers can optionally add comments in the second
line of the email body. They can also click a link in the email to access the approval page.

Specify a Submitter for an Approval Process

You can specify a submitter of a record programmatically using new Apex methods that have been added to the ProcessSubmitRequest
class. With this improved flexibility, you can submit records in bulk on behalf of other submitters.

For more information about the Apex methods, see New and Changed Apex Classes.
@ Nofte: If you use custom email templates with merge fields, you need to account for the possibility that the current user and the

submitter aren’t the same user. For example, you may need to change current user references of {{User.field name}toa
specified submitter reference {|{ApprovalRequestingUser.field name}.

Other Changes in Business Logic and Process Automation

Learn about other enhancements to Visual Workflow and workflow.

Identify Recipients More Flexibly in the Send Email Element
The Send Email element in Visual Workflow now has two ways to identify the recipients of the email. Previously, there was one
required parameter called Email Addresses.That parameterisnow Email Addresses (comma-separated) to
differentiate it from a second parameter for recipients called Email Addresses (collection).Both parametersare
optional, but you must use at least one of them for the flow to successfully send the email. Between the two parameters, the total
number of email addresses must be five or fewer.

The Email Addresses (collection) parameteracceptsonly collection variables of type Text. See Store Multiple Values
Together in a Flow for details about collection variables.

The Email Addresses (comma-separated) parameteracceptsonly non-collection string values. Forexample, you can
reference the value for an input field, a variable of type Text, or a comma-separated list of manually entered email addresses.

Send Email from an Organization-Wide Email Address
The Send Email element in Visual Workflow now allows you to send emails from an organization-wide email address. In enabling
this functionality, we also added a new Sender Address parameter to the Send Email element.

To send an email from an organization-wide email address:
1. For Sender Type, enter OrgWideEmailAddress.

2. For sender Address, enter the value of the verified organization-wide email address.
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Target  Source
Body [{lemailBody} I

Subject  [{lemailSubject) I

[ Email Addresses (collection) || [urecipients) I
[ sender Type [~] [orawideEmailaddress I
[ Sender Address || [info@acmeuireless.com I

Deploy Flows That Contain Email Alerts
If a flow contains an email alert, you can now deploy that flow via change sets or packages.

Debug Flows That Contain Loop Elements and Action Calls
Two new Apex debug log events help you to more easily troubleshoot your flows:

* FLOW LOOP_ DETAIL—Provides details about Loop elements.

® FLOW ACTIONCALL DETAIL—Provides details about Email Alert, Post to Chatter, Quick Action, Send Email, and Submit
for Approval elements.

Notify Assignee Checkbox Removed from Workflow Tasks When You Expose New Notification Setting
If you show a new user setting that lets users control their task assignment email notifications globally, then the Notify Assignee
checkbox is removed from workflow tasks. For details on the new setting, see Let Your Users Control Task Notifications Globally on
page 138.

The default list view for workflow tasks still displays the Notify Assignee column; as a workaround, avoid filtering by the Notify
Assignee field and remove the Notify Assignee column from the list view.

User Interface Changes to the Cloud Flow Designer
e The OTHER ACTIONS section is now QUICK ACTIONS.

e SObject Collection is now SObject Collection Variable.

Security and Identity

Use security to protect both your data and applications. These features also provide user identity and access management.

IN THIS SECTION:

Set Session Timeout and Password Policies for Individual Profiles

Now you can customize the session timeout and password requirements per profile, for finer control over the user experience than
previous settings applied to the entire organization. The settings for session duration and password policies at the profile level
override the settings at the organization level.

Use Event Monitoring to Understand Organization Trends (Generally Available)

Use the SOAP APl and REST APl resources to retrieve event log files that contain information useful for assessing organizational usage
trends and user behavior.

Security Tokens Required for API Logins from Callouts

Enhance your organization’s authentication process with required security tokens for APl logins from callouts.

Some Settings Changed for Managing File Upload and Download Behavior
Review changes to settings that control how some file types are handled during upload and download.
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Customize and Manage User Authentication with Login Flows

Login flows allow administrators to build post-authentication processes to match their business practices, associate the flow with
a user profile, and send the user through that flow as they log in. Use login flows to collect registration information from users,
provide a terms of service acceptance form, prompt the user for a second factor of authentication and other customization.
Export and Import Authentication Certificates between Organizations for Flexible Certificate and Key Management

Export all of your organization’s authentication certificates into a keystore for storage, or import certificates from a local keystore.

Configure a LinkedIn Authentication Provider
Let users log in to a Salesforce organization using their LinkedIn accounts.

Configure a Twitter Authentication Provider
Let users log in to a Salesforce organization with their Twitter accounts.

Give Community Users Button Icons to Log in with their Third-party Accounts

Provide users a graphic button on your community's login page for an established authentication provider, such as Twitter, Facebook
and others.

A Custom Logout URL is Available for Community Users

After using SAML for single sign-on, external users of a Community can be redirected to the logout URL specified in the community
SAML settings. This is now supported for organizations with multiple SAML configurations.

View and Download SAML Login Metadata for Communities and Custom Domains

Get the The SAML Login Information for each community or custom domain from the user interface. The Connected App detail
page and SAML Single Sign-On Setting detail page include a Download Metadata button for easy retrieval of domain-specific
login information and endpoints.

Internet Explorer 6 Logins Removed from the Organization Login History Page

A simplified organizaton-wide Login History page no longer displays information for users logging in with IE6.

View an Optimized OAuth Connected Apps List on the User Detail Page

The Oauth Connected Apps list on a user's detail page now includes refresh requests for the same application authorization in the
Use Count value.

Include the Organization ID to Identify Users from Different Salesforce Auth. Providers

Identify users who have the same user ID in different organizations, such as in two sandboxes.

Identity URL and UserInfo Endpoint Redirect Response Removed

The response to a successful request for an Identity URL, or to the Userinfo endpoint, no longer includes a redirect to the information.
OAuth 2.0 JWT Bearer Token Support Expands to Meet the Current Standards

To stay compatible with OAuth JWT 2.0 bearer token standards, Salesforce allows either prn or sub forthe username in the token.
New External Identity License Expands Your Community User License Choices

External Identity is a new type of Salesforce license that provides a low cost Identity and Access Management service for customers
and partners. This license can be upgraded to Customer Community or Partner Community licenses.

Add Bookmark Apps to the App Launcher and App Menu for Easy Access to Frequently Used Apps
Create a connected app without specifying any SAML or OAuth settings to link users to a site or service with one click.

Use the System for Cross-domain Identity Management (SCIM), a Standards-based User Management AP

Salesforce introduces support for cross-domain identity management SCIM specification 1.1, and provides a few extensions to the
spec 5o you can edit and manage user properties using the REST API.

Identity Features Added to More License Types
The “Use Identity Features” option is now available for Customer Portal and Partner Portal license users.
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Security Fix Protects Organization Data from Guest Users

A potential security vulnerability related to guest user sessions has been fixed. Previously, some custom Force.com Community site
pages generated guest user session IDs. These guest sessions could lead to anonymous APl access via the guest user's object, field,
and record permissions.

Set Session Timeout and Password Policies for Individual Profiles

Now you can customize the session timeout and password requirements per profile, for finer control
over the user experience than previous settings applied to the entire organization. The settings for
session duration and password policies at the profile level override the settings at the organization

EDITIONS

Available in:
level.  Enterprise
Until you set the Session Timeout on a profile, the organization-wide Timeout value inthe e Performance
Session Settings applies to users of the profile. Once set, the Session Timeout on a profile overrides *  Unlimited
the organization-wide Timeout wvalue forusersofthatprofile. Changes to the organization-wide ¢ Developer
Timeout wvalue will not apply to users of a profile with its own Session Timeout value.
To set the session time limit on a profile:

1. F , clickM > Profiles.
rom Setup, click Manage Users > Profiles To edit session and

2. Select a profile. password settings in
3. Depending on which user interface you're using, do one of the following: prof:les: i
e "Manage Profiles and
e Enhanced profile user interface—Click Session Timeout, then click Edit. Permission Sets”
e Original profile user interface—Click Edit, then scroll to the Session Timeout section. To set password policies:

* “Manage Password

4. Click the drop-down list to select another value. Policies”

5. Click Save.

Until you set the Password Policies on a profile, the organization-wide Password Policies apply to
users of the profile. Once set, the Password Settings on a profile override the organization-wide Password Policies for users of that profile.
Changes to the organization-wide Password Policies will not apply to users of a profile with its own Password Policies.

To set the Password Policies on a profile:
1. From Setup, click Manage Users > Profiles.
2. Select a profile.
3. Depending on which user interface you're using, do one of the following:
e Enhanced profile user interface—Click Password Policies, then click Edit.

e Original profile user interface—Click Edit, then scroll to the Password Policies section.

4. Change the values for the current profile.

For a description of all the settings, see Setting Password Policies in the Salesforce help.

5. Click Save.
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Use Event Monitoring to Understand Organization Trends (Generally
Available)

Use the SOAP APl and REST API resources to retrieve event log files that contain information useful
. o . EDITIONS
for assessing organizational usage trends and user behavior.

@ Note: We anticipate this product will be generally available in the November 2014 to January Available ih:
2015 time frame. Any unreleased services or features referenced in this or other public * Enterprise
statements are not currently available and may not be delivered on time or at all. Customers Performance
who purchase Salesforce applications should make their purchase decisions based upon Unlimited

e Developer

features that are currently available.

Because event log files are accessed through the Force.com SOAP APl and REST API, you can integrate
log data with your own back-end storage and data marts so that you can correlate data from multiple organizations and across disparate
systems easily. When using event monitoring, keep the following in mind:

e Inthe unlikely case where no log files are generated for 24 hours, contact Salesforce.

e |og datais read-only. You can't insert, update, or delete log data.

e Usethe EventType field to determine which files were generated for your organization

® TogDate tracks usage activity for a 24-hour period, from 12:00 a.m. to 11:59 p.m. UTC time.

e Anevent generates log data in real time. However, log files are generated the day after an event takes place, during nonpeak hours.
Therefore, log file data is unavailable for at least one day after an event.

® CreatedDate tracks when the log file was generated.

e Logfiles, represented by the EventType field, are only generated if there is at least one event of that type for the day. If no events
took place, the file won't be generated for that day

e Log files are available based on CreatedDate for the last 30 days when organizations purchase User Event Monitoring or one
day for Developer Edition organizations.

e All event monitoring logs are exposed to the API through the EventLogFile object, however there is no access through the user
interface.

Event monitoring can be used with 28 different file types:
e Apex Callout

e Apex Execution

e Apex SOAP

e Apex Trigger

e APl

e Async Report

e Bulk API

e (Change Set Operation

e (Content Distribution

e (Content Document Link

e Content Transfer

e Dashboard

e Document Attachment Downloads
e Login

e Login As
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Logout

MDAPI Operation
Multiblock Report
Package Install

Report

Report Export

REST AP

Salesforce1 Adoption (Ul Tracking)
Sandbox

Sites

Time-Based Workflow
URI

Visualforce

Use Event Monitoring to Understand Organization Trends
(Generally Available)

See New Objects to learn about the EventlLogFile object to use with event monitoring

@ Example:

Example

You can use Workbench to describe event log files. In the Execute text box, type
/services/data/v32.0/sobjects/EventLogFile/describe.

Example raw response

{

"actionOverrides" : [ ],
"activateable" : false,
"childRelationships" 1,
"compactLayoutable" : false,
"createable" : false,
"custom" : false,
"customSetting" : false,
"deletable" : false,
"deprecatedAndHidden" false,
"feedEnabled" : false,
"fields" : [ {
"autoNumber" : false,
"byteLength" : 18,
"calculated" : false,
"calculatedFormula" null,
"cascadeDelete" : false,
"caseSensitive" : false,
"controllerName" : null,

"createable" : false,

}

@ Note: Logdataschemaforeach EventType canchange. Atthe start of each release, use the LogFileFieldNames
and LogFileFieldTypes fields tovalidate schema changes foreach EventType. In the unlikely case where no log

files are generated for 24 hours, contact Salesforce.
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Security Tokens Required for API Logins from Callouts

Enhance your organization's authentication process with required security tokens for APl logins from callouts.

Security tokens are now required for APl logins from callouts in APl version 32.0 and later. In APl version 31.0 and earlier, security tokens
are not required by default, but you can require them by setting a new preference, Require security tokens for APl logins from
callouts (API version 31.0 and earlier), accessible from the Identity Confirmation section of the Session Settings page. To access the
page, from Setup, click Security Controls > Session Settings.

Some Settings Changed for Managing File Upload and Download Behavior

Review changes to settings that control how some file types are handled during upload and
d d P gup EDITIONS

download.

Disallowing HTML uploads also prevents users from uploading . swf and . xhtm1 files Available in all editions
When Don't allow HTML uploads as attachments or document records is enabled in your
organization, users can‘tupload . swf and . xhtml filetypes,inadditionto .html, .htt, USER PERMISSIONS
.mht,and . svg file types.

HTML and THTML files share download behavior settings To configure file upload and

downlad settings:

Previously, the download behavior settings for . html and . thtml files were configured } o
e "Customize Application”

separately. Now, both file types are managed by the settings for .html files.

If you previously configured .html or . thtml files to have hybrid download behavior, the

hybrid download behavior now appliesto .html, .acgi, .htm, .htx, .shtm, .shtml,and . thtml files. Hybrid download
behavior means that Chatter and Salesforce CRM Content files always download when accessed by users in your organization, but
attachments to records and documents run in the browser if they're able.

Configure file upload and download security settings from Setup by clicking Security Controls > File Upload and Download Security.
For more information about managing file security in your organization, see Configure File Upload and Download
Security Settings inthe Salesforce Help.

Customize and Manage User Authentication with Login Flows

Login flows allow administrators to build post-authentication processes to match their business
practices, associate the flow with a user profile, and send the user through that flow as they log in.

Use login flows to collect registration information from users, provide a terms of service acceptance Available in:
form, prompt the user for a second factor of authentication and other customization. « Enterprise
Use the Flow Designer to create login flows, then associate those flows with specific profiles in your e Performance
organization. You can connect the same flow to multiple profiles. Users with the profile are directed *  Unlimited
tothelogin flow after they authenticate, but before the user is directed to the organization’s content. * Developer

The login flow screens are embedded within the standard Salesforce login page for an integrated
user login experience.

USER PERMISSIONS

Login flows support all of the Salesforce user interface authentication methods, including username

and password, delegated authentication, SAML single sign-on and social sign-on through a To open, edit, or create a
third-party Auth. Provider. Login flows can be applied to logins to Salesforce organizations, ﬂOW_ in the Cloud Flow
communities and portals. Designer:

e “Manage Force.com
@ Note: Currently, login flows cannot be applied to APl logins, or when sessions are passed Flow”

to the Ul through frontdoor. jsp froma non-Ul login process.
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Build Your Own Login Flow

Use the following process to build your own login flow.

1. Create a new flow using the Flow Designer and Apex.

Customize and Manage User Authentication with Login Flows

For example, you can design a custom IP-based two-factor authentication flow that requires a second factor of authentication only
if the user is logging in from outside of the corporate Trusted IP Range. (To find or set the Trusted IP Range, from Setup, choose

Security Controls > Network Access.)

@ Note: Do not set the Login IP Ranges directly in the user profile. The Login IP Ranges set directly in a profile restrict access to
the organization for users of that profile who are outside that range, entirely, and those users cannot enter the login flow

process.

The flow should contain the following.

a. Anew Apex class defining an Apex plugin that implements from the (Process . Plugin) and uses the
Auth.SessionManagement classto access the time-based one-time password (TOTP) methods and services. The new
Apex class for the plugin generates a time-based key with a quick response (QR) code to validate the TOTP provided by the user
against the TOTP generated by Salesforce.

b. Ascreen elementto scan a QR code.

¢. Adecision element to handle when the token is valid and when the token is invalid.

[+]
TwoFactorPlugin Screen
4 Get User Info [[] Scan QR Code

Token is invaild

TwoFactorPlugin
4k Validate

Decislon
b Login

Within the flow, you can set input variables. If you use the following specified names, these values will be populated for the flow

when it starts.

Name
LoginFlow LoginType
LoginFlow IpAddress

LoginFlow LoginIpAddress

LoginFlow UserAgent
LoginFlow Platform
LoginFlow Application
LoginFlow Community
LoginFlow_ SessionLevel

LoginFlow UserId
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Value Description
The user type, such as Chatter Community external user
The user's current IP address

The user's IP address used during login, which can change after
authentication

The user agent string provided by the user’s browser

The operating system for the user

Application used to request authentication

Current Community, if this login flow applies to a Community
The current session security level, Standard or High Assurance

The user's 18-character ID.
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2.
3.
4,

During the flow, you can assign the following, pre-defined variables values for specific behavior.

@ Note: The flow loads these values only after a Ul screen is refreshed (a user clicking a button does not load the values, a new
screen must be added to the flow for the values to be loaded).

Name Value Description

LoginFlow FinishLocation A Text value. Provide a string that defines where the user goes
after completing the login flow. The string should be a valid
Salesforce URL (the user cannot leave the organization and stay
in the flow) or relative path.

LoginFlow ForceLogout A Boolean value. Set this variable to true to log the user out,
immediately, and force the user to exit the flow.

Save the flow.
Activate the flow.

Connect the login flow to a profile.

Connect Your Login Flow

After you create a login flow in Flow Designer and activate the flow, you need to associate the login flow with a profile in your organization.

1.
2.
3.

From Setup, click Security Controls > Login Flows.
Click New.
Entera Name to reference this login flow association if you need to edit or delete it.

The Name does not need to be unique.

Enter the Profile to connectto the login flow. You can use the picklist to see available profiles.
Selectthe Login Flow forthe profile from the drop-down list. The list includes all the available flows saved in the Flow Designer.
Click Save.

Users of the profile will now be directed to the login flow.

A single login flow can be associated with one or more profiles. However, a profile can't be connected to more than one login flow.

For more information, see the Flow Designer Overview in the Salesforce help, and the new Auth.SessionManagement Apex class.
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Export and Import Authentication Certificates between Organizations for

Flexible Certificate and Key Management

Export all of your organization’s authentication certificates into a keystore for storage, or import
certificates from a local keystore.

You can export your certificates and private keys into a keystore in JKS (Oracle’s Java Keystore)
format, or import certificates and keys from a local keystore. This allows you to move private keys
from one organization to another.

1. From Setup, click Security Controls > Certificate and Key Management.
2. Select Export to Keystore or Import from Keystore.

For more information about the JKS format, see Oracle's Java KeyStore documentation.

Configure a LinkedIn Authentication Provider

Let users log in to a Salesforce organization using their LinkedIn accounts.

Complete these steps to configure LinkedIn as an authentication provider.

1. Decide which scopes (user details) to get from Linkedin.

2. Setup a LinkedIn application.

3. Define a LinkedIn Provider in your Salesforce organization and establish a registration handler.
4, Edit the registration handler.
5

. Update your LinkedIn application to use the Callback URL generated by Salesforce as an entry
in the LinkedIn OAuth 2.0 Redirect URLs.

6. Test the single sign-on connection.

Decide which scopes (user details) o get from LinkedIn

Scopes determine the information you get from LinkedIn about a user during the authorization
process. You can request some basic information, such as username and a photo URL, or you can
get more specific information, such as an address, phone number, contact list, and more. The user
approves the exchange of information before it is given.

When you set up LinkedIn as an Auth. Provider, you can set the scopes in three different places: in
the LinkedIn application settings, in the Salesforce Auth. Provider settings, or in a query to LinkedIn’s
user info endpoint using field selectors. Consider the following as you decide where to specify the
scopes, and the values to use.

EDITIONS

Available in all editions

USER PERMISSIONS

To create, edit, and manage
certificates:

e "Customize Application”

EDITIONS

Available in:

e Professional
e Enterprise

e Performance
e Unlimited

e Developer

USER PERMISSIONS

To view the settings:

e "View Setup and
Configuration”

To edit the seftings:

e "Customize Application”

AND

“Manage Auth.
Providers”

® You can leave this value blank in the LinkedIn and Salesforce settings. The default value is r basicprofile, which provides

only the most basic user information as defined by LinkedIn.

e Salesforce requires the email address for users.

e Referto the LinkedIn Authentication documentation for a list of supported values and their meaning, or the LinkedIn Field Selectors

page for information about requesting scopes using a URL.

e Ifyou set the Default Scopes in the Salesforce Auth. Provider settings, that value overrides the value in the LinkedIn Application

settings.

e Separate multiple scope values in the LinkedIn Application settings or the Salesforce Auth. Provider settings with a space, only, such

as r basicprofile r emailaddress.
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If you use LinkedIn Field Selectors with a URL, separate multiple values with a comma, only, such as
https://api . linkedin.com/vl/pecple/~: (id, formatted-name, first-name, last-name, public-profile-url, email-address).

Set up a LinkedIn Application

Before you can configure Linkedin for your Salesforce organization, you must set up an application in LinkedIn.

1.

o vk W N

Sign in to your developer account for the LinkedIn website.

Click on the username at the top and select API Keys.

Click Add New Application.

Enter the application settings.

Note the API Key and Secret Key of the new application, you'll need these later in Salesforce.
Optionally, enter a LinkedIn supported scope value, or several space-separated values.

For more information about using scopes with LinkedIn, see Decide which scopes (user details) to get from LinkedIn.

Define a LinkedIn Provider in your Salesforce organization

You need the LinkedIn APT Key and Secret Key tosetup a LinkedIn provider in your Salesforce organization.

1.

o W

From Setup, click Security Controls > Auth. Providers.
Click New.

Select LinkedIn for the Provider Type.

Enter a Name for the provider.

Enterthe URL Suffix. Thisis used in the client configuration URLs. For example, if the URL suffix of your provider is
“MyLinkedInProvider,” your single sign-on URL is similar to:

https://login.salesforce.com/services/sso/00Dx00000000001/MyLinkedInProvider

Usethe APT Key from Linkedin for the Consumer Key field.
Usethe Secret Key from LinkedIn forthe Consumer Secret field.
Optionally, enter a supported value from LinkedIn in the Default Scopes field, or several space-separated values.

For more information about using scopes with LinkedIn, see Decide which scopes (user details) to get from LinkedIn.

Optionally, set the following fields

a. User Info Endpoint URL tochange the values requested from Linkedin’s profile API. See
https://developer.linkedin.com/documents/profile-fields for more information on fields. The endpoint must start with
https://api.linkedin.com/v1/people/~ and requested fields must correspond to requested scopes.

b. Custom Error URL forthe provider to use to report any errors.

¢. Click Automatically create a registration handler template to create an Apex class template for the registration handler,
unless you already have one. You must edit this class, later, and modify the default content before using it.

@ Note: You must specify a registration handler class for Salesforce to generate the Single Sign-On Initialization URL.

d. Selectthe userthatrunsthe Apex handler classfor Execute Registration As.Theusermusthave the “Manage Users”
permission. A user is required if you selected a registration handler class or are automatically creating one.

e. Touse a portal for LinkedIn users, select the portal from the Portal drop-down list.
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10. Use the Tcon URL field to add a path to an icon to display as a button on the login page for a community. This icon applies to a
community, only,and does not appear on the login page for your Salesforce organization or custom domain created with My Domain.
Users click the button to log in with the associated authentication provider for thecommunity.

You can specify a path to your own image, or copy the URL for one of our sample icons into the field.

11. Click Save.
Several client configuration URLs are generated after defining the authentication provider:

® Test-Only Initialization URL:Administrators use this URL to ensure the third-party provider is set up correctly. The
administrator opens this URL in a browser, signs in to the third party, and is redirected back to Salesforce with a map of attributes.

® Single Sign-On Initialization URL:Use this URLto perform single sign-oninto Salesforce from a third party (using
third-party credentials). The end user opens this URL in a browser, and signs in to the third party. This then either creates a new user
for them, or updates an existing user, and then signs them into Salesforce as that user.

® Existing User Linking URL:Use this URL to link existing Salesforce users to a third-party account. The end user opens
this URL in a browser, signs in to the third party, signs in to Salesforce, and approves the link.

® OQauth-Only Initialization URL:Use this URL to obtain OAuth access tokens for a third party. Users must authenticate
with Salesforce for the third-party service to get a token; this flow does not provide for future single sign-on functionality.

e Callback URL: Use the callback URL for the endpoint that the authentication provider calls back to for configuration. The
authentication provider has to redirect to the Callback URL with information for each of the above client configuration URLs.

The client configuration URLs support additional request parameters that enable you to direct users to log into specific sites, obtain
customized permissions from the third party, or go to a specific location after authenticating.

Edit the Registration Handler

1. From Setup, click Develop > Apex Classes.

2. Edit the auto-created Apex registration handler (or the existing registration handler if you had one) to map fields between LinkedIn
and Salesforce

@ Nofte: The default profile query for LinkedIn only retrieves the following fields: first-name, last-name, headline, profile URL.
The default registration handler requires email. Either remove the email requirement from the registration handler or change
the desired scopes in Decide which scopes (user details) to get from LinkedIn on page 223 to include the email address, and
any other fields you want in the registration handler.

The following is an example Apex registration handler specifically for a LinkedIn application as the Auth. Provider. This registration
handler assumes the requested scopes include r basicprofile and r emailaddress.ltalso assumes the users are
logging in to a customer portal.

//TODO:This auto-generated class includes the basics for a Registration
//Handler class. You will need to customize it to ensure it meets your needs and
//the data provided by the third party.
global class LinkedInRegHandler implements Auth.RegistrationHandler ({
//Creates a Standard salesforce or a community user
global User createUser (Id portalld, Auth.UserData data) {
if (data.attributeMap.containsKey ('sfdc networkid')) ({
//We have a community id, so create a user with community access
//TODO: Get an actual account
Account a =[SELECT Id FROM account WHERE name = 'LinkedIn Account'];
Contact ¢ = new Contact();
c.accountId = a.Id;
c.email = data.email;
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c.firstName = data.firstName;

c.lastName = data.lastName;

insert (c);

//TODO: Customize the username and profile. Also check that the username
//doesn't already exist and possibly ensure there are enough org licenses
//to create a user. Must be 80 characters or less.

User u = new User();

Profile p =[SELECT Id FROM profile WHERE name = 'Customer Portal Manager'];

.username = data.firstName + '@sfdc.linkedin.com';
.email = data.email;

.lastName = data.lastName;

.firstName = data.firstName;

String alias = data.firstName;

//Alias must be 8 characters or less

if (alias.length() > 8) {

¢ o cc

alias = alias.substring (0, 8);
}
u.alias = alias;
u.languagelocalekey = UserInfo.getLocale();
u.localesidkey = UserInfo.getLocale();
u.emailEncodingKey = 'UTF-8';
u.timeZoneSidKey = 'America/Los Angeles';
u.profileld = p.Id;
u.contactId = c.Id;

return u;
} else {
//This is not a community, so create a regular standard user
User u = new User();
Profile p =[SELECT Id FROM profile WHERE name = 'Standard User'];
//TODO: Customize the username. Also check that the username doesn't
//already exist and possibly ensure there are enough org licenses
//to create a user. Must be 80 characters or less
u.username = data.firstName + '@salesforce.com';
u.email = data.email;
u.lastName = data.lastName;
u.firstName = data.firstName;
String alias = data.firstName;
//Alias must be 8 characters or less
if (alias.length() > 8) {
alias = alias.substring (0, 8);

.alias = alias;

.languagelocalekey = UserInfo.getLocale();
.localesidkey = UserInfo.getLocale();
.emailEncodingKey = 'UTF-8';
.timeZoneSidKey = 'America/Los_ Angeles';
.profileId = p.Id;

=i =i e o T

return u;

}

//Updates the user's first and last name

global void updateUser (Id userId, Id portalld, Auth.UserData data) {
User u = new User (id = userId);
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u.lastName = data.lastName;
u.firstName = data.firstName;
update (u) ;

}

See the RegistrationHandler Inteface documentation for more information and examples.

Update Your Linkedin Application

Configure a Twitter Authentication Provider

After you define the LinkedIn authentication provider in your Salesforce organization, go back to LinkedIn and update your application
to use the Salesforce-generated Callback URL asthe Linkedin OAuth 2.0 Redirect URLs value.

Test the Single Sign-on Connection

In a browser, openthe Test-Only Initialization URL onthe Auth.Provider detail page. It should redirect you to Linkedin
and ask you to sign in. Upon doing so, you are asked to authorize your application. After you authorize, you are redirected back to
Salesforce.

Configure a Twitter Authentication Provider

Let users log in to a Salesforce organization with their Twitter accounts.

Complete these steps to configure Twitter as an authentication provider.

1.

Set up a Twitter application.

2. Define a Twitter Provider in your Salesforce organization and establish a registration handler.
3.
4

Edit the registration handler.

. Update your Twitter application to use the Callback URL generated by Salesforce as an entry in

the Twitter application settings.

Test the single sign-on connection.

Set up a Twitter Application

Before you can configure Twitter for your Salesforce organization, you must set up an application
in Twitter.

1.

o wN

Sign in to your developer account for the Twitter website.

Click on the user icon at the top and select My Applications (or go to apps.twitter.com).
Click Create New App.

Enter the application settings.

In the APl Keys, note the APT key and API secret of the new application, you'll need
these later in Salesforce.

Define a Twitter Provider in your Salesforce organization

EDITIONS

Available in:

e Professional
e Enterprise

e Performance
e Unlimited

e Developer

USER PERMISSIONS

To view the settings:

* "View Setup and
Configuration”

To edit the settings:

e "Customize Application”

AND

“Manage Auth.
Providers”

You need the Twitter APT key and APT Secret from your Twitter application to set up a Twitter provider in your Salesforce
organization.
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-

9.

o wN

From Setup, click Security Controls > Auth. Providers.
Click New.

Select Twitter for the Provider Type.

Entera Name for the provider.

Enterthe URL Suffix. Thisis used in the client configuration URLs. For example, if the URL suffix of your provider is
“MyTwitterProvider,” your single sign-on URL is similar to:

https://login.salesforce.com/services/sso/00Dx00000000001/MyTwitterProvider

Usethe API key from Twitter for the Consumer Key field.

Usethe API secret from Twitter forthe Consumer Secret field.
Optionally, set the following fields

a. Custom Error URL forthe provider to use to report any errors.

b. Click Automatically create a registration handler template to create an Apex class template for the registration handler,
unless you already have one. You must edit this class, later, and modify the default content before using it.

@ Nofe: You must specify a registration handler class for Salesforce to generate the Single Sign-On Initialization URL.

¢. Selectthe userthatrunsthe Apex handler classfor Execute Registration As.Theusermusthave the “Manage Users”
permission. A user is required if you selected a registration handler class or are automatically creating one.

d. To use a portal for Twitter users, select the portal from the Portal drop-down list.

e. Usethe Icon URL field to add a path to an icon to display as a button on the login page for a community. This icon applies
to a community, only, and does not appear on the login page for your Salesforce organization or custom domain created with
My Domain. Users click the button to log in with the associated authentication provider for thecommunity.

You can specify a path to your own image, or copy the URL for one of our sample icons into the field.

Click Save.

Several client configuration URLs are generated after defining the authentication provider:

Test-Only Initialization URL:Administrators use this URL to ensure the third-party provider is set up correctly. The

administrator opens this URL in a browser, signs in to the third party, and is redirected back to Salesforce with a map of attributes.

Single Sign-On Initialization URL:Use this URL to perform single sign-on into Salesforce from a third party (using
third-party credentials). The end user opens this URL in a browser, and signs in to the third party. This then either creates a new user
for them, or updates an existing user, and then signs them into Salesforce as that user.

Existing User Linking URL: Use this URL to link existing Salesforce users to a third-party account. The end user opens
this URL in a browser, signs in to the third party, signs in to Salesforce, and approves the link.

Callback URL: Use the callback URL for the endpoint that the authentication provider calls back to for configuration. The
authentication provider has to redirect to the Callback URL with information for each of the above client configuration URLs.

The client configuration URLs support additional request parameters that enable you to direct users to log into specific sites, obtain
customized permissions from the third party, or go to a specific location after authenticating.

Edit the Registration Handler

1.

From Setup, click Develop > Apex Classes.
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2. Edit the auto-created Apex registration handler (or the existing registration handler if you had one) to map fields between Twitter
and Salesforce.

The following is an example Apex registration handler specifically for a Twitter application as the Auth. Provider.

global class MyTwitterRegHandler implements Auth.RegistrationHandler({

global User createUser (Id portalld, Auth.UserData data)
{
if (data.attributeMap.containsKey ('sfdc networkid'))
{
// Create communities user
Account a = [SELECT Id FROM account WHERE name='Twitter Account']; // Make sure
this account exists

Contact ¢ = new Contact();
c.accountlId = a.Id;

c.email = 'temp@CHANGE-ME.com';
c.firstName = data.fullname.split ("' ') [0];
c.lastName = data.fullname.split(' ') I[1];

insert(c);

User u = new User();

Profile p = [SELECT Id FROM profile WHERE name='Customer Portal Manager'];
u.username = data.username + '@sfdc-portal-twitter.com';

u.email = 'temp@CHANGE-ME.com';

u.firstName = data.fullname.split (' ') [0];

u.lastName = data.fullname.split (' ") [1];

String alias = data.fullname;

//Alias must be 8 characters or less
if (alias.length() > 8) {

alias = alias.substring (0, 8);
}
u.alias = alias;
u.languagelocalekey = 'en US';
u.localesidkey = 'en US';
u.emailEncodingKey = 'UTF-8';
u.timeZoneSidKey = 'America/Los_Angeles';
u.profileld = p.Id;
u.contactId = c.Id;

return u;
} else {
// Create Standard SFDC user
User u = new User();
Profile p = [SELECT Id FROM profile WHERE name='Standard User'];

u.username = data.username + '@sfdc-twitter.com';
u.email = 'temp@CHANGE-ME.com';
u.firstName = data.fullname.split (' ') [0];
u.lastName = data.fullname.split(' ") [1];
String alias = data.fullname;
if (alias.length() > 8)

alias = alias.substring (0, 8);
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u.alias = alias;

u.languagelocalekey = 'en US';
u.localesidkey = 'en US';
u.emailEncodingKey = 'UTF-8';
u.timeZoneSidKey = 'America/Los_Angeles';
u.profileld = p.Id;

return u;

global void updateUser (Id userId, Id portalld, Auth.UserData data)
{

User u = new User (id=userId);
u.firstName = data.fullname.split (' ') [0];
u.lastName = data.fullname.split(' ") [1];
String alias = data.fullname;
if(alias.length() > 8)

alias = alias.substring (0, 8);

u.alias = alias;
update (u) ;

See the RegistrationHandler Interface documentation for more information and examples.

Update Your Twitter Application

After you define the Twitter authentication provider in your Salesforce organization, go back to Twitter and update your application to
use the Salesforce-generated Callback URL asthe Callback URL value inyour Twitter application settings.

Test the Single Sign-on Connection

In a browser, open the Test-Only Initialization URL on the Auth. Provider detail page. It should redirect you to Twitter
and ask you to sign in. Upon doing so, you are asked to authorize your application. After you authorize, you are redirected back to
Salesforce.
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Give Community Users Button Icons to Log in with their Third-party Accounts

Provide users a graphic button on your community’s login page for an established authentication
. ! EDITIONS
provider, such as Twitter, Facebook and others.
1. For your community, from Setup, click Security Controls > Auth. Providers. Available in:
2. Foran existing Auth. Provider, click Edit. Otherwise, click New to set up a new Auth. Provider. Erct)fess‘lonol
nterprise
3. Usethe Icon URL field to add a path to anicon to display as a button on the login page for o Performance
a community. This icon applies to a community, only, and does not appear on the login page e Unlimited
for your Salesforce organization or custom domain created with My Domain. Users click the « Developer
button to log in with the associated authentication provider for thecommunity.
You can specify a path to your own image, or copy the URL for one of our sample icons into USER PERMISSIONS
the field.

To view the settings:

*  “View Setup and
page. Configuration”

When you save the Auth. Provider settings, the icon appears as a button to the user on the login

To edit the seftings:
e “Customize Application”

AND

“Manage Auth.
Providers”

Forgot password? Not a member?

or log in with a Social Profile

LY
/ )
lll g“ III
\ J
e

For more information, see Add Custom Login, Logout, and Self-Registration Pages and “Customizing Communities Login” in Getting
Started with Communities.
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A Custom Logout URL is Available for Community Users

After using SAML for single sign-on, external users of a Community can be redirected to the logout

URL specified in the community SAML settings. This is now supported for organizations with multiple EDITIONS
SAML configurations. Available in:
The SAML settings are in Setup, Security Controls > Single Sign-On Settings. Set the Identity e Enferprise
Provider Logout URL inthe community’s SAML settings to provide a custom logout URL. ¢ Performance
Previously, a custom logout URL for external users of a community only worked when an organization * Unlimited

e Developer

had one SAML configuration, and users were directed to a page containing the “You have been
logged out” message. This change also removes the “You have been logged out” message page.

View and Download SAML Login Metadata for Communities and Custom

Domains

USER PERMISSIONS EDITIONS

To read: “Customize Application” Connected Apps can be

T q delete: P . lication® AND eith created in: Group,

o create, update, or delete: Customize Application” AND either Professional, Enterprise,
“Modify All Data” OR “Manage Connected Performance, Unlimited,
Apps” and Developer Editions
C ted A b

To update all fields except Profiles, “Customize Application” in(;?or]leecciein~ AF:IPES d?t(i]onnse

Permission Sets, and Service Provider SAML '

Atfributes:

To update Profiles, Permission Sets, and “Customize Application” AND “Modify All

Service Provider SAML Attributes: Data”

To uninstall: “Download AppExchange Packages”

Get the The SAML Login Information for each community or custom domain from the user interface. The Connected App detail page
and SAML Single Sign-On Setting detail page include a Download Metadata button for easy retrieval of domain-specific login information
and endpoints.

Forexample, if you have a SAML-enabled connected app that uses SAML for single sign-on with a community or custom domain created
using My Domain, you can view and download login information specific to that service provider's domain.

1. From Setup, click Manage Apps > Connected Apps.
2. C(lick the name of a connected app to view its detail page.

3. Inthe SAML Login Information section, view login URLs for each domain or click the Download Metadata button to get
domain-specific metadata.
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SAML Login Information
https:/! salesforce.com  Download Metadata
IdP-Initiated Login URL
SP-Initiated POST Endpoint
SP-Initiated Redirect Endpeint

https force.com | Download Metadata ‘
IdP-Initiated Login URL
SP-Initiated POST Endpoint

SP-Initiated Redirect Endpeint

And, the Single Sign-On Setting page now also includes SAML Login Information for each community or custom domain. from Setup,
click Security Controls > Single Sign-On Settings

1. From Setup, click Security Controls > Single Sign-On Settings.
2. C(lickthe name of a SAML Single Sign-On configuration to view its detail page.

3. C(lickthe Download Metadata button to get domain-specific metadata.

Internet Explorer 6 Logins Removed from the Organization Login History
Page

A simplified organizaton-wide Login History page no longer displays information for users logging

in with IE6. EDITIONS

Administrators can monitor the successful and failed login attempts for their organization and Available in all editions
enabled portals or communities using an organizaton'’s Login History page.

To view this page from Setup, click Manage Users > Login History. USER PERMISSIONS

IE6 reporting has been removed from this page and any report that is downloaded from this page. To monitor logins:

e “Manage Users”

View an Optimized OAuth Connected Apps List on the User Detail Page

The Oauth Connected Apps list on a user’s detail page now includes refresh requests for the same EDITIONS
application authorization in the Use Count value.

A user's detail page includes a list of Oauth Connected Apps the user approved for authorization. Available in all editions
An application may be listed more than once. Each time you grant access to an application, it obtains

anew access token. However, requests for refresh tokens now increase the Use Count displayed

for the application authorization.
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Include the Organization ID to Identify Users from Different Salesforce Auth.
Providers

Identify users who have the same user ID in different organizations, such as in two sandboxes.

EDITIONS

For Salesforce authentication providers set up in the in the Summer '14 release and earlier, the user

identity provided by an organization does not include the organization ID, and the destination Available in:
organization can't differentiate between users with the same user ID from two sources (such as  Professional
two sandboxes). e Enterprise
) ) . . . - e Performance
To differentiate users from different sources, edit the settings for the existing Salesforce Auth. Unlimited
e Unlimite

Provider, and select the checkbox to include the organization ID for third-party account links. After
enabling this feature, users need to re-approve the linkage to all of their third party links. Salesforce
authentication providers created in the Winter '15 release and later have this setting enabled by

default. USER PERMISSIONS

1. From Setup, click Security Controls > Auth. Providers.

e Developer

To view the settings:

2. C(lick Edit next to the name of your existing Salesforce Auth. Provider. «  “View Sefup and
3. Select the checkbox to include the organization ID. Configuration”
, . o To edit the seftings:
@ Nofte: Select the checkbox only if your users‘encounter this problgm gaining access to « "Cusfomize Application”
a sandbox copy using a Salesforce Auth. Provider. After enabling this feature, users need AND
to re-approve the linkage to their third party links. These links are listed in the Third-Party
Account Links section of a user's detail page. "Manage Auth.
Providers”

Identity URL and UserInfo Endpoint Redirect Response Removed

The response to a successful request for an Identity URL, or to the Userinfo endpoint, no longer
. 4 : 4 EDITIONS
includes a redirect to the information.

In the Summer '14 release and earlier, requests for an Identity URL, or to the Userlnfo endpoint, Available in all editions
resulted in a 302 redirect to the information. This redirect has been removed, and successful requests
simply return the requested information without a redirect.

For more information, see Identity URLs and The UserInfo Endpoint in the online help.

OAuth 2.0 JWT Bearer Token Support Expands to Meet the Current
Standards

To stay compatible with OAuth JWT 2.0 bearer token standards, Salesforce allows either prn or

sub for the username in the token.

When creating a JWT bearer token to request an OAuth access token, you can use subject (sub) Available in all editions
instead of principal (prn) to specify the username. If both are specified, prn is used. For more

information, see the spec at http://tools.ietf.org/html/draft-ietf-oauth-jwt-bearer and OAuth 2.0
JWT Bearer Token Flow in the Salesforce online help.

To manage, create, edit,
and delete OAuth
applications:

*  "Manage Connected
Apps”
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Force.com Customization New External Identity License Expands Your Community User

License Choices

Example:
{"iss": "3MVG990xTyEMCQ3gNp2PjkgeZKxnmAiGlxV40oHhIAKL rSK.BoSVPGZHQ
ukXnVjzRgSuQgGn75NL7yfkQcyy7",
"sub": "Pierre Delacroix@SeattleApps.com",
"aud": "https://login.salesforce.com",

"exp": "1333685628"}

New External Identity License Expands Your Community User License

Choices

External Identity is a new type of Salesforce license that provides a low cost Identity and Access
Management service for customers and partners. This license can be upgraded to Customer
Community or Partner Community licenses.

@ Nofe: We anticipate this product will be generally available in the November 2014 to January
2015 time frame. Any unreleased services or features referenced in this or other public
statements are not currently available and may not be delivered on time or at all. Customers
who purchase Salesforce applications should make their purchase decisions based upon
features that are currently available.

The External Identity license gives you the flexibility to add users to your community site without
using Customer Community licenses. The External Identity license user adds users at a lower cost
than the Customer Community license, but without access to community critical features like Cases
orKnowledge. Store and manage these users, authenticate them through username and password,
single sign-on, social sign-on (using Facebook, Google+, and LinkedIn identities), and allow user
self-registration for efficient provisioning of new users. These users are typically consumers for your
business, partners, dealers, patients, and other customers.

This table shows which features are available to users with an External Identity license and a Customer
Community license.

EDITIONS

External Identity licenses are
available in: Enterprise,
Performance, Unlimited,
and Developer Editions

USER PERMISSIONS

To assign and manage
External Identity users:

e “Manage Users”

To enable Communities:
e "Customize Application”

Feature External Identity Customer Community
Chatter

Identity

Cases

Can create and manage their own cases.
Products
Read Only

Orders

Chatter (People, Groups, Feeds, Private

Messages)

Files

Chatter Answers
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Feature
Ideas

Knowledge

Tasks

Custom Objects

Notes and Attachments

Add Bookmark Apps to the App Launcher and App Menu
for Easy Access to Frequently Used Apps

External Identity Customer Community
Read Only
Read Only
2 custom objects per license (custom 10 custom objects per license (custom

objects in managed packages don't count  objects in managed packages don't count
towards this limit). towards this limit)

@ Note: The Notes and Attachments

related list is not available on
Accounts and Contacts.

For more information about Identity features, see the Salesforce Identity Implementation Guide. And, for information about creating a
community for Identity users, see Template to Configure Identity Features for Community Users.

Add Bookmark Apps to the App Launcher and App Menu for Easy Access

to Frequently Used Apps

USER PERMISSIONS

To read:

To create, update, or delefe:

To update all fields except Profiles,

EDITIONS

“Customize Application” Connected Apps can be
created in: Group,
Professional, Enterprise,
“Modify All Data” OR “Manage Connected Performance, Unlimited,
Apps” and Developer Edifions

“Customize Application” AND either

Connected Apps can be

Customize Application installed in: All Editions

Permission Sets, and Service Provider SAML

Attributes:

To update Profiles, Permission Sets, and
Service Provider SAML Aftributes:

To uninstall:

“Customize Application” AND “Modify All
Data”

“Download AppExchange Packages”

Create a connected app without specifying any SAML or OAuth settings to link users to a site or service with one click.

A connected app without authorization settings appears in the user's App Launcher and the user’s drop-down app menu, and behaves

like a "bookmark" to the associated URL.
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Force.com Customization Use the System for Cross-domain Identity Management

1.
2
3.
4

5.

(SCIM), a Standards-based User Management API

From Setup, click Create > Apps.

In the Connected Apps section, click New.

In the Basic section, enter the information about your connected app.
In the Web App Settings section, provide a Start URL.

Click Save.

If the destination requires authentication, the service hosting the destination URL should prompt users to provide login credentials when
they navigate to it.

Use these bookmarks to direct users to sites where they manage their own authentication, or as helpful links to commonly used URLs.
For example, you can add a connected app that links to the Salesforce “How to...” video site to help new users.

Setup Help & Training App Launcher =

Sales

Call Center

Marketing

Salesforce Chatter
Community

Salesforce Videos: @Nm

AppExchange
Developer Community

salesforoe Success Community
MAMNC iy wrouw
Marketing

salesforce
=

Salesforce Videos: How to...

For more information, see Configure and Use the App Launcher.

Use the System for Cross-domain Identity Management (SCIM), a
Standards-based User Management API

Salesforce introduces support for cross-domain identity management SCIM specification 1.1, and
. . . . . EDITIONS
provides a few extensions to the spec so you can edit and manage user properties using the REST

API.

Available in all editions

The following are the Salesforce SCIM endpoints, where salesforce org url isthe
organization URL (such as a custom domain) for the user.

https://salesforce org url/services/scim/v1/Users
https://salesforce org url/services/scim/v1/Groups
https://salesforce org url/services/scim/vl/Entitlements

https://salesforce org url/services/scim/v1/Schemas
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Force.com Customization Identity Features Added to More License Types

You can request the capabilities of the Salesforce SCIM implementation using
https://salesforce org url/services/scim/vl/ServiceProviderConfigs.

You can request the properties of a specific user using

https://salesforce org url/services/scim/vl/Users/userIDwhere userID isthe user's 18-character
organization ID.

Salesforce also extends its SCIM 1.1 implementation with the following new properties.

* manager D

e external users

e custom attributes

® permission sets

For more information, see the SCIM 1.1 core schema specification, the SCIM 1.1 REST API specification, and the Salesforce REST AP
Developer's Guide.

Identity Features Added to More License Types

The “Use Identity Features” option is now available for Customer Portal and Partner Portal license
users ’ i EDITIONS

For more information about Identity Features, see the Salesforce Identity Implementation Guide. Available in:
e Enterprise
e Performance

Security Fix Protects Organization Data from Guest * Unlimited
UserS e Developer

A potential security vulnerability related to guest user sessions has been fixed. Previously, some
custom Force.com Community site pages generated guest user session IDs. These guest sessions could lead to anonymous APl access
via the guest user's object, field, and record permissions.

With this fix, custom Force.com Community site pages don't generate or display guest user session IDs, and aren't vulnerable to anonymous
access. Custom Force.com Community site pages that use API version 32.0 are secure. Salesforce’s built-in pages are also secure.

@ Note: In APl versions 32.0 and later, the Apex UserInfo.getSessionId () static method returns the string
NULL SESSION ID.The Visualforce S$Api.Session_ ID fieldreturnsa null value asthe session ID for asite’s
guest user. This is because guest user sessions are disabled, and the guest user context is no longer the default context. This change
affects only APl versions 32.0 and later.

Sharing

Sharing improves your control over who sees what.

IN THIS SECTION:

Disable Customizable Forecasting and Territory Management

Disabling Customizable Forecasting automatically disables Territory Management in your organization. Disabling Territory Management
enables you to migrate to Territory Management 2.0 and Collaborative Forecasts, which makes it easier for you to model your sales
territories into a logical but flexible structure and plan the sales cycle from pipeline to closed sales.
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Force.com Customization Disable Customizable Forecasting and Territory Management

Automatic Recalculation Added for Large Operations

Sharing rule recalculation is run after a group membership operation to add or remove access where needed. It now runs automatically
for larger operations to simplify your sharing updates.

Disable Customizable Forecasting and Territory Management

Disabling Customizable Forecasting automatically disables Territory Management in your
organization. Disabling Territory Management enables you to migrate to Territory Management
2.0 and Collaborative Forecasts, which makes it easier for you to model your sales territories into a

EDITIONS

Available in:
logical but flexible structure and plan the sales cycle from pipeline to closed sales. * Enferprise
@ Nofte: Todisable Customizable Forecasting and Territory Management for your organization, ¢ Performance

contact Salesforce. After contacting Salesforce, disable Customizable Forecasting via the user ¢ Unlimited

e Developer

interface. From Setup, click Customize > Forecasts (Customizable) > Settings. Then,
deselect the Forecast Enabled checkbox. Deselecting this checkbox automatically
disables Territory Management.

Previously, organizations with Territory Management couldn’t migrate to Collaborative Forecasts. With Winter 15, these organizations
can disable Customizable Forecasting and Territory Management before migrating to Collaborative Forecasts. For more information on
migrating to Collaborative Forecasts, see “Planning Your Migration from Customizable Forecasting to Collaborative Forecasts” in the
Salesforce Help.

Disabling Customizable Forecasting deletes all forecasts, overrides, and quotas. Since disabling Customizable Forecasting automatically
disables Territory Management, it also invalidates all territory-based sharing rules and manual shares. The Territories and
Territory fields nolonger appear on the account and opportunity layouts respectively. Additionally, APl access to Territory objects
will no longer be available. If you want to reenable Customizable Forecasting and Territory Management, contact Salesforce. You can't
reenable these features if you have already enabled Territory Management 2.0 or Collaborative Forecasts.
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Automatic Recalculation Added for Large Operations

Sharing rule recalculation is run after a group membership operation to add or remove access where
needed. It now runs automatically for larger operations to simplify your sharing updates.

Previously, you must run recalculation manually if the group membership operation affected more
than 30,000 records. These operations include changes to groups, roles, record ownership, and
territories. Sharing rule recalculation now runs automatically regardless of the number of affected
records and the administrator receives an email notification when the operation is completed.

You can suspend and resume the recalculation later. From Setup, click Security Controls > Defer
Sharing Calculations, then click Suspend in the Sharing Rule Calculations related list.

@ Nofte: If you don't see Defer Sharing Calculations in Setup, you don't have this feature
enabled. To enable it for your organization, contact Salesforce. You can't run other sharing
rule operations when sharing rule recalculation is in progress.

Globalization

Globalization tools help administrators manage resources that vary from country to country, such
as multilanguage, multicurrency, and translated content.

IN THIS SECTION:

Supported Languages Changed and Added

Norwegian is now a fully supported language, and Portuguese (Portugal) and Slovak are now
end user languages. You and your customers can access Salesforce and your custom applications
in more languages than before.

Process Changed for Enabling Multiple Currencies

The process for enabling multiple currencies has a new confirmation step. Additionally,

Automatic Recalculation Added for Large Operations

EDITIONS

Account and contact sharing
rules are available in:
Professional, Enterprise,
Performance, Unlimited,
and Developer Editions

Account territory, case, lead,
opportunity, and custom
object sharing rules are
available in: Enterprise,
Performance, Unlimited,
and Developer Editions

Campaign sharing rules are
available in Professional
Edition at an additional cost,
and Enterprise,
Performance, Unlimited,
and Developer Editions

USER PERMISSIONS

To recalculate sharing rules:
e “Manage Sharing”

improvements have been made to the activation process, with the goal of reducing the amount of time that multi-currency activation
requires. Organizations that are growing and need to track monetary values in multiple countries should find it easier to activate

multiple currencies.

Other Changes in Globalization
Corrections and optimizations were made to a few language and locale features.

Supported Languages Changed and Added

Norwegian is now a fully supported language, and Portuguese (Portugal) and Slovak are now end user languages. You and your customers

can access Salesforce and your custom applications in more languages than before.

Norwegian (no) has been promoted from an end user language to a fully supported language. More user interface labels, text, and Help

are translated, and Norwegian is available as a choice during service sign-up.

Two languages have been promoted from platform-only languages to end user languages.
e Portuguese (Portugal) (pt_PT)

e Slovak (sk)

Forend userlanguages, Salesforce provides translated labels for all standard objects and pages except Setup and Help. When you specify

an end user language, labels and Help that aren't translated display in English instead.
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Two languages that were fully supported in earlier releases are now available as a choice during service sign-up.
e Danish (da)
®  Spanish (Mexico) (es MX)

All fully supported languages should be available during service sign-up. The omission of these languages from the options available
was an error.

For comprehensive details of what languages are supported and at what level, see “What languages does Salesforce support?”in the
Salesforce Help.

Process Changed for Enabling Multiple Currencies

The process for enabling multiple currencies has a new confirmation step. Additionally, improvements have been made to the activation
process, with the goal of reducing the amount of time that multi-currency activation requires. Organizations that are growing and need
to track monetary values in multiple countries should find it easier to activate multiple currencies.

To approve the activation of multiple currencies in the organization where you want multiple currencies enabled, in Setup, go to
Company Profile > Company Information, and then click Edit. Enable Allow Support to Activate Multiple Currencies, and then
save your changes.

Edit Organization Profile Help for this Page &

Universal Samples

Use the form below to edit your organization profile

Organization Edit

""--J\'W-J".f“"*-"r—""' _,-“'d—ﬁ-‘-_-__"’r-.-..’-«

Currency Settings

Currency Locale I English (United States) v
Allow Support to Activate ¥ (i
Multiple Currencies
(e [ 1 Satti

g

#| Users receive the salesforce.com news|etter
#| Users receive the salesforce com admin newsletter

Login Notifications

Hide Notices About System Hide Notices About System
Maintenance Downtime

Save | Cancel

This setting is used to verify the specific organization that's approved for multi-currency activation.
After this setting is enabled, contact Salesforce and ask us to activate the organization for multiple currencies.

For a complete explanation of the process, and details of the implications of activating multiple currencies in your organization, see
“Enabling Multiple Currencies” in the Salesforce Help.

Other Changes in Globalization

Corrections and optimizations were made to a few language and locale features.

Inactive Multiple-Language Features Removed from Single-Language Organizations
Some single-language organizations had access to two multiple-language features in Setup, but these features were inactive in their
organization. These features have been removed from Setup in these organizations to reduce confusion.
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The affected features are, from Setup:
e Company Profile > Language Settings

When accessed, administrators received an insufficient privileges error. This item is no longer displayed.

e Customer Portal > Assigned Languages

This related list used to allow customers to add languages besides the default language that was chosen when the organization
was set up. Added languages would nevertheless be inactive in their customer portal. The Add New Language button now
only allows administrators to add a single language, and the only allowed language is the organization’s default language.
Adding the default language as an assigned language has no effect on your customer portal.

Non-Currency Locales Removed from Currency Locale Lists
In single-currency organizations, when you were choosing a currency locale in Setup, it was possible to choose a locale that didn't
have a currency associated with it. This setting could cause minor unexpected behavior, such as an incorrect currency symbol in
front of currency amounts. Locales without currencies are no longer options in these menus.

If your organization was affected by this issue, simply update your organization’s currency. In Setup, go to Company Profile >
Company Information, and then click Edit. Choose the appropriate currency locale under Currency Settings, and then save your
changes. There's no need for you to do anything else, unless you've written custom code that depends on the specific contents of
these menus or list of locales.

New Value Allowed for Gender Metadata Field Type
The gender field type allows a new value, AnimateMasculine, for use in Slavic languages—currently Czech, Polish, Russian,
Slovak, Slovenian, and Ukrainian.

Site.com

Site.com is a Web content management system (CMS) that makes it easy to build dynamic,
data-driven Web pages quickly, edit content in real time, and manage your websites.

EDITIONS

Available for purchase in:
IN THIS SECTION: Enterprise, Performance,

Add Flexibility to Your Page Templates with Custom Properties and Unlimited Editions

Site.com page templates let designers and site administrators save time by defining the layout Available (with limitations)
and functionality of site pages in a reusable template. And with the introduction of custom in: Developer Edition
properties, you can now achieve even greater flexibility over how your templates are reused.

Site.com Workbook Discontinued
We're discontinuing the Site.com Workbook in Winter "15.

Add Flexibility to Your Page Templates with Custom Properties

Site.com page templates let designers and site administrators save time by defining the layout and functionality of site pages in a reusable
template. And with the introduction of custom properties, you can now achieve even greater flexibility over how your templates are
reused.

When you create a page template, you can add custom properties to it and specify their values in the Properties pane. Then, by adding
custom code or content blocks to the page template, you can access the property values by using expressions. Expressions serve as
placeholders for data that will be replaced with information when the page loads.

In turn, when you or your team create a page from the template, the page is a copy or instance of the template. Because expressions
are just placeholders, their values are updated automatically when you update the values in the page’s Properties pane.
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When the page template is open, you add custom properties to it by clicking Edit Custom Properties in the Properties pane.

Properties
Page

[[]

Class Name

#| Auto Height

Edit Custom Properties

Edit Branding Properties

This action opens a new Custom Properties dialog box, where you can create properties and group them into sections.

5

Custom Properties
Label *

ﬂ Deefine custom properties to contl to a page. Learn more...

Page Subject

Expression Name * @

+ MNew Section pageSubject
Type
Base - + New Property
Text v |
You havent crealed any properties
: =y propertesy Default Valua
This Subject
# Required

But that's not alll To let your team update the template’s appearance, you can add branding properties to the template by clicking Edit
Branding Properties in the Properties pane. When you use expressions in the site’s style sheet as placeholder styles, your team can
use the Branding Editor to update the branding properties in any template-derived page.

@ Nofte: For Communities users, custom and branding properties for templates aren't available when using Communities Designer
(Beta) with the four available templates.

Example: For example, let's say you add a content block to the template to contain the page’s heading. In this case, when users
create a page from the template, you want to let them replace part of the text to suit their needs, but without letting them edit
the entire content block.

By adding a custom property that's called pageSubject and specifying an initial value, you can instead use the following
expression in the content block:

Learn About {!pageSubject}

This action lets team members rename any page that's derived from the template by updating the Page Subject property
in the page’s Properties pane, which automatically updates the value that's represented by the { ! pageSubject} expression.
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o
LEArN ABOUT||CATS A1l About Cats
Doctype
| Add subject information here. fr— v

¥ PAGE SETTINGS

Page Subject*

Cats

Site.com Workbook Discontinued

We're discontinuing the Site.com Workbook in Winter "15.

Other than the workbook, however, all other Salesforce Help and user assistance remains in place to support Site.com customers fully.

Critical Updates

This release includes updates that improve the performance, logic, and usability of Salesforce but

. L o USER PERMISSIONS
might affect your existing customizations.
To ensure a smooth transition, each critical update has an opt-in period, which ends on the To view crifical updates:
auto-activation date that's displayed on the Critical Updates page in Setup. During this period, you *  "View Sefup and
can manually activate and deactivate the update as often as you need to evaluate the impact on Configuration”
your organization and modify affected customizations. After the opt-in period has passed, the To activate critical updates:
update is automatically activated. For more details, see “Critical Updates Overview” in the Salesforce e "Modify All Data”
Help. AND
Behavior Changed for Default Values in Flow Screen Fields “Customize Application”

Previously, flows used the last-entered value for a field on a screen if the screen had been visited
before, regardless of whether it was the same instance of that screen. The “Behavior Change
for Default Values in Flow Screen Fields” critical update ensures that when a flow is designed
to visit a screen multiple times, such as in a loop, the default value is used.

Receive Email for Each Unhandled Fault
Previously, when multiple interviews resulted in unhandled faults whose messages were similar, the flow creator received an email
for only the first unhandled fault. When the “Flow Creators Receive Email for Each Unhandled Fault” critical update is activated, flow
creators receive one email for each unhandled fault that occurs. That way, you and other flow creators are aware of every fault that
occurs in one of your flows.

Serve Static Resources from the Visualforce Domain
When activated, this update changes the way that your static resources, such as images, JavaScript, and CSS files, are served from
Salesforce. To avoid broken references to static resources, make sure that you review our recommended best practices.

Other Changes in Force.com

Even small customization enhancements can make Salesforce easier to use.

User Interface Change to Enabling State and Country Picklists
The user interface for enabling state and country picklists has been revised slightly. Clicking Enable immediately shows a message
confirming that state and country picklists are in the process of being enabled, rather than waiting for the enabling process to
complete. This fixes a rare situation where the request could time out before the enabling process finished.
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FORCE.COM DEVELOPMENT

Force.com helps you develop new applications and integrations to help your organization or for resale to other organizations.

IN THIS SECTION:

Change Sets and Deployment
Administrators and developers now have new ways to use change sets and external tools for deployments.

Force.com Canvas
Easily integrate a third-party application in Salesforce with a set of tools and JavaScript APIs that let you expose an application as a
canvas app. Take your new or existing applications and make them available to your users as part of their Salesforce experience.

Developer Console
Use new features of Developer Console to more easily manage code in your organization.

Visualforce
Develop apps that combine Visualforce with HTML and JavaScript, including Salesforce1 and other mobile apps.

Apex Code

Using syntax that looks like Java and acts like database stored procedures, Apex enables developers to add business logic to most
system events, including button clicks, related record updates, and Visualforce pages. Apex code execution can be initiated by Web
service requests and from triggers on objects.

Lightning Components (Beta)
The Lightning Component framework powers Salesforce. You can use it to create your own Lightning components and make them
available to Salesforce1 users.

API
Use the API to create applications that integrate with Salesforce.

ISVforce
Winter '15 includes enhancements to the Partner Community, Environment Hub, and the License Management Application (LMA).

Other Changes in Force.com Development
We've improved your experience with Force.com Development tools.

Change Sets and Deployment

Administrators and developers now have new ways to use change sets and external tools for
EDITIONS
deployments.
Ifyou're using the Force.com Migration Tool or Force.com IDE, also see the changes in the Metadata Available in
Types and Fields on page 333. e Enferprise
The components available for a change set vary by edition. The following components are now ‘ Elefor;n?jnce
e Unlimite

available for change sets.
e Database.com
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CORS Whitelist Origin
Represents an origin in the CORS whitelist. CORS (cross-origin resource sharing) is a W3C recommendation that enables Web browsers
to request resources from origins other than their own. For example, using CORS, a JavaScript script at
https://www.example.com could request a resource from https://www.salesforce.com.

IN THIS SECTION:

Deploy with Active Jobs
An option has been added to the Deployment Settings page that lets you deploy components referenced by active Apex jobs. With
this option, you don't have to cancel Apex jobs to be able to have a successful deployment.

Deploy Your Components in Less Time (Pilot)

You can now deploy components to production by skipping the execution of all Apex tests for components that have been validated
within the last four days. With Quick Deploy, you no longer have to wait for all tests to run for your deployment to complete in
production, and your deployment will likely finish in less than 30 minutes.

Deploy with Active Jobs

An option has been added to the Deployment Settings page that lets you deploy components referenced by active Apex jobs. With this
option, you don't have to cancel Apex jobs to be able to have a successful deployment.

Previously, deployments failed if they contained components that were referenced by Apex jobs that were pending or in progress. For
example, if you deploy an Apex class that implements Schedulable, and there is a scheduled job that corresponds to this class, this class
can't be deployed, and the entire deployment fails.

You can now enable the deployment of components with corresponding jobs—including scheduled jobs, batch jobs, and future
methods—and avoid deployment failure. To do so, from Setup click Deployment Settings > Allow deployments of components
when corresponding Apex jobs are pending or in progress, and then click Save.

As part of this change, the Deployment Connections page has been renamed to Deployment Settings.

This option applies to change sets and deployments started through the Metadata API.

@ Note:
e Enabling this option might cause Apex jobs to fail due to unsupported changes.

e This option doesn't affect editing and saving Apex code in the Salesforce user interface (in Setup or the Developer Console),
which will fail if there are active jobs associated with the Apex class. Updating Apex code by using the Force.com IDE can
succeed if this option is enabled because Metadata APl is used for the code update.

Deploy Your Components in Less Time (Pilot)

You can now deploy components to production by skipping the execution of all Apex tests for components that have been validated
within the last four days. With Quick Deploy, you no longer have to wait for all tests to run for your deployment to complete in production,
and your deployment will likely finish in less than 30 minutes.

@ Nofte: This feature is currently available to select customers through a pilot program. To be nominated to join this pilot program,
contact Salesforce. Additional terms and conditions may apply to participate in the pilot program. Please note that pilot programs
are subject to change, and as such, we cannot guarantee acceptance into this pilot program or a particular time frame that this
feature can be enabled. Any unreleased services or features referenced in this or other press releases or public statements are not
currently available and may not be delivered on time or at all. Customers who purchase our services should make their purchase
decisions based upon features that are currently available.
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Force.com Development Deploy Your Components in Less Time (Pilot)

As part of a deployment to production, all Apex tests are run in the production organization. If the organization contains a large number
of Apex tests, the execution of all tests can be time-consuming and can delay your deployment. To reduce deployment time to production,
you can perform a quick deployment by skipping the execution of all tests. Quick deployments are available only for validations with
test runs that have passed in the last four days (96 hours) and that meet the code coverage requirements: the overall code coverage in
the organization must be at least 75%, and Apex triggers must have some coverage.

To perform a quick deployment, first run a validation-only deployment with Apex test execution on the set of components that you
need to deploy to production. If your validation succeeds and qualifies for a quick deployment, you can start a quick deployment by
clicking Quick Deploy next to your validation in the Deployment Status page or in the validation’s detail page. This button appears only
for qualifying validations.

Deployment Details Help for this Psge @

« Back to Deployment Status

Validation Succeeded o Deploy Components 9 Run Apex Tests

Name: 0AD00000004P vl

Type: API

Deployed By: Test User

Start Time: 7/29/2014 11:23 AM
End Time: 7/20/2014 11:23 AM

Ready for Quick Deployment Expires in 3d 23h
Enables the quick deployment of recently validated components by skipping Apex tests as part of the deployment.

Quick Deploy

You can start a quick deployment only through the Salesforce user interface. Quick Deploy is available for change sets and Metadata
APIl-based deployments that appear in the user interface.

@ Note: Quick Deploy is enabled for recent validations in which all Apex tests have executed successfully and code coverage
requirements have been met. Note the following:

e Because Apex tests are required to run in production, quick deployments are supported for validations that meet the criteria.
This applies to change sets and Metadata API-based deployments (including the Force.com Migration Tool).

e When deploying to non-production environments (sandbox), Apex tests aren't required and aren’t run automatically. When
using Metadata API (including the Force.com Migration Tool), Quick Deploy is supported in sandbox only for validations that
explicitly enable the execution of tests (for example, via the runA11Tests parameter for the Migration Tool). For change
sets, Quick Deploy is not supported in sandbox because there is no option to enable test runs for change sets.

e Ifyou perform a deployment after a validation, whether through Quick Deploy or a regular deployment, all validations no
longer qualify for quick deployment. You must revalidate the set of components that you need to quick-deploy.
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Force.com Canvas

Easily integrate a third-party application in Salesforce with a set of tools and JavaScript APIs that let
you expose an application as a canvas app. Take your new or existing applications and make them

EDITIONS

available to your users as part of their Salesforce experience. Available in:
The version of the Force.com Canvas SDK is 32.0. * Enferprise
For more information, see the Force.com Canvas Developer's Guide. ‘ Performance
e Unlimited
e Professional (with
IN THIS SECTION: Force.com Canvas
enabled)

Provide Canvas Personal Apps Directly to End Users
) » e Developer

Canvas personal apps let you create connected apps designed specifically for end users across

organizations, without relying on organization administrators for app distribution. With canvas

personal apps, end users can discover, install, and seamlessly interact with the apps that you create.

Use Salesforce1 Methods to Integrate Navigation with Canvas Apps

Leverage new methods in the Force.com Canvas framework to smoothly integrate navigation or record actions between a canvas
app and Salesforce1, without needing to use Visualforce. Now your development tools are within a single framework.

SDK Object and Field Changes

The following changes have been made to the objects and fields in the Force.com Canvas SDK.

Provide Canvas Personal Apps Directly to End Users

Canvas personal apps let you create connected apps designed specifically for end users across organizations, without relying on
organization administrators for app distribution. With canvas personal apps, end users can discover, install, and seamlessly interact with
the apps that you create.

As an administrator, you can still install canvas apps in an organization. Canvas personal apps give developers new freedom to create
apps and allow users to install and use the apps immediately.

Canvas personal apps also offer a lightweight way to integrate outside functionality with Salesforce for any number of users. End users
install and use a canvas personal app right from the Chatter tab, which allows the app to connect to their Salesforce data. Because only
the app’s metadata is installed, installation is quick and easy, and end users get only the functionality that they need.

.l:f' Application Approval Required
LGB

It appears that you have not yet approved this application for use within Salesforce com.
If you are seeing this message, it is because you have either not yet approved this application, or an administrator

has temporarily revoked the ability for this application to act on your behalf. Click on the "Approve" link below to
begin the approval process

Approve
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sale§]6rce

Logged in as admin@canvas-demo.org ( Mot you? )

: \Cer
"Canvas Personal App Test" is -
requesting permission to: e

Access your basic information

Access and manage your data
Provide access to your data via the
Web

Access and manage your Chatter data
Provide access to custom applications
Allow access 1o your unique identifier
Access custom permissions

Canvas Personal App Test

Only click Allow for applications you trust
You may revoke access at any time by
visiting your Settings page

A new organization preference in the Setup node lets administrators enable or disable use of canvas personal apps in the organization.
On the developer side, making a canvas app into a personal app is as easy as selecting a new app setting. For details, see the Force.com
Canvas Developer's Guide.

Use Salesforcel Methods to Integrate Navigation with Canvas Apps

Leverage new methods in the Force.com Canvas framework to smoothly integrate navigation or record actions between a canvas app
and Salesforce, without needing to use Visualforce. Now your development tools are within a single framework.

Previously, the only way to circumvent the navigational limitations of the iframe that contains a canvas app was to use Visualforce pages.
These Force.com Canvas methods offer a simpler alternative for controlling navigation to or from canvas apps in Salesforce1.

For example, your canvas app code can call Salesforce1 "create record” logic to navigate to the page where the Create Account button
resides. Clicking the button triggers a Salesforce1 navigation method to go to the record creation page, which is outside of the canvas
app.

Reference the navigation method as an event variable, with name and payload. For example:

var event = {name:"sl.createRecord", payload: {entityName: "Account", recordTypeld:
"00h300000001234"}};

For more information, see “Salesforce1 Navigation Methods for Use with Canvas Apps” in the Force.com Canvas Developer’s Guide.

SDK Object and Field Changes

The following changes have been made to the objects and fields in the Force.com Canvas SDK.

e The Application object contains a new field, canvasContext.application.isInstalledPersonalApp.Inthe
example shown, the field’s value is false, so the application is not designated as a canvas personal app. This is a JSON-formatted field,
and is part of the payload for a signed request. For example:

"application": {
"namespace": null,
"name": "CanvasContextPrettyPrint",
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"canvasUrl": "https://canvas-context-pretty-print.herokuapp.com/canvas.jsp",
"applicationId": "06PD00000004CO0",

"version": "1.0",

"authType": "SIGNED REQUEST",

"referenceId": "09HDO0O0OO0O0OO4CFQ",

"options": [1],

"samlInitiationMethod": "None",

"developerName": "CanvasContextPrettyPrint",

"isInstalledPersonalApp": false

Developer Console

Use new features of Developer Console to more easily manage code in your organization.

EDITIONS
IN THIS SECTION: Available in: Enterprise,
Work with Lightning Resources in the Developer Console Performance, Unlimited,

Developer, and

Create Lightni ts and applications in the Devel Console. The Fil '
reate Lightning components and applications in the Developer Console. The File menu in Database.com Edifions

the Developer Console enables you to quickly access Lightning resources.

Work with Lightning Resources in the Developer Console

Create Lightning components and applications in the Developer Console. The File menu in the Developer Console enables you to quickly
access Lightning resources.

@ Note: Lightning components are available in a beta release. For more information, see Lightning Components (Beta). To create
Lightning resources, you must use a Developer Edition organization that has a namespace prefix.

A Lightning definition can be an application, component, event, or interface. To create a new Lightning definition in the Developer
Console, click File > New and select the definition (1) you want to create. To open an existing definition, click File > Open Lightning
Resources. Once you open the definition, other supporting resources in the definition bundle are available in the sidebar (3), which you
can open by clicking their names on the sidebar. Your resources open in separate tabs in the Source Code Editor (2).

IFlIe ~ Edit~ Debug~ Test~ Workspace~ Help~ < : 1
expenseTracker.app formController.js form.cmp formHelper.js * form.css
1-|( form
2~ getExpenses: function(component) { 2 Cil=Shit=1  COMPONENT
3 var action = component.get("c.getExpenses"); ol Shits2  CONTROLLER

a var self = this;
action.setCallback(this, function(a) {
component.set("v.expenses"”, a.getReturnvalue());

self.updateTotal{component);
1 Ol + Shift+6  RENDERER Creste
H

Curl + Shift +3  HELPER

Cul + Shift +4  STYLE

Cirl + Shift + 5 DOCUMENTATION Create

$A.engueueAction(action);

b

updateTotal : function(component) { '
var expenses = component.get("v.expenses"); 3
14 var total = @;
5 for{var 1 = 8; i < expenses.length; i++){
var e = expenses[i];
total += e.tutorial__Amount_ c;
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Lightning components and applications have optional supporting resources. Events and interfaces don't have supporting resources.
These are the optional supporting resources for components and applications.

e Controller: The client-side controller actions in JavaScript

e Helper: The helper functions in JavaScript

e Style: The CSS declarations

e Documentation: The description and sample code

e Renderer: The custom renderer that overrides the default rendering implementation

When working with Apex classes with Lightning components in the Developer Console, it's useful to refer to the Logs tab to evaluate
your Apex code. For example, if your Apex code fails to save a record because of an invalid input field entryona ui : inputDateTime
Lightning component, you'll see an exception logged in the Logs tab.

Visualforce

Devglop apps that combine Visualforce with HTML and JavaScript, including Salesforce1 and other EDITIONS

mobile apps.

For furtherinformation on features that are affected by these enhancements, refer to the Visualforce Available in: Contact

Developer's Guide. Manager, Group,
Professional, Enterprise,

IN THIS SECTION: Performance, Unlimited,

and Developer Editions
Add Data Access to Your Visualforce Pages with Remote Objects (Generally Available)

Remote Objects is generally available! Woo-hoo! Remote Objects are proxy objects that enable

basic DML operations on sObjects directly from JavaScript. Remote Objects makes it easier to create dynamic pages that use JavaScript
libraries such as jQuery or AngularJS. This exciting feature for adding data access to your JavaScript-based Visualforce pages is now
supported for production use. Additionally, there are two new query operators that you can use in your Remote Objects queries.

Other Changes in Visualforce
We've made some additional changes in Visualforce.

Add Data Access to Your Visualforce Pages with Remote Objects (Generally
Available)

Remote Objects is generally available! Woo-hoo! Remote Objects are proxy objects that enable basic DML operations on sObjects directly
from JavaScript. Remote Objects makes it easier to create dynamic pages that use JavaScript libraries such as jQuery or AngularJS. This
exciting feature for adding data access to your JavaScript-based Visualforce pages is now supported for production use. Additionally,
there are two new query operators that you can use in your Remote Objects queries.

The new query operators are as follows.

e in:in, used for finding a value that matches any of a set of fixed values. Provide values as an array, for example, ['Benioff', 'Jobs',
'Gates'].

e nin:notin, used for finding a value that matches none of a set of fixed values. Provide values as an array, for example, ['Benioff,
'Jobs', 'Gates'].

Here's a query definition that searches for records that match any of several last names.

{

where:
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{

LastName: { in: ['Benioff', 'Jobs', 'Gates'] }

}

Other Changes in Visualforce

We've made some additional changes in Visualforce.

IN THIS SECTION:

Standard Style Sheets Combined by Visualforce

Visualforce now combines various style sheets into a single file before referencing or serving them in page requests. Combining
style sheets reduces the number of network connections that are required to load a page and its resources. Reducing the number
of connections improves performance modestly and should particularly affect higher-latency connections, such as those on some
mobile networks.

Preserve sObject Field Encryption in Visualforce Expressions

For Visualforce pages set to APl version 32.0 or later, expressions that reference encrypted sObject fields return the encrypted values
instead of the decrypted (plain) values. This behavior more closely matches your expectations and reduces the risk of inadvertent
exposure of sensitive data due to programmer error.

Serve Static Resources from the Visualforce Domain

When activated, this update changes the way that your static resources, such as images, JavaScript, and CSS files, are served from
Salesforce. To avoid broken references to static resources, make sure that you review our recommended best practices.

Standard Style Sheets Combined by Visualforce

Visualforce now combines various style sheets into a single file before referencing or serving them in page requests. Combining style
sheets reduces the number of network connections that are required to load a page and its resources. Reducing the number of connections
improves performance modestly and should particularly affect higher-latency connections, such as those on some mobile networks.

Previously Visualforce referenced and served these style sheets separately. The style sheet content is unchanged. You don't need to do
anything to take advantage of this improvement.

Preserve sObiject Field Encryption in Visualforce Expressions

For Visualforce pages set to APl version 32.0 or later, expressions that reference encrypted sObject fields return the encrypted values
instead of the decrypted (plain) values. This behavior more closely matches your expectations and reduces the risk of inadvertent exposure
of sensitive data due to programmer error.

An expression might be used with a Visualforce component that displays it, such as <apex : outputText> or <apex:column>,
orasa"raw” expression on the page, forexample, { ! myObject c.encryptedField ¢ }.Inthesescenarios,the encrypted
value, rather than the decrypted value, of the field is displayed.

This behavior parallels the documented behavior of <apex : inputField> and <apex:outputField>, whichdisplayencrypted
values for encrypted fields.

Pages set to APl version 31.0 or earlier continue to display decrypted values for encrypted sObject fields, except when displayed by using
<apex:inputField>and <apex:outputField>.

This change is versioned, and you must update your pages to API version 32.0 or later to see the changed functionality.
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@ Nofe: Because Apex doesn't have an encrypted data type, expressions that reference controller properties or methods that return
Apex variables—that is, Apex values rather than sObject values—always display plain (decrypted) values.

Serve Static Resources from the Visualforce Domain

When activated, this update changes the way that your static resources, such as images, JavaScript, and CSS files, are served from
Salesforce. To avoid broken references to static resources, make sure that you review our recommended best practices.

Prior to the Winter '15 release, some static resources, such asimages and CSS files, were loaded from the Salesforce Domain. This update
changes that behavior so that all static resources are loaded from the Visualforce Domain. This change to the origin domain can cause
absolute references to static resources to break.

It's a best practice to reference static resources by using the SResource global variable and the URLFOR () function instead of
static strings. For example:

® <apex:includeScript value="{!S$Resource.MyJavascriptFile}"/>

® <apex:image url="{!URLFOR (S$SResource.TestZip, 'images/Bluehills.jpg')}" width="50"
height="50"/>

These references are safe to use regardless of your organization’s settings for this Critical Update.

We recommend that you test this update in a sandbox or Developer Edition organization to verify correct behavior of your pages before
enabling it in your production organization.

To activate this critical update:
1. From Setup, click Critical Updates.

2. C(lick Activate for “Serve static resources from Visualforce Domain.”

Apex Code

Using syntax that looks like Java and acts like database stored procedures, Apex enables developers
to add business logic to most system events, including button clicks, related record updates, and
Visualforce pages. Apex code execution can be initiated by Web service requests and from triggers

EDITIONS

Available in: Enterprise,

on objects. Performance, Unlimited,
Apexincludes the following enhancements. For detailed information on these enhancements, refer Developer, and

to the Force.com Apex Code Developer's Guide. Database.com Editions
IN THIS SECTION:

Submit and Monitor Jobs for Asynchronous Execution with the Queueable Interface

Take control of your asynchronous Apex processes by using the Queueable interface. This interface enables you to add jobs to
the queue and monitor them, which is an enhanced way of running your asynchronous Apex code compared to using future
methods.

Run More Future Methods and Callouts

The execution limits of future methods and callouts in an Apex transaction have increased to 50 methods and 100 callouts respectively.
These limit increases enable you to do more with Apex without having to be restricted by the previous limits.

Run More Tests in Sandbox and Developer Organizations

The test execution limit for asynchronous tests has increased and you can now run twice as many tests in large sandbox or Developer
Edition organizations.
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Apex Triggers Supported for the Territory2 Object
Use triggers on the Territory2 object to automate actions or processes related to customizations or record updates.

Apex Triggers Supported for the UserTerritory2Association Object
Use triggers on the UserTerritory2Association object to automate actions or processes related to customizations or record updates.

Apex Supported for the SearchPromotionRule sObject

Promoted search terms are useful for promoting a Salesforce Knowledge article that you know is commonly used to resolve a support
issue when an end user’s search contains certain keywords. Users can promote an article in search results by associating keywords
with the article in Apex (by using the SearchPromotionRule sObject) in addition to the Salesforce user interface.

New and Changed Apex Classes

These classes, methods, and interfaces are new or have changed in this release.

Submit and Monitor Jobs for Asynchronous Execution with the Queueable
Interface

Take control of your asynchronous Apex processes by using the Queueable interface. This interface enables you to add jobs to the
queue and monitor them, which is an enhanced way of running your asynchronous Apex code compared to using future methods.

For Apex processes that run for a long time, such as extensive database operations or external Web service callouts, you can run them
asynchronously by implementing the Queueable interface and adding a job to the Apex job queue. In this way, your asynchronous
Apex job runsin the background in its own thread and doesn't delay the execution of your main Apex logic. Each queued job runs when
system resources become available. A benefit of using the Queueable interface methods is that some governor limits are higher
than for synchronous Apex, such as heap size limits.

Queueable jobs are similar to future methods in that they're both queued for execution, but they provide you with these additional
benefits.

e Getting an ID for your job: When you submit your job by invoking the System.enqueueJob method, the method returns the
ID of the new job. This ID corresponds to the ID of the AsyncApexJob record. You can use this ID to identify your job and monitor
its progress, either through the Salesforce user interface in the Apex Jobs page, or programmatically by querying your record from
AsyncApexJob.

e Chaining jobs: You can chain one job to another by starting a second job from a running job. Chaining jobs is useful if you need to
do some processing that depends on another process to have run first.

Example
This example is an implementation of the Queueable interface. The execute method in this example inserts a new account.

public class AsyncExecutionExample implements Queueable ({
public void execute (QueueableContext context) {
Account a = new Account (Name='Acme', Phone="'(415) 555-1212");
insert a;

}
To add this class as a job on the queue, call this method:
ID jobID = System.enqueueJob (new AsyncExecutionExample());

After you submit your queueable class for execution, the job is added to the queue and will be processed when system resources become
available. You can monitor the status of your job programmatically by querying AsyncApexJob or through the user interface in Setup
by clicking Jobs > Apex Jobs.
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the Queueable Interface

To query information about your submitted job, perform a SOQL query on AsyncApexJob by filtering on the job ID that the
System.enqueueJob method returns. This example uses the joblID variable that was obtained in the previous example.

AsyncApexJob jobInfo = [SELECT Status,NumberOfErrors FROM AsyncApexJob WHERE Id=:jobID];

Similar to future jobs, queueable jobs don't process batches, and so the number of processed batches and the number of total batches
are always zero.

Testing Queueable Jobs

This example shows how to test the execution of a queueable job in a test method. A queueable job is an asynchronous process. To
ensure that this process runs within the test method, the job is submitted to the queue between the Test.startTest and
Test.stopTest block The system executes all asynchronous processes started in a test method synchronously after the
Test.stopTest statement. Next, the test method verifies the results of the queueable job by querying the account that the job

created.

@isTest

public class AsyncExecutionExampleTest {

}

static testmethod void testl () {

// startTest/stopTest block to force async processes
// to run in the test.

Test.startTest () ;

System.enqueueJob (new AsyncExecutionExample());
Test.stopTest () ;

// Validate that the Jjob has run

// by verifying that the record was created.

// This query returns only the account created in test context by the

// Queueable class method.

Account acct = [SELECT Name, Phone FROM Account WHERE Name='Acme' LIMIT 17];
System.assertNotEquals (null, acct);

System.assertEquals (' (415) 555-1212', acct.Phone);

@ Nofe: The ID of a queueable Apex job isn't returned in test context—System. enqueueJob returns null inarunning test.

Chaining Jobs

If you need to run a job after some other processing is done first by another job, you can chain queueable jobs. The maximum number
of jobs in the chain (maximum stack depth) is two, which means that you can link a job only once. To chain a job to another, submit the
second job from the execute () method of your queueable class. You can add only one job from an executing job. For example, if
you have a second class called SecondJob thatimplements the Queueable interface, you can add this class to the queue in the
execute () method as follows:

public class AsyncExecutionExample implements Queueable ({

public void execute (QueueableContext context) {

// Your processing logic here

// Chain this job to next job by submitting the next job
System.enqueueJob (new SecondJob ()) ;
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You can't chain queueable jobs in an Apex test. Doing so results in an error. To avoid getting an error, you can check if Apex is running
in test context by calling Test . isRunningTest () before chaining jobs.

Queueable Apex Limits

e The execution of a queued job counts once against the shared limit for asynchronous Apex method executions.
e You can add up to 50 jobs to the queue with System.enqueueJob in a single transaction.

e The maximum stack depth for chained jobs is two, which means that you can link a job only once and have a maximum of two jobs
in the chain.

e When chaining jobs, you can add only one job from an executing job with System.enqueueJob.

Run More Future Methods and Callouts

The execution limits of future methods and callouts in an Apex transaction have increased to 50 methods and 100 callouts respectively.
These limit increases enable you to do more with Apex without having to be restricted by the previous limits.

For example, you might have transferred much of your long-running code to future methods that you call and run asynchronously from
your main class. If you did many of these future calls in your class, you might have hit the limit of 10 future calls in one transaction. With
the increased limit of 50 calls, you can make many more future calls without likely hitting this limit.

The following limits have increased.

Limit Description Old Value New Value
Maximum number of methods with the future annotation allowed per Apex 10 50
invocation

Maximum number of callouts (HTTP requests or Web services calls) in a transaction 10 100

Run More Tests in Sandbox and Developer Organizations

The test execution limit for asynchronous tests has increased and you can now run twice as many tests in large sandbox or Developer
Edition organizations.

For sandbox and Developer Edition organizations, the following test execution limit for asynchronous tests has increased.

Limit Value

Maximum number of test classes that can be queued per 24-hour  The greater of 500 or 20 multiplied by the number of test classes
period in the organization

The increase is in the portion of the limit that varies with the number of test classes in your organization—20 (instead of 10) multiplied
by the number of test classes in the organization. If your organization has a large number of test classes (26 or more test classes), you
will benefit from this increase and you can run twice the number of tests than what was previously possible.

The increase in the test execution limit increase applies to sandbox organizations in all supported editions and Developer Edition
organizations. This limit is unchanged for production organizations in all other editions.

256



Force.com Development Apex Triggers Supported for the Territory2 Object

Apex Triggers Supported for the Territory2 Object

Use triggers on the Territory2 object to automate actions or processes related to customizations or record updates.

@ Example: For example, you might create a trigger that reads a custom field and tracks the number of territories in each territory
model, incrementing or decrementing the count each time a territory is created or deleted.

Apex Triggers Supported for the UserTerritory2Association Object

Use triggers on the UserTerritory2Association object to automate actions or processes related to customizations or record updates.

@ Example: For example, you might create a trigger that sends an email notification to your company’s Sales Operations group to
let them know when users are added to territories.

Apex Supported for the SearchPromotionRule sObject

Promoted search terms are useful for promoting a Salesforce Knowledge article that you know is commonly used to resolve a support
issue when an end user’s search contains certain keywords. Users can promote an article in search results by associating keywords with
the article in Apex (by using the SearchPromotionRule sObject) in addition to the Salesforce user interface.

@ Example: This code sample shows how to add a search promotion rule. This sample performs a query to get published articles
of type MyArticle__kav. Next, the sample creates a SearchPromotionRule sObject to promote articles that contain the word
“Salesforce” and assigns the first returned article to it. Finally, the sample inserts this new sObject.

// Identify the article to promote in search results
List<MyArticle kav> articles = [SELECT Id FROM MyArticle kav WHERE
PublishStatus='Online' AND Language='en US' AND Id='Article Id'];

// Define the promotion rule

SearchPromotionRule s = new SearchPromotionRule (
Query="'Salesforce',
PromotedEntity=articles[0]);

// Save the new rule
insert s;

To perform DML operations on the SearchPromotionRule sObject, you must enable Salesforce Knowledge.

New and Changed Apex Classes

These classes, methods, and interfaces are new or have changed in this release.

New Methods

The following existing classes have new methods.
Approval.ProcessSubmitRequest class:

getProcessDefinitionNameOrld()
Returns the developer name or ID of the process definition.
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getSkipEntryCriteria()
If getProcessDefinitionNameOrId () returnsavalueotherthan null, getSkipEntryCriteria () determines
whether to evaluate the entry criteria for the process (t rue) or not (false).

getSubmitterld()
Returns the user ID of the submitter requesting the approval record. The user must be one of the allowed submitters in the
process definition setup.

setProcessDefinitionNameOrld(String)
Sets the developer name or ID of the process definition to be evaluated.

setSkipEntryCriteria(Boolean)
If the process definition name or ID is not null, setSkipEntryCriteria () determineswhether to evaluate the entry
criteria for the process (t rue) or not (false).

setSubmitterld(String)
Sets the user ID of the submitter requesting the approval record. The user must be one of the allowed submitters in the process
definition setup. If you don't set a submitter ID, the process uses the current user as the submitter.

Schema.DescribeFieldResult class:

getReferenceTargetField()
Returns the name of the custom field on the parent standard or custom object whose values are matched against the values of
the child external object's indirect lookup relationship field. The match is done to determine which records are related to each
other.

System.Limits class:

getQueueablelobs()
Returns the number of queueable jobs that have been added to the queue per transaction. A queueable job corresponds to a
class that implements the Queueable interface.

getLimitQueueableJobs()
Returns the maximum number of queueable jobs that can be added to the queue per transaction. A queueable job corresponds
to a class that implements the Queueable interface.

System.Network class:

getLoginUrl(String)
Returns the absolute URL of the login page used by the community.

getLogoutUrl(String)
Returns the absolute URL of the logout page used by the community.

getSelfRegUrl(String)
Returns the absolute URL of the self-registration page used by the community.

loadAllPackageDefaultNetworkDashboardSettings()
Maps the dashboards from the Communities Analytics package onto each community’s unconfigured dashboard settings.
Returns the number of settings it configures.

System.System class:

enqueuelob(Object)
Adds a job to the Apex job queue that corresponds to the specified queueable class and returns the job ID.

Changed Methods

The following methods have changed.
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instanceof keyword:

Versioned behavior change when instanceof is used with a null object
In Apex saved with APl version 32.0 and later, instanceof returns false if the left operand is a null object. For example,
the following sample returns false.

Object o = null;
Boolean result = o instanceof Account;
System.assertEquals (false, result);

In APl version 31.0 and earlier, instanceof returns true in this case.

New Properties and Fields
The following existing classes have new properties.
InboundEmail .BinaryAttachment class:

headers
Any header values associated with the attachment. Examples of header names include Content-Type,
Content-Transfer-Encoding,and Content-1ID.

InboundEmail.TextAttachment class:

headers
Any header values associated with the attachment. Examples of header names include Content-Type,
Content-Transfer-Encoding,and Content-ID.

The following existing classes have new constants.

System.Math class:

E
Returns the mathematical constant e, which is the base of natural logarithms.
PI
Returns the mathematical constant pi, which is the ratio of the circumference of a circle to its diameter.
New Classes

The following classes have been added.

Auth.AuthConfiguration Class
Contains methods for configuring the settings for users to log in to a community, or a custom domain created using My Domain,
with an authentication provider, such as Facebook®.

getAuthConfig()
Returns the AuthConfig sObject, which represents the authentication options, for a community or custom domain that was
created by using My Domain.

getAuthConfigProviders()
Returns the list of authentication providers configured for a community or custom domain.

getAuthProviders()
Returns the list of authentication providers available for a community or custom domain.

getAuthProviderSsoUrl(String, String, String)
Returns the single sign-on URL for a community or custom domain.
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getBackgroundColor()
Returns the color for the background of the login page for a community.

getDefaultProfileForRegistration()
Returns the profile ID assigned to new community users.

getFooterText()
Returns the text at the bottom of the login page for a community.

getLogoUrl()
Returns the location of the icon image at the bottom of the login page for a community.

getSamlProviders()
Returns the list of SAML-based authentication providers available for a community or custom domain.

getSamlSsoUrl(String, String, String)
Returns the single sign-on URL for a community or custom domain.

getSelfRegistrationEnabled()
Indicates whether the current community allows new users to create their own account by filling out a registration form.

getSelfRegistrationUrl()
Returns the location of the self-registration page for new users to sign up for an account with a community.

getStartUrl()
Returns the page of a community or custom domain displayed after a user logs in.

getUsernamePasswordEnabled()
Indicates whether the current community is set to display a login form asking for a username and password. You can configure
the community not to request a username and password if it is for unauthenticated users or users logging in with a third-party
authentication provider.

Auth.CommunitiesUtil Class
Contains methods for getting information about a community user.

getLogoutUrl()
Returns the page to display after the current community user logs out.

getUserDisplayName()
Returns the current user's community display name.

isGuestUser()
Indicates whether the current user isn't logged in to the community and may need to be redirected to log in, if required.

isInternalUser()
Indicates whether the current user is logged in as a member of the parent Salesforce organization, such as an employee.

Auth.SessionManagement Class
Contains methods for customizing security levels, two-factor authentication, and trusted IP ranges for a current session.

getCurrentSession()
Returns a map of attributes for the current session.

getQrCode()
Returns a map containing a URL to a quick response (QR) code and a time-based one-time password (TOTP) shared secret to
configure two-factor authentication apps or devices.

inOrgNetworkRange(String)
Indicates whether the given IP address is within the organization's trusted IP range according to the organization's Network
Access settings.
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islpAllowedForProfile(String, String)
Indicates whether the given IP address is within the trusted IP range for the given profile.

setSessionLevel(Auth.SessionLevel)
Sets the user's current session security level.

validateTotpTokenForKey(String, String)
Indicates whether a given time-based one-time password (TOTP) code (token) is valid for the given shared key.

validateTotpTokenForUser(String)
Indicates whether a given time-based one-time password (TOTP) code (token) is valid for the current user.

New Interfaces

The following interfaces have been added.
System.Queueable interface:

execute(QueueableContext)
Executes the queueable job.

System.QueueableContext interface:

getJobld()
Returns the ID of the submitted job that uses the Queueable interface.

IN THIS SECTION:

ConnectApi (Chatter in Apex)
To create custom Chatter experiences in Salesforce, use Chatter in Apex.

ConnectApi (Chatter in Apex)
To create custom Chatter experiences in Salesforce, use Chatter in Apex.

Many Chatter REST APl resource actions are exposed as static methods on Apex classesinthe ConnectApi namespace. These methods
use other ConnectApi classes to input and return information. The ConnectApi namespace is referred to as Chatter in Apex.

In Apex, it's possible to access some Chatter data using SOQL queries and objects. However, ConnectApi classes expose Chatter
datainamuch simpler way. Data is localized and structured for display. For example, instead of making many calls to access and assemble
a feed, you can do it with a single call.

@ Nofte: To integrate mobile apps, intranet sites, and third-party Web applications with Chatter, use Chatter REST API.

IN THIS SECTION:
General Updates to Chatter in Apex
New and Changed Chatter in Apex Classes
New and Changed Chatter in Apex Input Classes
New and Changed Chatter in Apex Output Classes
New and Changed Chatter in Apex Enums
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General Updates to Chatter in Apex

Feed Elements

@ Important: APl version 32.0 introduces new methods that get, search, update, and post feed elements. These methods operate
onand return new input and output classes that represent feed elements. Older methods and classes that operate on and represent
feed items aren't supported in APl version 32.0. The documentation for older methods and classes contains links to the
documentation for the newer methods and classes.

In APl versions 30.0 and earlier, a Chatter feed was a container of feed items. In APl version 31.0, the definition of a feed expanded to
include new objects that didn't entirely fit the feed item model. The Chatter feed became a container of “feed elements.” The abstract
class ConnectApi.FeedElement wasintroduced as a parent class to the existing ConnectApi . FeedItem classand the
subset of properties that feed elements share was moved into the ConnectApi.FeedElement class.

This change allows the Chatter feed to contain both feed items and other objects that inherit from the ConnectApi . FeedElement
class, such as Recommendations (which are ConnectApi.GenericFeedElement objects with arecommendations capability).

Feed Elements Inheritance Diagram

ConnectApi.FeedElement

* body
* capabilities
* CcreatedDate
* TeedElementType
* header
* id
* modifiedDate
®* parent
* relativeCreatedDate
®* url
|
I
ConnectApi.FeedItem ConnectApi.GenericFeedElement
®* actor
#* canShare
# clientInfo
* event
# isDeleteRestricted
# originalFeedItem
% originalFeedItemActor
* photolrl
% type
* yvisibility

APl version 31.0 introduced methods that operate on feed elements instead of on feed items. Detailed information about these changes
are in the Feed Elements section of New and Changed Chatter in Apex classes. Detailed information about the new feed element input
and output classes are in those sections of the release notes.

Capabilities

@ Important: Attachments are not supported in APl version 32.0. All attachment functionality has been moved into capabilities.
Whereas a feed item could have only one attachment, feed items can now have multiple capabilities. The documentation for
attachments contains links to the new capabilities.

As part of the effort to diversify the feed, pieces of functionality found in feed elements have been broken out into capabilities. Capabilities
provide a consistent way to interact with objects in the feed. Instead of inspecting feed item type and using other indirect means to
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determine which functionality is available for a specific feed element, the capabilities object tells you explicitly what is available. A client
should check for the presence of a capability to determine what it can do to a feed element.

In version 32.0 and later, every feed element can have a unique set of capabilities. A capability object includes both an indication that a
feature is possible and data associated with that feature. If a capability property exists on a feed element, that capability is available, even
if there isn't any data associated with the capability yet. For example, if the chatterLikes capability property exists on a feed
element (with or without any likes included in the list of likes found in the chatterLikes.page.1items property), the context
user can like that feed element. If the capability property doesn't exist on a feed element, it isn't possible to like that feed element.

Capabilities Inheritance Diagram

ConnectApi.FeedElement {abstract)

* body
* capabilities =———————————————— ConnecthApi.FeedElementCapabilities
* createdDate * approval
* TeedElementType * banner
* header * bookmarks
* id * bundle
* modifiedDate #* Canvas
* parent * caseComment
* relativeCreatedDate #* chatterLikes
®* url * comments
#* content
* dashboardComponentSnapshot
* emailMessage
* enhancedLink
#* link
* moderation
* poll
* guestionAndAnswers
#* recommendations
* recordSnapshot
* topics
* trackedChanges

Detailed information about these changes are in the “Capabilities” sections of the release notes.

Recommendations

Recommendations are new to the Chatter feed in APl version 32.0. Recommendationsare ConnectApi.GenericFeedElement
objectswitha ConnectApi.RecommentationsCapability.They'reanexample of what's possible with the new feed element
and capabilities architecture.

The news feed in Salesforce 1 mobile browser app can include recommendations about useful groups to join. The feed can also recommend
the Today app but this option can be turned off from Setup > Customize > Chatter > Settings.

Methods that get feed elements from a feed, such as ChatterFeeds.getFeedElementsFromFeed, return
ConnectApi.FeedElementPage, which containsalist of ConnectApi.FeedElement objects.

This diagram shows the properties that ConnectApi .GenericFeedElement inheritsfrom ConnectApi.FeedElement,
and shows the recommendations capability associated with the generic feed element.
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Recommendations Inheritance Diagram

ConnectApi.FeedElement

ConnectApi.GenericFeedElement

* body
% capabilities -- ConnectApi.FeedElementCapabilities
* CcreatedDate * recommendations == ConnectApi.RecommendationsCapability
* TeedElementType * items -- List=ConnectApi.AbstractRecommendation=
* header * explanation
* id * recommendationType
* modifiedDate |
* parent |
* relativeCreatedDate
* url | |
ConnectApi.EntityRecommendation ConnectApi.NonEntityRecommendation
* actOnUrl * displaylLabel
% action =- RecommendationActionType * motif
®* entity * Tollow
* join
®* View

See Recommendations on page 285 for detailed information about these changes.
New and Changed Chatter in Apex Classes

Batch Posting Feed Elements

Post a batch of up to 500 feed elements for the cost of one DML statement. For example, you could create a trigger that bulk posts to
the feeds of newly inserted accounts.

Post a batch of feed elements
Usethe ChatterFeeds.postFeedElementBatch (String, List<ConnectApi.BatchInput>) method.In
the ConnectApi.BatchInput constructor, the input object must be a concrete instance of the abstract
ConnectApi.FeedElementInput class.

Capabilities
See Capabilities on page 262 for general information about capabilities and how they have changed in APl version 32.0.

Bookmark or unbookmark a feed element
If the bookmarks capability is available, you can use these two ChatterFeeds methods to bookmark or unbookmark a feed
element:

® updateFeedElementBookmarks (String, String, ConnectApi.BookmarksCapabilityInput)
® updateFeedElementBookmarks (String, String, Boolean)

Get comments for a feed element
If the comments capability is available, you can use these ChatterFeeds methods to get comments for a feed element:

® getCommentsForFeedElement (String, String)
® getCommentsForFeedElement (String, String, String, Integer)

Post a comment to a feed element
If the comments capability is available, you can use these ChatterFeeds methods to post a comment to a feed element:

® ChatterFeeds.postCommentToFeedElement (String, String, String)
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® ChatterFeeds.postCommentToFeedElement (String,

ConnectApi.BinaryInput)

Like or unlike a feed element

New and Changed Apex Classes

String, ConnectApi.CommentInput,

If the Chatter likes capability is available, you can use the ChatterFeeds.likeFeedElement (String, String)

method to like or unlike a feed element.

Get likes for a feed element

If the Chatter likes capability is available, you can use these ChatterFeeds methods to get likes for a feed element:

® getlLikesForFeedElement (String,
® getLikesForFeedElement (String,

Vote on a poll

String)
String,

Integer, Integer)

If the poll capability is available, you can use the ChatterFeeds.voteOnFeedElementPoll (String, String,

String) method to vote on a poll.

Get information about a poll

If the poll capability is available, you can use the ChatterFeedsgetFeedElementPoll (String, String) method

to get information about a poll.

Get, remove, and add flags to feed elements

If the moderation capability is available, you can use these CommunityModeration methods:

® addFlagToFeedElement (String, String)
® addfFlagToFeedElement (String, String,
® getFlagsOnFeedElement (String, String)
® getFlagsOnFeedElement (String, String,

® removeFlagFromFeedElement (String,

String,

ConnectApi.CommunityFlagVisibility)

ConnectApi.CommunityFlagVisibility)

String)

This table describes how to migrate from earlier API versions to APl version 32.0.

In API versions 31.0 and earlier use...

ChatterFeeds.getCommentsForFeedItem (String,

String, String, Integer)

ChatterFeeds.getCommentsForFeedItem (String,
String)

ChatterFeeds.getFeedPoll (String, String)

ChatterFeeds.getlLikesForFeedItem(String,

String, Integer, Integer)

ChatterFeeds.getLikesForFeedItem(String,

String)
ChatterFeeds.likeFeedItem(String, String)
ChatterFeeds.postComment (String, String,

ConnectApi.CommentInput,
ConnectApi.BinaryInput)

In API version 32.0, use...

ChatterFeeds.getCommentsForFeedElement (String,

String, String, Integer)

ChatterFeeds.getCommentsForFeedElement (String,
String)

ChatterFeeds.getFeedElementPoll (String,
String)

ChatterFeeds.getLikesForFeedElement (String,

String, Integer, Integer)

ChatterFeeds.getLikesForFeedElement (String,
String)

ChatterFeeds.likeFeedElement (String,
String)

ChatterFeeds.postCommentToFeedElement (String,
String, ConnectApi.CommentInput,

ConnectApi.BinaryInput)
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In API versions 31.0 and earlier use...

ChatterFeeds.postComment (String, String,

String)

ChatterFeeds.updateBookmark (String, String,
Boolean)

ChatterFeeds.voteOnFeedPoll (String,
String)

String,

CommunityModeration.addFlagToFeedItem (String,
String, ConnectApi.CommunityFlagVisibility)

CommunityModeration.addFlagToFeedItem (String,
String)

CommunityModerationgetFlagsOnFeedItem (String,
String, ConnectApi.CommunityFlagVisibility)

CommunityModeration.getFlagsOnFeedItem (String,
String)

CommunityModeration. removeFlagFromFeedItem (String,

String, String)

Communities

New and Changed Apex Classes

In API version 32.0, use...

ChatterFeeds.postCommentToFeedElement (String,

String, String)

ChatterFeeds.updateFeedElementBookmarks (String,

String, Boolean)

ChatterFeeds.voteOnFeedElementPoll (String,

String, String)

CommunityModeration.addFlagToFeedElement (String,
String, ConnectApi.CommunityFlagVisibility)

CommunityModeration.addFlagToFeedElement (String,
String)

ConmunityModeration.getFlagsOnFeedElement (String,
String, ConnectApi.CommunityFlagVisibility)

CommunityModeration.getFlagsOnFeedElement (String,
String)

Camuni tyModeration. removeFlagEFromFeedElement (String,

String, String)

Communities helps companies share information with their customers and partners.

Get and search feed elements from the Communities home feed
The Communities home feed contains all the feed elements associated with any managed topics in a community. To get and search
this feed, call the existing getFeedElementsFromFeed, getFeedElementsUpdatedSince,and
searchFeedElementsInFeed methodsand pass ConnectApi.FeedType.Home forthe feedType parameter.

Get a community member’s reputation

Usethenew ChatterUsers.getReputation (String, String) method togetacommunity member's reputation.

Get information about, create, reorder, and delete managed topics
Only community managers (users with the “Create and Set Up Communities” or “Manage Communities” permission) can create,

reorder, and delete managed topics.

Get information about managed topics in a community with these new ManagedTopics methods:

® getManagedTopic (String, String)
® getManagedTopics (String)

® getManagedTopics (String,

ConnectApi.ManagedTopicType)

Create a managed topic in a community with these new methods:

® createManagedTopic(String, String,

® createManagedTopicByName (String,

Reorder managed topics in a community with this new method:

® reorderManagedTopics (String,

Delete a managed topic in a community with this new method:

String,

ConnectApi.ManagedTopicType)

ConnectApi.ManagedTopicType)

ConnectApi.ManagedTopicPositionCollectionInput)
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® deleteManagedTopic (String, String)

Get question and answers suggestions
Get question and answers suggestions with this new QuestionAndAnswers method: getSuggestions (String,
String, String, Boolean, Integer).

This method has an associated setTest method to register data for use in a test context.

Choose or change a best answer
Use this QuestionAndAnswer.updateQuestionAndAnswers (String, String,
ConnectApi.QuestionAndAnswersCapabilityInput) methodtochoose or change the bestanswer fora question.

Get and search feed elements filtered by question type from the Communities home, news, record, and topic feeds
Getand search feed elements filtered by question type from the home, news, record, and topic feeds. The question types are defined
inthe new ConnectApi.FeedFilter enum:

e AllQuestions—Onlyfeed elements that are questions.

® SolvedQuestions—Onlyfeed elements that are questions and that have a best answer.

® UnansweredQuestions—Only feed elements that are questions and that don't have any answers.
® UnsolvedQuestions—Onlyfeed elements that are questions and that don't have a best answer.
Pass one of these values in the £ilter parameterin a call to these new ChatterFeeds methods:

® getFeedElementsFromFeed (String, ConnectApi.FeedType, Integer,
ConnectApi.FeedDensity, String, Integer, ConnectApi.FeedSortOrder,
ConnectApi.FeedFilter)

® getFeedElementsFromFeed (String, ConnectApi.FeedType, String, Integer, Integer,
ConnectApi.FeedDensity, String, Integer, ConnectApi.FeedSortOrder, Boolean,
ConnectApi.FeedFilter)

® getFeedElementsUpdatedSince (String, ConnectApi.FeedType, Integer,
ConnectApi.FeedDensity, String, Integer, String, ConnectApi.FeedFilter)

® getFeedElementsUpdatedSince (String, ConnectApi.FeedType, String, Integer, Integer,
ConnectApi.FeedDensity, String, Integer, String, Boolean, ConnectApi.FeedFilter)

® searchFeedElementsInFeed(String, ConnectApi.FeedType, Integer,
ConnectApi.FeedDensity, String, Integer, ConnectApi.FeedSortOrder, String,
ConnectApi.FeedFilter)

® searchFeedElementsInFeed(String, ConnectApi.FeedType, String, Integer,
ConnectApi.FeedDensity, String, Integer, ConnectApi.FeedSortOrder, String, Boolean,
ConnectApi.FeedFilter)

These methods have associated setTest methods to register data for use in a test context.

Access public content from a guest user account
If your community allows access without logging in, all overloads of these methods are now available to guest users. These methods
return information the guest user has access to.

ChatterFeeds methods:

® getCommentsForFeedElement
® getFeed

® getFeedElementBatch

® getFeedElementPoll

® getLike
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® getLikesForFeedElement
ChatterUsers methods:

® getFollowers

® getFollowings

® getGroups

® getPhoto

® getReputation

® getUser

® getUserBatch

® getUsers

® searchUserGroups

® searchUsers

ManagedTopics methods:

® getManagedTopic

® getManagedTopics

Topics methods:

® getGroupsRecentlyTalkingAboutTopic
® getRecentlyTalkingAboutTopicsForGroup
® getRecentlyTalkingAboutTopicsForUser
® getRelatedTopics

® getTopic

® getTopics

® getTrendingTopics

Data.com
Data.com is the solution for delivering leading business data inside Salesforce.

Purchase Data.com contacts or companies, and track your purchase usage information

New and Changed Apex Classes

Match and purchase Data.com contacts and companies with these new ConnectApi.Datacloud methods:

® getCompaniesFromOrder (String, String, String)
® getCompany (String)

® getContact (String)

® getContactsFromOrder (String, String, String)
® getOrder (String)

® getUsage (String)

® postOrder (ConnectApi.DatacloudOrderInput)

Feed Elements

See Feed Elements on page 262 for general information about how feed elements and feed items have changed in API version 32.0.
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New and Changed Apex Classes

This table describes how to migrate from earlier APl versions to APl version 32.0. The methods in the first column are supported in AP
versions 31.0 and earlier. The methods in the second column were new in APl version 31.0. The feed element methods return a
ConnectApi.FeedElement or ConnectApi.FeedElementPage object.

@ Important: APl version 31.0 was a transitional release that supported both methods that operate on feed elements and methods
that operate on feed items. When you call a feed items method in APl version 31.0, it returns only feed items, not other feed
element subclasses. As of APl version 32.0, only feed element methods are supported.

In API versions 31.0 and earlier use...

ChatterFavorites.getFeedItems (String,

String, String)

ChatterFavorites.getFeedItems (String,

String, String, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFavorites.getFeedItems (String,
String, String,
FeedSortOrder)

Integer, String, Integer,

ChatterFeeds.deleteFeedItem(String, String)

ChatterFeeds.getFeedItem(String, String)

ChatterFeeds.getFeedItemBatch (String,
List<String>)

ChatterFeeds.getFeedItemsFromFeed (String,
ConnectApi.FeedType, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFeeds.getFeedItemsFromFeed (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder, Boolean)

ChatterFeeds.getFeedItemsFromFeed (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFeeds.getFeedItemsFromFeed (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFeeds.getFeedItemsFromFeed (String,

ConnectApi.FeedType, String, String,

Integer, ConnectApi.FeedSortOrder)

ChatterFeeds.getFeedItemsFromFeed (String,

ConnectApi.FeedType, String)

In API versions 31.0 and later, use...

ChatterFavorites.getFeedElements (String,

String, String)

ChatterFavorites.getFeedElements (String,

String, String, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFavorites.getFeedElements (String,
String, String,
FeedSortOrder)

Integer, String, Integer,

ChatterFeeds.deleteFeedElement (String,
String)

ChatterFeeds.getFeedElement (String, String)

ChatterFeeds.getFeedElementBatch (String,
List<String>)

ChatterFeeds.getFeedElementsFromFeed (String,
ConnectApi.FeedType, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFeeds.getFeedElementsFromFeed (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder, Boolean)

ChatterFeeds.getFeedElementsFromFeed (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFeeds.getFeedElementsFromFeed (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFeeds.getFeedElementsFromFeed (String,

ConnectApi.FeedType, String, String,

Integer, ConnectApi.FeedSortOrder)

ChatterFeeds.getFeedElementsFromFeed (String,

ConnectApi.FeedType, String)
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In API versions 31.0 and earlier use...

ChatterFeeds.getFeedItemsFromFeed (String,
ConnectApi.FeedType)

ChatterFeeds.getFeedItemsFromFilterFeed (String,

String, String, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFeeds.getFeedItemsFromFilterFeed (String,

String, String, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFeeds.getFeedItemsFromFilterFeed (String,

String, String)

ChatterFeeds.
getFeedItemsFromFilterFeedUpdatedSince (String,
String, String, Integer,
ConnectApi.FeedDensity, String, Integer,

String)

ChatterFeeds.getFeedItemsUpdatedSince (String,
ConnectApi.FeedType, Integer,

ConnectApi.FeedDensity, String, Integer,

String)

ChatterFeeds.getFeedItemsUpdatedSince (String,

ConnectApi.FeedType, String, Integer,
ConnectApi.FeedDensity, String, Integer,
String, Boolean)

ChatterFeeds.getFeedItemsUpdatedSince (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedDensity, String, Integer,

String)

ChatterFeeds.postFeedItem(String,
ConnectApi.FeedType, String,
ConnectApi.FeedItemInput,

ConnectApi.BinaryInput)

ChatterFeeds.postFeedItem(String,

ConnectApi.FeedType, String, String)

ChatterFeeds.searchFeedItems (String,

String, ConnectApi.FeedSortOrder)

ChatterFeeds.searchFeedItems (String,

String, Integer, String, Integer,

ConnectApi.FeedSortOrder)

New and Changed Apex Classes

In API versions 31.0 and later, use...

ChatterFeeds.getFeedElementsFromFeed (String,
ConnectApi.FeedType)

ChatterFeeds.getFeedElementsFromFilterFeed (String,

String, String, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFeeds.getFeedElementsFromFilterFeed (String,

String, String, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFeeds.getFeedElementsFromFilterFeed (String,

String, String)

ChatterFeeds.
getFeedElementsFromFilterFeedUpdatedSince (String,
String, String, Integer,
ConnectApi.FeedDensity, String, Integer,

String)

ChatterFeeds.getFeedElementsUpdatedSince (String,
ConnectApi.FeedType, Integer,

ConnectApi.FeedDensity, String, Integer,

String)

ChatterFeeds.getFeedElementsUpdatedSince (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedDensity, String, Integer,

String, Boolean)

ChatterFeeds.getFeedElementsUpdatedSince (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedDensity, String, Integer,

String)

ChatterFeeds.postFeedElement (String,
ConnectApi.FeedElementInput,
ConnectApi.BinaryInput)

ChatterFeeds.postFeedElement (String,
String, ConnectApi.FeedElementType, String)

ChatterFeeds.searchFeedElements (String,

String, ConnectApi.FeedSortOrder)

ChatterFeeds.searchFeedElements (String,

String, Integer, String, Integer,

ConnectApi.FeedSortOrder)
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In API versions 31.0 and earlier use...

ChatterFeeds.searchFeedItems (String,

String, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFeeds.searchFeedItems (String,

String, String, Integer)

ChatterFeeds.searchFeedItems (String,
String)

ChatterFeeds.searchFeedItemsInFeed (String,

ConnectApi.FeedType, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder, String)

ChatterFeeds.searchFeedItemsInFeed (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder, String, Boolean)

ChatterFeeds.searchFeedItemsInFeed (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder, String)

ChatterFeeds.searchFeedItemsInFeed (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedSortOrder, String)

ChatterFeeds.searchFeedItemsInFeed (String,

ConnectApi.FeedType, String, String,

Integer, ConnectApi.FeedSortOrder, String)

ChatterFeeds.searchFeedItemsInFeed (String,

ConnectApi.FeedType, String, String)

ChatterFeeds.searchFeedItemsInFeed (String,

ConnectApi.FeedType, String)

ChatterFeeds.searchFeedItemsInFilterFeed (String,

String, String, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder, String)

ChatterFeeds.searchFeedItemsInFilterFeed (String,

String, String, String, Integer,

ConnectApi.FeedSortOrder, String)

ChatterFeeds.searchFeedItemsInFilterFeed (String,

String, String, String)

New and Changed Apex Classes

In API versions 31.0 and later, use...

ChatterFeeds.searchFeedElements (String,

String, String, Integer,

ConnectApi.FeedSortOrder)

ChatterFeeds.searchFeedElements (String,

String, String, Integer)

ChatterFeeds.searchFeedElements (String,
String)

ChatterFeeds.searchFeedElementsInFeed (String,

ConnectApi.FeedType, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder, String)

ChatterFeeds.searchFeedElementsInFeed (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder, String, Boolean)

ChatterFeeds.searchFeedElementsInFeed (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder, String)

ChatterFeeds.searchFeedElementsInFeed (String,

ConnectApi.FeedType, String, Integer,

ConnectApi.FeedSortOrder, String)

ChatterFeeds.searchFeedElementsInFeed (String,

ConnectApi.FeedType, String, String,

Integer, ConnectApi.FeedSortOrder, String)

ChatterFeeds.searchFeedElementsInFeed (String,

ConnectApi.FeedType, String, String)

ChatterFeeds.searchFeedElementsInFeed (String,

ConnectApi.FeedType, String)

ChatterFeeds. searchFeedElementsInFilterFeed (String,

String, String, Integer,

ConnectApi.FeedDensity, String, Integer,

ConnectApi.FeedSortOrder, String)

ChatterFeeds. searchFeedElementsInFilterFeed (String,

String, String, String, Integer,

ConnectApi.FeedSortOrder, String)

ChatterFeeds.searchFeedElementsInFilterFeed (String,

String, String, String)
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In API versions 31.0 and earlier use... In API versions 31.0 and later, use...
ChatterFeeds.shareFeedItem(String, ChatterFeeds.shareFeedElement (String,
ConnectApi.FeedType, String, String) String, ConnectApi.FeedElementType, String)

New and Changed Chatter in Apex Input Classes

Batch Posting Feed Elements

ConnectApi.BatchInput Class
Construct a set of inputs to be passed into a method at the same time.

The class has these constructors:
ConnectApi.BatchInput (Object input)

ConnectApi.BatchInput (Object input, ConnectApi.BinaryInput binary)
ConnectApi.BatchInput (Object input, List<ConnectApi.BinaryInput> binaries)

The constructors takes these parameters:

e input—Anindividual input object to be used in the batch operation. For example, for postFeedElementBatch (),
this should be ConnectApi.FeedElementInput.

® binary—A binary file to associate with the input object.

® Dbinaries—A list of binary files to associate with the input object.

Capabilities
See Capabilities on page 262 for general information about capabilities and how they have changed in APl version 32.0.

ConnectApi.BookmarksCapabilityInput
Create or update a bookmark on a feed element.

This new input class is a subclass of ConnectApi.FeedElementCapabilityInput andhasone property,
isBookmarkedByCurrentUser, whichisaboolean value specifying whether to bookmark the feed element (t rue) or not
(false).

ConnectApi.CanvasAttachmentInput
This class isn't available in version 32.0 and later. In version 32.0 and later, use the ConnectApi.CanvasCapabilityInput
class.

ConnectApi.CanvasCapabilityInput
Create or update a canvas app associated with a feed element.

This new input class is a subclass of ConnectApi.FeedElementCapabilityInput and hasthese properties:
® description—A description of the canvas app. The maximum size is 255 characters.

e developerName—The APl name (developer name) of the connected app.

® height—The height of the canvas app in pixels.

® namespacePrefix—A unique namespace prefix for the canvas app.

e parameters—IJSON parameters passed to the canvas app.

® thumbnailUrl—A thumbnail URL to a preview image. The maximum thumbnail size is 120 pixels by 120 pixels.

e title—Atitleforthe canvas link.
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ConnectApi.CommentInput Class

This input class has one new property, capabilities, which contains any capabilities to associate with the comment, such as
file attachments. Use this property instead of attachment, which is no longer supported.

ConnectApi.ContentAttachmentInput

This classisn't available in version 32.0 and later. In version 32.0 and later, use the ConnectApi.ContentCapabilityInput
class.

ConnectApi.ContentCapabilityInput

Attach or update a file with a feed element. Use this class to attach a new file or update a file that has already been uploaded to
Salesforce.

This new input class is a subclass of ConnectApi.FeedElementCapabilityInput and hasthese properties:
® contentDocumentId—ID of the existing content.
e description—Description of the file to be uploaded.

e title—Title of thefile. This value is used as the file name for new content. For example, if the title is My Title, and the file is a
Ixt file, the file name is My Title.txt.

ConnectApi.FeedElementCapabilitiesInput
A container for all capabilities that can be included when creating a new feed element.

This input class has these new properties:

® Dbookmarks—Describes bookmarks added to this feed element.

e canvas—Describes a canvas app added to this feed element.

e content—Describes content added to this feed element.

e 1link—Describes a link added to this feed element.

e poll—Describes a poll added to this feed element.

® questionAndAnswers—Describes a question and answer capability added to this feed element.

ConnectApi.FeedElementInput Class

This class has anew capabilities property, whichisa ConnectApi.FeedElementCapabilitiesInput object
that contains all the capabilities associated with a feed element.

ConnectApi.FeedItemAttachmentInput
This class isn't available in version 32.0 and later. In version 32.0 and later, use the
ConnectApi.FeedElementCapabilityInput class.

ConnectApi.FeedItemInput Class
These properties aren't available in version 32.0 and later:

® attachment—Usethe capabilities property inherited from ConnectApi.FeedElementInput
® isBookmarkedByCurrentUser—Usethe ConnectApi.BookmarksCapabilityInput object.
® originalFeedItemId—Usethe originalFeedElementId property.

ConnectApi.LinkAttachmentInput

This class isn't available in version 32.0 and later. In version 32.0 and later, use the ConnectApi.LinkCapabilityInput
class.

ConnectApi.LinkCapabilityInput
Create or update a link on a feed element.

This new input class is a subclass of ConnectApi.FeedElementCapabilityInput and hasthese properties:

e url—Link URL The URL can be to an external site.
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e urlName—Description of the link.

ConnectApi.NewFileAttachmentInput
This classisn't available in version 32.0 and later. In version 32.0 and later, use the ConnectApi.ContentCapabilityInput
class.

ConnectApi.PollAttachmentInput
This class isn't available in version 32.0 and later. In version 32.0 and later, use the ConnectApi.PollCapabilityInput
class.

ConnectApi.PollCapabilityInput
Create, update, or vote on a poll on a feed element.

This new input class is a subclass of ConnectApi.FeedElementCapabilityInput and hasthese properties:
® choices—The choices used to create a new poll. You must specify 2—10 poll choices for each poll.
®* myChoiceId—ID of an existing choice on the feed poll. Used to vote on an existing poll.

ConnectApi.QuestionAndAnswersCapabilityInput
Create a question feed element or set the best answer of the existing question feed element.

This new input class is a subclass of ConnectApi.FeedElementCapabilityInput and hasthese properties:

* DbestAnswerId—AcommentIDtouseasa bestanswerforaquestionfeed element. The bestanswer comment must already
exist on the question feed element.

® questionTitle—Title fora question feed element.

This table describes how to migrate from earlier APl versions to AP version 32.0.

In API versions 31.0 and earlier, use... In API version 32.0, use...

ConnectApi . FeedItemInput . isBookmarkedByCurrentUser ConnectApi.BookmarksCapabilityInput

The ConnectApi.FeedItemInput.capabilities
property holds the
ConnectApi.BookmarksCapabilityInput object.

ConnectApi.CanvasAttachmentInput ConnectApi.CanvasCapabilityInput
ConnectApi.CommentInput.attachment ConnectApi.CommentInput.capabilities
ConnectApi.ContentAttachmentInput ConnectApi.ContentCapabilityInput

ConnectApi.NewFileAttachmentInput

ConnectApi.FeedItemAttachmentInput ConnectApi.FeedElementCapabilityInput

This class is abstract and is the superclass of the other attachment  This class is abstract and is the superclass of the other capability
input classes. input classes.

NA ConnectApi.FeedElementCapabilitiesInput

Use this class to specify capabilities for the feed element.

ConnectApi.FeedItemInput.attachment ConnectApi.FeedItemInput.capabilities

This property takes a This property takes a

ConnectApi.FeedItemAttachmentInput object. ConnectApi.FeedElementCapabilitiesInput
object.
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In API versions 31.0 and earlier, use... In API version 32.0, use...

ConnectApi . FeedItemInput.isBookmarkedByCurrentUser ConnectApi.FeedItemInput.capabilities.
bookmarks.isBookmarkedByCurrentUser

ConnectApi.FeedItemInput.originalFeedItemId ConnectApi.FeedItemInput.originalFeedElementId

ConnectApi.LinkAttachmentInput ConnectApi.LinkCapabilityInput
ConnectApi.PollAttachmentInput ConnectApi.PollCapabilityInput

NA ConnectApi.QuestionAndAnswersCapabilityInput
Communities

Communities helps companies share information with their customers and partners.

ConnectApi.ManagedTopicPositionCollectionInput Class
A collection of relative positions of managed topics.

This class has one property:
® managedTopicPositions—oList of relative positions of managed topics.

ConnectApi.ManagedTopicPositionInput Class
Relative position of a managed topic.

This class has these properties:
* managedTopicId—ID of existing managed topic.

® position—Relative position of the managed topic, indicated by zero-indexed, ascending whole numbers.

Data.com
Data.com is the solution for delivering leading business data inside Salesforce.

ConnectApi.DatacloudOrderInput
Input representation for DatacloudOrder to purchase contacts or companies and retrieve purchase information.

New and Changed Chatter in Apex Output Classes

Capabilities
See Capabilities on page 262 for general information about capabilities and how they have changed in APl version 32.0.

ConnectApi.AbstractBundleCapability
In version 32.0, this class has been renamed ConnectApi.BundleCapability.The feedElements property name has
changed to page andisa ConnectApi.FeedElementPage object.

ConnectApi.ApprovalAttachment
This class isn't available in version 32.0 and later. In version 32.0 and later, ConnectApi .ApprovalCapability is used.

ConnectApi.ApprovalCapability
If a feed element has this capability, it includes information about an approval.

This new output class is a subclass of ConnectApi.FeedElementCapability and contains these properties:

e id—The workitem ID. The workitem IDis nul1 if there isn't a pending work item associated with the approval record.
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® postTemplateFields—The details of the approval post template field.
e processIntanceStepId—The processinstance stepID.The associated record represents one stepin an approval process.
e status—The status of the approval.

ConnectApi.BasicTemplateAttachment
This class isn't available in version 32.0 and later. In versions 32.0 and later, use ConnectApi.EnhancedLinkCapability.

ConnectApi.BookmarksCapability Class
This output class has one new property: i sBookmarkedByCurrentUser, which is a boolean value indicating whether the
feed element has been bookmaked (t rue) or not (false).

ConnectApi.BundleCapability Class
In version 31.0, this class was called ConnectApi.AbstractBundleCapability.Inversion32.0,the feedElements
property name has changed to page andisa ConnectApi.FeedElementPage object.

This class is still abstract and is the superclass for
® ConnectApi.GenericBundleCapability Class
® ConnectApi.TrackedChangeBundleCapability

ConnectApi.CanvasCapability
If a feed element has this capability, it renders a canvas app.

This new output class is a subclass of ConnectApi.FeedElementCapability and has these properties:

® description—A description of the canvas app. The maximum size is 255 characters.

® developerName—The APl name (developer name) of the connected app.

® height—The height of the canvas app in pixels.

e icon—Theicon for the canvas app.

®* namespacePrefix—A unique namespace prefix for the canvas app.

* parameters—IJSON parameters passed to the canvas app.

® thumbnailUrl—A thumbnail URL to a preview image. The maximum thumbnail size is 120 pixels by 120 pixels.
e title—Atitleforthe canvas link.

ConnectApi.CanvasTemplateAttachment
This class isn't available in version 32.0 and later. In version 32.0 and later, ConnectApi .CanvasCapability isused.

ConnectApi.CaseComment
This class isn't available in version 32.0 and later. In version 32.0 and later, ConnectApi .CaseCommentCapability isused.

ConnectApi.CaseCommentCapability
If a feed element has this capability, it has a case comment on the case feed.

This new output class is a subclass of ConnectApi.FeedElementCapability and has these properties:
* actorType—Specifies the type of user who made the comment.

® createdBy—Information about the user who created the comment.

® createdDate—IS08601 date string, for example, 2011-02-25T18:24:31.000Z.

* eventType—Specifies an event type for a comment in the case feed.

e id—18-character ID of case comment.

® published—Specifies whether the comment has been published.

e text—Textof the case comment.
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ConnectApi.ChatterLikePage
This output class has one new property, items, whichisalistof ConnectApi.ChatterLike objects. Use this property
instead of the 1ikes property, which is no longer supported as of version 32.0.

ConnectApi.ChatterLikesCapability Class
If a feed element has this capability, the context user can like it. Exposes information about existing likes.

This output class has these new properties:

* isLikedByCurrentUser—Indicates whether the feed element is liked by the current user (true) ornot (false).
e page—1Likes information for this feed element.

® 1likesMessage—A message body that describes who likes the feed element.

* myLike—Ifthe context user has liked the feed element, this property is a reference to the specific like, nul1 otherwise.

ConnectApi.Comment Class
This class has these new properties:

® capabilities—A ConnectApi.CommentCapabilities objectrepresenting the capabilities associated with the
comment. Use this property instead of the attachment property, which is no longer supported.

e feedElement—A ConnectApi.Reference object representing the feed element on which the comment is posted.
Use this property instead of the feedItem property, which is no longer supported.

ConnectApi.CommentCapabilities Class
A set of capabilities on a comment.

This new output class has one property, content, whichisa ConnectApi.ContentCapability object containing
information about a file attached to a comment.

ConnectApi.CommentPage Class
This output class has one new property, items, whichisalist of ConnectApi .Comment objects. Use this property instead
of the comments property, which is no longer supported as of version 32.0.

ConnectApi.CommentsCapability Class
If a feed element has this capability, the context user can add a comment to it.

This output class has one new property, comments, whichisa ConnectApi.CommentPage object containing information
about the comments on this feed element.

ConnectApi.ContentAttachment
This class isn't available in version 32.0 and later. In version 32.0 and later, ConnectApi.ContentCapability isused.

ConnectApi.ContentCapability
If a feed element has this capability, it has a file attachment.

This new output class is a subclass of ConnectApi.FeedElementCapability and hasthese properties:
e checksum—MD5 checksum for the file.

e contentUrl—URL of the content for links and Google docs.

e description—Description of the attachment.

e downloadUrl—URL to the content.

e fileExtension—~Extension of the file.

e fileSize—Size of thefile in bytes. If size cannot be determined, returns Unknown.

o fileType—Type offile.

® hasPdfPreview—true if the file has a PDF preview available, false otherwise.

e id—18-character ID of the content.
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isInMyFilesSync—true ifthefileisincluded in the user's Salesforce Files Sync folder, and is synced between that folder
and Chatter; false otherwise.

mimeType—MIME type of the file

renditionUrl—URLtothe rendition resource for the file. Renditions are processed asynchronously and may not be available
immediately after the file has been uploaded.

renditionUr1240By180—URLtothe 240x180 size rendition resource for the file. Renditions are processed asynchronously
and may not be available immediately after the file has been uploaded.

renditionUrl720By480—URLtothe 720x480 size rendition resource for the file. Renditions are processed asynchronously
and may not be available immediately after the file has been uploaded.

textPreview—Text preview of the file if available, nul1 otherwise. The maximum number of characters is 200.

thumb120By90RenditionStatus—The status of the rendering of the 120x90 pixel sized preview image of the file.
Should be either Processing, Failed, Success, or Na if unavailable.

thumb240Byl80RenditionStatus—The status of the rendering of the 240x180 pixel sized preview image of the file.
Should be either Processing, Failed, Success, or Na if unavailable.

thumb720By480RenditionStatus—The status of the rendering of the 720x480 pixel sized preview image of the file.
Should be either Processing, Failed, Success, or Na if unavailable.

title—Title of the file.

versionId—Version ID of the file.

ConnectApi.DashboardComponentAttachment
This class isn't available in version 32.0 and later. In version 32.0 and later,
ConnectApi.DashboardComponentSnapshotCapability isused.

ConnectApi.DashboardComponentSnapshot
Represents both dashboard component snapshots and alerts you receive when a dashboard component value crosses a threshold.

This new output class has these properties:

component Id—18-character ID of the dashboard component.
componentName—The dashboard component name.

dashboardBodyText—Display this text next to the actor in the feed element.Use this text in place of the default body
text.

dashboardId—18-character ID of the dashboard.

dashboardName—The name of the dashboard.

fullSizeImageUrl—The source URL toretrieve the full-size image of a snapshot. Access this URL with OAuth credentials.
lastRefreshDate—IS0-8601 formatted date specifying when this dashboard component was last refreshed.

lastRefreshDateDisplayText—Display text for the last refresh date, for example, “Last Refreshed on October 31,
2013

runningUser—The running user of the dashboard at the time the snapshot was posted. This value may be nul1l.Each
dashboard has a running user, whose security settings determine which data to display in a dashboard.

thumbnailUrl—The source URL to retrieve the thumbnail image of a snapshot. Access this URL with OAuth credentials.

ConnectApi.DashboardComponentSnapshotCapability
If a feed element has this capability, it has a dashboard component snapshot. A snapshot is a static image of a dashboard component
at a specific point in time.

This new output class is a subclass of ConnectApi.FeedElementCapability and hasone new property:
dashboardComponentSnapshot, whichisa ConnectApi.DashboardComponentSnapshot
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ConnectApi.EmailMessage
This class isn't available in version 32.0 and later. In version 32.0 and later, ConnectApi .EmailMessageCapability is
used.

ConnectApi.EmailMessageCapability
If a feed element has this capability, it has an email message from a case.

This new output class is a subclass of ConnectApi.FeedElementCapability and has these properties:
® direction—Thedirection of the email message. Values are:

* ecmailMessageId—The ID of the email message.

e subject—The subject of the email message.

® textBody—The body of the email message.

® toAddresses—The To address of the email message.

ConnectApi.EnhancedLinkCapability
If a feed element has this capability, it has a link that may contain supplemental information like an icon, a title, and a description.

This new output class is a subclass of ConnectApi.FeedElementCapability and hasthese properties:
® description—A description with a 500 character limit.

e icon—Aicon.

® linkRecordId—A ID associated with the link if the link URL refers to a Salesforce record.

® 1inkUrl—Alink URL to a detail page if available content can't display inline.

e title—Atitletoadetail page.

ConnectApi.FeedElementCapabilities Class
A container for all capabilities that can be included with a feed element.

This output class has these new properties:

e approval—Ifafeed element has this capability, it includes information about an approval.

e canvas—Ifafeed element has this capability, it renders a canvas app.

* caseComment—Ifa feed element has this capability, it has a case comment on the case feed.
e content—Ifafeed element has this capability, it has a file attachment.

* dashboardComponentSnapshot—Represents both dashboard component snapshots and alerts you receive when a
dashboard component value crosses a threshold.

* emailMessage—Ifafeed element has this capability, it has an email message from a case.

® enhancedLink—Ifafeed element has this capability, it has a link that may contain supplemental information like an icon,
atitle, and a description.

e 1inklfafeed element has this capability, it has a link.
* recommendations—Ifafeed element has this capability, it has a recommendation.

* recordSnapshot—Ifafeed element has this capability, it contains all the snapshotted fields of a record for a single create
record event.

* trackedChanges—Ifafeedelementhas this capability, it contains all changes to a record for a single tracked change event.

ConnectApi.FeedItemAttachment
This class isn't available in version 32.0 and later. In version 32.0 and later, ConnectApi . FeedElementCapability isused.

ConnectApi.FeedItem Class
These properties aren't available in version 32.0 and later. Their functionality has moved to capabilities.
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® attachment
® comments
® isBookmarkedByCurrentUser
® isLikedByCurrentUser
e likes
® likesMessage
®* myLike
® topics
ConnectApi.FeedItemTopicPage
This class isn't available in version 32.0 and later. In version 32.0 and later, ConnectApi . TopicsCapability isused.

ConnectApi.FeedPoll
This class isn't available in version 32.0 and later. In version 32.0 and later, ConnectApi .PollCapability is used.

ConnectApi.GenericBundleCapability Class
If a feed element has this capability, the feed element has a group of other feed elements condensed into one feed element. This
group is called a bundle.

This class is a subclass of ConnectApi.BundleCapability.

ConnectApi.LinkAttachment
This class isn't available in version 32.0 and later. In version 32.0 and later, ConnectApi .LinkCapability is used.

ConnectApi.LinkCapability
If a feed element has this capability, it has a link.

This new output class is a subclass of ConnectApi.FeedElementCapability and hasthese properties:
e url—Link URL. The URL can be to an external site.
e urlName—Description of the link.

ConnectApi.PollCapability Class
If a feed element has this capability, it includes a poll.

This output class has these new properties:
e choices—~Collection of poll choices that make up the poll.

® myChoiceId—18-characterID of the poll choice that the current user has voted for in this poll. Returns nul11 if the current
user has not voted.

® totalVoteCount—Total number of votes cast on the feed poll element.

ConnectApi.QuestionAndAnswersCapability Class
If a feed element has this capability, it has a question and comments on the feed element are answers to the question.

This output class is a subclass of ConnectApi.FeedElementCapability and hasthese properties:
® bestAnswer—The comment selected as the best answer for the question.
® bestAnswerSelectedBy—The user who selected the best answer for the question.

e canCurrentUserSelectOrRemoveBestAnswer—Indicates whether current user can select orremove a best answer
(true)ornot(false).

® questionTitle—Title forthe question.

ConnectApi.RecommendationsCapability
If a feed element has this capability, it has a recommendation.
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This new output class is a subclass of ConnectApi .FeedElementCapability andhasone property, items, whichisa
listof ConnectApi.AbstractRecommentation objects.

ConnectApi.RecordSnapShotAttachment
This class isn't available in version 32.0 and later. In version 32.0 and later, ConnectApi .RecordSnapshotCapability
is used.

ConnectApi.RecordSnapshotCapability
If a feed element has this capability, it contains all the snapshotted fields of a record for a single create record event.

This new output class is a subclass of ConnectApi.FeedElementCapability and hasone property: recordview,
which is a representation of the reord that contains metadata and data for easy display.

ConnectApi.TopicsCapability Class
If a feed element has this capability, the context user can add topics to it. Topics help users organize and discover conversations.

This output class has these new properties:
® canAssignTopics— true ifatopic can be assigned to the feed element, false otherwise.
e items—A collection of topics associated with this feed element.

ConnectApi.TrackedChangeAttachment
This class isn't available in version 32.0 and later. In version 32.0 and later, ConnectApi.TrackedChangesCapability
is used.

ConnectApi.TrackedChangesCapability
If a feed element has this capability, it contains all changes to a record for a single tracked change event.

This new output class is a subclass of ConnectApi.FeedElementCapability and contains one property, changes,
which is a collection of feed tracked changes for the feed element.

This table describes how to migrate from earlier API versions to API version 32.0.

API versions 31.0 and earlier use... API version 32.0 uses...

ConnectApi.ApprovalAttachment ConnectApi.ApprovalCapability

ConnectApi.BasicTemplateAttachment ConnectApi.EnhancedLinkCapability

ConnectApi.CanvasTemplateAttachment ConnectApi.CanvasCapability

ConnectApi.CaseComment ConnectApi.CaseCommentCapability

ConnectApi.Comment.attachment ConnectApi.Comment.capabilities
This property holds a

ConnectApi.CommentCapabilities object, which
holds the capabilities associated with the comment.

ConnectApi.Comment.feedItem ConnectApi.Comment.feedElement
ConnectApi.CommentPage.comments ConnectApi.CommentPage.items
ConnectApi.ContentAttachment ConnectApi.ContentCapability

ConnectApi.DashboardComponentAttachment ConnectApi . DashboardComponentSnapshotCapability

ConnectApi.EmailMessage ConnectApi.EmailMessageCapability
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API versions 31.0 and earlier use...

ConnectApi.FeedItem.attachment

ConnectApi.FeedItem.comments
ConnectApi.FeedItem.isBookmarkedByCurrentUser
ConnectApi.FeedItem.isLikedByCurrentUser
ConnectApi.FeedItem.likes
ConnectApi.FeedItem.likesMessage
ConnectApi.FeedItem.myLike
ConnectApi.FeedItem.moderationFlags
ConnectApi.FeedItem.topics

ConnectApi.FeedItemAttachment
This class is abstract and is the superclass of the other attachment
input classes.

ConnectApi.FeedItemTopicPage

ConnectApi.FeedPoll
ConnectApi.LinkAttachment
ConnectApi.RecordSnapShotAttachment
ConnectApi.TrackedChangeAttachment

Communities

New and Changed Apex Classes

APl version 32.0 uses...

ConnectApi.FeedElement.capabilities

This property holds a
ConnectApi.FeedElementCapabilities object,
which holds the capabilities associated with the feed element.

capabilities.comments.page
capabilities.bookmarks.isBookmarkedByCurrentUser
capabilities.chatterLikes.isLikedByCurrentUser
capabilities.chatterLikes.page
capabilities.chatterLikes.likesMessage
capabilities.chatterLikes.myLike
capabilities.moderation.moderationFlags
capabilities.topics.items

ConnectApi.FeedElementCapability

This class is abstract and is the superclass of the other capability
input classes.

ConnectApi.TopicsCapability

ConnectApi.PollCapability
ConnectApi.LinkCapability
ConnectApi.RecordSnapshotCapability

ConnectApi.TrackedChangesCapability

Communities helps companies share information with their customers and partners.

ConnectApi.ArticleItem Class
Article item in question and answers suggestions.

This class has these properties:

e id—Idofthearticle.

e rating—Therating of the article.

e title—Title of the article.

e urlLink—Link URL of the article.

* viewCount—Number of votes given to the article.

ConnectApi.ChatterMessage Class

This class has one new property, sendingCommuni ty, that providesinformation about the community from which the message

was sent.
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ConnectApi.Community Class
This class has one new property, nicknameDisplayEnabled,that specifies whether nicknames are displayed in the community.

ConnectApi.Features Class
This class has these new properties:

* communityReputation—Specifies whether reputation is enabled for communities in the organization.
* managedTopicsEnabled—Indicates access to the community home feed and the managed topic feed.

ConnectApi.ManagedTopic Class
Represents a managed topic in a community.

This class has these properties:

e id—ID of managed topic.

* managedTopicType—IType of managed topic.
® topic—Information about the topic.

e url—Chatter REST API URL to the managed topic.

ConnectApi.ManagedTopicCollection Class
A collection of managed topics.

This class has these properties:
® currentPageUr1—Chatter REST APl URL identifying the current page.
* managedTopics—List of managed topics.

ConnectApi.QuestionAndAnswersSuggestions Class
Question and answers suggestions.

This class has these properties:
e articles—Listofarticles.
® questions—List of questions.

ConnectApi.Reputation
Reputation for a user.

This new output class has these properties:

® reputationLevel—User'sreputation level.

® reputationPoints—User's reputation points, which can be earned by performing different activities in the community.
e url—A Chatter REST API' URL to the reputation.

ConnectApi.ReputationLevel Class
Reputation level for a user.

This new output class has these properties:
* levelImageUrl—URL tothe reputation level image.
® levelName—Name of the reputation level.

® levelNumber—Reputation level number, which is the numerical rank of the level, with the lowest level at 1. Administrators
define the reputation level point ranges.

ConnectApi.Topic Class
This class has one new property, images, which represents images associated with the topic.

ConnectApi.TopicImages Class
This new class has these properties:
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* coverImageUrl—URL to atopic's coverimage, which appears on the topic page. Both topics and managed topics can
have cover images.

® featuredImageUrl—URLtoamanaged topic's featured image, which appears wherever you feature it, for example, on
the communities home page.

ConnectApi.User Class
This class has these new properties:

® communityNickname—User's nickname in the community.

* displayName—User's name thatis displayed in the community. If nicknames are enabled, the nickname is displayed. If
nicknames aren't enabled, the full name is displayed.

® reputation—~Reputation of the user.

Data.com
Data.com is the solution for delivering leading business data inside Salesforce.

ConnectApi.DatacloudCompany Class
Information about a Data.com company.

ConnectApi.DatacloudCompanies Class
Lists all companies that were purchased in a specific order, page URLs, and the number of companies in the order.

ConnectApi.DatacloudContact Class
Information about a Data.com contact.

ConnectApi.DatacloudContacts Class
Lists all contacts that were purchased in the specific order, page URLs, and the number of contacts in the order.

ConnectApi.DatacloudOrder Class
Returns the orderId, purchase date, purchase count, and URLSs to details about your order.

ConnectApi.DatacloudPurchaseUsage Class
Information about Data.com point usage for Monthly Users and List Pool Users.

Feed Elements and Bundles
See Feed Elements on page 262 for general information about how feed elements and feed items have changed in API version 32.0.

ConnectApi.Bundle
This output class has been replaced by instances of the ConnectApi.GenericFeedElement class holding the
ConnectApi.BundleCapability class.

@ Note: Bundled posts are available through a pilot program. For information, contact Salesforce. During the pilot, bundles
contain only feed-tracked changes.

ConnectApi.Feed
The feedItemsUrl property isn't available in APl version 32.0. Use the feedElementsUrl property.

ConnectApi.FeedDirectoryIltem
The feedItemsUrl property isn't available in APl version 32.0. Use the feedElementsUr1l property.

ConnectApi.FeedItemPage
This class isn't available in version 32.0 and later. Use the ConnectApi .FeedElementPage property.

ConnectApi.GenericFeedElement Class
A concrete implementation of the abstract ConnectApi .FeedElement class. This class has no properties other than the
properties it inherits from ConnectApi.FeedElement.
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This table describes how to migrate from earlier API versions to API version 32.0.

API versions 31.0 and earlier use... API version 32.0 uses...
ConnectApi.FeedItemPage ConnectApi.FeedElementPage
ConnectApi.Feed.feedItemsUrl ConnectApi.Feed.feedElementsUrl

ConnectApi.FeedDirectoryItem.feedItemsUrl ConnectApi.FeedDirectoryltem.feedElementsUrl

Files
Simplify file management for your users with file syncing, sharing, and collaboration.

ConnectApi.File Class
This output class has a new property, contentModi fiedDate, which is a file-specific modified date, updated only for direct
file operations, such as rename. Modifications to the file from outside of Salesforce can update this date.

ConnectApi.UserSettings Class
This class has these new properties:

e fileSyncLimit—Maximum number of files user can sync.

® folderSyncLimit—Maximum number of folders user can sync.

Recommendations
See Recommendations on page 263 for general information about recommendations.
ConnectApi.AbstractRecommendation Class

This new class is a superclass of:

® ConnectApi.EntityRecommendation Class

® ConnectApi.NonEntityRecommendation Class

This class has these properties:

® explanation—Therecommendation explanation.

* recommendationType—>Specifies the type of record being recommended.
ConnectApi.AbstractRecommendationExplanation Class

This new class is a superclass of ConnectApi.RecommendationExplanation Class and contains these properties:

® summary—Summary explanation for recommendation.

e type—Indicates the reason for the recommendation.

ConnectApi.EntityRecommendation Class
This new class represents a recommendation for a Salesforce entity, such as afile, group, record, or user, and is a subclass of
ConnectApi.AbstractRecommendation Class.

This class has these properties:

® actonUrl—~Chatter REST URL that can be used with a POST request to take action on a recommendation.
e action—Specifies the action to take on a recommendation.

e entity—The entity with which the receiver is recommended to take action.
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ConnectApi.NonEntityRecommendation Class
This new class represents a recommendation for a non-Salesforce entity, such as an application, and is a subclass of
ConnectApi.AbstractRecommendation Class.

This class has these properties:
e displayLabel—Localized label of the non-entity object.
* motif—Motif for the non-entity object.

ConnectApi.RecommendationExplanation Class
This new classis asubclass of ConnectApi.AbstractRecommendationExplanation Class and has this property:

® detailsUrl—URL toexplanation details or null if the recommendation doesn't have a detailed explanation.

New and Changed Chatter in Apex Enums

ConnectApi.DatacloudUserType
Specifies the type of user.

® Monthy—A user type that's assigned monthly point limits for purchasing Data.com records. Monthly points can be used by
only the assigned user. Points expire at the end of the month. Monthly is the default setting for DatacloudUserType.

® Listpool— A usertype that allows users to draw from a pool of points to purchase Data.com records.

ConnectApi.FeedElementCapabilityType
This enum has these new values:

e Approval—The feed elementincludes information about an approval.

e Canvas—The feed element renders a canvas app.

® CaseComment—The feed element has a case comment in the case feed.

e Content—The feed element has a file.

®* DashboardComponentSnapshot—The feed element has a dashboard component snapshot.

* FEmailMessage—The feed element has an email message from a case.

® EnhancedLink—Thefeedelementhasa link that may contain supplemental information like anicon, a title, and a description.
e TLink—The feed element hasa URL.

® QuestionAndAnswers—The feed element has a question, and users can add answers to the feed element instead of
comments. Users can also select the best answer.

e Recommendations—The feed element has a recommendation.
® RecordSnapshot—The feed element has all the snapshotted fields of a record for a single create record event.
e TrackedChanges—The feed element has all changes to a record for a single tracked change event.

ConnectApi.FeedElementType
Thisenum has one new type, Home, which is a feed containing all feed elements associated with any managed topic in a community.

ConnectApi.FeedFilter
This new enum specifies the feed filter and has these values:

® AllQuestions—Only feed elements that are questions.
® SolvedQuestions—Only feed elements that are questions and that have a best answer.
® UnansweredQuestions—Only feed elements that are questions and that don't have any answers.

® UnsolvedQuestions—Onlyfeed elements that are questions and that don't have a best answer.
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ConnectApi.ManagedTopicType
This new enum specifies the type of managed topic.

Featured—Topics that are featured, for example, on the community home page, but don't provide overall navigation.

Navigational—Topics that display in a navigational menu in the community.

ConnectApi.RecommendationActionType
This new enum specifies the action to take on a recommendation.

follow—rFollow arecord or user.
join—IJoin a group.

view—View a record or file.

ConnectApi.RecommendationExplanationType
This new enum indicates the reason for a recommendation.

FilePopular—rFiles with many followers or views

FileViewedTogether—rFiles often viewed at the same time as other files the context user views
FollowedTogetherWithFollowees—Users often followed with the same people the context user follows
GroupMembersFollowed—Groups with members the context user follows

GroupNew—Recently created groups

GroupPopular—Groups with many active members

ItemViewedTogether—Records often viewed at the same time as other records the context user views
PopularApp—Applications that are popular

RecordOwned—Records owned by the context user

RecordParentOfFollowed—~Parent records of records the context user follows
RecordViewed—Records the context user recently viewed

UserDirectReport—Users who report to the context user

UserFollowedTogether—Users often followed at the same time as other users the context user follows
UserFollowsSameUsers—Users who follow the same users as the context user

UserManager—The context user's manager

UserNew—Recently created users

UserPeer—Users who report to the same manager as the context user

UserPopular—Users with many followers

UserViewingSameRecords—Users who view the same records as the context user

ConnectApi.RecommendationType
This new enum specifies the type of record being recommended.

apps
files
groups
records

users

ConnectApi.UserProfileTabType
This enum has one new value, Element, which is a profile tab that displays generic content inline.
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Lightning Components (Beta)

The Lightning Component framework powers Salesforcel. You can use it to create your own
Lightning components and make them available to Salesforce1 users.

EDITIONS

@ Note: This release contains a beta version of Lightning components that is production quality Available in: Enterprise,
but has known limitations. Performance, Unlimited,

. . . . . and Developer Editions
Components are reusable sections of the Ul and can range in granularity from a single line of text

to an entire app. Components interact with each other by listening to or firing events.

Use the Lightning Component framework to develop dynamic Web apps for mobile and desktop devices. It's a modern framework for
building single-page applications engineered for growth.

The client-server Ul architecture enables you to use JavaScript on the client side and Apex on the server side.

For more information, see the Lightning Components Developer's Guide.

Benefits

There are many benefits of using the framework.

Out-of-the-Box Component Set
Comes with an out-of-the-box set of components to kick start building apps. You don't have to spend your time optimizing your
apps for different devices as the components take care of that for you.

Performance
Uses a stateful client and stateless server architecture that relies on JavaScript on the client side to manage Ul component metadata
and application data. The framework uses JSON to exchange data between the server and the client. To maximize efficiency, the
server only sends data that is needed by the user.

Intelligently utilizes your server, browser, devices, and network so you can focus on the logic and interactions of your apps.

Event-driven architecture
Uses an event-driven architecture for better decoupling between components. Any component can subscribe to an application
event, or to a component event they can see.

Faster development
Empowers teams to work faster with out-of-the-box components that function seamlessly with desktop and mobile devices. Building
an app with components facilitates parallel design, improving overall development efficiency.

Components are encapsulated and their internals stay private, while their public shape is visible to consumers of the component.
This strong separation gives component authors freedom to change the internal implementation details and insulates component
consumers from those changes.

Device-aware and cross browser compatibility
Apps are responsive and provide an enjoyable user experience. The Lightning Component framework supports the latest in browser
technology such as HTML5, CSS3, and touch events.

Known Limitations

The beta version of Lightning components has some known limitations.

Force.com Canvas Apps Don’t Work in Salesforce1 if Lightning Components are Enabled

Warning: You can't use Force.com Canvas apps in Salesforce if you enable Lightning components. Any Force.com Canvas
apps in your organization will no longer work in Salesforce if you enable Lightning components.
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Limited Set of Out-of-the-Box Components
The beta includes a very limited set of components.

Namespace Prefix Required
Your organization must have a namespace prefix required to develop Lightning components.

Open Source Aura Framework

The Lightning Component framework is built on the open source Aura framewaork. Aura is open sourced at
https://github.com/forcedotcom/aura. You can build general-purpose Web apps hosted on your own server. Your apps can be completely
independent of Salesforce and your data in Salesforce.

Note that the open source Aura framework has features and components that are not currently available in the Lightning Component
framework. We are working to surface more of these features and components for Salesforce developers.

IN THIS SECTION:

Ul Changes
There are a few Ul changes in Salesforce related to developing Lightning components.

APland Packaging Support

Ul Changes

There are a few Ul changes in Salesforce related to developing Lightning components.
Enable Lightning Components and Debug Mode
From Setup, click Develop > Lightning Components to see the Enable Lightning Components checkbox.
Warning: You can't use Force.com Canvas apps in Salesforce if you enable Lightning components. Any Force.com Canvas
apps in your organization will no longer work in Salesforce1 if you enable Lightning components.
For more information, see “Enabling Lightning Components” in the Salesforce Help.
You can also enable debug mode. For more information, see “Debugging JavaScript Code” in the Salesforce Help.

Create Lightning Components
Use the Developer Console to create and manage your component markup and code. For more information, see Work with Lightning
Resources in the Developer Console on page 250.

Add Lightning Components to the Navigation Menu in Salesforce1
From Setup, click Create > Tabs to create a Lightning Component tab. Creating a custom tab is a prerequisite to enabling your
component in the Salesforce 1 navigation menu, but accessing your Lightning component from the full Salesforce site is not supported.
An administrator has to add the custom tab to the navigation menu in Salesforce1 by clicking Mobile Administration > Mobile
Navigation from Setup. For more information, see “Adding Lightning Components to Salesforce1” in the Salesforce Help.

API and Packaging Support

SOAP API
Use the AuraDefinition and AuraDefinitionBundle objects to work with Lightning resources. See New Objects on page 291.

Metadata API
Use the AuraDefinitionBundle type to work with Lightning bundles. See Metadata APl on page 332.
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Packaging
For on overview of packaging Lightning resources, see Package Lightning Components on page 342.

API

Use the APl to create applications that integrate with Salesforce.

EDITIONS
IN THIS SECTION: Available in:

New and Changed Objects ‘ Developer
These obj have changed in APl version 32 ° Enterprise

ese objects are new or have changed in APl version 32.0. «  Unlimited
SOQL e Performance
Use the Salesforce Object Query Language (SOQL) to construct query strings used in Salesforce
APIs.
SOSL
Use the Salesforce Object Search Language (SOSL) to perform text searches with Salesforce APIs.
REST AP
The REST APl includes new and changed resources, new types, and changes to older APl versions.
SOAP AP
The SOAP APlincludes new and changed calls, new and changed types, and changes to older API versions.
Chatter REST AP

To integrate mobile apps, intranet sites, and third-party Web applications with Chatter, use Chatter REST API.

Tooling API

Use the Tooling API to build custom development tools for Salesforce applications. Support for many new features has been added,
including compact layouts, quick actions, workflows, and email templates.

Metadata API

Use the Metadata APl to manage customization information, such as custom object definitions and page layouts, for your organization.
Metadata support has been added or enhanced for many features, including Territory Management 2.0, managed topics, flows, and
tasks.

Data.com API

Search and purchase Data.com records using the Data.com API. Access the most up-to-date Data.com records to make sure your
data is clean and accurate.

Publisher.js API
Three events in the publisher.js APl now support the Post and Social Post actions, so you can create custom console components
that interact with these actions.

Salesforce Console API (Integration Toolkit)
The toolkit includes new methods that let you customize a console’s navigation tab and interaction log programmatically.

New and Changed Obijects

These objects are new or have changed in API version 32.0.
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IN THIS SECTION:

New Objects
These objects are new in APl version 32.0.

Changed Objects
These objects have changed in APl version 32.0.

New Obijects

These objects are new in APl version 32.0.

AuraDefinition
Represents a Lightning definition, such as component markup, a client-side controller, or an event. Lightning components is a beta
feature. This object is part of the Lightning components beta release.

AuraDefinitionBundle
Represents a Lightning definition bundle, such as a component or application bundle. A bundle contains a Lightning definition and
all'its related resources. Lightning components is a beta feature. This object is part of the Lightning components beta release.

AuthConfig
Represents authentication options for a communityor custom domain that was created by using My Domain.

AuthConfigProviders
Represents an authentication provider that's configured in an organization. This object is a child of the AuthConfig object.

ContentDistribution
Represents information about sharing a document, either by sharing via link in Chatter or by sending as a Salesforce CRM Content
delivery.

ContentDistributionView
Represents information about views of a shared document.

CustomPermissionDependency
Represents the dependency between two custom permissions when one custom permission requires that you enable another
custom permission.

DcSocialProfile
Represents social-handle profiles for Data.com contacts. The DcSocialProfile objectis a read-only object that's accessible
only through the Data.com Social Key API.

DcSocialProfileHandle
Represents social-handle profile details for Data.com contacts. The DcSocialProfileHandle object, a child object to
DcSocialProfile,isaread-only object that's accessible only through the Data.com Social Key API.

DuplicateRecorditem
Represents an individual record that's part of a duplicate record set. Use this object to create custom report types.

DuplicateRecordSet
Represents a group of records that have been identified as duplicates. Each duplicate record set contains one or more duplicate
record items. Use this object to create custom report types.

EventLogFile
Event monitoring information about your Salesforce organization’s operational events, which you can use to analyze usage trends
and user behavior. You can interact with event monitoring data through the EventLogFile object. This object has been available as
a pilot since APl version 29.0 and is generally available in APl versions 32.0 and later.
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@ Nofe: Log data schema can change. At the start of each release, use the LogFileFieldNames and
LogFileFieldTypes fields to validate schema changes.

@ Nofe: We anticipate this product will be generally available in the November 2014 to January 2015 time frame. Any unreleased
services or features referenced in this or other public statements are not currently available and may not be delivered on time
or at all. Customers who purchase Salesforce applications should make their purchase decisions based upon features that are
currently available.

ListView
Contains metadata that describes a list view.

LookedUpFromActivity
This read-only object is displayed as a related list on an activity record (an event or a task); the list contains records that have custom
lookup relationships from the activity to another object. This object is not queryable. See Add Custom Lookup Fields on Activities
(Beta) on page 137for more details.

OauthToken
Represents an OAuth access token for connected app authentication and can be used to create a user interface for token management.
Each time a user grants access to an application, the application obtains a new access token.

ReputationLevel
Represents a reputation level defined for a community.

ReputationLevel
Represents the reputation point rules for a community. Each rule specifies an action that community members can earn points from
and the points associated with those actions in a particular community.

SearchPromotionRule
Represents a promoted search term, which is one or more keywords that you associate with a Salesforce Knowledge article. When
a user's search query includes these keywords, the associated article is returned first in search results.

ThirdPartyAccountLink
Alist of third-party account links is generated when users of an organization authenticate using an external Auth. Provider. Use this
object to list and revoke a given user's social sign-on connections (such as Facebook®).

TwoFactorinfo
Use this object when customizing two-factor authentication in your organization.

WorkFeedbackHistory
This read-only object contains historical information about changes that have been made to the WorkFeedback object.

WorkFeedbackQuestionSetHistory
This read-only object contains historical information about changes that have been made to the WorkFeedbackQuestionSet object.

WorkFeedbackRequestFeed
Represents a single feed item in the feed displayed on the feedback request detail page. The feedback request feed shows changes
to a request for fields that are tracked in feeds, posts and comments about the request.

Changed Obijects

These objects have changed in APl version 32.0.

ActivityHistory
Sort order contraints and examples updated in Usage section.

AttachedContentDocument
The AttachedContentDocument object has the following new field: ExternalDataSourceName.
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AuthProvider
The AuthProvider object has the following new fields: OptionsIncludeOrgIdInId and IconURL.

AsyncApexJob
The JobType field has the following new value: Queueable. (This field is part of the Queueable Apex feature.)

The status field has the following new value: Holding. (This field was added in APl version 31.0 as part of the Apex Flex Queue
pilot.)

ChatterMessage
The ChatterMessage object has the following new field: SenderNetworkId.

CombinedAttachment
The CombinedAttachment object has the following new field: ExternalDataSourceName.

ContentDocument
The ContentDocument object has the following new field: ContentModifiedDate.

ContentDocumentLink
The Visibility field on the ContentDocumentLink object has the following new picklist value: SharedUsers.

ContentVersion
The ContentModifiedDate field on the ContentVersion object now supports the Create call.

The Language field on the ContentVersion object has the following new picklist value: no (Norwegian).
The ContentVersion object has the following new fields.

® ContentLocation

® ExternalDataSourcelD

® ExternalDocumentInfol

® ExternalDocumentInfo?2

® TIsMajorVersion

ContentVersionHistory
The Field field on the ContentVersionHistory object has the following new picklist value: TsMajorVersion.

ContentWorkspace
The TagModel field on the ContentWorkspace object has the following new picklist values.

e R (Restricted)
e G (Guided)
e U (Unrestricted)

CustomBrand

The CustomBrand object can be now be parented by Topic and ReputationLevel in addition to the previously supported Network
and Organization objects.

DatacloudContact
The firstName and lastName fields were hidden in the previous version. Both fields are now visible for all contact records.

DatacloudDandBCompany
The ParentOrHgDunsNumber is now searchable. You can see corporate hierarchies in the response.
The IsParent field was added.

DandBCompany
This object was previously read-only. It is now CRUD-enabled.
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@ Nofte: If Data.com automated Clean is activated in your organization, D&B company records might be overwritten during
update and manual changes.

Domain
The Domain object now contains this new field: OptionsExternalHttps. This field is read-only and indicates whether the
domain supports secure connections (true) or not (false). This field is available only if the domain is not pointing to the
yourdomain.yourl8characterOrgId.live.siteforce.com CNAME target.

EmailHeader
The triggerUserEmail field no longer supports sending an email when a task is created or modified.

EmailTemplate
The EmailTemplate object now supports the search () call.

CollaborationGroup
The CollaborationType field has the following new value: Unlisted.

CollaborationGroupFeed, Feedltem, FeedComment, FeedPollChoice, UserProfileFeed
These objects have been updated to support unlisted groups. Only users with the “Modify Unlisted Groups” can delete records of
these types in unlisted groups, aside from the users who created them.

LookedUpFromActivity
Sort order contraints and examples updated in Usage section.

Network
The Network object has the following new field: OptionsNicknameDisplayEnabled.

OpenActivity
Sort order contraints and examples updated in Usage section.

NetworkMember
e The NetworkMember object now supports Apex triggers and has the following new field: LastChatterActivityDate.
e The ReputationPoints fieldis now updateable.
Order
e The Order object has the following new field: Owner.
e The AccountId and ContractId fieldsare now updateable on orders with Draft status.

OpportunityTeamMember
The OpportunityTeamMember object now contains this new field: Phot oURL.

OwnedContentDocument
The OwnedContentDocument object has the following new field: ExternalDataSourceName.

PermissionSet and Profile
The PermissionsViewEncryptedData user permission, which was previously available only in the Salesforce user interface, is now
available in the API.

@ Note: Availability of specific permissions depends on the organization edition and user licenses.

ProcessDefinition
The ProcessDefinition object now supports the search () call.

Site
The following field has been added:
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OptionsRequireHttps
When true, the site requires secure connections. When false, the site operates normally via insecure connections instead of
redirecting to a secure connection.

StaticResource
The StaticResource object now supports the search () call.

StatusCode
The INVALID EVENT SUBSCRIPTION status code has been added to the available API status codes.

UserTerritory2Association
The UserTerritory2Association object has a new picklist field: Role in Territory.

User
The User object has the following new field: BadgeText.

UserProfile

The UserProfile object is deprecated in APl version 32.0. Please remove any references you have to the UserProfile object before the
Winter '15 release.

WorkBadge
The WorkBadge object now supports the search () call. Additionally, the object has the following new fields.

® Description

® GiverId

® TImageUrl

® LastReferencedDate

® LastViewedDate

® Message
WorkBadgeDefinition

The WorkBadgeDefinition object now supports the search () call. The LimitStartDate field's groupable property has
changed to true. Additionally, the object has the following new fields.

® GivenBadgeCount
® LastViewedDate
® LastReferencedDate

WorkFeedback
The WorkFeedback object now supports the search () call.

WorkFeedbackQuestion
The WorkFeedbackQuestion object now supports the search () call.

WorkFeedbackQuestionSet
The WorkFeedbackQuestionSet object now supports the search () call.

WorkFeedbackRequest
The WorkFeedbackRequest object has the following new field: IsShareWithSubject

WorkPerformanceCycle
The WorkPerformanceCycle object now supports the search () call. The State field's Process picklist value has been
removed. Additionally, the object has the following new field: CurrentTask.

WorkReward
The WorkReward object has the following new fields.

® RedemptionDisclaimer
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® RedemptionInfo
® RedemptionUrl

WorkRewardFund
The WorkRewardFund object now supports the search () call. Additionally, the object has the following new fields.

® TLastReferencedDate
® LastViewedDate

WorkRewardFundType
The WorkRewardFundType object now supports the search () call. Additionally, the object has the following new fields.

® TLastReferencedDate

® LastViewedDate

Changed Obijects That Affect Earlier API Versions

These objects have changed in APl version 32.0 and affect earlier API versions.

ForecastingAdjustment
The ForecastingAdjustment object has the following new field: AdjustmentNote. This field is available in APl version 31.0 and
later.

SOQL

Use the Salesforce Object Query Language (SOQL) to construct query strings used in Salesforce APIs.

SOQL query filtering with the new USING SCOPE clause
The new USING SCOPE clause lets you limit results by fi1lterScope. For example:

SELECT Id FROM Account USING SCOPE Mine

SOSL

Use the Salesforce Object Search Language (SOSL) to perform text searches with Salesforce APIs.

Highlight Matching Search Terms in Search Results by Using the WITH SNIPPET Clause
Addthe WITH SNIPPET clause to article searches to provide users with additional context for each matching article in the search
results. Search highlights and snippets make it easier for users to identify the content that they're looking for in the search results
when the search term isn't included in the article summary field.

REST API

The REST APl includes new and changed resources, new types, and changes to older APl versions.

New Resources

List View Resource
/vXX.X/sobjects/{sobjectType}/listviews/{listViewID}

Returns basic information about the specified list view.

List View Describe Resource
/vXX.X/sobjects/{sobjectType}/listviews/{listViewID}/describe

296



Force.com Development REST API

Returns detailed information about a list view, including the ID, the columns, and the SOQL query.

List View Results Resource
/vXX.X/sobjects/{sobjectType}/listviews/{listViewID}/results

Executes the SOQL query for the list view and returns the resulting data and presentation information.

List Views Resource
/VXX.X/sobjects/{sobjectType}/listviews

Returns the list of list views for the specified sObject, including basic information about each list view. You can also call this resource
for a specific listview entity 1D to return information for only a specific list view.

Recent List Views Resource
/VXX.X/sobjects/{sobjectType}/listviews/recent

Returns the list of recently used list views for the given sObject type.

Suggestions Resource
Returns a list of suggested records whose names match the user’s search string. The suggestions resource provides a shortcut for
users to navigate directly to likely relevant records, before performing a search.

List Invocable Actions
Returns Standard or Custom; the two primary action categories. Standard actions may be used statically while custom actions
must be defined in advance. Use the GET method for each specific action for additional information about the input parameters for
and the output parameters from invoking the action.

List Invocable Actions Standard
Returns the list of actions that can be statically invoked. The available actions are:

e (ChatterPost—Post text to the feed for a specific record, user, or Chatter group. The text can include @mentions and topics.
e EmailSimple—Send an email where you specify the subject, body, and recipients.
e SubmitApproval—Submit a Salesforce record for approval.

List Invocable Actions Custom
Returns the list of all custom actions. The available actions are:

e EmailAlert—Your organization’s workflow email alerts.
e Flow—The active trigger-ready flows in your organization.

e QuickAction—Auvailable quick actions in your organization.

Changed Resources

Approval Process Requests
New process requests are available for the following resource: /vXX.X/process/approvals/ . These requests enable you
to do the following:

e Specify a submitter requesting an approval record.

e Specify a developer name or ID of a process definition.

e Determine whether or not to evaluate entry criteria for the process.
See “Process Approvals” in the Force.com REST APl Developer's Guide.

SObject Rows
The GET method of the resource now supports external objects. For external object—specific usage details, see “SObject Rows” in
the Force.com REST API Developer's Guide.
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New Headers

Call Options Header
The Call Options header is a request header applied when working with a specific client. Use this header to specify a default namespace,
enabling you to resolve field names in managed packages without having to specify the namespace everywhere. The following
example sets the default namespace to battle:

Sforce-Call-Options: client=SampleCaseSensitiveToken/100, defaultNamespace=battle
Then queries such as the following will succeed:
/VXX.X/query/?q=SELECT+Id+botID c+FROM+Account

In this case the actual field queried is the battle botId c field.

Package Version Header
The Package Version header is a request header applied when working with managed packages. Use this header to specify the
version of each package referenced by your API client. A package version is a number that identifies the set of components and
behavior contained in a package. Publishers can use package versions to evolve the components in their managed packages gracefully
by releasing subsequent package versions without breaking existing customer integrations using the package. This header can also
be used to specify a package version when making calls to an Apex REST web service. The following example specifies a package
version of 1.0 forthe clientPackage package: x-sfdc-packageversion-clientPackage: 1.0

Query Options Header
The Query Options header is a request header applied when using the Query REST APl resource. Use this header to specify the query
results batch size. The following example sets the query results batch size to 1000: Sforce-Query-Options:
batchSize=1000

Other Changes

Compound Geolocation Field Support Added to Older API Versions
You can SELECT compound geolocation fields in REST requests in APl versions 26.0 and later. Previously, support for compound
geolocation fields was available in APl versions 30.0 and later.

SOAP API

The SOAP APl includes new and changed calls, new and changed types, and changes to older API versions.

New Calls

These calls are new in APl version 32.0.

describeSoq|lListViews()
Returns detailed information about a list view, including the ID, columns, and SOQL query.

executeListView()
Executes the SOQL query for the list view and returns the resulting data and presentation information.

Changed Calls

These calls have changed in APl version 32.0.

describeSObjects ()
The following field has been added to DescribeSObjectResult:
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® actionOverriddes — Anarray of action overrides that replace actions specified in the ur1Detail, urlEdit and
urlNew fields.

The following new type has been added:
® ActionOverride — Provides details about an action that replaces the default action pages for an object.

DescribeFlexiPageResult (returned by describeFlexiPages ())
The following field has been added:

e type—Required. The type of the Flexible Page.

describeLayout (), DescribeLayoutResult, and associated types
The following field has been added to the RelatedList subtype:

* Dbuttons—The buttons associated with the related list.
The following field has been added to the DescribeLayoutButton subtype:
e colors—-Array of color information for icons associated with this button or link. Each color is associated with a theme.

SearchResult (returned by SOS1. search)
The following field has been added:

® queryId—Unique identifier for the SOSL search.

New Types
These types are new in APl version 32.0.

DescribeSoqlListView
Contains information about the specified list view, including the columns, sObject type, and SOQL query.

DescribeSoqlListViewParams
Use DescribeSoqlListViewParams with describeSoglListViews to retrieve the SOQL from a list view.

DescribeSoqlListViewResult
Contains one or more DescribeSoglListView objects, each of which contains information about one or more list views,
including the ID, entity, columns, and SOQL query of each.

DescribeSoqlListViewsRequest
Use with describeSoqglListViews to retrieve information about a list view.

describeSoqlListViewsResponse
Containsthe DescribeSoglListViewResult thatdescribesa list view, including the SOQL needed to execute the list view.

ExecuteListViewRequest
Use with executeListView to retrieve data, labels, and actions from a list view.

ExecuteListViewResponse
Contains the ExecuteListViewResult object that holds list view data that you retrieved programmatically.

ExecuteListViewResult
Contains list view data that you retrieve programmatically.

ListViewColumn
Contains metadata about a single list view column.

ListViewOrderBy
Use with executeListView to determine the order that records are returned from a list view.

ListViewRecord
Represents a single row in a list view.
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ListViewRecordColumn
Represents a single cell in a row from a list view.

Changed Types

This type has changed in APl version 32.0.

Field on DescribeSObjectResult
The following field has been added to the Field type:

e referenceTargetField —Appliesonly toindirect lookup relationships on external objects. Name of the custom field
on the parent standard or custom object whose values are matched against the values of the child external object's indirect
lookup relationship field. This matching is done to determine which records are related to each other.

The following field was changed on the Field type:

* extraTypelInfo —Expandedtosupport reference typefieldsonexternal objects. Indicates the type of external object
relationship.

Other Changes

Compound Geolocation Field Support Added to Older API Versions
You can SELECT compound geolocation fields in SOAP requests in APl versions 26.0 and later. Previously, support for compound
geolocation fields was available in APl versions 30.0 and later.

@ Note: SOAP calls that use APl versions earlier than 30.0 return geolocation compound values as strings. See “Returned
Geolocation Data Types” in the Object Reference for Salesforce and Force.com.

Chatter REST AP

To integrate mobile apps, intranet sites, and third-party Web applications with Chatter, use Chatter REST API.

@ Note: To create custom Chatter experiences in Salesforce, use ConnectApi (Chatter in Apex).

IN THIS SECTION:
General Updates
New and Changed Resources
New and Changed Request Bodies

New and Changed Response Bodies

General Updates

Feed Elements

In APl versions 30.0 and earlier, a Chatter feed was a container of feed items. In APl version 31.0, the definition of a feed expanded to
include new objects that didn't entirely fit the feed item model. The Chatter feed became a container of feed elements. In APl version
32.0, feed elements can be either feed items or generic feed elements. Generic feed elements don't have an actor property, which
means they can be used for system-generated content like the new recommendations in the feed.
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This table shows the properties that are shared by Generic Feed Element and Feed Item, and the properties that are unique to Feed Item.

Property Generic Feed Element Feed ltem
actor X
body X X
capabilities X X
canShare X
createdDate X X
feedElementType X X
header X X
id X X
isDeleteRestricted X
modifiedDate X X
originalFeedItem X
originalFeedItemActor X
parent X X
photoUrl X
relativeCreatedDate X X
type X
url X X
visibility X

@ Important: APl version 32.0 introduces new resources that get, search, update, and post feed elements. These resources operate
on and return new request and response bodies that represent feed elements. Older resources, request bodies, and response
bodies that operate on and represent only feed items aren't supported in APl version 32.0. The documentation for older resources,
request bodies, and response bodies contains links to the documentation for the newer resources, request bodies, and response
bodies.

Detailed information about these changes are in the following “Feed Elements” sections.

Capabilities

As part of the effort to diversify the feed, pieces of functionality found in feed elements have been broken out into capabilities. Capabilities
provide a consistent way to interact with objects in the feed. Instead of inspecting feed item type and using other indirect means to
determine which functionality is available for a specific feed element, the capabilities object tells you explicitly what is available. A client
should check for the presence of a capability to determine what it can do to a feed element.

All feed elements have a capabilities property, which holds a Feed Element Capabilities response body. The Feed Element
Capabilities response body can have one or more properties, each holding a capability of the feed element.
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Feed Element Capabilities Property
approval

associatedActions

banner

bundle

canvas
caseComment

chatterLikes

comments

content
dashboardComponentSnapshot
emailMessage

enhancedLink

link

moderation

poll

questionAndAnswers
recommendations
recordSnapshot

topics

trackedChanges

Chatter REST API

Type

Approval Capability

Associated Actions Capability
Banner Capability

e Generic Bundle Capability

e Tracked Change Bundle Capability
Canvas Capability

Case Comment Capability
Chatter Likes Capability
Comments Capability

Content Capability

Dashboard Component Snapshot Capability
Email Message Capability
Enhanced Link Capability

Link Capability

Moderation Capability

Poll Capability

Question and Answers Capability
Recommendations Capability
Record Snapshot Capability
Topics Capability

Tracked Changes Capability

In version 32.0 and later, every feed element can have a unique set of capabilities. A capability includes both an indication that a feature
is possible and data associated with that feature. If a capability exists on a feed element, that capability is available, even if there isn't
any data associated with the capability yet. For example, if the chatterLikes capability property exists on a feed element (with or
without any likes included in the list of likes found in the chatterLikes.page.items property), the context user can like that
feed element. If the capability property doesn't exist on a feed element, it isn't possible to like that feed element.

@ Important: In APl version 32.0, new resources have been introduced that operate on the capabilities of feed elements. These
resources operate on and return new request and response bodies that represent capabilities. Older resources, request bodies,
and response bodies are not supported in APl version 32.0. In addition, all attachment functionality has been moved into capabilities
and attachments are not supported in APl version 32.0. Whereas a feed item could have only one attachment, feed items can now
have multiple capabilities. The documentation for attachments contains links to the new capabilities.

Detailed information about these changes are in the following “Capabilities” sections.
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Recommendations
Recommendations are new to the Chatter feed in APl version 32.0.

The news feed in Salesforce1 mobile browser app can include recommendations about useful groups to join. The feed can also recommend
the Today app but this option can be turned off from Setup > Customize > Chatter > Settings.

Recommendations are generic feed elements with a recommendations capability. They're an example of what's possible with the new
feed element and capabilities architecture.

Recommendations

Feed Element

Generic Feed Element
body
capabilities —————= Feed Element Capabilities
createdDate * recommendations =—---- Recommendations Capability
feedElementType % items -- Collection of these
header Recommendation types
id |
modifiedDate |
parent |
relativeCreatedDate |
url —

| |

| |

LR B A A

Entity Recommendation Non-Entity Recommendation
# actOnUrl #* displaylLabel

% action =--- RecommendationActionType * explanation

* entity * Tollow * motif

* explanation * join * recommendationType
* recommendationType * View

Detailed information about these changes are in the following “Recommendations” sections.

Use CORS (Cross-Origin Resource Sharing) to Access Chatter REST AP

@ Note: To enable this feature, contact your Salesforce representative. In APl version 32.0, only Chatter REST API supports CORS.
REST API does not support CORS.

CORSisaW3Crecommendation that enables Web browsers to request resources from origins other than their own (cross-origin requests).
For example, using CORS, a JavaScript script at https://www.example . com could request a resource from
https://www.salesforce.com

Chatter REST API supports CORS (cross-origin resource sharing). To access this APl from JavaScript in a Web browser, add the origin
serving the script to the CORS whitelist.

To add an origin to the CORS whitelist, from Setup, choose Security Controls > CORS. Click New and enter an origin URL pattern.

The origin URL pattern must include HTTPS and a domain name, and may include a port. The wildcard character (*) is supported and
must be in front of a second-level domain name. For example, https://*.example.com adds all the subdomains of
example.com to the whitelist.

If a browser that supports CORS makes a request to an origin in the Salesforce CORS whitelist, Salesforce returns the origin in the
Access-Control-Allow-Origin HTTP header,along with any additional CORS HTTP headers. If the origin is not in the whitelist,
Salesforce returns HTTP status code 404.

You must still pass an OAuth token with requests that require it.
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New and Changed Resources

Action Links (Pilot)

@ Note: Action Links are currently available to select customers through a pilot program. To be nominated to join this pilot program,
contact salesforce.com. Additional terms and conditions may apply to participate in the pilot program. Please note that pilot
programs are subject to change, and as such, we cannot guarantee acceptance into this pilot program or a particular time frame
in which this feature can be enabled. Any unreleased services or features referenced in this document, press releases, or public
statements are not currently available and may not be delivered on time or at all. Customers who purchase our services should
make their purchase decisions based upon features that are currently available,

An action link is an indicator on a feed element that targets an API, a Web page, or a file and is represented by a button in the Salesforce
Chatter feed Ul. An action link includes an HTTP method and can include header information, such as a bearer token for authentication.
Use action links to integrate Salesforce and third-party systems into the feed.

The highlighted buttons are action links:
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Search this feed

What | Follow » =

Pam Smith to Deanna Li:
3m ago

Deanna, here are the Installation instructions. Use
'Order' when you're ready to have your part 3D
printed at your designated pick-up location.

au Y[

o

iy Like Com

In version 32.0 of the pilot, action links are no longer restricted to the Salesforce mobile browser app. In addition, we made these
changes.

Action links name changes

The Action Link resource (/chatter/action-1links/actionLinkId) now returnsa Platform Action response body that
describes an action link.

The Action Link Group resource (/chatter/action-link-groups/actionLinkGroupId) now returns a Platform
Action Group response body that describes an action link group.

Get diagnostic information for action links
To get diagnostic information for action links, use the new
/chatter/action-links/actionLinkId/diagnostic-info resource.Diagnosticinfoisgivenonly foruserswho
can access the action link.
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Batch Posting Feed Elements

Post a batch of feed elements
To post a batch of up to 500 feed elements, make a POST request to the /chatter/feed-elements/batch resource.

Capabilities
See Capabilities on page 301 for general information about capabilities and how they have changed in APl version 32.0.

Access a capability on a feed element
To access a capability on a feed element, make GET requests to these resources:

e /chatter/feed-elements/feedElementId/capabilities/approval—Accesstheapproval capability of
a feed element.

e /chatter/feed-elements/feedElementId/capabilities/associated-actions—Accesstheassociated
actions capability of a feed element. (Available in APl version 31.0)

e /chatter/feed-elements/feedElementId/capabilities/banner—Accessthe banner capability of a
feed element. (Available in APl version 31.0)

e /chatter/feed-elements/feedElementId/capabilities/bookmarks—Getinformationaboutwhether
a feed element is bookmarked, or add a bookmark to a feed element. (Available in APl version 31.0)

® /chatter/feed-elements/feedElementId/capabilities/bundle—Accessthe bundle capability of a
feed element. (Available in pilot APl version 31.0 and 32.0))

e /chatter/feed-elements/feedElementId/capabilities/bundle/feed-elements—Accessallfeed
elements that are grouped together in a bundle. (Available in pilot in APl version 31.0 and 32.0.)

® /chatter/feed-elements/feedElementId/capabilities/canvas—Accessthe canvascapability ofafeed
element.

e /chatter/feed-elements/feedElementId/capabilities/case-comment—Accessthe case comment
capability of a feed element.

e /chatter/feed-elements/feedElementId/capabilities/chatter-1ikes—Accessinformationabout
the chatter likes capability for a feed element. (Available in APl version 31.0.)

e /chatter/feed-elements/feedElementId/capabilities/comments—Accessthe comments capability
for a feed element (Available in APl version 31.0.)

e /chatter/feed-elements/feedElementId/capabilities/content—Accessthe contentcapability of a
feed element.

¢ /chatter/feed-elements/feedElementId/capabilities/dashboard-component-snapshot—Access
the dashboard component capability of a feed element.

e /chatter/feed-elements/feedElementId/capabilities/email-message—Accesstheemailmessage
capability of a feed element.

e /chatter/feed-elements/feedElementId/capabilities/enhanced-11ink—Accesstheenhanced link
capability of a feed element.

e /chatter/feed-elements/feedElementId/capabilities/1ink—Access the link capability of afeed
element.

® /connect/communities/communityId/
/chatter/feed-elements/feedElementId/capabilities/moderation—Getinformation about afeed
element's moderation capability, add a moderation flag to a feed element, or delete all moderation flags from a feed element.
(Available in APl version 31.0.)
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e /chatter/feed-elements/feedElementId/capabilities/poll—Accessa pollforafeedelement, create
a poll, or vote on a poll. (Available in APl version 31.0)

e /chatter/feed-elements/feedElementId/capabilities/question-and-answers—Accessquestion
and answers for a feed element, or update question and answers on a feed element. (Available in beta in APl version 31.0)

e /chatter/feed-elements/feedElementId/capabilities/recommendations—Accessthe
recommendations capability of a feed element.

e /chatter/feed-elements/feedElementId/capabilities/record-snapshot—Access the record
snapshot capability of a feed element.

® /chatter/feed-elements/feedElementId/capabilities/topics—Get, delete,and posttopicsassociated
with a feed element. (Available in APl version 31.0)

e /chatter/feed-elements/feedElementId/capabilities/tracked-changes—Access the tracked
changes capability of a feed element.

Bookmark a feed element
If the bookmark capability is available, you can make a PATCH request to
/chatter/feed-elements/feedElementId/capabilities/bookmarks.

Like a feed element
If the Chatter likes capability is available, you can make a POST request to
/chatter/feed-elements/feedElementId/capabilities/chatterLikes/items.

Post a comment
If the comments capability is available, you can make a POST request to
/chatter/feed-elements/feedElementId/capabilities/comments/1items

Add a moderation flag to a feed element, or delete all moderation flags from a feed element
If the moderation capability is available, you can make a POST or DELETE requestto /connect/communities/communityId/
/chatter/feed-elements/feedElementId/capabilities/moderation

Create a poll or vote on a poll
If the poll capability is available, you can make a PATCH request to
/chatter/feed-elements/feedElementId/capabilities/poll.

Update question and answers on a feed element
If the question and answers capability is available, you can make a PATCH request to
/chatter/feed-elements/feedElementId/capabilities/question-and-answers.

Delete and post topics
If the topics capability is available, you can make a DELETE or POST request to
/chatter/feed-elements/feedElementId/capabilities/topics.

This table describes how to migrate from earlier APl versions to AP version 32.0.

In API versions 31.0 and earlier, use... In API version 32.0 and later, use...

/chatter/feed-items/feedItemId /chatter/feed-elements/feedElementId/

PATCH to bookmark a feed item. capabilities/bookmarks

/chatter/feed-items/feedItemId/comments /chatter/feed-elements/feedElementId/
capabilities/comments/items

/chatter/feed-items/feedItemId/likes /chatter/feed-elements/feedElementId
/capabilities/chatter-likes/items
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In API versions 31.0 and earlier, use...

/connect/communities/communityId/
chatter/feed-items/feedItemId/
moderation-flags

/chatter/feed-items/feedItemId/poll

/chatter/feed-items/feedItemId/topics

Chatter REST API

In API version 32.0 and later, use...

/connect/communities/communityId/
chatter/feed-elements/feedElementId/
capabilities/moderation

/chatter/feed-elements/feedElementId
/capabilities/poll

/chatter/feed-elements/feedElementId

/capabilities/topics

Communities

Communities Home feed
Make a GET request to the new resource

/connect/communities/communityId/chatter/feeds/home/feed-elements togetall feed elements
associated with any managed topic in a community.

Get the reputation of a user in a community
Make a GET request to the new resource

/connect/communities/communityId/chatter/users/userId/reputationtogetthereputationofauser
ina community.

Search for question and answers suggestions
To search for question and answer suggestions, make a GET request to the
/connect/question-and-answers/suggestions resource.

Filter feeds to specify which questions are returned
Tofilter the communities home, news, record, or topic feed, make GET requests with the new £ilter parameter to these resources:

® /connect/communities/communityId/chatter/feeds/home/feed-elements
e /chatter/feeds/news/userId/feed-elements

e /chatter/feeds/record/recordId/feed-elements

® /chatter/feeds/topics/topicId/feed-elements

The £ilter parameter can have these values:

e AllQuestions—Onlyfeed elements that are questions.

® SolvedQuestions—Only feed elements that are questions and that have a best answer.

® UnansweredQuestions—Only feed elements that are questions and that don't have any answers.
® UnsolvedQuestions—Only feed elements that are questions and that don't have a best answer.

Get all the managed topics, reorder managed topics, or create a managed topic for a community
To get all the managed topics for a community, make a GET request to the
/connect/communities/communityId/managed-topics resource. Tocreateamanaged topic, make a POST request
to the same resource. To reorder managed topics, make a PATCH request to the same resource.

Only community managers (users with the “Create and Set Up Communities” or “Manage Communities” permission) can create and
reorder managed topics.
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Get information about or delete a managed topic in a community
To get information about a managed topic in a community, make a GET request to the
/connect/communities/communityId/managed-topics/managedTopicIdresource.To delete a managed
topic, make a DELETE request to the same resource.

Only community managers (users with the “Create and Set Up Communities” or “Manage Communities” permission) can delete
managed topics.

Dashboard Component Snapshot

Dashboard Component Snapshot Resource returns new response body
In APl versions 31.0 and earlier, the /connect/dashboards/components/componentId/snapshots resource
returns a Feed Item Attachment: Dashboard response body.

In APl version 32.0, it returns a Dashboard Component Snapshot response body.

Data.com

Purchase Data.com contacts or companies, and track your purchase usage information
Purchase Data.com contacts and companies, and track purchase information with these new resources.

® /connect/datacloud/companies/companyId

® /connect/datacloud/contacts/contactId

® /connect/datacloud/orders/orderId

® /connect/datacloud/orders/orderId/companies
® /connect/datacloud/orders/orderId/contacts
® /connect/datacloud/orders

® /connect/datacloud/usage/userId

Feed Elements
See Feed Elements on page 300 for general information about feed elements and how they have changed in APl version 32.0.

This table describes how to migrate from earlier APl versions to APl version 32.0. The resources in the first column are supported in AP
versions 31.0 and earlier. The resources in the second column were new in APl version 31.0.

@ Important: APIversion 31.0 was a transitional release that supported both resources that operate on feed elements and resources
that operate on feed items. As of APl version 32.0, only feed element resources are supported.

In API versions 31.0 and earlier, use... In API version 32.0 and later, use...
/chatter/feed-items?g=searchTerm /chatter/feed-elements?g=searchTerm
/chatter/feed-items/batch/feedItemIds /chatter/feed-elements/batch/feedElementIds
/chatter/feed-items/feedItemId /chatter/feed-elements/feedElementId
/chatter/feeds/bookmarks/me/feed-items /chatter/feeds/bookmarks/me/feed-elements
/chatter/feeds/company/feed-items /chatter/feeds/company/feed-elements

/chatter/feeds/favorites/me/ favoriteld/feed-items /chatter/feeds/favorites/me/favoriteld/feed-elements
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In API versions 31.0 and earlier, use...
/chatter/feeds/files/me/feed-items
/chatter/feeds/filter/userId/idPrefix/feed-items
/chatter/feeds/groups/me/feed-items

NA

/connect/communities/communityId
/chatter/feeds/moderation/feed-items

/chatter/feeds/news/me/feed-items
/chatter/feeds/people/me/feed-items
/chatter/feeds/record/recordId/feed-items
/chatter/feeds/to/me/feed-items
/chatter/feeds/topics/topicId/feed-items

/chatter/feeds/user-profile/me/feed-items

Files

Update the description of an existing file

Chatter REST API

In API version 32.0 and later, use...
/chatter/feeds/files/me/feed-elements
/chatter/feeds/filter/userId/idPrefix/feed-elements
/chatter/feeds/groups/me/feed-elements

/connect/communities/communityId/
chatter/feeds/home/feed-elements

/connect/communities/communityId
/chatter/feeds/moderation/feed-elements

/chatter/feeds/news/me/feed-elements
/chatter/feeds/people/me/feed-elements
/chatter/feeds/record/recordId/feed-elements
/chatter/feeds/to/me/feed-elements
/chatter/feeds/topics/topicId/feed-elements

/chatter/feeds/user-profile/me/feed-elements

Pass the new desc parameterin a PATCH requestto /chatter/files/fileId to update the description of a file that has

already been uploaded to Salesforce.

Files Connect Repository

Afiles connect repository is an external content repository that's connected to Salesforce.

Get a list of files connect repositories

To get a list of files connect repositories, make a GET request to the /connect/content-hub/repositories resource.

Get information about a files connect repository

To get information about a files connect repository, make a GET request to the
/connect/content-hub/repositories/repositoryIdresource.

Get information about a files connect repository file

To get information about a files connect repository file, make a GET request to the
/connect/content-hub/repositories/repositoryId/files/repositoryFileIdresource

Get the content of a files connect repository file

To get the content of a files connect repository file, make a GET request to the
/connect/content-hub/repositories/repositoryld/files/repositoryFileId/contentresource.

The content is streamed as the body of the response.

Get information about the files and folders in a files connect repository folder
To get information about the files and folders in a files connect repository folder, make a GET request to the
/connect/content-hub/repositories/repositoryId/folders/repositoryFolderId/items resource.
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New and Changed Request Bodies

Action Links (Pilot)

Action Link Group Definition Input
The Unclassified value of the category property is now called Overflow.

Batch Posting Feed Elements

Batch Collection Input
Describes a collection of inputs for a batch request. This request body has one property:

e inputs—A collection of Batch Input request bodies.

Batch Input
A single batch input to nest in a batch collection input. This request body has these properties:

® binaryPartNames—oList of the name parametersinthe Content-Disposition header of the binary body parts
to include with this input. If this value exists, the corresponding binary part must be included in the request. When used with
the /chatter/feed-elements/batch resource, this property can contain only one element.

® richInput—Aninputbody (request body) for the request. The richInput property must contain the request body that
the resource expects. When used with the /chatter/feed-elements/batch resource, this value must be a Feed
ltem Input request body.

Capabilities

See Capabilities on page 301 for general information about capabilities and how they've changed in API version 32.0.

Associated Actions Capability Input
In APl version 31.0, within a feed item, action link groups are returned in the order of their creation date, and then their ID. In API
version 32.0, within a feed item, action link groups are returned in the order specified in the actionLinkGroupIds property

of the Associated Actions Capability Input request body. The order of action links associated with feed items in APl version 31.0 is
preserved in APl version 32.0.

Attachment Input: Canvas App
This request body isn't available in version 32.0 and later. In version 32.0 and later, use the Canvas Capability Input request body.

Attachment Input: Existing Content
This request body isn't available in version 32.0 and later. In version 32.0 and later, use the Content Capability Input request body.

Attachment Input: Feed Poll
This request body isn't available in version 32.0 and later. In version 32.0 and later, use the Poll Capability Input request body.

Attachment Input: Link
This request body isn't available in version 32.0 and later. In version 32.0 and later, use the Link Capability Input request body.

Attachment Input: New File Upload
This request body isn't available in version 32.0 and later. In version 32.0 and later, use the Content Capability Input request body.

Bookmarks Capability Input
Create or update a bookmark on a feed element.

This new request body has one property, i sBookmarkedByCurrentUser, which specifies if the feed element should be
bookmarked for the user (true) ornot (false).

Canvas Capability Input
Create or update a canvas app associated with a feed element.
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This new request body has these properties:

description—A description of the canvas app. The maximum size is 255 characters.
developerName—The APl name (developer name) of the connected app.

height—The height of the canvas app in pixels.

namespacePrefix—A unique namespace prefix for the canvas app.

parameters—JSON parameters passed to the canvas app.

thumbnailUrl—A thumbnail URL to a preview image. The maximum thumbnail size is 120 pixels by 120 pixels.
title—Atitle for the canvas link.

Comment Capability Input
This request body has one new property, capabilities, whichisaComment Capabilities Input request body containing a

Content Capability Input request body, which can contain a file attachment. Use this property instead of attachment, which is
no longer supported.

Comment Capabilities Input
This new request body has one property, content, which is a Content Capability Input request body.

Comment Input

This request body has one new property, capabilities, which contains any capabilities, such as file attachments, associated
with the comment. Use this property instead of attachment, which is no longer supported.

Content Capability Input
Create or update a file associated with a feed element.

This new request body has these properties:

contentDocument Id—ID of the existing content.
description—Description of the file to be uploaded.

title—Title of thefile. This value is used as the file name for new content. For example, if the title is My Title, and the file is a
Ixt file, the file name is My Title.txt.

Feed Element Capabilities Input
A container for all capabilities that can be included when creating a new feed element.

This request body has these new properties:

bookmarks—Describes bookmarks added to this feed element.
canvas—Describes a canvas app added to this feed element.
content—Describes content added to this feed element.
1ink—Describes a link added to this feed element.
poll—Describes a poll added to this feed element.

questionAndAnswers—Describes a question and answer capability added to this feed element.

Feed Item Input
These properties aren’t available in version 32.0 and later:

attachment—Usethe capabilities property.
isBookmarkedByCurrentUser—Use the Bookmarks Capability Input.

originalFeedItemId—Usethe originalFeedElementId property.

Feed Poll Input
This request body isn't available in version 32.0 and later. In version 32.0 and later, use the Poll Capability Input request body.
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Link Capability Input

Create or update a link attached to a feed element.

This new request body has these properties:

e url—Link URL The URL can be to an external site.

e urlName—Description of the link.

Poll Capability Input

Create, update, or vote on a poll attached to a feed element.

This new request body has these properties:

e choices—The choices used to create a new poll.

Chatter REST API

® myChoiceId—ID of an existing choice on the feed poll. Used to vote on an existing poll.

Question and Answers Capability Input

Create a question feed element or set the best answer of the existing question feed element.

This new request body has these properties:

* bestAnswerId—AcommentIDtouseasabestanswerforaquestionfeed element. The bestanswercomment must already

exist on the question feed element.

® questionTitle—Titlefora question feed element.

This table describes how to migrate to APl version 32.0.

In API versions 31.0 and earlier use...
Attachment Input: Canvas App

Attachment Input: Existing Content
Attachment Input: Link

Attachment Input: New File Upload
Attachment Input: Feed Poll

Feed Item Input

attachment property

Feed Item Input

isBookmarkedByCurrentUser property

Feed Item Input

originalFeedItemId property

Feed Poll Input

Communities

Managed Topic Input
A managed topic.

In API version 32.0, use...
Canvas Capability Input
Content Capability Input

Link Capability Input

Content Capability Input

Poll Capability Input

Feed Item Input

capabilities property

Feed Item Input

capabilities.bookmarks.isBookmarkedByCurrentUser
property

Feed Item Input

originalFeedElementId property

Poll Capability Input
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The request body has these properties:

®* managedTopicType—IType of managed topic.
- Featured—Topics that are featured, for example, on the community home page, but don't provide overall navigation.
- Navigational—Topics that display in a navigational menu in the community.

e name—Name of the managed topic.

® recordId—ID of the record to become a managed topic.

Managed Topic Position Collection Input
A collection of relative positions of managed topics.

The request body has this property:
* managedTopicPositions—~Collection of managed topic position request bodies.

Managed Topic Position Input
The relative position of a managed topic.

The request body has these properties:
®* managedTopicId—ID of existing managed topic.

® position—~Relative position of the managed topic, indicated by zero-indexed, ascending whole numbers.

Data.com

Datacloud Order Input
A list of Data.com identification numbers that are used to purchase contacts or companies by a specific userType.

These are the properties for this request body:

® companyIds—The list of companies to purchase. If contactIds areincluded with companyIds, your purchase fails.

e contactIds—Thelistof contactsto purchase. We recommend that you include only contacts in your list. If companyIds
are included with contactIds, your purchase fails.

® userType—The Data.com user type.

Files Connect

File Input
This request body has these new properties:

® contentModifiedDate—rFile-specific last modified date that can be used to set a client-side modified date.
® repositoryFileId—ID ofthe externalfile.

® repositoryId—ID of the external data source.
New and Changed Response Bodies

Action Links (Pilot)

Action Link
The Action Link response body is now called Platform Action. See Platform Action for new and changed properties.

Action Link Diagnostic
This new response body has these properties:
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diagnosticInfo—Any diagnosticinformation thatis returned from the REST endpoint when an action link has been
executed. Diagnostic information is given only for users who can access the action link.

url—The Chatter REST API URL for this action link diagnostic.

Action Link Group
The Action Link Group response body is now called Platform Action Group. See Platform Action Group for new and changed properties.

Action Link Group Definition
The Unclassified value of the category property is now called Overflow.

Platform Action
The Action Link response body is now called Platform Action. It has these new or changed properties:

actionLinkGroup isnow called plat formActionGroup—A reference to the platform action group containing this
platform action.

apiName—The APl name. This value may be nul1l.

createdDate isremoved.

diagnosticInfo isremoved.

iconUr1—The URL of the icon for the platform action. This value may be nul1.

quickActionInfo isremoved.

requiresConfirmation isremoved.

type isnow called subtype—The subtype of a platform action. One of these values:

Api—The action link calls a synchronous API.
ApiAsync—The action link calls an asynchronous API.
Download—The action link downloads afile.

Ui—The action link takes the user to a user interface.

type—The type of the platform action. One of these values:

ActionLink—Anindicator on a feed element that targets an API, a Web page, or a file and is represented by a button
in the Salesforce Chatter feed Ul.

AnchorAction—A preconfigured record action (such as Map, Read News, or View Website) in the Salesforce1 action
bar.

CustomButton—When clicked, opens a URL or a Visualforce page in a window or executes JavaScript.

QuickAction—An action on the Chatter publisher on the home page, on the Chatter tab, in Chatter groups, and on
record detail pages. Quick actions also appear in the action bar in Salesforce1. Quick actions are called publisher actions in
Salesforce Help.

StandardButton—A prebuilt Salesforce button such as New, Edit, and Delete.

Platform Action Group
The Action Link Group response body is now called Platform Action Group. It has these new or changed properties:

actionLinks isnow called platformActions—A list of platform action response bodies for this group.

createdDate is removed.

executionsAllowed is removed.

expirationDate isremoved.
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Capabilities

See Capabilities on page 3071 for general information about how feed elements and feed items have changed in APl version 32.0.

Approval Capability
If a feed element has this capability, it includes information about an approval.

This new response body has these properties:

id—The work item ID. The work item ID is nul1 if there isn't a pending work item associated with the approval record.
postTemplateFields—The details of the approval post template field.
processIntanceStepId—The processinstance step ID. The associated record represents one step in an approval process.

status—The status of the approval.

Associated Actions Capability
The actionLinkGroups propertyisnow called platformActionGroups.

Action link groups are returned in the order specified in the Associated Actions Capability Input request body.

Bookmarks Capability
If a feed element has this capability, the current user can bookmark it.

This response body has one property, i sBookmarkedByCurrentUser, which specifies whether the feed element is bookmarked
(true)ornot (false).

Canvas Capability
If a feed element has this capability, it renders a canvas app.

This new response body has these properties:

description—A description of the canvas app. The maximum size is 255 characters.
developerName—The APl name (developer name) of the connected app.

height—The height of the canvas app in pixels.

icon—Theicon for the canvas app.

namespacePrefix—A unique namespace prefix for the canvas app.

parameters—IJSON parameters passed to the canvas app.

thumbnailUrl—A thumbnail URL to a preview image. The maximum thumbnail size is 120 pixels by 120 pixels.

title—Atitle for the canvas link.

Case Comment Capability
If a feed element has this capability, it has a case comment on the case feed.

This new response body has these properties:

actorType—Specifies the type of user who made the comment.
createdBy—Information about the user who created the comment.
createdDate—IS08601 date string, for example, 2011-02-25T18:24:31.000Z.
eventType—Specifies an event type for a comment in the case feed.
id—18-character ID of case comment.

published—Specifies whether the comment has been published.

text—Text of the case comment.

ChatterLikes Capability
If a feed element has this capability, the context user can like it. Exposes information about existing likes.

This response body has these new properties:
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® isLikedByCurrentUser—Indicates whether the feed elementis liked by the current user (true) ornot (false).
e page—TLikesinformation for this feed element.

* likesMessage—A message body that describes who likes the feed element.

* myLike—Ifthe context user has liked the feed element, this property is a reference to the specific like, nul1 otherwise.

Comment
This response body has these new properties:

® capabilities—A Comment Capabilities response body representing the capabilities associated with the comment. Use
this property instead of the attachment property, which is no longer supported.

e feedElement—A Reference response body representing the feed element on which the comment is posted. Use this property
instead of the feedTtem property, which is no longer supported.

Comment Page
This response body has one new property, items, which is a collection of Comment response bodies. Use this property instead of
comments, which is no longer supported as of version 32.0.

Comment Capabilities
A container for all capabilities that can be included with a comment.

This new response body has one property, content, which is a Content Capability response body containing a file attached to a
comment.

Comments Capability
If a feed element has this capability, the context user can add a comment to it.

This new respose body has one new property: page, which is a Comment Page response body containing information about the
comments on this feed element.

Content Capability
If a feed element has this capability, it has a file attachment.

This new response body has these properties:

e checksum—MD5 checksum for the file.

® contentHubRepository—The external data source associated with this file, or nul1 if it doesn't point to an external
file.

e contentUrl—URL of the content for links and Google docs.
® description—Description of the attachment.
® downloadUrl—URL to the content. This property can include a bearer token URL.

® externalDocumentUrl—Theexternal URL thisfile points to,or nul1l ifit does not point to an external file. This property
can include a bearer token URL.

e fileExtension—Extension of the file.

e filesize—Size of thefile in bytes. If size cannot be determined, returns Unknown.
e fileType—Type offile.

® hasPdfPreview—true if the file has a PDF preview available, false otherwise.
e id—18-character ID of the content.

® isInMyFileSync—true ifthefileisincluded in the user's Salesforce Files Sync folder, and is synced between that folder
and Chatter; false otherwise.

e mimeType—MIME type of the file.

® renditionUrl—URLtotherendition resource for the file. Renditions are processed asynchronously and may not be available
immediately after the file has been uploaded. This property can include a bearer token URL.
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® renditionUr1240By180—URLtothe 240x180 size rendition resource for thefile. Renditions are processed asynchronously
and may not be available immediately after the file has been uploaded.

®* renditionUrl720By480—URLtothe 720x480 size rendition resource for the file. Renditions are processed asynchronously
and may not be available immediately after the file has been uploaded.

®* repositoryFileUrl—The URL of the Chatter REST APl resource giving access to the external repository file properties,
or null if this file doesn't point to an external file. This property can include a bearer token URL.

® textPreview—Text preview of the file if available, null otherwise. The maximum number of characters is 200.

® thumbl20By90RenditionStatus—The status of the rendering of the 120x90 pixel sized preview image of the file.
Should be either Processing, Failed, Success, or Na if unavailable.

® thumb240Byl80RenditionStatus—The status of the rendering of the 240x180 pixel sized preview image of the file.
Should be either Processing, Failed, Success, or Na if unavailable.

® thumb720By480RenditionStatus—The status of the rendering of the 720x480 pixel sized preview image of the file.
Should be either Processing, Failed, Success, or Na if unavailable.

e title—Title of thefile.

e versionId—Version ID of the file.

Dashboard Component Snapshot Capability
If afeed element has this capability, it has a dashboard component snapshot. A snapshot is a static image of a dashboard component
at a specific point in time.
This new response body has one new property: dashboardComponentSnapshot,whichisaDashboard Component Snapshot
response body.

Email Message Capability
If a feed element has this capability, it has an email message from a case.

This new response body has these properties:

e direction—The direction of the email message. Values are:
* emailMessageId—ThelD of the email message.

® subject—The subject of the email message.

® textBody—The body of the email message.

® toAddresses—The To address of the email message.

Enhanced Link Capability
If a feed element has this capability, it has a link that may contain supplemental information like an icon, a title, and a description.

This new response body has these properties:

e description—A description with a 500 character limit.

® icon—Aicon.

e linkRecordId—A ID associated with the linkif the link URL refers to a Salesforce record.
e 1inkUrl—Alink URL to a detail page if available content can't display inline.

e title—Atitletoadetail page.

Feed Element Capabilities
This response body has these new properties:

* approval—Ifafeed element has this capability, it includes information about an approval.
e canvas—Ifafeed element has this capability, it renders a canvas app.

* caseComment—If afeed element has this capability, it has a case comment on the case feed.
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* content—Ifafeed element has this capability, it has a file attachment.

¢ dashboardComponentSnapshot—Represents both dashboard component snapshots and alerts you receive when a
dashboard component value crosses a threshold.

* emailMessage—Ifafeed element has this capability, it has an email message from a case.

® enhancedLink—Ifafeed element has this capability, it has a link that may contain supplemental information like an icon,
atitle, and a description.

e 1inklfafeed element has this capability, it has a link.
* recommendations—Ifafeed element has this capability, it has a recommendation.

®* recordSnapshot—Ifafeed element has this capability, it contains all the snapshotted fields of a record for a single create
record event.

e trackedChanges—Ifafeedelementhas this capability, it contains all changes to a record for a single tracked change event.

Feed Item
These properties aren't available in version 32.0 and later. Their functionality has been moved to capabilities.

® attachment
® comments
® isBookmarkedByCurrentUser
® islLikedByCurrentUser
e likes
® likesMessage
°* myLike
® topics
Feed Item Attachment: Approval
This response body isn't available in version 32.0 and later. In version 32.0 and later, the Approval Capability response body is used.

Feed Item Attachment: Basic Template
This response body isn't available in version 32.0 and later. In version 32.0 and later, the Enhanced Link Capability response body is
used.

Feed Item Attachment: Canvas
This response body isn't available in version 32.0 and later. In version 32.0 and later, the Canvas Capability response body is used.

Feed Item Attachment: Case Comment
This response body isn't available in version 32.0 and later. In version 32.0 and later, the Case Comment Capability response body is
used.

Feed Item Attachment: Content
This response body isn't available in version 32.0 and later. In version 32.0 and later, the Content Capability response body is used.

Feed Item Attachment: Dashboard
This response body isn't available in version 32.0 and later. In version 32.0 and later, the Dashboard Component Snapshot Capability
response body is used.

Feed Item Attachment: Email Message
This response body isn't available in version 32.0 and later. In version 32.0 and later, the Email Message Capability response body is
used.

Feed Item Attachment Link
This response body isn't available in version 32.0 and later. In version 32.0 and later, the Link Capability response body is used.
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Feed Item Attachment: Poll
This response body isn't available in version 32.0 and later. In version 32.0 and later, the Poll Capability response body is used.

Feed Item Attachment: Record Snapshot

This response body isn't available in version 32.0 and later. In version 32.0 and later, the Record Snapshot Capability response body
is used.

Feed Item Attachment: Tracked Change

This response body isn't available in version 32.0 and later. In version 32.0 and later, the Tracked Changes Capability response body
is used.

Feed Item Topics
This response body isn't available in version 32.0 and later. In version 32.0 and later, the Topics Capability response body is used.

Generic Bundle Capability
If a feed element has this capability, the feed element has a group of other feed elements condensed into one feed element. This
group is called a bundle.

The feedElements property name has changed to page.

Like Page
This response body has one new property, i tems, whichis a collection of Like response bodies. Use this property instead of 1ikes,
which is no longer supported as of version 32.0.

Link Capability
If a feed element has this capability, it has a link.
This new response body has these properties:
e url—Link URL. The URL can be to an external site.
® urlName—Description of the link.

Poll Capability
If a feed element has this capability, it includes a poll.

This response body has these new properties:
e choices—~Collection of poll choices that make up the poll.

® myChoiceId—18-characterID of the poll choice that the current user has voted for in this poll. Returns nu11 if the current
user has not voted.

® totalVoteCount—Total number of votes cast on the feed poll element.

Question and Answers Capability
If a feed element has this capability, it has a question and comments on the feed element are answers to the question.

This response body has these new properties:
®* bestAnswer—Ihe comment selected as the best answer for the question.
* DbestAnswerSelectedBy—The user who selected the best answer for the question.

e canCurrentUserSelectOrRemoveBestAnswer—Indicates whether current user can select or remove a best answer
(true)ornot(false).

® questionTitle—Title forthe question.

Recommendation Capability
If a feed element has this capability, it has a recommendation.

This new response body has one property, i tems, which is a list of Non-Entiy Recommendation and Recommendation response
bodies.
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Record Snapshot Capability
If a feed element has this capability, it contains all the snapshotted fields of a record for a single create record event.

This new response body has one property, recordview, which is a Record View response body.

Topics Capability
If a feed element has this capability, the context user can add topics to it. Topics help users organize and discover conversations.

This response body has these new properties:
® canAssignTopics— true ifatopic can be assigned to the feed element, false otherwise.
* items—A collection of topics associated with this feed element.

Tracked Change Bundle Capability
If a feed element has this capability, it has a group of other feed elements aggregated into one feed element called a bundle. This
type of bundle aggregates feed tracked changes.

The feedElements property name has changed to page.

Tracked Changes Capability
If a feed element has this capability, it contains all changes to a record for a single tracked change event.

ThefeedElements property name has changed to page.

This table describes how to migrate to APl version 32.0.

API versions 31.0 and earlier use... API version 32.0 uses...

Comment attachment property Comment capabilities property, which holds a Comment
Capabilities response body that holds all the capabilities associated
with a comment.

Comment feedItem property Comment feedElement property
Comment Page comments property Comment Page items property
Feedltem attachment property Feed Item property, capabilities, whichisa Feed Element

Capabilities response body containing all the capabilities associated
with the feed element.

Feed ltem comments property Feed Item property, capabilities.comments.page

Feed ltem isBookmarkedByCurrentUser property Feed Item property,
capabilities.bookmarks.isBookmarkedByCurrentUser

Feed ltem isLikedByCurrentUser property Feed Item property,
capabilities.chatterLikes.isLikedByCurrentUser

Feedltem 1ikes property Feed ltem property, capabilities.chatterLikes.page

Feed ltem 1ikesMessage property Feed Item property,
capabilities.chatterLikes.likesMessage

Feed Item moderationFlags property Feed Item property,
capabilities.moderation.moderationFlags

Feed ltem myLike property Feed Item property,
capabilities.chatterLikes.myLike

321



Force.com Development Chatter REST AP

API versions 31.0 and earlier use... APl version 32.0 uses...
Feed Item topics property Feed Item property, capabilities.topics.items
Feed Item Attachment: Approval Approval Capability
NA Associated Actions Capability
NA Banner Capability
NA Bundle Capability
Feed Item Attachment: Basic Template Enhanced Link Capability
Feed Item Attachment: Canvas Canvas Capability
Feed Item Attachment: Case Comment Case Comment Capability
Feed Item Attachment: Content Content Capability
Feed Item Attachment: Dashboard Dashboard Component Snapshot Capability
Feed Item Attachment: Email Message Email Message Capability
Feed Item Attachment Link Link Capability
Feed Item Attachment: Poll Poll Capability
NA Recommendation Capability
Feed Item Attachment: Record Snapshot Record Snapshot Capability
Feed Item Attachment: Tracked Change Tracked Changes Capability
Feed Item Topics Topics Capability
Communities
Article Item

This response body is an article in question and answer search results. It has these properties:

id—ID of the article.

® rating—Rating of the article.

e title—Title of the article.

e urlLink—TLink URL of the article.

e viewCount—Number of votes given to the article.

Community
The Community response body has one new property, nicknameDisplayEnabled, that specifies whether nicknames are
displayed in the community.

Features
The Features response body has these new properties:

° communityReputation—Specifies whether reputation is enabled for communities in the organization.

* managedTopicsEnabled—Indicates access to the community home feed and the managed topic feed.
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Managed Topic
Represents a managed topic in a community.

This new response body has these properties:
e id—ID of managed topic.
®* managedTopicType—IType of managed topic.
- Featured—Topics that are featured, for example, on the community home page, but don't provide overall navigation.

- Navigational—Topics that display in a navigational menu in the community.

® topic—Information about the topic.
e url—~Chatter REST APl URL to the managed topic.

Managed Topic Collection
A collection of managed topics in a community.

This new response body has these properties:
e currentPageUrl—~Chatter REST API URL identifying the current page.
* managedTopics—~Collection of managed topics.

Message
The Message response body has one new property, sendingCommuni ty, that provides information about the community from
which the message was sent.

Question and Answers Suggestion Collection
This new response body is a question and answers search result and has these properties:

e articles—~Collection of articles.
e questions—~Collection of questions.

Reputation
Reputation for a user.

This new response body has these properties:

® reputationLevel—User'sreputation level.

® reputationPoints—User's reputation points, which can be earned by performing different activities in the community.
e url—A Chatter REST API' URL to the reputation.

Reputation Level
Reputation level for a user.

This new response body has these properties:
® levelImageUrl—URL tothe reputation level image.
e levelName—Name of the reputation level.

® levelNumber—Reputation level number, which is the numerical rank of the level, with the lowest level at 1. Administrators
define the reputation level point ranges.

Topic
This response body has one new property, images, which represents images associated with the topic.

Topic Images
This new response body has these properties:

e coverImageUrl—URL toatopic's coverimage, which appears on the topic page. Both topics and managed topics can
have cover images.
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e featuredImageUrl—URLtoamanaged topic's featured image, which appears wherever you feature it, for example, on
the communities home page.

User Summary
The User Summary response body has these new properties:

® communityNickname—User's nickname in the community.

e displayName—User's name thatis displayed in the community. If nicknames are enabled, the nickname is displayed. If
nicknames aren't enabled, the full name is displayed.

* reputation—~Reputation of the user.

User Detail
The User Detail response body has these new properties:

® communityNickname—User's nickname in the community.

e displayName—User's name thatis displayed in the community. If nicknames are enabled, the nickname is displayed. If
nicknames aren't enabled, the full name is displayed.

® reputation—~Reputation of the user.

Dashboard Component Snapshot

Dashboard Component Snapshot
Represents both dashboard component snapshots and alerts you receive when a dashboard component value crosses a threshold.

This new response body has these properties:
® componentId—18-character ID of the dashboard component.
e componentName—The dashboard component name.

* dashboardBodyText—Display this text next to the actor in the feed element.Use this text in place of the default body
text.

® dashboardId—18-character ID of the dashboard.

® dashboardName—The name of the dashboard.

e fullSizeImageUrl—The source URL to retrieve the full-size image of a snapshot. Access this URL with OAuth credentials.
* lastRefreshDate—I50-8601 formatted date specifying when this dashboard component was last refreshed.

® lastRefreshDateDisplayText—Display text for the last refresh date, for example, “Last Refreshed on October 31,
2013

® runningUser—The running user of the dashboard at the time the snapshot was posted. This value may be nul1. Each
dashboard has a running user, whose security settings determine which data to display in a dashboard.

e thumbnailUrl—The source URL to retrieve the thumbnail image of a snapshot. Access this URL with OAuth credentials.

Data.com

Datacloud Company
Represents company information for a single companyId.

® activeContacts—The number of active contacts that the company has.

® address—The address of the company.

® annualRevenue—The amount of money that the company makes in one year.
e companyId—The unique numerical identifier for the company.

® description—The description of the company.
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dunsNumber—A randomly generated nine-digit number that's assigned by Dun & Bradstreet (D&B) to identify unique business
establishments.

industry—A description for the area of focus in which the company does business.

isInactive—A true orfalse response. True means that the record is no longer active. False indicates that the contact is still
valid and active.

isOwned—Whether the company has been purchased by you or your organization (t rue) or not (false).

naicsCode—North American Industry Classification System (NAICS) codes were created to provide details about a business’s
service orientation. The code descriptions are focused on what a business does.

naicsDescription—A description of the NAICS classification.

name—The company’s name.

numberOfEmployees—The number of employees who are working for the company.
ownership—The type of ownership of the company can be private, public, government, or other.
phoneNumbers—A numerical string that contains a corporate telephone number for the company.
sic—Standard Industrial Codes (SIC) is a numbering convention that indicates what type of service a business provides.
sicDescription—A description of the SIC classification.

site—The type of location of the company, such as “Headquarters.”

tickersSymbol—The symbol that uniquely identifies companies that are traded on public stock exchanges.
tradestyle—A legal name under which a company conducts business.

updatedDate—The date when the information was last updated for this company.

website—The URL to the company’s website.

yearStarted—The standard URL for the company’s home page.

Datacloud Company Collection
Purchase information for all companies purchased for a specific order.

companies—A list of all companies for a specific order.

currentPageUrl—The URL to the current page of companies.

nextPageUrl—The URL to the next page of companies. If there isn't a next page, value is nul1l.
previousPageUrl—The URL to the previous page of companies. The value is nul11 if there isn't a previous page.

total—Number of companies in the order. Users can set how many companies are displayed on a page. The default page
size is 25.

Datacloud Contact
Represents contact information for a single contactId.

address—A postal address for the company where this contacts works.
companyId—The unique numerical identifier for the company at which the contact works.
companyName—The name of the company at which the contact works.
contactId—The unique numerical identifier for a contact.

department—The name of the department to which the contact is assigned.
emai1—An email address for this contact.

firstName—The first name of a contact.

isInactive—A true or false response. True means that the record is no longer active. False means that the contact
is still valid and active.

i sOwned—>Specifies whether your organization owns this contact.
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® lastName—The last name of a contact.
e level—Ahuman resource label designating a person’s level in the company.
® phoneNumbers—A numerical string that contains the direct-dial phone number for the contact.
e title—Thejobtitle fora contact.
e updatedDate—The date when the information for this contacts was updated.
Datacloud Contact Collection
e contacts—A list of all the contacts for a specificorder1d.
e currentPageUrl—The current page of contacts.
* nextPageUrl—The URL to the next page of contacts. If there’s only one page of contacts, the value is null.
® previousPageUrl—The URL to the previous page of contacts. The value is null when there’s only one page of contacts.

e total—Numberof contacts that are associated with this order. The total number of contacts can be greater than the number
of contacts that are displayed on a single page.

Datacloud Order
Information about the Data.com records that you purchased and details of the purchase.

°* entityUrl—A URLtoalist of purchased records for a specific order.
e id—The orderId thatidentifies a specific order.
® purchaseCount—The number of records that were purchased for this order.
e purchaseDate—The date when records were purchased.
e url—A URL for the order information for a specific order.
Datacloud Purchase Usage
® listpoolCreditsAvailable—oListpool creditsthat are available for all users in the Listpool group.
® listpoolCreditsUsed—Listpool credits that were used by all the users in the Listpool group.
* monthlyCreditsAvailable—Monthly credits that are assigned to a specific user.

* monthlyCreditsUsed—Monthly credits that were used by a specific user.

Feed Elements and Bundles
See Feed Elements on page 300 for general information about how feed elements and feed items have changed in API version 32.0.

Bundle
This response body has been replaced by the Generic Feed Element response body holding the Bundle Capability response class.

@ Note: Bundled posts are available through a pilot program. For information, contact Salesforce. During the pilot, bundles
contain only feed-tracked changes.

Feed
The feedItemsUrl property is no longer available. Use the feedElementsUrl property.

Feed Directory Item
The feedItemsUrl property is no longer available. Use the feedElementsUrl property.

Feed Item Page
This response body isn't available in version 32.0 and later. In version 32.0 and later, the Feed Element Page response body is used.

Generic Feed Element
A generic feed element.

This new response body has these properties:
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body—Information about the feed element.
capabilities—A container for all capabilities that can be included with a feed element.
createdDate—An ISO 8601 format date string, for example, 2011-02-25T18:24:31.000Z.

feedElementType—~Feed elements are the top-level objects that a feed contains. The feed element type describes the
characteristics of that feed element.

- Bundle—A container of feed elements. A bundle also has a body made up of message segments that can always be
gracefully degraded to text-only values.

- FeedItem—A feed item has a single parent and is scoped to one community or across all communities. A feed item can
have capabilities such as boomarks, canvas, content, comment, link, poll, and so on. Feed items have a body made up of
message segments that can always be gracefully degraded to text-only values.

- Recommendation—A recommendation is a feed element with a recommendations capability. A recommedation
suggests records to follow, groups to join, or applications that may be helpful to the context user.

header—The header is the title of the post. This property contains renderable plain text for all the segments of the message.

If a client doesn't know how to render a feed element type, it should render this text.

id—The ID for a feed element.

modi fiedDate—An ISO 8601 format date string, for example, 2011-02-25T18:24:31.000Z.

parent—The parent of the feed element.

relativeCreatedDate—The created date formatted as arelative, localized string, for example, “17m ago” or “Yesterday.”

url—~Chatter REST API URL to this feed element.

This table describes how to migrate to APl version 32.0.

API versions 31.0 and earlier use... API version 32.0 uses...

Feed Item Page Feed Element Page

Feed feedItemsUrl property Feed feedElementsUrl property

Feed Directory feedItemsUrl property Feed Directory feedElementsUrl property
Files

User Settings
The User Settings response body has these new properties:

fileSyncLimit—Maximum number of files user can sync.

folderSyncLimit—Maximum number of folders user can sync.

Files Connect

File Detail
This response body has these new properties:

contentHubRepository—The external data source associated with this file, or nul1 if it doesn’t point to an external
file.

contentModi fiedDate—AnISO 8601 format date string, for example, 2011-02-25T18:24:31.000Z. File-specific modified
date, which is updated only for direct file operations, such as rename. Modifications to the file from outside of Salesforce can
update this date.
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externalDocumentUrl—The external URL this file points to, or nul1 if it doesn’t point to an external file.

repositoryFileUrl—The URL of the Chatter REST API resource giving access to the external repository file properties,
or null if this file doesn’t point to an external file. This property can include a bearer token URL.

File Summary
This response body has these new properties:

contentHubRepository—The external data source associated with this file, or nul1l if it doesn't point to an external
file.

contentModi fiedDate—AnISO 8601 format date string, for example, 2011-02-25T18:24:31.000Z. File-specific modified
date, which is updated only for direct file operations, such as rename. Modifications to the file from outside of Salesforce can
update this date.

externalDocumentUrl—The external URL this file points to, or nul1 if it doesn't point to an external file. This property
can include a bearer token URL.

repositoryFileUrl—The URL of the Chatter REST APl resource giving access to the external repository file properties,
or nul1l if this file doesn’t point to an external file. This property can include a bearer token URL.

Files Connect Provider Type
Information about the files connect provider.

This new response body has these properties:

label—The localized label of the provider type.
type—The provider type.

Files Connect Repository
Information about a files connect repository.

This new response body has these properties:

features—The repository features.
id—18-character ID of the external data source
label—The repository label.

mot i f—The motif properties contain URLs for small, medium, and large icons that indicate the Salesforce record type. Common
record types are files, users, and groups, but all record types have a set of motif icons. Custom object records use their tab style
icon. All icons are available to unauthenticated users so that, for example, you can display the motif icons in an email. The motif
can also contain the record type’s base color.

mySubscription—If the context user is following this record, this contains information about the subscription; otherwise
returns null.

name— Ihe repository name.
providerType—The repository provider type.

recordViewUr1l—The URL of the Chatter REST API record view resource for this record, or nul1l if this record does not
have a record view layout, or if “Connect Records API" is not enabled for this organization, or if the record type isn't supported.

rootFolderItemsUr1—URL to the repository root folder items, or null if the repository does not support browsing.
type—Type of record, ContentHubRepository.
ur1—Chatter REST API resource URL for the files connect repository

Files Connect Repository Collection
A collection of files connect repositories.

This new response body has these properties:

currentPageUrl—Chatter REST APl URL identifying the current page.
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nextPageUr1—~Chatter REST API URL identifying the next page or nul1 if there isn't a next page.

Chatter REST API

previousPageUrl—~Chatter REST API URL identifying the previous page or null if thereisn't a previous page.

repositories—~Collection of repositories.

Files Connect Repository Features
Information about the features of a files connect repository.

This new response body has these properties:

canBrowse—Specifies whether the repository's folder hierarchy can be browsed (t rue) or not (false).

canSearch—Specifies whether the repository can be searched (t rue) or not (false).

Repository File Detail
Detailed description of a repository file.

This new response body has these properties:

checkinComment—The checkin comment of the file.
contentSize—Length in bytes of the content of the file.
createdBy—Name of user who created the file.
createdDate—Created date of the file.

description—rFile description.

downloadUr1—URL to the repository file content. This property can include a bearer token URL.

externalContentUr1—URL of this file’s content in the external system.
externalDocumentUr1—URL of this file in the external system.
id—ID of the file.

mimeType—Mime type of the file.

modi fiedBy—Name of user who last modified the file.

modi f iedDate—Modified date of the file.

mot i f—Motif of the file.

name—Name of the file.

repository—The file external repository.

title—Title of thefile.

type—Record type, file.

url—~Chatter REST API URL for this file.

versionId—ID of the file version in the external system.

Repository File Summary
Description of a repository file.

This new response body has these properties:

checkinComment—The checkin comment of the file.
contentSize—Lengthin bytes of the content of the file.
createdBy—Name of user who created the file.
createdDate—Created date of the file.

description—rFile description.

downloadUr1—URL to the repository file content. This property can include a bearer token URL.

externalContentUr1—URL of this file’s content in the external system.
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externalDocumentUr1—URL of this file in the external system.

id—ID of the file.

mimeType—Mime type of the file.

modi fiedBy—Name of user who last modified the file.
modi f iedDate—Modified date of the file.

mot i f—Motif of the file.

name—Name of the file.

repository—The file external repository.
title—Title of thefile.

type—~Record type, file.

url—~Chatter REST API URL for this file.

versionId—ID of the file version in the external system.

Repository Folder Item
Description of a folder item.

This new response body has these properties:

file—Ifthis folder item represents a file, the file summary. If this folder item represents a folder, nul1l.

folder—Ifthis folder item represents a folder, the folder summary. If this folder item represents a file, nul1.

type—The type of folder item: folder or file.

Repository Folder Items Collection
A collection of repository folder items.

This new response body has these properties:

currentPageUr1—Chatter REST API URL identifying the current page.

items—Collection of items in a repository folder.

nextPageUr1l—~Chatter REST API URL identifying the next page or nul1 if there isn't a next page.

Chatter REST API

previousPageUrl—~Chatter REST APl URL identifying the previous page or nul1l if there isn't a previous page.

Repository Folder Summary
Description of a repository folder.

This new response body has these properties:

createdBy—Name of user who created the folder.
createdDate—Created date of the folder.

description—~Folder description.

externalFolderUr1—Chatter REST API URL for this folder in the external system.
folderItemsUrl—-Chatter REST API URL that lists the files and folders in this folder.

1d—ID of the folder.

modi f iedBy—Name of user who last modified the folder.
modi f iedDate—Modified date of the folder.

mot i £—Motif of the folder.

name—Name of the folder.

path—The absolute path of the folder in the external system.

repository—The folder external repository.
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* type—~Recordtype, folder.

e url—Chatter REST API URL for this folder.

Recommendations

Non-Entity Recommendation

Represents a recommendation for a non-Salesforce entity, such as an application.

This new response body has these properties:

e displayLabel—Localized label of the non-entity object.

® explanation—An explanation for the recommendation.

* motif—NMotif for the non-entity object.

* recommendationType—Specifies the type of record being recommended.

Recommendation

This response body has these new properties:

® entity—The entity with which the receiver is recommended to take action.

Tooling API

The object property is no longer supported in version 32.0. The ent ity property provides this information in versions 32.0

and later.

* recommendationType—>Specifies the type of record being recommended.

User Profile Tab
User Profile Tab

The tabType property can have a new Element value which indicates a tab that displays generic content inline.

Tooling API

Use the Tooling API to build custom development tools for Salesforce applications. Support for many new features has been added,
including compact layouts, quick actions, workflows, and email templates.

New objects in Tooling API version 32.0 includes the following new objects:

Object
Compactlayout
EmailTemplate
EntityDefinition
FieldDefinition
Layout
Menultem
Name

Profile

ProfileLayout

Description
Represents a compact layout.

Represents an email template.

Represents an entity definition.

Represents a field definition.
Represents a layout.
Represents a menu item.
Represents a name.
Represents a user profile.

Represents a profile layout.
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Obiject Description

QuickActionDefinition Represents the definition of a quick action.

QuickActionList Represents a list of quick actions.

QuickActionListltem Represents an item in a quick action list.

RecordType Represents a record.

User Represents a user.

WorkflowAlert Represents the metadata associated with a workflow alert.
WorkflowFieldUpdate Represents the metadata associated with an update to a workflow field.
WorkflowOutboundMessageMember Represents the metadata associated with an outbound workflow message, for

deploying with a metadata container.

WorkflowTask Represents the metadata associated with a workflow task.

Changes in Tooling APl version 32.0 include the following new fields:

Object Fields

CustomField ® CreatedDate—The date the field was created.

® EntityDefinition—The metadata defining the custom field.

® EntityDefinitionId—ThelD forthe field's definition object.

CustomObject ® CreatedDate—The date the custom object was created.

FlexiPage ® CreatedDate—The date the page was created.

e Type—The Flexible Page type. In APl version 32.0, this field can only have a value of AppPage.

ValidationRule e CreatedDate—The date the rule was created.

WorkflowRule e CreatedDate—The date the rule was created.

For details, see the Force.com Tooling API Developer's Guide.

Metadata API

Use the Metadata APl to manage customization information, such as custom object definitions and page layouts, for your organization.
Metadata support has been added or enhanced for many features, including Territory Management 2.0, managed topics, flows, and
tasks.
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IN THIS SECTION:

Metadata Types and Fields
Metadata types and fields have been added or modified in version 32.0.

Metadata Types and Fields

Metadata types and fields have been added or modified in version 32.0.

New Metadata Types

AuraDefinitionBundle
Represents a Lightning definition bundle. A bundle contains a Lightning definition and all its related resources. The definition can
be a component, application, event, or interface. Lightning components is a beta feature.

CorsWhitelistOrigin
Represents an origin in the CORS (cross-origin resource sharing) whitelist. CORS is a W3C recommendation that enables Web browsers
to request resources from origins other than their own. For example, using CORS, a JavaScript script at
https://www.example.com could request a resource from https://www.salesforce.com.

ManagedTopics
Represents navigational and featured topics managed in a community.

SynonymDictionary
Manage synonym groups. Optimize search results for acronyms, variations of product names, and other terminology unique to your
organization.

Territory2
Represents the metadata associated with a sales territory in Territory Management 2.0.

Territory2Model
Represents the metadata associated with a territory model in Territory Management 2.0.

Territory2Rule
Represents the metadata associated with a territory assignment rule associated with an object, such as Account, in Territory
Management 2.0.

Territory2Settings
Represents the metadata for the default settings for Territory Management 2.0 users to access and modify records associated with
sales territories. The standard record access settings apply to accounts and opportunities. If your organization uses Private default
internal access for contacts or cases, you can also set access for those records.

Territory2Type
Represents the metadata for a category of territories in Territory Management 2.0. Every Territory2 must have a Territory2Type.

XOrgHub
Represents the metadata that’s associated with a hub organization in a cross-organization data connection.

XOrgHubSharedObject
Represents the metadata that's associated with a shared object in a cross-organization data connection.

Updated Metadata Types and Fields
These metadata fields have been added or changed in API version 32.0.

ActivitiesSettings
The following fields have been added:
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enableSimpleTaskCreateUI
Allows administrators to specify whether tapping New Task in Salesforce1 opens a regular task record edit page or a page that
displays key task fields first. For details, see It's Easier to Create a Task on page 77.

enableUNSTaskDelegatedToNotifications
On the Activity settings page, exposes a setting for administrators to hide or show a user setting that lets individual users enable
or disable email notifications when tasks are assigned to them. For details, see Let Your Users Control Task Notifications Globally
on page 138.

AssignmentRules
The following field has been added to the RuleEntry type:

notifyCcRecipents
Specifies whether email addresses included on the Cc line of an incoming Email-to-Case or Web-to-Lead message should be
included on the Cc line of the auto-response to that message (true) ornot (false).

AuthProvider
The following field has been added:

iconURL
The path to an icon to use as a button on the login page for a community. Users click the button to log in to a community with
the associated authentication provider, such as Twitter® or LinkedIn®.

The following supported values for the providerType field have been added:

LinkedIn
For information, see Configure a LinkedIn Authentication Provider.

Twitter
For more information, see Configure a Twitter Authentication Provider.

CaseSettings
The following field has been added:

caseFeedItemSettings
Specifies the settings for feed items in feed-based case page layouts.

ConnectedApp
The following field has been added to the ConnectedAppOauthConfig subtype.

consumerSecret
A value that is combined with the consumerKey and used by the consumer for identification to Salesforce. Referred to as
client secret inOAuth 2.0.Typically, this value is generated by Salesforce when you create the connected app. However,
the field is write-enabled so you can customize the shared secret value. Once set, the value is not returned in metadata API
requests.

The value must be alphanumeric (no special characters and no spaces) and a minimum of eight characters (maximum of 256
characters). If you specify a secret already in use for another connected app in the organization, you'll get an error.

The following field has been updated in the ConnectedAppOauthConfig subtype.

consumerKey
This field is now write-enabled so you can customize the value when you create the OAuth configuration. Once set, the value
cannot be edited. The value must be alphanumeric (no special characters and no spaces) and a minimum of eight characters
(maximum of 256 characters). If you specify a key already in use for another connected app in the organization, you'll get an
error.

The following field has been updated in the ConnectedAppCanvasConfig subtype.
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options
This field now accepts an additional value: PersonalEnabled, which indicates whether the canvas app can be designated
by the developer as a canvas personal app (installable by end users). This is a new value for the CanvasOptions enumeration.

CustomField
The following fields have been added:

externalDeveloperName
Available only for external objects. Name of the table column on the external data source that maps to this custom field in
Salesforce.

isFilteringDisabled
Available only for external objects. Indicates whether the custom field is available in filters.

isNameField
Available only for external object fields of type text. For each external object, you can specify one field as the name field.

isSortingDisabled
Available only for external objects. Indicates whether the custom field is sortable.

referenceTargetField
Available only for indirect lookup relationship fields on external objects. Specifies the custom unique, external ID field on the
parent object to match against the child’s indirect lookup relationship field, whose values come from an external data source.

CustomObject
The following fields have been added:

externalDataSource
Required and available for external objects only. The name of the external data source that stores the data for the external object.

externalName
Required and available for external objects only. The name of the table in the external data source that contains the data for the
external object.

CustomPermission
The following field has been added:

requiredPermission
Indicates which custom permissions are required by the parent custom permission.

CustomSite
The following field has been added:
requireHttps
Determines whether the site requires secure connections (true) or not (false). When false, the site operates normally via insecure
connections instead of redirecting to a secure connection.

CustomTab
The following field has been added:

auraComponent
Indicates whether this tab is for a Lightning component (t rue) or not (false). If set to true, the name of the tab matches
the name of the Lightning component. This field is part of the Lightning Components (Beta) feature.

ExternalDataSource
The following field has been added:

authProvider
The authentication provider that is represented by the AuthProvider component.

The following fields have been changed:
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apiKey
This field is now reserved for future use. It was previously used by a beta feature that is no longer available.

type
The field type changed from string to enumeration of type string.

FlexiPage
The following field has been added:

type
Required. The type of a page. In APl version 32.0, this field can only have a value of AppPage.

Flow
The following field has been added to the Flow type.

waits
An array of wait nodes. Wait nodes allow you to configure the flow to wait for one or more events to occur.

The following base type has been added.

FlowBaseElement
Base class for all flow elements that require contextual information in metadata values. This is an abstract class. Some flow

metadata types now inherit from FlowBaseElement, including all input and output parameter types.
The following field has been changed on the FlowVariable subtype.

isCollection
This field can now be set to true for variables of any data type.

Layout
The following values are now supported for the component Type field on the SidebarComponent subtype:

Files and CaseExperts.

@ Note: Case Experts is currently available through a pilot program.

The following field has been added to the FeedlLayout subtype.

compactFeed
Specifies whether the feed-based page layout uses a compact feed (true) or not (false).If setto true, feed items on the

page are collapsed by default, and the feed view has an updated design.
The following field has been added to the Container subtype:

isContainerAutoSizeEnabled
Determines if stacked console components in the sidebars autosize vertically. Set to t rue by default for newly created console

components.

Network
The following field has been added to the Network type:

enableNicknameDisplay
Determines if user nicknames display instead of their first and last names in most places in the community. Setto false by

default.

The following field has been added to the ReputationLevel subtype:

branding
Represents branding associated with the reputation level, specifically, the custom image for the reputation level. If not specified,

the default reputation level image is used.

These metadata field types have been changed in APl version 32.0.
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Gender Field Type
The gender field type allows a new value, AnimateMasculine, for use in Slavic languages—currently Czech, Polish, Russian,
Slovak, Slovenian, and Ukrainian. Additionally, the documentation was corrected to note that the values Euter and Common are
displayed in the user interface but aren't valid in the Metadata API.

Data.com API

Search and purchase Data.com records using the Data.com API. Access the most up-to-date Data.com records to make sure your data
is clean and accurate.

New Data.com APlIs

The following are new Data.com APIs that are documented in the Data.com Developer’s Guide.
Data.com Social Match API

Match contacts with social handles such as LinkedIn and Twitter. The Data.com Social Profile Match API uses a unified match AP
call pattern. Match options can now be specified in the POST body instead of the URL. Key Data.com fields that are more up-to-date
are flagged.

Matchable fields:

® CompanyName

® ContactId

® FEmail

® FirstName

¢ LastName

® SocialHandles
Data.com DUNSRight Match API

Match account records with Data Universal Numbering System (DUNS) numbers and other matchable fields. Match your account
records with Data.com company records by DUNS number and other key fields. Key Data.com fields that are more up-to-date are
flagged.

Matchable fields:
® City
® Country

® DunsNumber

® Name

® Phone
® State
® Street

® TickerSymbol
* Zip
Data.com Purchase API

A Connect-based purchase API. Purchase Data.com contacts and companies, and retrieve purchase information. This APl is a
lightweight solution for purchasing Data.com contacts and companies.
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New Obijects

DcSocialProfile
Represents social-handle profiles for Data.com contacts. The DcSocialProfile objectis a read-only object that's accessible
only through the Data.com Social Match API.

DcSocialProfileHandle
Represents social-handle profile details for Data.com contacts. The DcSocialProfileHandle object, a child object to
DcSocialProfile,isaread-only object that's accessible only through the Data.com Social Match API.

Changed Obijects

DandBCompany
This object was previously read-only. It is now CRUD-enabled.

@ Nofte: If Data.com automated Clean is activated in your organization, D&B company records might be overwritten during
update and manual changes.

DatacloudContact
The firstName and lastName fields were hidden in the previous version. Both fields are now visible for all contact records.

DatacloudDandBCompany

The ParentOrHgDunsNumber isnow search-enabled. Search on the ParentOrHgDunsNumber field to see corporate
hierarchies in the response.

The IsParent field was added.

Publisher.js API

Three events in the publisher.js APl now support the Post and Social Post actions, so you can create custom console components that
interact with these actions.

For more information on working with publisher js, see “Creating Custom Console Components That Interact with Case Feed” in
Customizing Case Feed with Code.

The following events have changed in API version 32.0.

publisher.selectAction
Supported values now include FeedItem. TextPost,the standard Chatter Post action, and
SocialPostAPIName.SocialPost,the Social Post action.

publisher.setActionInputValues
targetFields are now available on FeedItem.TextPost and SocialPostAPIName.SocialPost.

invokeAction
Supported values now include FeedItem. TextPost, the standard Chatter Post action, and
SocialPostAPIName.SocialPost,the Social Post action

Salesforce Console API (Integration Toolkit)

The toolkit includes new methods that let you customize a console’s navigation tab and interaction log programmatically.
For more information (English only) about the toolkit, see the Salesforce Console Integration Toolkit Developer's Guide.

The following methods are new or have changed in APl version 32.0.
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isCustomConsoleComponentHidden ()
Determines if the application-level custom console component window is hidden. This method is available in API version 32.0 and
later. In APl version 31.0 and earlier, this method was called i sCustomConsoleComponentWindowHidden ().

setCustomConsoleComponentHeight ()
Sets the window height of an application-level custom console component that's on a page. This method is available in APl version
32.0or later.

setCustomConsoleComponentVisible ()
Sets the window visibility of an application-level custom console component that's on a page. This method is available in APl version
32.0and later.In APlversion 31.0 and earlier, this method was called setCustomConsoleComponentWindowVisible ().

setCustomConsoleComponentWidth ()
Sets the window width of an application-level custom console component that's on a page. This method is available in APl version
32.0 or later.

ISVforce

Winter ‘15 includes enhancements to the Partner Community, Environment Hub, and the License Management Application (LMA).

IN THIS SECTION:

Partner Community

The Partner Community, at https://partners.salesforce.com, now includes support for filing cases, integrated search, and online
training sign-up, making it even more useful as the primary resource for ISVs.

Environment Hub Setup Simplified

My Domain deployment is no longer required for enabling Environment Hub. This simplifies the default setup and makes the feature
more widely accessible.

Create Trialforce Source Organizations in the Environment Hub

You can create Trialforce Source Organizations (TSOs) directly from the Environment Hub. This is a simpler alternative to using a
Trialforce Management Organization (TMO).

Environment Hub Included with Platform License

Environment Hub is included with all platform licenses, making it available in additional development contexts. Previously, the
feature was available only in organizations with a Salesforce license.

Refresh Licenses Using the LMA

Partners can refresh all customer licenses directly from the License Management App (LMA). This makes it easier to ensure that
licenses are up-to-date without having to contact salesforce.com.

View More Subscriber Information in the LMA

The License Management App (LMA) displays additional information such as the status, instance, and expiration date of customer
organizations. Partners can view all relevant license details in one place, making it easier to support customers.

Package External Data Integrations

The External Data Source component is now available in managed and unmanaged packages. Add external data sources and their
dependent external objects and custom fields to packages to easily distribute external data integrations to any Salesforce organization.
Package Lightning Components

Package and distribute Lightning components and applications to make them available to other Salesforce users and organizations.
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Partner Community

The Partner Community, at https://partners.salesforce.com, now includes support for filing cases, integrated search, and online training
sign-up, making it even more useful as the primary resource for ISVs.

The new enhancements are as follows.

e (ases: Log support cases directly from the Partner Community, instead of going to the Partner Portal. You can also track the status
of cases and get useful information on particular support issues.

e Integrated search: Search results now span the Partner Community and Success Community, making it faster and easier to find
relevant resources.

e Online training signup: Browse the complete schedule of training courses and sign up for the ones of interest to you.

@ Nofe: The Partner Portal, at https://salesforce.com/partnerportal, can still be used for creating test organizations. If you've set up
the Environment Hub, you can also use it to create test organizations. Using the Environment Hub can speed up development by
making it easier to manage multiple organizations.

Environment Hub Setup Simplified

My Domain deployment is no longer required for enabling Environment Hub. This simplifies the
. . EDITIONS
default setup and makes the feature more widely accessible.

You can enable Environment Hub and use it to create new organizations, without using My Domain. Available in:
However, My Domain deployment is still required to enable Single Sign-On or to connect existing e Enterprise
organizations to the hub. e Performance
e Unlimited
e Developer

Create Trialforce Source Organizations in the Environment Hub

You can create Trialforce Source Organizations (TSOs) directly from the Environment Hub. This is a
simpler alternative to using a Trialforce Management Organization (TMO).

EDITIONS

To create a TSO in the Environment Hub, click Create Organization, choose Trialforce Available in:

Source Organization from the drop-down list, and enter the required information. After e Enferprise

the organization is created, it appears in the Environment Hub, and you get an email confirmation. * Performance
e Unlimited

Note: Custom branding is not supported in TSOs that are created by using the Environment
Hub. If you plan to brand your emails or login page, create the TSO from a TMO instead.

USER PERMISSIONS

To set up and configure the
Environment Hub:

e “Manage Environment
Hub”

To connect an organization
to the Environment Hub:

e “Connect Organization
to Environment Hub”
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Environment Hub Included with Platform License

Environment Hub is included with all platform licenses, making it available in additional development EDITIONS
contexts. Previously, the feature was available only in organizations with a Salesforce license.

All platform licences now include Environment Hub by default. However, you still need to log a Available in:
support case to get the feature enabled for your organization. e Enferprise
e Performance
e Unlimited

Refresh Licenses Using the LMA

Partners can refresh all customer licenses directly from the License Management App (LMA). This
makes it easier to ensure that licenses are up-to-date without having to contact salesforce.com.

A license refresh updates the current license information for every installation of a managed package across all Salesforce instances. To
refresh licences:

1. Inthe LMA, click the Packages tab.
2. On the Package Detail page, click Refresh Licenses.
The time required for the refresh varies depending on the number of installations.

@ Nofe: A package license refresh can be run only once every seven days. The date of the last refresh and the next available refresh
are shown on the Package Detail page.

View More Subscriber Information in the LMA

The License Management App (LMA) displays additional information such as the status, instance, and expiration date of customer
organizations. Partners can view all relevant license details in one place, making it easier to support customers.

The following new fields have been added to the License Detail page.

e Instance:the serverinstance of the organization, for example, “na8."

® Package Version Name:the version name of the installed package.

® Package Version:the version number of the installed package.

® Org Expiration Date:the expiration date of the organization.

e Org Status:the licensing status of the organization. Possible values include Trial, Free,and Active.

* Sandbox:indicates if the organization is a sandbox.

Package External Data Integrations

The External Data Source component is now available in managed and unmanaged packages. Add
external data sources and their dependent external objects and custom fields to packages to easily
distribute external data integrations to any Salesforce organization.

EDITIONS

Available in: Developer
@ Note: We anticipate this product will be generally available in the November 2014 to January Edition

2015 time frame. Any unreleased services or features referenced in this or other public Available for an additional
statements are not currently available and may not be delivered on time or at all. Customers cost in: Enterprise,
who purchase Salesforce applications should make their purchase decisions based upon Performance, and
features that are currently available. Unlimited Editions

Suppose, for example, that a publicly accessible database contains details about films, such as cast,
crew, ratings, and trivia. An ISV can create and sell a Film Database package that:

341



Force.com Development Package Lightning Components

e Lets users view and search that data as external objects within Salesforce.
e Letsadministrators set up relationships between that data and data within their Salesforce organizations.
e Enables query access to the data via SOQL.
e Enables programmatic access to the data from outside Salesforce via the Salesforce API.
Here are some special considerations for when you're packaging external data integrations.
e Afterinstallation from a managed or unmanaged package, the subscriber must reauthenticate to the external server.
— For password authentication, the subscriber must re-enter the password in the external data source definition.
- For OAuth, the subscriber must update the callback URL in the client configuration for the authentication provider and then

reauthenticate by selecting Start Authentication Flow on Save onthe external data source.

* Inmanaged and unmanaged packages, external objects are included in the custom object component.

Attributes of External Data Sources in a Managed Package

This table shows which attributes of an external data source are editable after installation from a managed package.

e Developer Editable: The developer can edit the component attributes in this column. These attributes are locked in the subscriber's
organization.

e Subscriber and Developer Editable: The subscriber and developer can edit the component attributes in this column. However, they're
not upgradeable; only new subscribers receive the latest changes.

e Locked: Once a package is Managed - Released, the developer and subscriber cannot edit the component attributes in this column.

Developer Editable Subscriber and Developer Editable  Locked
° Type e Password Name
o (ertificate e Username

e Custom Configuration
e Endpoint

e Protocol

Package Lightning Components
Package and distribute Lightning components and applications to make them available to other Salesforce users and organizations.

@ Note: Lightning components are available in a beta release. For more information, see Lightning Components (Beta).

Publish applications and components to and install them from AppExchange. When adding an application or component to a package,
all definition bundles referenced by the application or component are automatically included, such as other components, events, and
interfaces. Custom fields, custom objects, list views, page layouts, and Apex classes referenced by the application or component are also
included. However, when you add a custom object to a package, the application and other definition bundles that reference that custom
object must be explicitly added to the package.

@ Note: Package versions are not supported for Lightning resources.

To create and work with managed or unmanaged packages, you must use a Developer Edition organization and register a namespace
prefix. A namespace prefix is required for creating applications and components in the Developer Console. To ensure that your application
and other resources are fully upgradeable, use a managed package. A managed package includes your namespace prefix in the component
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names and prevents naming conflicts in an installer's organization. An organization can create a single managed package that can be
downloaded and installed by other organizations. After installation from a managed package, the application or component names are
locked, but the following attributes are editable.

e APl Version

e Description

e [abel
e language
e Markup

Any Apex that is included as part of your definition bundle must have at least 75% cumulative test coverage. When you upload your
package to AppExchange, all tests are run to ensure that they run without errors. The tests are also run when the package is installed.

For more information on packaging and distributing, see the /SVforce Guide.

Other Changes in Force.com Development

We've improved your experience with Force.com Development tools.

Make Your Own Improvements to the Force.com IDE
Clone the repository for the Force.com IDE plug-in for Eclipse on GitHub, customize the plug-in to meet your needs, and collaborate
with the growing community of Salesforce developers to build new Force.com IDE features. Check out the Force.com IDE Release
Notes to see improvements that we've made to the plug-in.

Person Accounts Are Now Packagable
Want your app to better serve organizations using a business-to-consumer model? Now, you can include Person Account components
and attributes in managed and unmanaged packages.
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OTHER SALESFORCE PRODUCTS

desk.com

Desk.com is an all-in-one customer support app for small businesses and growing teams.

For information on new features, go to the Desk.com Product Updates Blog.

Heroku

Heroku is a cloud-based application platform for building and deploying web apps.

For information on new features, go to the Heroku Changelog.

Salesforce Marketing Cloud

Salesforce Marketing Cloud is a unified social marketing suite that allows companies to listen to and engage customers, publish content,
optimize social advertising, measure campaigns, and integrate social insights with customer data.

For information on new features, go to the Salesforce Marketing Cloud Facebook page.
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HELP AND TRAINING

Videos

[ ]
0 How to Manage Leads and Opportunities

Learn how Salesforce can help you track your leads and opportunities through the sales funnel, and automatically incorporates
updates into management forecasts.

o Managing Duplicate Records in Salesforce with Duplicate Rules (Beta)

Learn how to create a duplicate rule so you can control whether and when users are allowed to save records that are identified as
duplicates.

0 Identifying Duplicate Records with Matching Rules (Beta)

Learn how to create a matching rule so you can control how duplicate records are identified.

Developer Guides

® Inthe SOAP API Developer's Guide, the following changes have been made to the documentation for DescribelayoutResult to bring
it in line with what's already in the API.

—  DescribeButtonSection has been updated to DescribelLayoutButtonSection, and information aboutits field detailButtons
has been added.

- Adescription for DescribelayoutButton was added, as well as information for its three fields: custom, 1abel, and name.

Trust and Compliance Documentation

The Salesforce.com Trust and Compliance Documents have undergone seasonal updates. Click the link to view the documents. You
don'tneedtologinto help.salesforce.com.

The following changes have been made in the Notices and Licenses Documentation:
e Updated distributed software disclosures and related terms for the following products:
- Salesforce Services
- ExactTarget
- Predictive Intelligence
-~ Marketing Cloud Services
- Heroku

—  Desk.com

e Updated third-party notices to reflect current product offerings for the following products:
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- ExactTarget
- Predictive Intelligence

- Marketing Cloud Services

e Desk.com documentation also contains an updated list of third-party applications provided via Desk.com Services.
The following changes have been made in the Security, Privacy, and Architecture Documentation:

Salesforce Services
You can opt in your end users, based on usage data, to receive information about Salesforce Service updates.

Pardot
e Added information about third party vendors that Pardot Services uses for email deliverability and email usage analytics
e Added information about security controls including CAPTCHA and SSO
e Updated information on data encryption standards
e (Changed the Customer Data retention period from 180 days to 90 days
e (Changed the disaster recovery objective for the restoration of Pardot Services from 48 to 72 hours

ExactTarget
Added information on:

e TRUSTe Privacy Seal
e Use of cookies for two factor identification

Predictive Intelligence
In the Audit and Certifications section, added information about security assessments by internal personnel and third parties.

Radian6
Added “Social Studio” as a service covered by this document.

BuddyMedia
e Added “Social Studio” as a service covered by this document
e Added information on TRUSTe Privacy Seal

Data.com
In the Audit and Certifications section, added information about security assessments by internal personnel and third parties.

Heroku
e Added information on Heroku's certification to the EU/U.S. and Swiss/U.S. Safe Harbor framework

e (larified that restrictions on the submission of certain customer data to the Heroku Services don't apply to financial information
provided to Salesforce.com

e Disclosed the tracking and analytics of usage data that is personally identifiable and clarified that such data may be provided to
third parties
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